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1.1 An introduction to The Observer XT

This chapter gives a general overview of what The Observer XT program does. Please note 
that this chapter is a conceptual overview; it shows the basic ideas behind the way in which 
The Observer XT translates your observations into computer language, and then processes 
them to produce statistics and graphs. This chapter describes why you have to carry out 
certain steps with The Observer XT before you see the results of your study, and not how. We 
recommend reading this chapter to all first-time users of The Observer XT. For more detailed 
descriptions listing all The Observer XT's functions, please see the rest of the chapters in this 
manual.

Sample projects

On The Observer XT download page (www.noldus.com/downloads), you find a number of 
sample projects of The Observer XT in various research areas, from entomology to human-
machine interactions. Download one of these projects together with their videos and the 
pfd-file ‘Description of The Observer XT sample projects’, to get an idea on how to 
implement a research project in The Observer XT. See Restoring a Project on page 408 how to 
open a sample project. 

what is the observer xt?

The Observer XT is a professional and complete manual event recorder for the collection, 
management, analysis and presentation of observational data. It is an important tool for the 
study of behavioral processes when you need to record a level of detail that you cannot 
obtain without an automated system. You use The Observer XT whenever you need to record 
activities, postures, movements, positions, social interactions or any other aspect of the 
behavior of humans and animals.

The Observer XT was first developed as an automated system to collect observations of 
behavioral patterns in animals. However, soon it became clear that the flexibility and 
powerful analysis functions of The Observer XT made it suitable for almost any study 
involving observational data. In human psychology, The Observer XT aids in collecting data 
on behavioral development, parent-child as well as any social interaction (Figure 1.1), 
communication, education, language acquisition, cognition, psychological assessment, etc.
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How difficult is working with a machine? How easy-to-use are cash dispensers for 
customers? The Observer XT is also useful whenever one needs to collect observational data 
that is essential, for instance, to assess a physical workload (Figure 1.2), usability of products, 
or to study human-machine interactions.

overview

The entire process carried out with The Observer XT can be summarized as follows (see also 
Figure 1.3): 

1. A researcher formulates a research question. 

2. The researcher defines for which individuals (animal or human) and their behaviors 
quantitative data need to be obtained in order to answer the research question. 

3. Each individual and each behavior is linked to a keycode in a coding scheme.

Figure 1.1 Recording interactions between 
children at play.

Figure 1.2 Recording arm movements in an 
ergonomics study.
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4. The researcher defines independent variables, for example treatment, or whether the 
parent is present or not. Independent variables remain constant throughout the 
experiment but may affect the outcome. 

5. The researcher watches one or more individuals (humans or animals) and enters the 
behaviors that occur as codes in The Observer XT. 

6. The observational data can be visualized and analyzed. The Observer XT produces lists, 
tables, graphs or statistical calculations to answer the research question.

Figure 1.3 From research question to analysis output with The Observer XT.
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how the codes are stored in the observer xt

The example in Figure 1.3 has codes for behaviors only. If you study multiple individuals, you 
have to define codes to them as well. Individuals are called Subjects in The Observer XT. 
When you score the observation “Jeffrey is Walking” at time 0:00:01, The Observer XT stores 
this in the following way. 

Time Subject Behavior
0:00:01 Jeffrey Walk
When another action is scored (for example, “Jeffrey is sitting” at time 0:00:03, The 
Observer XT stores it by creating another record consisting of the same elements:

Time Subject Behavior
0:00:01 Jeffrey Walk
0:00:03 Jeffrey Sit

Each record is attached to a time stamp, so that The Observer XT can calculate the duration 
of any action being recorded. In this case, The Observer XT interprets your records as Jeffrey 
has walked for two seconds. 

Observations are certainly more complex than the examples above. To add more detail to the 
records, The Observer XT has a feature called Modifier. Suppose that you want to score where 
Jeffrey is sitting:

‘Jeffrey is sitting on a chair’

This can be scored in The Observer XT in this way:

Time Subject Behavior  Modifier
0:00:01 Jeffrey Sit Chair

In this case, the Modifier specifies location where the behavior takes place. Modifiers can be 
numerical as well, for example to score sound level, or aggression class. 

You can define which behavior to score for which subject. For example, for a teacher you may 
be interested in other behaviors than for pupils. And similarly you can score modifiers for 
some behaviors and not for others. Scoring the modifier Sound level does not make sense for 
the behavior Walk, while it does for the behavior Sing. 

the steps in the observer xt

Steps 1 to 4in Figure 1.3 are carried out before you start working with The Observer XT. It is 
possible to skip these steps, start observing and build the coding scheme while you observe. 
However it usually benefits the quality of the observational data if you have arranged your 
coding scheme according to your research questions. Your coding scheme also determines 
the data you obtain and the kind of statistical analysis you can carry out.
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Steps 4, 5, and 6 are included in the three main steps in The Observer XT Setup, Observe and 
Analyze. These steps are visible in the overview window of The Observer XT, in the Project 
Explorer on the left side of your screen and in the menu at the top of your screen. 

Setup

You first set the main features of your project. In this step you specify:

 The source of the observation (live or from video or audio).

 The observation method (continuous, by intervals or a combination of the two). 

 The coding scheme;

 The independent variables, which are factors that can vary per observation, but remain 
constant during each observation. Typical examples of independent variables are age and 
identity of your subjects, or the observer that carries out the observation. 

Observe

You carry out your observations, either live or from previously recorded video files. If you use 
video files, you can go through them for each subject or behavior group separately, to score 
every event accurately. 

Analyze

In this step you visualize and analyze your data. 

Figure 1.4 The overview window of The Observer XT in which you can navigate to the different main 
components: Setup, Observe, Analyze.
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Visualization

With the Visualize Data function, The Observer XT produces an event plot in which events 
are plotted horizontally against a time axis. If you have scored data from video or audio, you 
can play this back synchronously with the observational data. If you have the External Data 
Module (see page 21), you can play back the imported external data synchronous with the 
events and videos as well.  

Figure 1.5 An example of the Visualization window containing the videos, the playback control and the 
time-event plot with observational data. When you have the External Data Module, the Visualization 
window also shows the imported physiological data.
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Then you analyze the data. The Observer XT can give many descriptive statistics for your 
data, like the number of times an event takes place, its mean duration, total duration, 
standard deviation, and statistics for non-normally distributed data. 

Data selection

Instead of analyzing all data, you may want to analyze a time interval. For example to 
analyze pupils’ behavior when a teacher explains something, or to analyze the behavior of a 
social group of monkeys when the alpha male is aggressive. For this purpose, The Observer 
XT has a data selection feature. The Observer XT is very flexible in the options for defining a 
time interval, it can be based on time, or on events that take place. If you have the External 
Data Module (see page 21) the time interval can be based on the value of the external data as 
well. After you defined the interval, you calculate the descriptive statistics as you would do 
for all data. 

To select data, you build a sequence of selection boxes connected to each other. This 
sequence always starts from a box called Start, containing all the data in your project, and 
represents the flow of data progressively extracted from each box. The last box, called 
Results, represents the data set you use for visualization and analysis.

Episode selection

The Episode Selection functionality of The Observer XT makes it possible to create a video 
from selected fragments. This can be useful when you want to demonstrate what a certain 
behavior looks like. 

Figure 1.6 An example of a data selection sequence. 1. Start box, containing all observations of all data. 2. 
Interval box to make time intervals based on the behaviors specified in this box. 3. Filter box, specifying the 
observations to be analyzed. 4. Results box, representing the container of the selected data. 

The Observer XT supports the use of Chinese simplified characters, Japanese 
characters, and Cyrillic characters.
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1.2 Extra options for The Observer XT 

The Observer XT has five modules:

 Base Module – With the Base Module of The Observer XT you can score events in a live 
situation, without using video files. This module can be extended with one of the other 
modules.

 Media Module – You need this module if you want to score data Live with a video device, 
or Offline from video files (see Section Observation Source in Chapter 3 of The Observer 
XT Reference Manual). The module allows you to play back and record a maximum of two 
media files.

 Multiple Media Module – You need this modules to be able to record and play back a 
maximum of four media files at the same time.

If you have a fast computer, it is in principle possible to play back more than four video 
files (up to 20) simultaneously. Please contact us for more information.

 External Data Module – With this module, you can import any external data stored in 
ASCII format. External data may include physiological data (e.g., heart rate in BPM, ECG, 
EEG, blood pressure), environmental data (e.g., temperature, humidity) or eye-tracking 
data. It is possible to synchronize logged events and associated external data and 
subsequently visualize, select and export these data.

Note that if you work with interbeat intervals, you do not need this module. See The 
Observer XT Service Manual for details. You can download this manual from 
www.noldus.com/downloads.

 Advanced Analysis Module – With this module you can carry out a Reliability Analysis to 
analyze your own consistency as observer, or to determine whether multiple coders code 
the same. The Advanced Analysis Module also includes Lag Sequential analysis, with 
which you can analyze what precedes or follows a specific event. 

Additional licenses

You can extend The Observer XT with the following licenses:

 Pocket Observer license– If you need to be mobile during observations, you can use this 
module and score events with Pocket Observer installed a handheld device (for example 
a smartphone).

 Coder license – When several observers work on the same project. A coder license is a low 
cost coding tool. It allows for coding and visualization only. The observations from the 
coding stations are imported in the main project on the computer with The Observer XT. 
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Tools

In addition to the modules and licenses the following tools are available that can be used in 
combination with The Observer XT:

 Noldus uASQ – With Noldus uASQ you can set up questionnaires and collect subjective 
information from your test participants. Typical questions could be ”How do yo assess 
the workload at the moment (low/medium/high)?” or “How do you rate the 
attractiveness of this web page (scale 1-5)?”.

For details, please refer to the Noldus uASQ Reference Manual which can be found in the 
documentation folder on the installation DVD.

 E-prime – Combine The Observer XT with the stimulus presentation program E-prime. 
Annotate events in The Observer XT based on the presented stimuli and start and stop E-
prime with commands from The Observer XT. When done, visualize E-prime data 
together with the manually scored events in The Observer XT.

 Software Development Kit – The Software Development Kit (SDK) is a set of development 
tools that allows software engineers to create applications for use in combination with 
The Observer XT. See the paragraph The Software Development Kit on page 161 for more 
information. 

How do I know which licenses and tools I have?

In The Observer XT, choose Help > About The Observer XT > License info. Under Modules you 
find which options are enabled with your license. 
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1.3 The Observer XT interface

When you create or open a Project, the overview window of The Observer XT appears on your 
screen (see Figure 1.4). This window can guide you through the three main steps Setup, 
Observe and Analyze to complete your work. Click one of the three tabs and then a button to 
the function you want to activate. You can go back to the overview window at any time by 
clicking Setup, Observations or Analysis in the left part of your screen (the Project Explorer, 
see below).

By default, the interface of The Observer XT consists of two views: the Project Explorer, and 
the working area that depends on where you are in the program, for example project setup, 
visualization or analysis. 

The Project Explorer gives an overview of the observations and analysis results of your 
project. Use the Project Explorer for management of your project data. The other windows 
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are customizable. The tool bar contains View Settings, which you can use to define what 
windows to display. 

project explorer

The Project Explorer displays all the project files belonging to your currently opened 
project. In the example in Figure 1.8, a project called 'Rat in open field' has been created. 
The project details have been made visible by clicking the arrows. 

Figure 1.7 The View Settings list for the coding scheme.

Figure 1.8 The Project Explorer.
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You can resize and undock the Project Explorer. In the View menu, you can select 
to view or hide the Project Explorer. And it can be minimized, using the Auto 
Hide button. 

Right-click menus

Most items in the Project Explorer are equipped with right-click menus. This way you can, for 
example, sort your observations by name. All key functionality can be conveniently accessed 
through right-click menus.

1.4 What's new in The Observer XT

Users of previous versions of The Observer XT should read this section to get an idea of the 
improvements and changes in The Observer XT 12.5 relative to The Observer XT 11,5 (see 
page 25) and The Observer XT 12 (see page 27). 

for users of the observer xt 11.5

Windows 7, 64 bit and Windows 8.1, 64 bit compatible

The Observer XT is compatible with the 64 bit versions of Windows 7 and Windows 8.1. For 
more information, see “System requirements for Noldus software” on www.noldus.com/
downloads.

Episode selection in visualization

It is now possible to select episodes in the time event plot to create an episode selection and 
a video with only these episodes. In contrast to the other methods to create an episode 
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selection, this method is independent from the start and stop of events. This means that you 
can start and stop the episode based on, for example, an audio or visual cue, which can 
appear halfway in an event. Furthermore, the new method is easy to use and intuitive, you 
can see immediately which video segments you have selected. 

Visualization of comments

Comments that are scored in the event log can now visualized in the time event plot. This is 
especially useful if you use The Observer XT for the transcription of a conversation. The 
visualization of comments allows you to see in one view what was said and when. But also if 
you used the comments to make notes about the experimental setup, it can be useful to see 
these together with the events. 

Playback control customizable

The Playback control window has been redesigned and is now customizable. Buttons that 
are not commonly used, like the step frame forward and step frame backward button, are 
hidden by default. You can select to show or hide these buttons in the Project Settings, so you 
can adjust the Playback control window to your own needs. 

New statistics

The statistics for behavior and numerical analysis now include the Median and the 25th and 
75th percentile. 

Find and export

With the find functionality you can easily make a selection of events. It is now possible to 
export these events directly to excel or a text file, for example for statistical analysis in a 
program like SPSS. 

Improved external data import

If you have the External Data Module of The Observer XT, you can import external data like 
heart rate, or galvanic skin response data. This way you can for example calculate the heart 
rate during the behavior Running, or see what behavior took place when the heart rate was 
above a certain threshold. External data can only be imported into The Observer XT when 
they have time stamps that deviate maximally 10% from being equidistant. Previous 
versions of The Observer XT were not able to import external data files when some time 
stamps, or samples were missing. This is now possible, missing time stamps are interpolated, 
and samples at those timestamp get the value NaN. 
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for users of the Observer xt 12.0

Loop in video

You can set a loop in the video to play it back repeatedly. This way you can repeatedly view a 
fragment. This can be useful to score a fragment accurately, to inspect part of an 
observation, or to demonstrate your project in a presentation. You can set the start and the 
end of the loop manually, but also use a loop of a fixed length. This way you can, for example, 
first score the first minute of a video accurately and then move the loop to the next minute. 

Data selection by duration

You can now select events and intervals with a minimum or maximum duration. This way 
you can, for example, select only those Aggression events that lasted minimally 1 minute. Or, 
for example, you can analyze only analyze those time intervals during which a child looked 
away from the mother for maximally 30 seconds. 

Compatibility with European Data Format

If you have the External Data Module (see Additional licenses on page 21), you can now 
import European Data Format (EDF) files. EDF is a standard binary format to store and 
exchange physiological data. It is also possible to import EDF+ data, that may contain 
annotations, but the annotations are not imported into The Observer XT. Import of BioSemi 
Data Format (BDF and BDF+) files, which is the 24 bit version of EDF (+), is also supported. 

Compatibility with Viso

It is now possible to import sessions created by the video recording and annotation program 
Viso into The Observer XT. Annotations done in Viso are imported as event logs in The 
Observer XT and Viso videos are automatically linked to these event logs. In The Observer XT, 
you can carry out more advanced annotations with your own coding scheme. And you can 
analyze the Viso data. 

uLog 3.5

Together with The Observer XT 12.5, a new version of the key logging program uLog is 
released. This version is compatible with the 64 bit versions of Windows 7 and 8.1. uLog 3.5 
creates log files in .odx format that can be imported into The Observer XT. In The Observer XT, 
you can analyze the logged computer activities. For more information, see the uLog 3.5 
Reference Manual.

Improved Coding Scheme setup

Adding behavior and behavior groups is now easier, because the behavior and group types 
are explained while adding them. Mutually exclusive groups are no longer exhaustive by 
default. This means it is no longer necessary to define and score initial state events. 
Chapter 1 - Introduction 27



1.5 Additional information

help menu

The Observer XT’s Help menu contains the following options:

 Help topics – Opens the PDF of The Observer XT Reference Manual.

 Video Tutorial – Take a few minutes to learn about how to set up an observational study 
in The Observer XT.

 The Observer XT Online – If your computer is connected to the Internet, choose this 
option to go to: 
- The Observer XT home page of the Noldus website. The Observer XT home page 

contains all kinds of information about the program as well as examples of how The 
Observer XT is used.

- Check for Updates – This opens a page on the Noldus website with available updates 
including an explanation of what problems have been fixed. You can download the 
updates after you have logged in on the website.

- Contact Help Desk – The Observer XT Help desk page of the Noldus website. Here you 
can find the phone numbers of our help desks and support request forms.

- Knowledge Base – The Knowledgebase is a database with hundreds of entries 
submitted by our customers to the Noldus support department with answers by our 
support staff.

- Report an Issue – You are forwarded to an online form where you can report your issue. 
Noldus Support will contact you after they received the form.

On the Noldus website you can also:
- Download technical documentation and sample projects. Visit www.noldus.com and 

browse to the Downloads section.
- Get information about known problems and their solution. This information is also 

available on the Support - Downloads section.

 Upgrade – If you have purchased an upgrade of The Observer XT, choose this option to 
type the new Upgrade Key number that you have received from Noldus. 

 About The Observer XT – Choose this option to see details of exactly which version of The 
Observer XT you are using. Click License info to see the registered user, license number of 
your software and what licenses you have. 

If you want to be kept up to date about the latest developments, click the link under Latest 
news on the window that appears when you start The Observer XT or close a project.
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quick help

In some parts of the program, the program you find short explanations about the 
functionality. Click the Quick Help button for these explanations. You find the button at the 
top right of your screen.
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2.1 System requirements

operating system

The Observer XT 12.5 supports Microsoft Windows 7 Service Pack 1, 64-bit Professional edition 
and Windows 8.1 Pro, 64 bit. 

On Windows 7, Service pack 1 or higher must be installed, otherwise installation is not 
possible.

Languages

It has also been tested with and Cyrillic, Japanese and simplified Chinese language packs. It is 
possible that certain local language versions of Windows may affect how well the program 
runs. For more information about using non-Latin characters, please see the section using 
Chinese, Japanese or Cyrillic characters in The Observer XT Service Manual. You can 
download this manual from www.noldus.com/downloads.

Supported hardware

Drivers of the supported hardware must be installed separately. These drivers are available 
on The Observer XT 12.5 installation disc. The following hardware works with The Observer 
XT 12.5 running on 64-bit Windows 7 and 8.1:

Recording devices

 Epiphan DVI2USB 2.0 screen capture device.

 Epiphan DVI2USB 3.0 screen capture device.

 Microsoft LifeCam Studio webcam.

Video controlling device

 Contour ShuttlePRO v2 Jog/shuttle device.

Mobile scoring device for Pocket Observer

 Psion Workabout Pro WA4003-G2 handheld computer*.

 Samsung Galaxy S GT-I9000 and Samsung Galaxy Note GT -7000 smartphones**.

 Samsung Galaxy 2 10.1 GT-P5100 tablet**.

Do not record with a higher frame rate than 30 fps with the Epiphan DVI2USB 
screen capture devices. The device may crash if you do so. To change the 
frame rate, see page 50. 
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* Used for Pocket Observer 3.1 which runs on Windows Mobile 6.1. Please note that Windows 
Mobile 6.1 is no longer supported by Microsoft Windows. 

**Tested with Android versions 2.2 and 2.3 for the phones and 4.0 for the tablet.

For more information, see System requirements for Noldus software on www.noldus.com/
downloads.

computer

The type of computer you need to run The Observer XT depends on the use you will put The 
Observer XT to. If you are carrying out a few live observations, then a simple netbook will 
suffice. If you are working with video or have a large number of observations in your project, 
then a professional workstation will be necessary. If you purchase a complete setup from 
Noldus then we will make sure that you get a computer suitable for your purposes. 
Otherwise we recommend that you contact us for advice before purchasing a computer to 
use with The Observer XT.

System requirements for simple live observations

For using The Observer XT for live observation (no video files, cameras or physiological data), 
with a maximum of 200 short observations, or a small number of observations with up to 
5000 event lines, a simple netbook is sufficient. Coding schemes with non mutually-
exclusive modifiers should not be used with such a computer, as this type of modifier has a 
severe impact on the performances. Noldus recommends in this case an ultrabook or laptop 
with at least 2 GHz processor and 2GB of memory.

System requirements for normal use

For working with The Observer XT and video (files or cameras), we recommend that you use a 
professional workstation. It is possible to buy consumer-range computers with a high 
processor speed and plenty of memory, but in order to remain competitive regarding price, 
the manufacturers often economize on the underlying system architecture. That means 
those computers are suitable for home use, but not for running professional scientific 
software. You should select a computer which is intended for professional use or labeled by 
the manufacturer as a workstation.

If you install software which installs codec packages on your computer, this can interfere 
with the codecs installed by The Observer XT (see the section Formats, containers and 
codecs in The Observer XT Service Manual that you can download from www.noldus.com/

The Observer XT is not designed for use with the touch features of Windows 7 
and 8.1.
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downloads). This includes DVD-burning software. We recommend to uninstall DVD burner 
software, video editing packages and similar.

Recommended computer

If you order a complete solution from Noldus Information Technology, you will obtain a Dell 
Precision™ T5810 workstation (or its successor), or a M4800 laptop (or its successor) with The 
Observer XT software installed and ready to use. These computers are the standard test 
platforms for The Observer, and we recommend that you use those computers. The Observer 
XT has been tested with Dell Precision™ T3610 or T5810 PC’s and the M4800 laptop.

Technical specifications Dell Precision™ T3610 PC:

 Processor: Intel Xeon E5-1620 v2 (Quad Core), 3.7 GHz.

 Internal memory: 8 Gb.

 Hard disk: 1 TB.

 Graphics card: 2 Gb NVIDA Quadro K2000, resolution 1920x1080.

Technical specifications Dell Precision™ T5810 PC:

 Processor: Intel Xeon E5-1620 v3 (Quad Core), 3.5 GHz.

 Internal memory: 8 Gb.

 Hard disk: 1 TB.

 Graphics card: 2 Gb NVIDA Quadro K620, resolution 1920x1200.

Technical specifications Dell Precision™ M4800 laptop

 Processor: Intel Core I7-4800QM (Quad core), 2.7 GHz.

 Internal memory: 8 GB.

 Hard disk: 500 GB.

 Graphics card: 2 GB NVIDA Quadro K2100M, resolution 1920x1080.

If you are planning to purchase a different computer than the T5810 or the M4800, please 
contact us for detailed advice.

We recommend that you do not use the following computers, as these have caused our 
customers problems in recent years:

 All HP (Hewlett Packard) computers.

 Dell Optiplex or Dell Vostro.

 Low-end consumer models.
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Older computers

If you are upgrading from an older version of The Observer XT you can still install the latest 
version on an older workstation. That should have at least a 2.6 GHz dual core processor and 
at least 4 GB of memory as well as a video card supporting DirectDraw acceleration. We 
recommend a 2.8 Ghz quad core processor with 8GB of memory.

Video card

To be able to play back videos in The Observer XT, your video card should have Direct3D 
Acceleration. All newer cards support this feature, but older cards (in older PC’s) do not. 

 For Windows 8.1 — Direct3D Acceleration is enabled by default.

 For Windows 7 — To check whether your card has Direct 3D Acceleration, open the 
Windows Start menu and type dxdiag in the Search Programs and Files field. Open the 
program dxdiag.exe. Open the Display tab. Under DirectX Features, Direct3D 
Acceleration should be enabled. If you have multiple screens, Direct3D acceleration 
should be enabled for all screens. 

disk space to store media files

If you are scoring from video files on the hard disk, you need sufficient free space to store 
them. Here below you find an estimate of the disk space required per hour, depending on the 
video format. Please note that file size may vary according to video resolution, bit rate etc. 
For compressed video, the actual disk space required for a recording also depends on the 
amount of change in the images. Video images with much movement requires larger disk 
space.

Note: If you are scoring from video files on CD, DVD or mobile devices, you should copy the 
video files to your hard disk.

For supported media formats, see The Observer XT Service Manual that you can download 
from www.noldus.com/downloads.

Format Disk space required

MPEG-1 600 MB/hr

MPEG-2 2.4 GB/hr

MPEG-4 DivX 700 MB/hr

MPEG-4 H.264 0.6 - 2 GB/hr

DV-AVI 12 GB/hr

QuickTime 1 GB/hr
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2.2 Installation

This chapter instructs you about the installation of The Observer XT and the connection and 
installation of all hardware and software components necessary to work with the program. It 
provides you with step-by-step instructions on how to perform certain tasks. Please follow 
these instructions carefully, and in the order they are presented.

If you ordered a new computer from Noldus Information Technology when you purchased 
The Observer XT, all your software and any internal hardware is already installed and tested.

If, having read this chapter and the separate equipment manuals, you still have problems or 
questions regarding installation, please contact our Technical Support department (see 
page 457).

2.3 Before you install

To be able to install The Observer XT you must have administrator rights, i.e. either you are 
the system administrator or you are a member of the Windows group Administrators and 
have been assigned administrator rights. Windows Power Users cannot install The Observer 
XT.

Prior to installation, please check the packing list to make sure all the components are 
present. If any of the components listed is missing or damaged, please report this to us 
immediately.

The contents of your package differ for new and existing users:

 If you are a new user of The Observer – You received The Observer XT software DVD, The 
Observer XT documentation and a hardware key (see the picture on page 41).

 If you are upgrading from older versions of The Observer – You received The Observer XT 
software DVD and this Reference Manual. You also received a number to upgrade your 
current hardware key. Hence, no hardware key is enclosed, because the one you have is 
upgraded automatically when you start The Observer XT for the first time and enter the 
upgrade number.

turn off automatic updates for device drivers

Although the general recommendation from Microsoft to use automatic updates is good, 
especially for security updates, automatic updates of hardware device drives can sometimes 
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give problems. The procedure below describes how to specifically turn off the automatic 
updates only for device drivers. If you ordered a computer from Noldus IT, the automatic 
updates for device drivers have already been turned off. 

1. Windows 7

2. From the Windows Start menu, go to Devices and Printers

3. Right-click the icon of your computer and select Device installation settings.

4. To the question “Do you want Windows to download driver software and realistic icons 
for your devices?,” select No, let me choose what to do and then

If you do not see Devices and Printers, open the Windows Start menu and 
type Devices and Printers.
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5. Select Never install driver software from Windows Update.

6. Click Save Changes.

Windows 8.1
1. Open the Start window with tiles and type Settings. 

2. Click the Settings tile. 

3. Click Change Device Installation Settings. 

4. To the question “Do you want Windows to download driver software and realistic icons 
for your devices?,” select No, let me choose what to do and then

5. Select Never install driver software from Windows Update. 
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6. Also deselect the checkbox in front of Automatically get the device app and info provided 
by your device manufacturer. 

7. Click Save Changes.

2.4 Installing The Observer XT

1. Insert The Observer XT software DVD into your DVD-ROM drive. The setup program
should start automatically.

If the setup program does not start automatically, browse the DVD and double-click the 
file setupbrowser.exe.

2. The Observer XT Setup Browser appears. Under Install software, click The Observer XT 12.

3. In The Observer XT 12.5 Installshield Wizard, click Next, read the license agreement, select 
I accept the terms in the license agreement and click Next.

4. On the Destination Folder screen, select where to install The Observer XT program files. 
We recommend that you accept the default location. Then click Next.

Important: first install The Observer XT and then connect the hardware key to 
your computer, not the other way around!
Chapter 2 - Installation 39



5. On the Document Folders screen, accept the default directories below or select others to 
which you have write access. Then click Next.
- Projects – C:\Users\Public\Public Documents\Noldus \The Observer XT\Projects.
- Templates - C:\Users\Public\Public Documents\Noldus \The Observer XT\Templates.
- Video – C:\Users\Public\Public Documents\Noldus \The Observer XT\Video files.
- Audio - C:\Users\Public\Public Documents\Noldus \The Observer XT\Audio files.

6. Select whether you use Media Recorder on the same computer as The Observer XT and 
click Next and then Install. If you use Media Recorder on the same computer, recording 
video must be done by Media Recorder. 

The Observer XT requires that the Noldus MainConcept Codec Package 8.5.32 (To play 
back video files), the Noldus MainConcept Encoder Package 7.7.10 (To create video files) 
and the Noldus LAV Audio Filter 1.0.6 (To play back audio) be installed on your PC. They 
will be installed during installation of The Observer XT, when not already present. 

7. The Installshield Wizard Completed screen appears, informing you that the program has 
been installed successfully. 

8. Insert the hardware key in one of your PC's USB ports, select Launch The Observer XT and 
click Finish. 

Notes

 The installation software checks if DirectX 9.0c or higher is installed on your computer. If 
none of those versions is detected, it will be installed. Follow the instructions on the 
screen. You will be asked to restart your computer.

 If the installation software finds a previous version of Sentinel Runtime installed on your 
computer, it informs you that when clicking Yes it will de-install the previous version and 
install the new one (6.60.1.36770). 

 In order to view the documentation in PDF format, you need Adobe Reader, or another 
PDF reader installed on your computer. If you do not already have this program, click 
Adobe Reader XI under Install software in the Setup Browser and follow the instructions 
on the screen. 

 When you select Media Recorder is used in this computer, you cannot use the LifeCam 
cameras and the DVI2USB 2.0 or 3.0 screen capture device to record video with The 
Observer XT. You must use Media Recorder on that computer to record video from those 
devices.

 If you re-install The Observer XT, and during installation you change the Project default 
folders (step 5 on page 40), the new path is only applied when clicking Reset to Default in 
the Preferences window. 
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 You can download The Observer XT installation file from www.noldus.com/downloads., 
with or without codecs. The version without codecs is for scoring live only. The video 
tutorial can be downloaded separately.

 Installing uASQ — uASQ is not shown in the Setup browser. You can install uASQ from 
the installation DVD, under uASQ. If you upgrade from a previous version of The Observer 
XT, uninstall uASQ, with the Programs and Features item of the Control Panel. Then re-
install uASQ from the installation disc of The Observer XT 12.5.

 Installing uLog — uLog is not present on The Observer XT installation disc. You receive it 
separately when you buy it. 

installing and upgrading the hardware key

Each license for The Observer XT comes with a hardware key, which 
determines which setup is available to you (base functionality with or 
without Video Support, Physiological inputs or Mobile scoring). This is 
a very important piece of equipment, as it represents the full value of 
your license and cannot be replaced if lost. Full use of The Observer XT 
is only possible when the hardware key is connected to your computer. When it is installed 
and connected properly, a red light glows inside it. 

 Connecting the hardware key

1. Plug the key into the correct USB port. 

2. Start The Observer XT.

If you remove the hardware key accidentally while The Observer XT is running, a message 
appears. Plug the key again in the PC, then click Close.

Please keep this in mind and make sure that you do not lose the key! You will 
need to pay for a new license if so.

Please be careful with the hardware key. It is sensitive and can be easily 
damaged.

Important: You must connect the hardware key after you install the software.
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Upgrading the hardware key

If you are upgrading from previous versions of The Observer, you can either uninstall the old 
version before installing The Observer XT, or leave it on your computer and install the new 
version to a different program directory.

When you start The Observer XT for the first time after installation, the system 
automatically detects the old hardware key and asks you to type the new Upgrade Key 
number in the Enter Upgrade Key dialog box (see Figure 1; the Enter Upgrade Key option is 
selected). This 20-digit number is normally sent to you by e-mail or in your welcome letter. 

This is the only occasion where this dialog box appears automatically. At other times, you 
can view it by selecting Upgrade from the Help menu.

You can also use The Observer XT 12.5 as a trial version, using a Trial Key (see The Observer XT 
12.5 trial version on page 43).

An Upgrade Key produced for a certain The Observer XT version can only be used in that 
version. For example, if you have The Observer XT 8 and you have an upgrade Key for The 
Observer XT 12.5, then you need to install The Observer XT 12.5 and enter that key there.

2.5 Upgrading to XT 12.5

See the system requirements on page 33 to check that your computer can run The 
Observer XT12.5.

 Installing The Observer XT 12.5 while keeping a previous version – You can install The 
Observer XT 12 while keeping a version lower than XT 12. To do so, during installation (see 

Figure 1  The Enter Upgrade Key window.
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page 39) make sure that the destination folder on C:\Program Files x86 is not the same 
as that of the previous version (for this purpose we advise you to keep the default folders 
selected). Installing The Observer XT 12.5 removes The Observer XT 12 from your 
computer. 

 Opening a project created with an older version in The Observer XT 12.5 — You can open 
a project that was created in an older Observer version with The Observer XT 12.5. The 
project is then converted to an Observer XT 12.5 project. A project created in The Observer 
XT 12.5 cannot be opened in previous versions. To work with that project in older versions 
of The Observer XT, restore the project from the backup file (see the section Restoring a 
Project in Chapter 11 of The Observer XT Reference Manual).

2.6 The Observer XT 12.5 trial version

If you have a previous The Observer XT version 

Remove the hardware key and follow the instructions below.

If you do not have a previous The Observer XT version
1. Go to the following web page:

http://www.noldus.com/animal-behavior-research/products/the-observer-xt 

or

http://www.noldus.com/human-behavior-research/products/the-observer-xt

and click Free trial to receive a free Trial activation code by e-mail.

2. When you install and start The Observer XT 12.5, a window appears on top: 

3. Click Start Trial. 

If you click Continue, the program will close.
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4. In the window that appears, enter the trial activation code and your mail address.

5. Click OK.

6. To see how many days you have left, from the Help menu select About The Observer XT.

The trial version has a number of restrictions:

 Use The Observer XT for 30 days.

 No recording of video files.

 Maximum number of video/audio files per observation is 2.

 Maximum number of observations is 5.

 Maximum observation time is 30 minutes.

 The use of the External Data module is disabled.

 The use of Pocket Observer is disabled.

 The use of Noldus uASQ and other plug-ins is disabled.

When the trial period expires, a message is shown at start up. Click Contact Noldus to 
request a new Trial activation code.

When you purchase an Observer XT 12.5 license, insert the hardware key in your PC. The trial 
version license is replaced by a full license.
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3.1 To get started

Create new project

To get started, create a new project. A project is a container with all your observations, video 
files, and analyses. Choose File > New project. Give the project a name, accept the default 
location or choose a new one, and click OK. Continue with Project setup on page 47 to create 
your settings, and then your coding scheme (page 66) and independent variables (page 86). 

Open project 

To open an existing project, choose File > Open Project. Browse to the project and click Open.

Save project

Choose File > Save Project. Choose Save Project As, to rename the project. 

Create new project from template

With a project template you do not have to make the same settings and coding scheme for 
every new project. See page 46 to make a project template. Use a template when:

 You want to use settings and coding scheme from an existing project for a new one. 

 You work in an observational lab and want to use the same settings to control other 
software and hardware for all new projects.

 You have a multiple coding station set-up with a main computer with The Observer XT 
and coding stations with coder licenses. See also “Creating a multiple coding station 
configuration” on page 409.

1. To create a new project based on an existing template project, choose File > New Project
From Template.

2. Click the Select button to select a template project (*.otb, or *.otx if the template was 
made with a previous version of The Observer XT).

3. Give the project a name and click OK.

It is also possible to start with a previously created template with settings, 
coding scheme and independent variables. See Create new project from 
template below.

You cannot use the characters \ / : ; * ? “ < > |. for a filename. 
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In a project created with a template, the configuration is locked. To change settings or the 
coding scheme, choose Setup > Unlock Configuration. See page 55 for more information 
about locking the configuration.

saving a project as a template

1. Choose File and then Save Project As Template.

2. Optionally click the Save options for the following additional options:
- Include Independent Variables.
- Include hardware and software devices – When you select this option, the hardware 

and software settings in the Devices list (see page 48) and settings for tools like Noldus 
uASQ and E-Prime are stored in the template project. This is useful, for example, if you 
use The Observer XT in an observation lab and want to make standard hardware and 
software settings.

- Template information – For additional information like a project description.

3.2 Project setup

In the project setup you specify whether you carry out a live or offline observation, which 
observation method you want to use and the duration of the observation.

Choose Setup > Project Setup. Choose the observation source, observation method, 
observation duration and optionally enter project information (see below). 

Settings for hardware devices are only useful if you work with the same 
computer. A hardware device (e.g., a webcam) is not the same device if it is 
used on a different computer or even in a different USB port.

If you plan to make several projects with the same project setup, make a project 
template. 
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observation source

Choose one of the options:

 Offline Observation – To score data from previously-recorded video or audio files. 

 Live Observation – If you want to score data from a live scene. 

Choose this option also:
- To record video with The Observer XT.
- To record data other than events (for example, physiological data). 

Devices for live observation

If you select Live Observation, the Devices window opens. You can also open the Devices 
window, by clicking the Devices button under Live Observation. You have the following 
options (for more information, see also The Observer XT Service Manual):

 DAQ Settings (available with the External Data Module) – Select this option if you want 
to co-acquire external (physiological) data during your observations. Double-click the cell 
under Status or click the Edit Settings button at the bottom of the table. Select the 
correct DAQ hardware profile.

There may be a name other than DAQ Settings displayed in the Devices list, depending 
on what DAQ hardware settings profile is on top of the list in the DAQ Hardware Settings 
window.

 Automatic linking of video files – Select this option if you want to capture video during 
the observation (for example, to capture the screen content of a test PC), and want The 
Observer XT to associate the saved video with that observation. In the window that 
appears, instruct the program on how to locate the video files.

 Other options – Depending on what devices are connected, more options may be 
available:
- External programs – You can have one or more programs running when you carry out 

an observation. For example, Media Recorder, or eye-tracking software. See The 
Observer XT Service Manual, that you can download from www.noldus.com/
downloads, for instructions. 

See The Observer XT Service Manual, that you can download from 
www.noldus.com/downloads, for the supported video and audio formats.

You can change the observation source for different observations. Select the 
observation source before you create a new observation. 
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- Video devices – To view live images from a camera and optionally record video with 
The Observer XT. The Observer XT supports the Microsoft LifeCam Studio USB camera 
and the Ephiphan DVI2USB 2.0 and DVI2USB 3.o screen capture devices. For other 
cameras or devices, we recommend to create video files with Media Recorder and score 
offline. 
Connect the camera to a USB port of your computer before you start The Observer XT. 
Open the Devices window and select the camera. Double-click the text under Status or 
click the Edit Settings button at the bottom of the table.

In the Video Settings window (Figure 3.1) that opens, check that the camera image is 
present in the Video preview box. 

If you accidentally unplugged the device, plug it in again and restart The 
Observer XT.
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Under Video settings, select Record video to media file on hard disk if you want The 
Observer XT to record video. Then select the Video format. DivX is an MPEG-4 format 
and AVI is an uncompressed high quality format with a very large file size (about 12.5 
GB/hour). If you choose AVI, check that you have enough disc space to store them. If 
you have the Xvid Codec installed on your computer, you can also use that format. The 
quality of Xvid is similar to DivX. Also choose the File base name, which will be used in 
every video file created by The Observer XT. Each file will be named as [name of video 
device]+[base name]+[number]. In addition, choose the location for the video files and 
your audio device. If your camera does not have a microphone, you need a separate 
microphone.

Recording with the DVI2USB screen capture devices 

Use a maximum frame rate of 30 fps for the Epiphan DVI2USB screen capture devices. The 
device may crash if you use a higher frame rate. 

Figure 3.1 The Video Settings window for a web camera connected to the Observer computer.

If you change the Observation method from live to offline between 
observations, you can no longer see the devices set for the live observations. 
To view them, right-click the observation in the Project Explorer, select 
Properties and go to the Devices tab.

It is not possible to record audio without video with The Observer XT. To do 
so, use the Windows Sound Recorder software. Type Sound Recorder in the 
search field of the Start menu of Windows 7, or in the tiles of Windows 8. 
50 Chapter 3 - Setting up your Project



To change the frame rate: 

1. Locate the program V2UGUI2.exe, which is by default in 
C:\Program FIles\Epiphan\Frame Grabber Software\

2. Right-click the file V2UGUI2.exe and select Properties.

3. Open the tab Compatibility and under Privilege level, select Run as administrator. Ask 
your system administrator for help if you do not have administrator rights on your 
computer. 

4. Open the program Epiphan Capture Tool.

5. Choose Capture and then Configure device. 

6. In the DirectShow tab, select the checkbox Limit frame rate to and select a frame rate of 
maximally 30 fps.   

observation method

Choose one of the options: 

 Continuous Sampling – With this method you record all occurrences of the behaviors of 
interest of one or more subjects as they occur. You obtain full descriptive statistics of the 
behaviors, like the duration per instance, the total duration and frequency. 

 Instantaneous Sampling – With this method you record the behavior of one ore more 
subjects at preselected moments in time (s). You obtain frequencies of the behaviors, not 
their durations. 

This method is also referred to as “scan sampling”, “interval sampling”, “intermittent 
sampling” or “point sampling”. 

 Combine Continuous and Instantaneous Sampling – This method combines the previous 
two methods.

Which Observation method do I choose?

Choose Continuous Sampling to calculate absolute frequencies and durations of the 
behaviors of interest.

Instantaneous Sampling in The Observer XT is different from “one-zero 
sampling”; with one-zero sampling it is recorded whether a behavior occurred 
(one) or not (zero) during the previous sample period.
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Example – You want to record the interaction between a parent and child and calculate the 
duration and frequency of the child smiling in presence and absence of the parent.

Choose Instantaneous Sampling when your observations are too long, or your number of 
subjects is too large to score every behavior of every subject as it occurs. Instantaneous 
sampling is commonly used to calculate time budgets, general activity of one or more 
subjects, behavioral synchronization of several subjects and spatial relations in groups.

Example – You observe a group of children and want to know the spatial distribution of the 
group over different tables. 
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Instantaneous sampling is not suitable when you want to record behaviors with a very short 
duration (for example, individual pecks or jumps). Also do not use instantaneous sampling if 
you plan to create episode selections with your data.

Use Combine Continuous and Instantaneous Sampling when you want to record the 
behavior of one or more subjects in detail (focal subjects) while recording the behavior of 
other subjects in less detail. 

Example – You observe a group monkeys and want record the behavior of the alpha male in 
detail and the behavior of the rest of the group at regular time intervals. 

Sample interval length

Once you select Instantaneous Sampling or Combine Continuous and Instantaneous 
Sampling, the Sample interval length field appears under Observation duration. It is 
important to choose an appropriate interval between samples to yield meaningful data. If 
the sample interval is long, collecting a decent amount of data is time-consuming. If the 
sample interval is too short, data from successive samples are not independent. For more 
information on the sample interval see: Engel, J. (1996). Choosing an appropriate sample 
interval for instantaneous sampling. Behavioural Processes 38: 11-17.

observation duration 

Select one of the following options:

 Open ended observation – The observation ends when you stop it manually, or when the 
end of the video file has been reached. Select one of the other two options if you want 
the observation to stop automatically after a predefined time.  

 Duration based on elapsed time – The observation stops after a predefined time. Enter 
the time in the Observation duration field that appears. The maximum is 500 hours.
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 Duration based on observed time – The observation stops after a predefined time, 
excluding the time the observation was suspended. (see suspending an observation on 
page 149).Enter the time in the Observation duration field that appears. The maximum is 
500 hours.   

 Duration based on sample intervals – This option is only available when you chose 
Instantaneous Sampling, or Combine Continuous and Instantaneous Sampling as 
observation method. Enter the Sample interval length and the Number of sample 
intervals in the fields that appear. The Observation duration is calculated automatically 
based on the combination of Number of sample intervals and Sample interval length 
(see Figure 3.2).

If you observe from pre-recorded video, there is no difference between 
the elapsed and observed time. There is only a difference when you 
observe live and at some point you suspend the observation (see page 
171).

Figure 3.2 Observation duration based on sample intervals. The Observation duration is based on the 
combination of the Number of sample intervals and the Sample interval length.

Because the first sample is taken at 0 seconds, the duration of the 
observation is actually shorter than the displayed Observation duration when 
you use Instantaneous Sampling.

Example – In Figure 3.4 the observation duration is set to Duration based on 
sample intervals. You set the Sample interval length to 30 secs and the 
Number of sample intervals to 30. The Observation duration is then 
automatically set to 0:15:00. However, the first sample is at 0 seconds, so the 
last sample is at 0:14:30. There is no sample at the exact stop time of the 
observation. 
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project information

Under Project information, you can enter important information about your project. The 
following project information is available:

 Date Created – The date and time when the project was created. This field cannot be 
edited.

 Location – The location where your project is stored on your computer. For the default 
location, see page 447. To change the default location of future projects, see page 93.

 Description – Enter information about your project such as: location, date or time of year 
of the study, observers, the scientific research question that you aim to answer with this 
study, etc. You can edit the description at any time. You can enter maximally 2047 ASCII 
characters.

Template information

If your project is based on a template, the Project Setup window also contain Template 
information with the Name, Date created and additional information. The template 
information cannot be edited. 

locking the project setup

If you want to prevent changes to the setup to occur, you can lock your setup. Choose Setup > 
Lock Configuration. 

In a locked configuration the following items cannot be edited:

 Observation source – You cannot change the observation source from Offline 
Observation to Live Observation or vice versa. However, if the observation source is live, 
you can select new devices, de-select devices, edit settings for the devices or add new 
external programs. See page 48 for more information about selecting devices for live 
observation.
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 Observation method – see page 51.

 Observation duration – see page 53.

 Sample interval length – see page 53.

 Project information - see page 55. 

 Coding scheme – see page 66

 Independent variables – You cannot define new independent variables or change the 
properties of existing variables. Entering/editing independent variable values is possible. 
If you are coding offline, you can add new video files. See page 86 for more information 
about independent variables.

When you save your project as a template project, the project setup in the new project 
created with the template is locked.

Unlocking the Project setup

To unlock the project setup choose Setup > Unlock Configuration.

3.3 Project Settings

With project settings you define the way you record data, for example options for the 
keycodes, in what way the time should be displayed and which playback control buttons to 
use. You can change project settings at any time, also if you have already carried out 
observations. To return to the default options, click the Reset to default button. Note that 
this resets the options of all the tabs to their default settings, not only the ones on the 
current tab.

The following settings are available:
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coding scheme settings

Choose Setup, Project Settings > Coding Scheme Settings. 

Specify:

Keycodes are required

Select this option if you want to code your observations by typing keycodes on the keyboard 
and not with mouse clicks on the screen. 

Default - Keycodes are required.

Case-sensitive codes are allowed 

Select this option when you want to distinguish between UPPER-CASE (capital letters) and 
lower-case (small letters) codes. Selecting this option gives the possibility to define more 
elements, but using capitals will slow down your scoring. 

Default - Case sensitive is selected.

Generate start keycodes automatically

Select this option if you want the keycodes for your subjects, behaviors and modifiers to be 
generated automatically while building your coding scheme. 

The automatically generated keycode is based on the name of the element, for instance "w", 
"wa" or "wal" for "walk" (using a default keycode length of 1, 2 or 3, respectively). If the 
keycode is already in use, the next character in the name is used. If the resulting keycodes are 
also in use, the next suitable character in the alphabet is used.

Default – Generate automatically is selected.
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Generate stop keycodes automatically 

Select this option to let The Observer XT automatically generates keycodes to code the end of 
Start-Stop behaviors (see page 71). Choose one of the following two options:

 Same as start code – for instance, 'w' for start and stop walking.

 Switch case of start code – for instance, 'w' for start walking and 'W' for stop walking. 
Note that it is only possible to have case-sensitive keycodes if you have the option Case-
sensitive keycodes are allowed are selected (see above).

Default - Option selected, with the option Switch case of start code.

Default keycode length

The keycode length for keycodes that are automatically generated.      

Default - Keycode length 1.

Check coding scheme while editing 

When this option is selected, you get visual feedback when you make a mistake 
while editing the coding scheme. A warning triangle in the icon in front of the 
coding element warns you when the element contains an error. When you point with the 
mouse at an icon with a warning triangle, a description of the coding error pops up. Click the 
Check Coding Scheme button at the top of the coding scheme screen for more detailed 
information on the errors. See page 83 for more information.

Default - The option is selected.

 Use Pocket Observer with... 

When you want to send your coding scheme to Pocket Observer and score data on a Pocket 
PC, your coding scheme must be compatible with Pocket Observer 3.1 for Windows Mobile 6, 
or 3.2 for Google Android. From the list select either Android device or Windows Mobile 
device. See the Pocket Observer Reference Manual for more information. 

Default - The option is not selected.
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observation settings

Choose Setup > Project Settings. The Project Settings window appears with the Observation 
settings tab open. 

You have the following options.

Observation base name

Type a common name for your observations. The default base name is Observation. The 
observations will be named <Base Name>0001, <Base Name>0002, etc., unless you give 
them another name when you start an observation.  

Prompt for confirmation to end observation

Keep this option selected if you want The Observer to ask you whether you really want to 
end the observation, when you stop it. 

Edit Independent Variables

Specify whether to enter the values of independent variables before, after, or both before 
and after the observation.

Select Hide 'manual' variables if you want The Observer not to show variables that are 
specified as Manual in the Value update field of the independent variables list (see page 87). 
If you select this option and all user-defined variables are defined as Manual, the 
Independent Variables List is not shown at the start/end of the observation. If at least one of 
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the variables is defined as Optional or Compulsory, the variable list is shown at the start/end 
of the observation, but the Manual variables are hidden.

time formats

Choose Setup > Project Settings > Time formats, to change the time format. The time format 
is used in the Event Log window, File Synchronization window, Timers window, Playback 
Control window, Visualization and the Analysis Results.

Time formats

Select the preferred format and decimals. 

Project time format

Select either Absolute (the actual time during observing), or Relative (the time from the 
start of the observation).

Show date with absolute times

Select this option if you want to include the date in the time stamps. 

Show frame numbers while observing from video

Select this option to display frame numbers in the event log instead of times.
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Note about absolute time format

It may happen that you do not see AM or PM notation, even if you selected this in the 
Absolute Time Format window (see picture below).

This is caused by the settings of Windows for your clock time. To change these settings, click 
the clock, which is (usually) in the lower-right corner of your screen. Click Change date and 
time settings, Change date and time, Change calender settings and then the Time tab. After 
AM symbol choose AM and after PM symbol choose PM.

scoring options

From the Setup menu, choose Project Settings, and then Scoring options.  
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Auto Record Subject 

Select this if you want to score the same subject for consecutive events. Use this option 
when you score from video, have multiple subjects and go through the video for every 
subject. 

How to score a new subject – As soon as you want to enter the event for a different subject, 
click the cell where the subject was entered automatically, and score the new subject, the 
behavior and so on. The new subject is now scored for all the next events.

Default - Option not selected.

Pause playback when scoring an event

With this option the video pauses when you score the first element of an event. Playback 
resumes after scoring the last element of the event or pressing Enter to confirm the event 
line (see below). When you carry out an Offline observation with the Instantaneous 
Sampling method, the media file automatically stops at the moment of sampling.

This option is also very useful if you score from audio files and you want to transcribe spoken 
text into comments). 

Default - Option selected.

Always press Enter to confirm event line 

An event can consist of more than one elements (Subject, Behavior, Modifier). By default, The 
Observer automatically ends the coding of the event and moves to the next line in the event 
log when no further elements can be scored for that event. By selecting Press Enter to 
confirm Event line, you can press Enter once you have scored all the elements you require. 
This way, you can end an event when not all elements have been scored. For example, an 
event type where the Behavior is linked to a Modifier could be ended by scoring the Behavior, 
and then pressing Enter without scoring the Modifier. 

Default - Option not selected.

Repeated scoring of active behaviors 

Suppose you score an event at time 5 seconds. You score it again at ten seconds without 
having scored intermediate events. Select one of the options below to specify how both 
states are recorded.

 Allow repeated scoring of active Behaviors – The Observer XT records the end of the first 
event at T=5s and starts a new event at this point. This means that two different states 
will be recorded, that is one from T=5 to T=10 and one from T=10 to the stop of this event. 
The frequency of this event would be 2. If the second event is stopped at T=15 the average 
duration will be 7.5 s.
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 Ignore repeated scoring of active Behaviors – The Observer XT ignores the second start 
of the event at T=10s and gives an error message. With the example above the frequency 
of the event will be 1 and the duration 15 s. 

 Ask me for repeated scoring of active Behaviors - Select this option if you want The 
Observer XT to ask you what you want to do (whether to allow, or to ignore the recurring 
start). 

Default - Ignore repeated scoring of active Behaviors.

sound feedback

From the Setup menu, choose Project Settings, and then Sound feedback. 

Select one of the options for Sound feedback:

 None – No sound feedback. 

 After each key press – A sound at each key press.

 After each input element (default) – A sound after each element (Subject, Behavior, etc.) 
was been entered. 

 After each input event – A sound after the event has been completely coded. 

Default - The option None is selected.
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Sound selection

If you selected select to play sounds, select what to play under Sound Selection. Select Use 
coding scheme sounds (for elements only) to play the sounds specified in the coding scheme 
(for subjects, see page 67, for behaviors, see page 70, for modifiers, see page 79). This option 
only applies when you have selected a sound feedback After each input event (see above). 

playback control options

From the Setup menu, choose Project Settings, and then Playback control options. 
Alternatively press Ctrl+M to open this window.  

Slider range

Choose the segment of time you want to have displayed by the playback slider: 
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 All streams – The segment between A and B represents the time between the start of the 
earliest event/physiological/media file and the end of the latest event/physiological/
media file.

 Observation – The segment between A and B represent the time interval that data was 
scored in, no matter how long the other data/media file streams are. 

Note: the selection above affect the behavior of the Jump to begin or Jump to end buttons:,

As an example, if the event log starts 60 s later than the first video frame, and you select 
Observation as Slider range, clicking Jump to begin will position the slider cursor to the start 
of the observation (at 60s in the video), not at the start of the video. If you select All streams, 
the same action positions the slider cursor to the start of the earliest of all streams, that is 
the start of the video.

Default - The option All streams is selected.

Select Playback control buttons

By default some buttons are hidden in the Playback control window. You can select them or 
deselect buttons that you do not need while scoring. See playback control options on 
page 64 for more information on the buttons and see Showing and hiding playback control 
buttons on page 145 how to select and deselect them. 

Loop options

To replay a video fragment for accurate scoring or demonstration purposes. See Playback 
control buttons on page 141 for more information on the loop function. 

 Loop interval – By default the option User defined is selected. With this option selected, 
you either loop the entire video, or set an interval manually. If you select the option Fixed 
interval, a loop of a fixed length is created. (see Playback control buttons on page 141 for 
more information)

 Interval length – This option is enabled if you select Fixed interval in the Loop interval 
list. Set the length of the loop. 

Default - User defined interval is selected.

Quick review

With the Quick Review function (see Playback control buttons on page 141) you can 
automatically rewind to a certain point and play the media file at a certain speed. Here, you 
customize your Quick Review function:

 Pause playback after quick review – Select this checkbox if you want the video to pause 
after the video fragment is played back.
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 Quick review interval – Enter the number of seconds you want the video to be rewound 
before reviewing. 

 Quick review speed – Select the speed at which the media file is played back. Note that 
not all speeds are available with certain video formats. 

Default -Pause playback after Quick review is not selected. A Quick review interval of 5 
seconds with half playback speed. 

3.4 Coding scheme

The coding scheme is the set of elements that describe the events to be recorded. It consists 
of Subjects (optional), Behaviors, and Modifiers (optional). 

Keycodes

Each of these elements can be linked to a keycode, which is a key or a combination of keys 
(maximum length of 3 characters) on the keyboard that you use to record your behavioral 
events during scoring. If you code without keycodes, you have to click cells with your left 
mouse key, which is generally slower, and means that you have to take your eyes from the 
observed scene to the computer monitor. 

The assignment of keycodes is crucial, because it determines the efficiency and convenience 
with which you can do your recording. Your code definitions should be logical, easy to 
memorize and ergonomic. Make sure that the keycodes are unique. If you want to use a 
multiple keycode, you cannot for example use the code 'a' for subject 1 and code 'ab' for 
subject 2. However, you can use 'ab' and 'ac'. The keycode length may be different for 
subjects, behaviors and modifiers and may also differ within the categories. 

The Observer XT can generate keycodes automatically while you build your coding scheme 
(see page 57). If you want the program to regenerate a keycode because it is conflicting with 
another one, right-click the code in the coding scheme and select Regenerate selected 
keycodes. To regenerate all codes, right-click any code and select Regenerate all keycodes. 

Follow the steps below to build your coding scheme:

1. Define Subjects (optional; page 67), Behaviors (page 70), and Modifiers (optional;
page 79).

2. Check the coding scheme for errors (see page 83). 

To change the terminology of your coding scheme elements, for example to use 
Participants, or Animals instead of Subjects, or Actions or Events instead of 
Behaviors, choose File > Preferences > Terminology.
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subjects

What are subjects?

When you are observing more than one individual at a time, you normally not only want to 
record what somebody is doing, but also who that somebody is. These individuals are 
referred to as 'subjects'. Subjects are usually the roles of the individuals, like child and 
mother, a doctor and a patient, or alpha male and subdominant male.  

If you want to specify the name or other properties of each subject, then create an 
independent variable (see page 86) that specifies the name or other properties of those 
individuals for each observation.

Subjects can be individual animals or humans, but also, for instance, hands (on a keyboard), 
muscles in the face or shoals of fish. If you plan to observe only one subject in each 
observation, it is not necessary to use subjects. You can specify the actual name or identity of 
the subject as an independent variable (see page 87). 

It is not mandatory to score subjects, it is also possible to score only behaviors. In fact, even 
that is not compulsory, you can also decide to score neither subjects nor behaviors and record 
only comments (free text).

Examples

 Mother-child interaction – Mother and Child.

 Social interaction in a group of animals – Alpha male, Sub-dominant male, Female.

 Imitation in twins – Twin A, Twin B, Parent…

 School environment (more subjects are observed at a time) – Teacher, Pupil 1, Pupil 2....

 Test participant, where one person is observed in each test session – No subject needed.
Chapter 3 - Setting up your Project 67



Defining subjects

To define subjects, you must view the Subjects panel (Figure 3.3) on your screen. If you do not 
see it, select Subjects with View Settings at the far-right side on the Component tool bar.

A Subject group is created for each observation method you have selected (see page 51). 
Figure 3.3 below shows the Subjects panel with a subject group for continuous Sampling and 
instantaneous Sampling. By default, the continuous sampling subject group contains no 
subject, whereas the instantaneous sampling subject group contains one subject. 

The instantaneous sampling group also initially contains an error: “Missing Combinations”. 
This is because a subject should be linked to a behavior group to score for that subject. When 
you first open the coding scheme window, no behavior groups have yet been defined.

Add subjects by clicking the Add Subject button. Give the new subject a name. All subject 
names should be different and names cannot be longer than 64 characters (16 characters for 
Pocket Observer 3.1 and 3.2).

Subject properties

To make other subject properties visible, click the subject name and then the Properties 
button at the bottom of the Subjects panel.

Figure 3.3 The Subjects panel.
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The Properties pane appears showing the properties of the subject currently selected.

 Description – Optionally add a description to you subject in the Description field 
(maximally 1024 ASCII characters). This is particularly useful if two or more people are 
using the same coding scheme and need to know who the various subjects are.

 Start code – Enter a key if the program does not automatically create keycodes (see 
Generate keycodes automatically on page 57).

Limitations - All subject codes must be unique. The characters you use for keycodes must 
be ASCII characters in the range between 32d and 127d, excluding the space bar. 

 Sound – Optionally browse to a sound (*.wav file) you want to hear when you score that 
subject. To play the sounds, you must select the Use Coding scheme sounds (for elements 
only) check box in the Sound feedback tab of the Project Settings (see page 63).

 Observation method – You can see here to what subject group (Continuous Sampling or 
Instantaneous Sampling) a subject is assigned. If you use both continuous and 
instantaneous sampling, you can change the group a subject is assigned to. The 
instantaneous subject group must contain at least one subject. 

Many of the properties can be shown on columns in the Subjects pane, but are 
hidden by default. To show these columns, right-click one of the headers and 
select Show all columns. To hide a column, right-click that column's header and 
select Hide column. To choose a subset of columns, right-click a header, select 
Show column and make your selection. 
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 Add comment – Select this checkbox if you want to add a comment every time you score 
that subject. If you select this option, the cursor jumps to the Comment column in the 
Event Log window after you scored an event for this subject. Press Enter to leave the 
Comment column and score the next event.

 Inactive – Select this check box if you want to make the subject inactive when you do not 
want to use it anymore. For more information see page 86.

 Subject-Behavior Combinations – Specify which behavior to score for which subject. 
Examples of Subject-Behavior combinations are:
-  Mother-child interaction study - You are observing a mother and her two-year-old 

child and decide to score Play behavior of the child only. You define a Play behavior 
group and assign this to the subject Child, not Mother. 

- Primate study - You are observing a group of primates and decide to follow two of 
them as focal subjects (a mother and her baby). You have defined four behavior 
groups: Individual behavior, Social behavior, Location and Distance to Mother. For one 
focal subject (Baby), you record behaviors of all four groups. For the other subject 
(Mother) you only want to make a record of two behavior groups, Individual behavior 
and Social behavior since you do not want to score Location and Distance to Mother for 
the Mother itself. In this case, you would then define a total of 4+2 = 6 combinations. 

behaviors

What are Behaviors?

Behaviors are actions, tasks, movements, situations and locations of the subjects under 
study that are relevant for your research question. Behaviors must be organized in groups.

It is not mandatory to score behaviors, it is also possible to score only subjects. In fact, even 
that is not compulsory, you can also decide to score neither subjects nor behaviors and record 
only comments. However, you can only visualize an observation that contains scored 
behaviors (see Chapter 7 for information about visualizing your data).

Examples of behaviors

 Mother-infant interaction study – Gaze mother, Baby smile, Vocal imitation etc. 

 Research on Monkeys – Walk, Forage, Groom, Chase away, etc. 

If you delete a combination and you have already scored data for that 
combination, the observation contains errors (see page 147). To remove the 
errors, restore the combination, remove the events with errors, or re-score 
them using valid combinations. 
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 Usability study – Task 1, Task 2, Usability hit, User error, etc.

Behavior groups

Behaviors are organized in groups. Behavior groups contain behaviors that are closely 
related. Behaviors cannot be part of groups within larger groups. See page 71 for more 
information on behavior groups. Examples of behavior groups are:

 Mother-infant interaction study – A Gaze group including Gaze mother, Gaze elsewhere; 
An Emotion group including Baby smile, Baby neutral, etc. 

 Research on Monkeys – A Locomotory group including Walk, Climb, etc.; A Social group 
including Bite, Groom etc. 

 Usability study – A Tasks group including Task 1, Task 2, etc.; A User experience group 
including Usability hit, User error, etc. 

Behavior group types

There are two types of behavior groups:

Behaviors in this group type cannot occur at the same time – In this group type behaviors 
exclude each other. When one of the behaviors is active, the other behaviors within the same 
group cannot be active. This group type is called Mutually exclusive. The advantage of having 
mutually exclusive behaviors is that during coding you only score the start of behaviors. 
When you code the start of a new behavior, the previously coded behavior of the same group 
automatically stops. 
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Behaviors in this group type can overlap – In this group type behaviors can overlap and there 
can be gaps between behaviors. You need to code both the start and the stop of each 
behavior. Therefore this group type is called Start-Stop. In this group type you need more key 
presses than in a group in which behaviors cannot occur at the same time. 

We recommend to use behavior groups in which behaviors cannot occur at the same time, 
since the scoring effort is less. 

Mutually exclusive and exhaustive

A group in which behaviors cannot occur at the same time can have gaps between behaviors. 
If you do not want that, you can fill the gaps between the events with a behavior like Other, 
for example Other locomotion, or No locomotion in a behavior group Locomotion. This way 
you make the group Exhaustive, which means that always one behavior is active within the 
group. To do so, select the group name in the Behaviors panel of the Coding Scheme and click 
the Properties button at the bottom of the screen. Then select the checkbox Exhaustive. 

If you upgraded The Observer XT to version 12.5 — In previous versions a 
Mutually exclusive group was exhaustive by default. This is no longer the case. 
Therefore, it is no longer necessary to define and score Initial State Events (see 
Behavior types on page 73). 
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If you use a mutually exclusive and exhaustive behavior group, a behavior must be scored at 
the start of the observation. For this purpose, one of the behaviors in this group must be the 
Initial State Event (see Behavior types on page 73). 

Sample group

When you use instantaneous sampling (see page 51), the behaviors are defined in sample 
groups. Behaviors in sample groups do not have a duration. You score which behaviors are 
occurring at regular intervals and obtain frequencies of these behaviors, not durations. 

Behavior types

There are three types of behaviors: 

Behaviors without duration – Behaviors without measurable or relevant duration. Either 
their duration is very (immeasurably) short (for instance, for a behavior like 'hitting') or you 
are not interested in the duration of the behavior but only in its frequency (for instance, in 
the case of 'talking'). Such behaviors are called Point events. 
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Behaviors with duration – Behaviors that have a distinct start and end. Besides the 
frequency of occurrence, the duration is recorded. Examples are walking, playing, grooming, 
etc. Such behaviors are called State events. 

Initial state events – This behavior type is only needed in Mutually Exclusive and Exhaustive 
behaviors groups. In such a group always one behavior is active, also at the start of the 
observation. An Initial State Event is automatically scored at time 0. If you notice at the start 
of the observation that another behavior is occurring, press the key for the correct behavior 
before you start the observation (see page 72).

Defining behaviors in a behavior group (continuous sampling)

To define behaviors, you must view the Behaviors panel (Figure 3.4) on your screen. If you do 
not see it, open the coding scheme (see page 66).

First create a behavior group. Then you can add either behaviors to an existing group, or add 
new groups.

To define a behavior group:

1. Click the Add Behavior group button. 

2. In the window that appears, enter the Behavior Group name.

Choose whether the behaviors in the group type cannot occur at the same time or can 
overlap (see Behavior group types on page 71).

3. Add the behaviors and select whether they have duration or not (see Behavior types on 
page 73). Take notice of the example of the data you can obtain with this behavior type 
under Behavior Analysis. Each behavior should have a unique name. Names are limited to 
64 characters (16 characters for Pocket Observer 3.1 and 3.2). 

Figure 3.4 The Behaviors panel.
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4. When done, click OK. The new group appears in the Behaviors panel. 

Defining behaviors in a sample group (instantaneous sampling)

Behaviors in a sample group for instantaneous sampling always exclude each other. This 
means that in each sample only one behavior from this group can be scored. If you have 
behaviors that can occur at the same time, define them in different sample groups. 

To define behaviors in a sample group, first create the group. Then add behaviors to an 
existing group, or add new groups.

To define a sample group:

1. Click the Add Sample group button. 

2. In the window that appears, enter the Behavior Group name.

3. Add the behaviors.
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4. When done, click OK. The new group appears in the Behaviors panel. 

By default, each behavior/sample group is connected to each subject in a Subject-Behavior 
Combination, which means that you score every behavior/sample group for each subject. To 
change that, see page 70).

Behavior group properties

To display the properties for a behavior group, select the group name and click the Properties 
button at the bottom of the screen. 

Figure 3.5 The Add Behavior Group window (for a behavior group for instantaneous sampling).

To re-open the behavior/sample group, double-click the name in the Behavior 
Name column. 

Many of the properties can be shown on columns in the Behaviors pane, but are 
hidden by default. To show these columns, right-click one of the headers and 
select Show all columns. To hide a column, right-click that column's header and 
select Hide column. To choose a subset of columns, right-click a header, select 
Show column and make your selection. 
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 Description – Optionally add a description to you behavior in the Description field 
(maximally 1024 ASCII characters). This is particularly useful if two or more people are 
using the same coding scheme and need to know how the behaviors are defined.

 Mutually-exclusive – Select/de-select this check box if you want to change a group in 
which behaviors can overlap (start-stop) group into a group in which behaviors cannot 
occur at the same time (mutually exclusive) or vice versa.

 Exhaustive – By default, gaps can occur in a group in which behaviors cannot occur at the 
same time. If you do not want that, select the checkbox Exhaustive. This way always one 
behavior from this behavior group is active, also at the start of the observation. If you 
make the behavior group exhaustive, you must define one of the behaviors in this group 
as Initial State Event (see Behavior types on page 73). 

 Inactive – Select this check box if you want to make the behavior group inactive when 
you do not want to use it anymore. For more information see page 86.

Behavior properties

To display the properties for a behavior, select it and click the Properties button at the 
bottom of the screen. Many properties can also be shown on columns, see the note under 
‘Behavior group properties’. You can modify the following behavior properties:

 Description – Optionally add a description to you behavior in the Description field 
(maximally 1024 ASCII characters). This is particularly useful if two or more people are 
using the same coding scheme and need to know how the behaviors are defined.

 Start code – Accept the suggested code (if the program generates that automatically; see 
Generate keycodes automatically on page 57), or change it. 

 Color (for visualization purposes; see Chapter 7). The Observer XT automatically assigns 
colors and patterns to your behaviors. Click the Color cell to change it and to add a 
pattern (optionally).

 Sound – Optionally browse to a sound (*.wav file) you want to hear when you score that 
behavior. To play the sounds, you must select the Use Coding scheme sounds (for 
elements only) check box in the Sound feedback tab of the Project Settings (see page 63)

 Event Type – Specify whether the behavior is an Initial State Event, a State Event or a 
Point Event (see Behavior types on page 73). 
Chapter 3 - Setting up your Project 77



 Add comment – Select this checkbox if you want to add a comment every time you score 
that behavior. If you select this option, the cursor jumps to the Comment column in the 
Event Log window after you scored an event for this subject. Press Enter to leave the 
Comment column and score the next event.

Selecting Add Comment is especially useful if you score from audio files and want to 
transcribe spoken text into comments. Then, select the Add Comment check box for each 
behavior separately. 

 Inactive – Select this check box if you want to make the behavior inactive when you do 
not want to use it anymore. For more information see page 86.

 Modifiers – Choose the modifier groups you want to link to that behavior. See page 79 
for information about modifiers, how to define them and how to assign modifier groups 
to behaviors. 

Frequently-asked questions about behaviors

 When to use Behaviors with or without duration? – Define behaviors with duration 
(State events) if you need to know the duration of activities. Behaviors without duration 
(Point events) are recommended for behaviors of negligible duration, like eye blinks (in 
most applications). The behavior 'look at screen' can be defined as a state, and each blink 
as a point event. However, if you want to know the durations of the time between blinks 
you need to define them as states. So then you record with every event 'blink' the start of 
an interval between two blinks. Point events can be placed anywhere in the coding 
scheme, they do not stop mutually exclusive states.

 When to use a group type in which behaviors cannot occur at the same time? – Use 
behavior groups in which behaviors cannot overlap (Mutually exclusive) when you want 
to calculate time budgets, or when you are interested in the durations of the events. Use 
this kind of groups also when you plan to analyze the time when a specific event 
occurred during a certain episode. For example, if you want to calculate the number of 
user errors during each task performed, define tasks in a mutually-exclusive group.

 When to use Mutually-exclusive exhaustive behavior groups? – Make the behavior 
group in which behaviors cannot overlap Exhaustive if you want the durations within the 
group to add up to 100%. This way you can compare figures from different calculations. 
Mutually exclusive groups were exhaustive by default in previous versions of The 
Observer XT. This is no longer the case in The Observer XT 12.5. 

 When to use behavior groups in which behaviors can overlap? – You use a group in 
which behaviors can overlap (Start-Stop) when the behaviors in the group do not exclude 
each other. Scoring effort is higher in such a group, because you have to press a key for 
both the start and the stop of each behavior. If possible, split divide the behaviors over 
multiple behavior groups in which behaviors cannot occur at the same time.  
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 When to use Sample groups? – You use sample groups when the observation method is 
instantaneous sampling.

 Can I use Point Events from a behavior group for Instantaneous Sampling? – You cannot 
define point events when you use instantaneous sampling. You can use them if you use 
Combine Continuous and Instantaneous Sampling.

modifiers

What are Modifiers?

Modifiers can be attached to behaviors. They are used to limit the scope of a behavior. 
Modifiers can be either nominal or numerical, and must always be organized in groups. 
Modifiers cannot be part of groups within larger groups. Modifiers and modifier groups are 
defined in the Modifiers panel. Once defined, you assign a modifier group to one or more 
behaviors. 

Scoring modifiers involves making extra keystrokes. If you have a simple coding scheme 
without numerical data, it can be better to define more behaviors and not use modifiers. For 
example, the two behaviors Play alone and Play in a group instead of one behavior Play with 
two modifiers (Alone and In a group) attached. 

Examples of modifiers

 Child behavior study – To describe the object that is being played with, a modifier group 
Object is defined that includes the elements Cards, Ball, Castle for the behavior Play. 

 Usability study – To describe the type of error by the test participant, a modifier group 
Error type is defined that includes Wrong value, Wrong weblink as a modifier group for 
the behavior User error. 

 Aggression in lobsters – To describe the level of aggressiveness in territorial interactions, 
a modifier group Level that includes the values 0 to 5.

Modifier group types

Modifier groups can be nominal (text) or numerical (numbers). For nominal modifiers you 
can calculate the same descriptive statistics as for behaviors, like mean duration and 
frequency. For numerical modifiers you can also calculate these statistics. In addition to this, 
you can calculate the average and other numerical statistics of the numbers scored. For 
example, the numbers 1, 2, 3 and again 2 scored in an observation result in Total number= 4, 
Average= 2, Minimum = 1 and Maximum = 3.
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Defining modifiers

To define modifiers, you must have the Modifiers panel open on your screen. If you do not see 
it, select Modifiers with View Settings at the far-right side on your screen. 

To open the coding scheme, see page 66.

First create a modifier group. Then add either modifiers to an existing group, or add new 
groups.

To define a modifier group, click the Add Modifier group button and choose Add Nominal 
Modifier group or Add Numerical Modifier group (see Modifier group types on page 79). 

Nominal modifiers

1. Give the modifier group a name and select the following:
- Mutually exclusive – Select this for a mutually exclusive group (see Behavior group 

types on page 71 for an explanation of mutually exclusive). If you select this option, 
you can only score one modifier at a time for that group, that is, you cannot score two 
or more modifiers from the same group for a specific event.

- Modifier group must be scored – Selecting this option makes scoring a modifier 
compulsory when you score the associated behavior.

2. Enter the modifiers in the Value fields. Each modifier should have a unique name of 
maximally 64 characters (16 characters in Pocket Observer 3.1 and 3.2).

3. Define to which behavior the modifier group should be attached in the Link to behaviors 
field. 

Numerical modifiers 

1. Give the modifier group a name and define the keycode to activate this modifier group.
From the Values list, select one of the following:
- Predefined values – Make a list of predefined options from which to choose. For 

example if for the modifier group Aggression level, you want the observer to choose 
between 0, 1, 2 and 3.

- Range of values – Score the modifier by entering a value between a minimum and a 
maximum value. For example if for the modifier group Speed you want the observer to 
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score a value between a minimum of 0 and a maximum of 150 with a precision of 1 
decimal.

2. Define to which behavior the modifier group should be attached in the Link to behaviors 
field.  

Figure 3.6 An example of linking a modifier group to a 
behavior. The modifier group has been linked to the behavior 
Play.

To re-open the modifier group, double-click the name in the Modifier Name 
column. 
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Modifier group properties

To display the properties for a modifier group, select the group name and click the Properties 
button at the bottom of the screen. 

 Description – Optionally add a description to you modifier group in the Description field 
(maximally 1024 ASCII characters). This is particularly useful if two or more people are 
using the same coding scheme and need to know how the modifiers are defined.

 Inactive – Select this check box if you want to make the modifier group inactive when 
you do not want to use it anymore. For more information see page 86.

 Modifiers – Select in this field to which behaviors the modifier group should be attached. 

Modifier properties

To display the properties for a modifier, select it and click the Properties button at the 
bottom of the screen. Many properties can also be shown on columns, see the note under 
‘Modifier group properties’. You can modify the following behavior properties:

 Description – Optionally add a description to you modifier in the Description field 
(maximally 1024 ASCII characters). This is particularly useful if two or more people are 
using the same coding scheme and need to know how the modifiers are defined.

 Define keycodes – Accept the suggested code (if the program generates that 
automatically; see Generate keycodes automatically on page 57), or change it. 

 Color (for visualization purposes; see Chapter 7). The Observer automatically assigns 
colors to your behaviors. Click the Color cell to change it and to add a pattern (optionally).

 Sound – Optionally browse to a sound (*.wav file) you want to hear when you score that 
behavior. To play the sounds, you must select the Use Coding scheme sounds (for 
elements only) check box in the Sound feedback tab of the Project Settings (see page 61)

 Inactive – Select this check box if you want to make the behavior inactive when you do 
not want to use it anymore. For more information see page 86.

Many of the properties can be shown on columns in the Modifiers pane, but are 
hidden by default. To show these columns, right-click one of the headers and 
select Show all columns. To hide a column, right-click that column's header and 
select Hide column. To choose a subset of columns, right-click a header, select 
Show column and make your selection. 
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Defining subjects as modifiers

 To score an action of A directed to B, B must be defined as a modifier. You can therefore 
create a modifier group containing the names of your subjects that can be the receivers 
of an action.

You can copy your list of subjects and paste them into a modifier group. To do so, click the 
first subject name, hold the Shift-key and click the last subject name. Copy the cells by 
right clicking any of them and select Copy, or press Ctrl+C. Paste the cells into an empty 
nominal modifier group. The header Subject name is also pasted. Right-click it and select 
Delete. 

maximum number of elements

The coding scheme can contain maximally 250 subjects, 250 behaviors, and 250 modifiers (in 
up to 100 modifier groups). The maximum number of combinations of subjects x behaviors is 
5000.  

creating a coding scheme from previously-recorded data 

You can create a coding scheme by importing a data file, for instance an ODX file from The 
Observer XT (see page 424). In the coding scheme which you create in this way, all the 
subjects, behaviors and modifiers are ungrouped. This means that you may need to 
reorganize your coding scheme. Note that there are limits to the number of subjects, 
behaviors, and modifiers that you can import (see maximum number of elements above). 
You can only import files that comply with these restrictions.

checking your coding scheme

You cannot carry out an observation when your coding scheme contains errors. Therefore 
check the coding scheme before starting an observation. When you have the Check Coding 
Scheme while editing option selected in the Coding scheme settings window (see page 58), a 
warning triangle appears in front of the coding scheme element when the element contains 
an error. When you point with the mouse at an icon with a warning triangle, a description of 
the coding error pops up. 

Different limits apply if you use Pocket Observer. See the Pocket Observer 
Reference Manual for details.
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For a detailed overview of the coding scheme errors, click the Check Coding Scheme button.

The Check Coding Scheme window appears with all the errors in your coding scheme (see 
Figure 3.7). In this example, the behaviors Gaze adult and Gaze elsewhere have the same 
keycode (conflicting keycodes). 

To correct the errors:

1. Select an error to view a description of the problem.

2. Click the element to jump to it in the coding scheme. There correct it.

3. Click the Check again button to check whether the errors were corrected successfully.

4. Click Close when all the errors are corrected.

Common errors in the coding scheme:

 Two or more subjects, behaviors or modifiers are given the same keycode, or the same 
name.

 A behavior or modifier group does not contain any elements. 

 A mutually-exclusive and exhaustive behavior group does not contain an initial state 
event (see page 73). 

 You have selected the Use Pocket Observer with... option in the Coding Scheme settings 
(see page 58) and you have created a behavior group with only one behavior.

Figure 3.7 An example of a Check 
Coding Scheme window. 
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modifying your coding scheme

You can rename or add coding scheme elements at any time. You can only remove coding 
scheme elements before they have been scored in an observation. 

Adding a coding scheme element

 To add a subject, click the Add Subject button in the Subjects panel.

 To add a behavior or modifier, click first the group of behaviors/modifiers you want to 
add the element to, then click the Add button on top of the panel that applies. 

 To add a behavior group or modifier group, click the Add behavior group, or Add Modifier 
group button. 

Removing a coding scheme element from a group

To remove a behavior or modifier from a group, either delete it or move it to another group 
(see below). This is only possible when you did not score the element yet. You cannot place a 
behavior or modifier outside any group. 

Moving a coding scheme element from a group to another

Click the behavior/modifier you want to move, and drag the mouse to the name of the group 
where you want to place it. When ready, release the mouse button. 

Sorting coding scheme elements

You can change the order of the elements of your coding scheme for visualization purposes. 
For example, when creating a plot of the events, you may want to view the Verbal behaviors 
at the top and the Play behaviors at the bottom of the event plot, not the other way round.

To change the order of elements or groups, click its name and drag it below the name of 
other groups. 

Editing a coding scheme element

You can change the name and the properties of a coding scheme element at any time. Do 
this either in the coding scheme, or in its properties window. To open the properties window, 
select the element and click the Properties button at the bottom of your window. 
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Deleting a coding scheme element or group

You can only delete a coding scheme element or group when it has not been scored yet. 
Select the element and press Ctrl+Del. 

When the element was scored in at least one observation a question appears whether you 
want to inactivate it. If you want to delete the element anyway, you must first delete all the 
observations in which it was scored. 

When a coding scheme element is set to inactive, it is not used anymore although it is still 
present in the coding scheme. An inactive element is grayed out in the coding scheme:

If the element was already scored, it will remain present in the event log. However, it is not 
shown in the Codes window of new observations, so you cannot score it. In event plots and 
analysis results, the element is displayed as [Element name] (Inactive). You can use the 
keycode of an inactive element for new elements. 

To reactivate an inactive element, right-click it and select Activate. 

3.5 Independent variables

Choose Setup and then Independent Variables to open the Independent Variables list. The 
Observer XT distinguishes four kinds of independent variables:

 User-defined variables – Variables that describe the subjects, observation sessions and 
environmental conditions. You can define your user-defined variables in the Independent 
Variable List (see Figure 3.8 for an example). See page 87 for more information.

 Video files – Name and location of the video files used in the observation. They are added 
automatically to the independent variable list when you create an observation. The 
scope of a video file is always observation (see page 90)

If you already have observations, click Add Video to add video files to your observation.  

If you delete a group, you also delete the individual elements within that 
group.
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 Audio files – Name and location of the audio files used in the observation. The scope of 
an audio file is always observation (see page 90).

If you already have observations, click Add Audio to add audio files to your observation.

 External data files – This column is only present when you have the External Data 
Module. It shows the name of the external (physiological) data files imported into an 
observation. The scope of an external data file is always observation (see chapter 5 how 
to import external data into an observation).

 System variables – Three variables are automatically created by the system: the start 
time, stop time and the duration of an observation. To change the format of these 
variables, click the arrow in the Format field and make your selection in the window that 
appears.

adding user-defined variables

User-defined variables are variables that potentially determine the value of a dependent 
variable (for example, behavior). They are either simple descriptive categories (such as the 
name or age of the subject), or conditions manipulated by the observer (such as the type of 
treatment given to an animal or the substance being tested). You can add maximally 40 user-
defined variables. 

Click Add Variable to add user-defined variables. Optionally enter a name (maximum 64 
characters) and a description (maximum 255 characters). The following options are available 
for user-defined variables:

Figure 3.8 Example of the Independent Variable List. The upper part of the list shows some User-defined 
variables, Video and Audio files. The lower part lists the observations in the project and the values of each 
independent variable for those observations.
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Variable type 

Click the arrow in the Type field and from the list choose one of the following options:

 Text – A text variable is denoted by alphanumeric characters, composed of letters, 
numbers or both. For example, the name of the observer.

 Numerical – A variable represented by numbers only, for example, the age of the subject.

 Timestamp – A variable represented by a time stamp, for example the starting date and 
time of the experiment.

 Duration – A variable represented by a duration, for example, the duration of the 
treatment.

 Boolean – A variable that is either 'False' or 'True'. For example, the presence of the 
observer during the test. It was called Logical in The Observer 11.0 and older versions.

Variable format

Text and Boolean variables – For Text and Boolean variables you cannot specify a format. 

For the other types of variables, click the arrow in the Format field to display the Format 
window. The program uses the decimal separator specified in your computer's Regional 
Settings. If you change regional settings, close and restart The Observer XT.

Numerical variables – Choose the number of decimals (maximum 9). The Observer uses the 
decimal separator from the regional settings of the computer where the variable has been 
defined. If you change regional settings, close and restart the program. Deselecting the No. 
of decimals checkbox will result in using integers. 

Selecting the Scientific notation checkbox will result in numbers to be displayed as, for 
example, 1.485e+0.03 instead of 1485.236. 

In the Unit field, enter the unit of your variable, for instance, 'years' for the age of the subject. 
Click OK.
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Timestamp variables –Enter your preferred format. The format f represents the decimals you 
specified in the Time formats tab of the Project Settings window (see page 60). 

Duration variables – Enter your preferred format. The format f represents the decimals you 
specified in the Time formats tab of the Project Settings window (see page 60).
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Predefined variable values

Optionally predefine values. By doing this you can select from the predefined values when 
you edit the user-defined variables. For Timestamp and Duration variables you cannot 
specify predefined values. 

Text variables – Enter the text you want to choose from when you start or end an 
observation. Select the Allow other values check box if you are not sure whether the values 
you have defined are exhaustive. This allows you to add new values as they are needed.

Numerical variables – Choose whether your variable can have any value, can have a value in 
a range, or predefine values. Select the Allow other values check box if you are not sure 
whether the predefined values are exhaustive, so you can add new values when needed. 

Boolean variables – Enter the names to display. For instance, if your variable is 'presence of 
observer', you may define the values 'No' (False) and 'Yes' (True).

Editing predefined values – To replace or delete predefined values, delete first all the values 
from the variable column.

Variable scope

The scope of a variable is the portion of the observation for which the variable has a specific 
value. 
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Choose between the following:

 Observation – A variable has scope Observation if it has the same value during the entire 
observation. Typical examples of variables with scope Observation are the name of the 
observer, or the temperature in the setup. Also, if you observe only one subject per 
observation, variables like age or gender of the subject will have scope Observation. 

The scope of a video or audio file and of external data files is always Observation. 

 Event Log – In general there will be no difference between scope Observation and scope 
Event Log, because each observation contains only one event log. An observation can 
only have multiple event logs if you imported data as event logs into an observation. This 
happens, for example, if you import FaceReader facial states into an observation. In this 
case you can set the scope of a user-defined variable to Event Log if it has different values 
per event log. 

 Subject – This option is only available if you defined Subjects in your coding scheme. If 
your observation contains multiple subjects and the user-defined variable has different 
values per subject, select scope Subject. Typical examples of user-defined variables with 
scope Subject are age, gender, and identity of your subjects. 

If you plan to create groups of observations for analysis, set the Scope of independent 
variables to either Observation or Subject, not Event log (see page 90 for details). 

Changing a variable's scope – You can change the scope of a variable at any time. If you do, 
the variable column shows the first values previously stored for each observation. Enter the 
variable values according to the new scope. 

Showing/hiding variables

You can select which columns to display in the Independent Variables list. To do so, right-click 
a column header and select Show Independent Variables.  
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To hide one column, right-click in one of the variable fields and choose Hide Independent 
Variable.

Value Update

Define in the Observation settings (Setup, Project Settings) whether to enter the 
independent variables before the start of an observation, after the end of an observation, or 
both. See page 101 for more information.

Choose whether editing variable values is:

 Compulsory – You are always prompted to edit your independent variable values (at the 
start or the end of an observation or both) and must enter a value to proceed.

 Manual – You are prompted to edit your independent variables, unless you defined in the 
Observation Settings tab of the Project Settings to Hide ‘manual’ variables (see page 59). 
If you chose this option in the project settings, open the independent variable list to 
update the values.

  Optional – You are always prompted to edit your independent variables (at the start or 
the end of an observation or both), but you do not need to enter a value.

Entering variable values

Enter the user-defined variable values in the window that opens 
when you start or end an observation (dependent on what you chose 
in the Observation settings, see page 59). To enter or edit the values, 
open the independent variables list and fill in the values. You can also 
copy and paste values from, for example, Excel. However if you 
predefined a range, the values should fall within that range. 

Exporting Independent Variables

To export the independent variables and their values, choose File, Export and then 
Independent Variables. For details, see page 444. 

Removing variables

Right-click in one of the variable fields and choose Delete Independent Variable to remove 
the variable.

Printing the Independent Variable List

In the current version of The Observer XT, printing is not fully supported. To print the 
independent variable list, copy and paste the columns into another program such as Excel. If 
you copy the columns to Microsoft Word, you can use the convert text to table function.
92 Chapter 3 - Setting up your Project



3.6 Preferences

You can set preferences for terminology in the program, showing warning messages, file 
locations and the time interval at which The Observer XT saves your project. Choose File and 
then Preferences to open the Preferences window. Restart The Observer XT after you edited 
the preferences. To return to the default settings, click the Reset to default button. Please 
note that this returns the preferences in all tabs to their default settings, not only the ones 
on the current tab. 

terminology 

In the Preferences window, click Terminology.

For instance, when the subjects of your observational study are children, you can enter 'child' 
and 'children' as the singular and plural terms for your subjects.
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warnings

In the Preferences window, click Warnings.

Select the situations that you think you should be warned about when they occur. By default 
all warnings are selected. When you select the Never show warnings check box, you do not 
get any warnings.

file locations

In the Preferences window, click File locations. The default file locations are set during 
installation. 
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You can change file locations for:

  Projects – The location you choose here, will be the default project location when 
creating a new project (see page 46). 

 Video Files – The location you choose here, will be the default video file location in the 
Video Selection window when starting a new observation (see page 99). This is also the 
default location where video files generated from episode selections are saved (see 
page 290).

 Audio Files – In this location you can store the audio files used for coding.

 Templates – The location you choose here, will be the default location in which the 
templates are stored. See page 47 for information on how to create a template from a 
project. 

auto recovery

Auto recovery saves all data from The Observer XT to a temporary file. You can find this file in 
the folder with the same name as your project starting with a tilde ("~") in the folder 
C:\ProgramData\Noldus\The Observer\XT 12\Temp. Media files, or external data files are not 
saved to this temporary folder.

Your data are only saved in the project file when you manually save them (from the File 
menu, choose Save Project or press Ctrl+S). If the program crashes, you get the option to 
recover the auto-saved project, which is the temporary file, or to continue with The Observer 
XT. In the latter case, you can open the version of your project that was manually saved.
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By default auto recovery is enabled and your data are saved to a temporary file every five 
minutes. Optionally change the interval. We recommend to leave auto recovery enabled.  

viso settings

Viso settings are needed if you want to import sessions created in the observation recording 
program Viso into The Observer XT. 

In the Viso settings tab of the Preferences window you set the connection between the 
computer with The Observer XT and the computer with Viso Services. 

Enter the IP address of the computer with Viso Services in the Services address field. Do not 
change the Services port 5672. Then click the Test connection button. If the two computers 
are connected properly, the Status Connected appears. See page 436 how to import Viso 
Sessions into The Observer XT.
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4.1 Observations and Event logs

While you carry out an observation, events and comments are logged in what is called an 
Event Log. The data from your whole Observation are stored in one Event log. However, you 
can import Event data files into your Observation, which are stored as separate Event Logs. 
Furthermore, Pocket Observer files and files from certain Plug-ins, such as data from 
FaceReader that measures facial expressions, or the questionnaire tool Noldus uASQ are also 
stored as separate Event logs within your Observation. So one Observation can contain more 
than one Event log (see Figure 4.1).

If you score data from one or more media files, those files are part of an observation. 
Similarly, if you import physiological data (see Chapter 5), those are part of an observation 
although they are stored in separate files.  

In The Observer XT, the Event logs contain the event data. You can view the observation as a 
desk on which lay one or more sheets, the Event logs, containing the actual scored data plus 
media files and external data files (see Figure 4.1).

Figure 4.1 An observation can be composed by one or more Event log files containing the behavioral data, 
zero, one or more Media files, and zero, one or more External Data files. Note: the Start and End time of an 
observation are determined by the earliest start time and the latest end time of any data set (indicated by 
the black arrow), unless you change them manually (see page 125).
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4.2 Carrying out an observation

1 - creating a new observation

When you create a new observation, you create an empty worksheet for event logging called 
an Event Log, and prepare The Observer for the start of the observation. 

1. Choose Observe > Observation > New.

2. Optionally change the name and add a description.

3a. Live – Select devices in the Devices tab if you have not already done so (see page 48). Click 
OK.

3b.Offline – the Device tab is grayed out. Click OK. 

Select your video. To visualize the audio of a video file as a waveform, select the Visualize 
audio check box. 

Figure 4.2 The New Observation properties window.
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To code from audio files without video, close the Select Video window and click the 
Import audio button on the tool bar. Click OK.

2 - choosing the correct initial state events (mutually 
exclusive and exhaustive groups only)

1. If you defined mutually exclusive and exhaustive groups in your coding scheme, the
Initial state events (see page 73) now appear in your event log. Check that the states are
correct. If not, select the correct states. 

Example –The initial state event in the mutually exclusive and exhaustive group Playing 
is Not Playing. After you have created the observation, Not Playing appears in the event 
log at time 0. When you notice the child is playing with a toy, code the behavior Play toy 
before you start the observation. 

Score the correct event behavior by pressing the key code. This behavior is now recorded 
at time 0.

2. If the initial state events are linked to one or more modifiers that must be scored (see 
page 80), you must score the modifiers before you can start the observation. 

3. Repeat these steps above for all initial state events. 

In the example below, the subject Mother has one initial state Gaze Undefined, while 
Child has two initial states Not Playing and Gaze Undefined). Note: the Event Time 
column shows no time for the initialized states, because the observation has not started 
yet.  
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3 - positioning the video (scoring offline only)

1. If you score offline, position the video with the playback slider to where you want to
start scoring. Use the playback buttons for fine positioning (see page 141). 

If you do not see the Playback Control window, select it with View Settings on the far-
right side of the tool bar. 

2. Click the Start Observation button to start the observation (see below). 

4 - starting the observation

1. Click the Start Observation button.

2. If you have defined independent variables in your project setup and you chose to edit 
them before the observation (see page 59), enter the values in the window that appears. 
You can skip values that are not compulsory (see page 92). 

3. Now score your data.
- for continuous sampling see page 102.
- for instantaneous sampling see page 105.
- for combine continuous and instantaneous sampling see page 109.

If you know the exact video time at which you want to start the observation, 
click the Offset button on the tool bar and select Numerical Offset. Locate the 
cell under Offset for the media file. Type the time in the video/audio file you 
want to start at, preceded by "-". For example, if you want to start at one 
minute in the video/audio file, type -0:01:00.00. For more information, see 
page 127. 
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5 - scoring data 

Score the subjects, behaviors and their modifiers by typing the predefined key code or 
by clicking the keycode in the Codes window. Typing key codes is generally faster. 
What you have scored appears in the Event Log window. Each row in the event log 
corresponds to one event. You can also only type free text in the Comment column, 
and press Enter (see page 118). 

The following symbols appear in your Event log. 

5A - continuous sampling — how to score events

The procedure described below is very general and may not apply to your own coding scheme 
(for example, if you have not defined subjects or modifiers, then ignore the instructions 
referring to them). Also, the terms shown below may not be those you have chosen in the 
Preferences window (see page 93). For example, Subjects may refer to Actors, or Test 
participants etc. Furthermore, you can change the usual order of scoring (for example, score 
first the behavior, then the subject; see page 119).

The start of an event.

The stop of an event.

The start of an event in a mutually exclusive and exhaustive group. The 
state is active from that moment and the previous state is no longer 
active.

A Point event.

An instantaneous sample event.

If you have keycodes with the Shift-key it may happen that you press the right-
Shift key for a long time while scoring. Pressing the right-Shift key for 8 seconds 
enables the Filter keys option in Windows. With Filter keys, rapid keystrokes are 
ignored. To disable Filter keys, open the Control Panel and go to Ease of Access 
Centre in Windows 7 or press the Windows key + U in Windows 8. Click Make the 
Keyboard easier to use. De-select Turn on Filter Keys and click Set up Filter Keys. 
Deselect the check boxes in front of Turn on Filter Keys and Turn on Filter Keys 
when right Shift is pressed for 8 seconds. Click OK twice. 
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1. The cursor is present in the Subject column. The Codes window shows all subjects. When
a subject performs a behavior you are interested in, score the subject.

Result – The row is time-stamped and the 
time appears under Time. The time code is 
assigned to a record when the first element 
or the coding scheme is entered, no matter 
whether it is a subject, behavior or modifier. In the case you enter only free text, the time 
code is assigned when you enter the first character under Comment.  

2. The cursor moves to the Behavior column. The Codes window now shows all possible 
behaviors for this subject. Score the behavior. 

3. Result – The name of the behavior appears 
in the row.

4. If the behavior was linked to one or more 
modifiers, the cursor moves to the Modifier column. The Codes window now shows all the 
modifiers that can be attached to the scored behavior. Score the modifiers. 

Result – The name of the modifier appears in the row. 
- For numerical modifiers with a predefined range, first score the numerical modifier 

group and then type the value. The range of values allowed is shown in the Codes 
window under the modifier group name.

- For modifiers with predefined values, score the numerical modifier. 
Score the other modifiers that are linked to that behavior, If scoring modifiers is not 
compulsory (see page 80), you can skip them by placing the cursor in the Comment 
column, or pressing Enter. If scoring modifiers is compulsory, the name of the modifier 
group which contains required modifiers is displayed in the event log before you 
actually score it. This helps you to see which modifiers (from which modifier group) 
still must be scored (see the example in Figure 4.3) You can score required modifiers in 
any order you want. But they will appear in the event log in the same order as in the 
coding scheme.

If you hover over the Time column with your mouse, a tool tip shows the time 
format.
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5. To stop a behavior or modifier, first score the subject, then:
- Start-stop group – score the stop of the behavior/modifier. You cannot do this before 

the subject was scored.
- Mutually exclusive behavior – score another element in the same group and its 

modifier. Score the stop of the behavior if no other behavior is active. 
- Mutually exclusive modifier - score a behavior and then another modifier. 

6. If you have selected Add Comment in the Properties pane of the subject or the behavior 
you have just scored (see page 77), and the Comment column is shown in the event log 
(see page 138 for how to hide/show columns), the cursor moves to the Comment column, 
with the word ‘Comment’ in gray. Enter a comment if you require one, and press Enter. 

Figure 4.3 An example of how required modifiers are scored. In this example, the behavior 
‘Walk’ has two modifier groups: ‘Speed of walking’ and the associated ‘Breathing rate’ of the 
subject. A - The Event Log before the Modifiers of behavior Walk are scored; the Modifier 
column indicates in gray the required Modifier groups. B - The Codes window with required 
Modifiers groups and their Modifiers. C - The Event Log after the modifiers of ‘Walk’ have been 
scored.

If you confirm the event by pressing Enter without scoring the required 
modifier, The Observer XT warns you that the event is not complete:
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If you do not want to add any comment, just press Enter. You can also copy and paste 
comments. 

7. The event is now complete.

The cursor moves to a new row, and the Codes window now shows the 
subjects again. Add new events by repeating the steps above. Press the Undo 
button on the tool bar to correct a mistake. To make a correction undone, press the Redo 
button. 

For information on how to correct scoring errors after you finished the 
observation, please see page 120. 

For more information, see:
- The Notes on Continuous Sampling below.
- How to.. procedures on page 114.
- Additional observation functions on page 147. 

5B - instantaneous sampling – how to score events

1. A sound signal is given at the observation start. The Event log shows all subjects from the
Instantaneous Sampling subject group at time 0 and in gray the behavior groups that are
linked to the subjects (see page 70).

When you carry out an Offline observation, the video/audio file pauses until you scored 
all subjects, irrespective of whether you selected the option Pause playback of video 
when scoring an event in the project settings (see page 61).
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2. The Codes window shows the subject-behavior combination in the Status column (Female 
1 - Behavior in the example below) and the behavior group that needs to be scored.

Score a behavior for each subject. As soon as the behavior is scored it appears in the 
event log.

Figure 4.4 The event log for Instantaneous Sampling. This example shows the first block of subject-
behavior combinations that need to be scored. 

Figure 4.5 The event log for Instantaneous Sampling. In this example, the first behavior for subject 
Female 1 was scored.
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3. If the behavior was linked to one or more modifiers, the cursor moves to the modifier 
column. The Codes window now shows all the modifiers that can be attached to the 
scored behavior. Score the modifier.

Result – The modifier appears in the event log.

If modifiers are not required (see page 80), you can skip them and go to the Comment 
column (see below) or start a new event line. To do so, press Enter. 

If modifiers are required and you confirm the event by pressing Enter, a message appears 
on the bottom of the Event Log: 

Score the modifier, so that the cursor moves to the Comment column or to a new row. 

4. If you have selected Add Comment in the Properties pane of the subject or the behavior 
you have just scored (see page 77), the cursor moves to the Comment column with the 
word ‘Comment’ in gray. Optionally enter a comment, and press Enter. 

If you do not want to add any comment, just press Enter. 

5. The event is now complete.

Add new events by repeating the steps above to finish scoring the complete sample.

6.  Live – Wait until the sample interval has elapsed to score the next sample (indicated by a 
sound signal).

Offline – Click the Next sample button to position the video at the time of next 
sample.

If you do not want the cursor to move to the Comment column every time you 
score an event, make sure that for all behaviors and subjects the Add 
Comment option is not selected (see page 84). 
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You can use the Quick review button to play back the video/audio file a few seconds 
before the sample time sample; this is useful to be able to determine what 
behavior each subject is performing.

What next?

 Errors may occur while scoring data. Please see page 120 for how to correct errors. 

 For stopping the observation, see page 110. 

 For more information, see:
- The Notes on Instantaneous Sampling below.
- How to.. procedures on page 114.
- Additional observation functions on page 147. 

Notes on Instantaneous Sampling

 In the Timers window, the Remaining Interval Time is displayed. If no Timers window is 
visible, select Timers from View Settings at the far-right side of the component tool bar. 
You can drag the Timers window to below or next to the Event log, so you can easily see 
how much time is left until the next sample. To hide specific timers, right-click in the 
Timers window and deselect the timer. 

- For a Live observation, the timer counts down until the next Instantaneous sample.
- For an Offline observation, the timer displays the sample interval length.

 The subjects are listed in the event log in the same order as in the coding scheme. 
However, you can score the subjects in a different order; this is useful in a live situation in 
which some subjects might be initially out of sight. See Score the data in the order you 
prefer on page 119 for more information.

 When the next sample begins before you finished scoring the previous sample (this only 
occurs in a Live observation), the non-scored events are set to “missing”.
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 When your observation duration is a multiple of the sample interval, no sample is scored 
at the end of the observation. If you do want to score this sample, make the observation, 
for example, 1 second longer. 

5C - continuous and instantaneous Sampling – how to 
score events

1. As soon as the observation is started, the cursor moves to the first Instantaneous sample
block. Score this sample, according to the general procedure for instantaneous sampling
(see 5B - instantaneous sampling – how to score events on page 105).

2. As soon as you finish scoring the Instantaneous sample, Continuous Sampling starts and 
you can score data for Continuous Sampling until the next Instantaneous sample. Follow 
the procedure described in 5A - continuous sampling — how to score events on 
page 102. When a new sample starts before you have finished scoring a continuous event, 
you are asked whether you want to finish or discard the event before scoring the sample. 
This is, for example, the case   when you have not yet scored a required modifier.

Note on Continuous and Instantaneous Sampling

 What do I do when my focal subject changes behavior while I am scoring the 
Instantaneous sample? – Click the row under Instantaneous Sample (#) End (see Figure 
4.6) and score the behavior for the focal subject. Next, click a row in the Instantaneous 
sample block to continue Instantaneous Sampling.

 When your observation duration is a multiple of the sample interval, no sample is scored 
at the end of the observation. If you do want to score this sample, make the observation 
for example 1 second longer. Also an event scored with continuous sampling at the exact 
moment the observation stops is not included in the analysis. 
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6 - stopping the observation

An observation is ended when either the maximum recording time has elapsed or you 
manually end the observation.

Figure 4.6 Example of simultaneously carrying out Instantaneous and Continuous Sampling. When the 
Instantaneous Sample (3) starts (at 60 secs, row 29), the focal animal ‘Adult’ is ‘Standing’. While scoring the 
Instantaneous sample (3), ‘Adult’ starts ‘Walking’; this is scored by clicking row 36 under Instantaneous 
Sample (3) End and scoring ‘Walk’.

An event scored at the exact moment the observation stops is not included in 
the analysis. 
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Automatically stopping an observation

When the predefined maximum time is reached or the video/audio file ends, The Observer 
XT stops the observation.

Manually stopping an observation
- Click the Stop Observation button in the Playback Control window.

3. If you selected Prompt for confirmation to end observation in the Project Settings 
(see page 59), you get a warning. Click Yes to end the observation.

4. If you selected either After observation or Before and after observation under Edit 
Independent Variables in the Project Settings (see page 59), what happens depends on 
the Value Update property of your Independent Variables (see page 92):
- If at least one variable is Compulsory, Optional or Manual and you did not select the 

Hide manual variables option (see page 91), the Enter User Defined Variables values 
window displays. 

- If all your independent variables are Manual and you selected the Hide manual 
variables option, the Enter User Defined Variables values window does not open. 

5. Edit the Independent Variable values and click OK. 

What next? 

 You can play back, visualize and analyze data immediately after you end an observation. 

 To play back the data, use the Play buttons in the Playback Control window (not the Start 
Observation button!). For details on data playback, see page 141).

 To visualize data, from the Analyze menu, select Visualize Data (see Chapter 7), or click 
the Visualize button on the tool bar.

 If you have recorded external data during the observation, you need to import it in the 
observation before you can visualize all data together (see Chapter 7). 

If the maximum time was reached while you were in the middle of scoring 
elements in an event line, that line is saved, but is not complete. You can either 
delete, or edit the incomplete line (see page 34). 

For Compulsory variables, you must enter a value if the corresponding cell is 
empty. For Optional variables, you are free to enter a value or leave the cell 
empty.
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 To analyze data, select the data set you want to analyze (see Chapter 6), then choose an 
option from the Analyze menu (see Chapters 8-10).

 Checking for errors – When closing an observation, the program checks that the event 
log currently open contains errors, for example a start code without a matching stop 
code. Event log with errors are not analyzed nor visualized. For more information see 
page 147.

important notes

How and where observations are saved 

 While you are scoring observational data, these are 
saved in a temporary folder that has the same name of 
your project, preceded by the character ‘~’ in the folder 
C:\ProgramData\Noldus\The Observer\XT 12\Temp. For 
example, ~Kids at play. Each observation is stored in a 
sub folder named Event Data, within the temporary folder. Every time you edit the 
observation, the event log currently open is saved in that sub folder. 

 When you save the project, the Event Log file is saved in the Event Data subfolder within 
your regular project folder. 

When there are long intervals between scored events

Where digital media files are saved

If you score observations live with a video signal, and you have specified to record the video 
to a digital media file (see page 48), the resulting video files are saved in the folder specified 
under Video files in the File locations tab of the Preferences window (see page 94). For the 
default file locations, see page 447.

Make sure that the time before your computer goes into standby-mode or 
hibernation is set to longer than the longest likely interval between scored 
events.

To specify the interval for system standby and hibernation, in the Control Panel 
choose Power Options, click Change when the computer goes to sleep and make 
your selection.
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If you record live video (general)

Please read this and the next note if you record live video while observing (the corresponding 
settings are explained on page 48).

 There may be some delay (around 0.5 s) between the real scene being recorded and the 
image on your computer screen. This is because displaying the on-screen image has 
lower priority than the recording on media file.

 We cannot guarantee that the video files being recorded and the event data files are 
100% exactly synchronized with each other. This is due to several factors, including the 
workload of the processor during video recording, the type of camera you use and the 
format of digital video file being recorded.

 If you use the Media Recorder to record the videos, these are automatically synchronized 
with your observation. 

 It is always a good idea to check synchronization once the observation has ended. If 
necessary, you can adjust the synchronization point between video files, and between 
video files and event data (see page 127). 

If you record live video to DV-AVI files

 Check carefully that you have enough space on the hard drive chosen to store the 
resulting files. An hour of DV-AVI files requires about 12.5 GB of disk space!

 Once you stop an observation, the video files (one or two, depending on your settings; 
see page 48) recorded during the observation are opened in separate windows, so you 
can play them back immediately. The video files are synchronized with the events and, if 
you have imported them, external data. 

To improve synchronization between video files, you can use a visual signal, 
for example a brief flash that can be video-recorded. Alternatively, you can 
use the SyncBox (see The Observer XT Service Manual that you can download 
from www.noldus.com/downloads). You can adjust synchronization (see 
page 40) by re-positioning the video files at the point when the visual signal 
appears on the images.

If the available disk space is not sufficient to store the whole video, The 
Observer gives no message until you stop the observation. The Preview 
window freezes once the drive is full. The video file is saved up to that 
moment.
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4.3 How to…

play back observation data

Once you have stopped an observation (see page 110), you can play the data back for review 
and data editing. 

 If you add or remove a variable in the Independent Variables List (see page 86), the 
corresponding object (for example, a Video window if the variable is video file) is 
displayed or removed, respectively.

 You can also play back the data (including video and audio) in the Visualization mode. 
See Chapter 7. 

 To play back external data, you must first import the external data files in that 
observation. See Chapter 5.

How to play back data 

 To play back data for reviewing purposes, click the Play forward button in the Playback 
Control window. You can use the Play buttons as usual to control playback. 

 To play back data and add/edit event data, click the Start Observation button. You can 
now score data as usual (see page 102). When you are done with scoring, click the Stop 
Observation button. 

If you have scored data live with a video signal and recorded video to a media file (see 
page 48 for how to set this), when you play back the data the video is played back too, 
synchronized with the events. If you have recorded two or more video files, video is played 
synchronously. 

add an element to the coding scheme while observing

It may happen that you observe something that does not comply with any element in your 
coding scheme. You can add a new elements (Subjects, Behaviors, Modifiers) or element 
groups (Behavior and Modifier groups) in two ways:

 Method 1 (best for video/audio observations, and for extensive changes to the coding 
scheme) – Stop the observation, re-open the coding scheme (Setup, Open Coding 
Scheme) and add the new element, then re-open and start the observation.
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 Method 2 (for both live and offline observations, and for limited changes to the coding 
scheme) – Add the new element while you are observing and score that element 
immediately (see below).

How to add a coding scheme element while observing
1. If you are carrying out an observation from video/audio, pause the video/audio file first. 

2. In the Codes window, click the tabbed you want to add an element to. For example, if you 
want to add a behavior, click Behaviors. 

3. Click the button that applies at the bottom of the Codes window, or press Ctrl+E (only for 
adding elements, not groups). The corresponding window displays. See the instructions 
below for the category that applies. Next, you can keep scoring data. 

Adding a subject

4. In the Add Subject window, enter the name of the new subject and its keycode, or accept 
the suggested code. Next, click Add. The new subject is listed in the Codes window. 

If you add a new modifier, remember to define its connections to subjects or 
behaviors. 

If the configuration is locked (see page 54), or the project is read-only (see 
page 451), it is not possible to add new elements to the coding scheme.

In the Codes window, you can add new elements to your coding scheme, not 
modify or delete existing ones. To do so, open the coding scheme.

The Codes window allows you to make limited changes to the coding scheme. 
To change other properties of the elements like the sound, you must stop and 
close the observation and re-open the coding scheme.
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Adding a behavior

4. From the Add to group list, select the behavior group that you want the new behavior be 
part of.

4. Type in the Name and the Keycodes for the new behavior, or accept the suggested ones. 

5. From the Type list, select whether the new behavior is a Point Event, a State Event or an 
Initial State Event (see page 73).

6. In the Link to box, select the modifier groups you want to associate with the behavior.

7. Click Add. The new behavior is listed in the Codes window, under the corresponding group 
name. 

When your Observation method is Instantaneous Sampling, it does not matter which 
Behavior type you choose.

When you add a behavior, this is automatically included in the subject-behavior 
combinations that have been assigned to the group that behavior belongs to.

Adding a behavior group

When your observation method is Instantaneous sampling, you cannot add a behavior 
group. To add a behavior group for continuous sampling:

1. In the Add behavior group window, enter a name in the Group name field. 

2. Choose whether the behaviors in the group can or cannot occur at the same time. See 
Behavior group types on page 71 for more information. 

3. Enter the behaviors and, for each behavior, choose whether it has duration or not. See 
Behavior types on page 73 for more information.
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Adding a modifier

4. In the Add Modifier window, select the group which the new modifier belongs to. If you 
think that the modifier does not belong to any existing group, create a new group first 
(see below). 

5. Under Value, type in the modifier value or accept the suggested value. Under Keycode, 
type in the keycode for the new modifier or accept the suggested one. 

6. Click Add. The new modifier is listed in the Codes window under the corresponding group 
name.

Adding a modifier group

4. In the Add Modifier group window, click the option you require. For more information on 
the difference between Nominal and Numerical modifier groups, see page 79.

5. Type in the name of the modifier group and in the Behaviors box define all the modifiers 
of the group. 

6. In the Link to Behaviors box, select the behaviors that you want to associate with the 
modifier group. Next, click Create group.

modify or remove a coding scheme element after 
observing

To modify or remove an element of the coding scheme, you must first close the observation. 

1. Stop the observation (click the Stop Observation button or press Ctrl+Alt+Q). 

2. Open the coding scheme (from the Setup menu, select Open Coding Scheme).

3. Click the element you want to change, and then make sure that the Properties pane is 
expanded (click Properties at the bottom of the screen, or right-click the element in the 
Event log and select Properties). Modify the element properties (see Chapter 3 for details) 
or delete the element (press Ctrl+Delete). 

4. Re-open the observation and resume scoring.

If at least one of the observations contains the element you want to delete, the program 
inactivates it instead. The element is still present in your data, so you can analyze it. For 
more information on inactivated elements, see page 86.
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enter events as free text

With The Observer XT you can log events in form of free text by using the Comment column. 
Once you have typed the event description, press Enter to submit the event line. 

Entering text associated with a scored event

If you want the free text to be always associated with a scored event, score the event as 
usual, then click the Comment cell for that line and type in the text. Do this especially if you 
want to visualize the comments in an event plot, because comments are not visualized if 
they are not associated with a scored event. If necessary, create a dummy behavior in the 
coding scheme and select the option Add a comment for that behavior. 

Entering text only

To enter a new line of text only, press Ctrl+I or click the Insert event button on the tool bar.

Next, click the Comment cell for the new line and enter the text. The time stamp of an event 
line that only includes Comment is the time when you type the first character in the 
Comment column.

Entering long text with the Comment window

You can enter a text line of up to 1024 characters using the Comment window (Ctrl+W).

1. Score the event or click directly the Comment cell in a new line (see above).

2. Press Ctrl+W. The cursor is now in the Comment window. 

3. Enter the text, or paste it from an external source (e.g. the Windows Notepad). 

Note: When you type characters in the Comment window, the content of the Comment 
cell is updated accordingly and vice versa.

4. Press Enter to confirm.

If the text to copy is longer than 1024 characters, only part is copied to the Comment window 
up to a total of 1024 characters. Type or copy the remaining text in a new line of the event 
log.

To edit existing text, double-click the Comment cell in the event log and press Ctrl+W to 
switch to the Comment window. Next, edit the text.
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score the data in the order you prefer

Instantaneous Sampling

Subjects in an instantaneous sample block appear in the order they are placed in the coding 
scheme. To score them in a different order:

1. Click the behavior cell of another subject (or use the arrow keys to navigate to another
cell).

2. Score this Subject-Behavior combination.

3. The event log now continues with the next unscored Subject-Behavior combination.

4. Continue until you have scored all Subject-behavior combinations in the sample block.

Before starting the observation, hide the columns of the event log that are not 
useful for free text logging, that is, Subject, Behavior and their Modifiers. To hide 
columns, see page 52. 

You cannot analyze free text, but you can use the Find function (see page 60) to 
find text across all observations, including a quantification of how many events 
a given word occurs in.

If you want to continually type text while listening to audio to transcribe speech, 
de-select the option Pause playback of video when scoring an event in the 
Project Settings (Scoring options tab; see page page 61).

If most event lines must contain a comment, select the option Add a comment 
for the corresponding behavior in the coding scheme.

Do not press Enter to separate text lines within the same Comment. If you press 
Enter the Comment window is cleared and the text typed up to that moment is 
saved in the Comment cell of the event log. To keep two or more lines of text 
separated, create multiple event lines.

You can also open the Comment window from the View Settings (page 133).

Event lines made of Comment text only, that is, without accompanying scored 
events, are not visualized in an event plot. However, they can be visualized in an 
episode selection.
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submit an incomplete event 

If an event is made of several elements (for example, Subject, Behavior, and three Modifiers), 
The Observer checks that all the required elements are scored. However, you can still allow 
incomplete events by selecting the Always press Enter to confirm Event Line option (see 
page 61). 

To submit an incomplete event, press Enter, or click the Finish sample button at the top of the 
Event log. 

score numerical modifiers

You can score numerical modifiers (see page 80), that is, modifiers that have numbers as 
possible values instead of text. For example, you may want to score a behavior that has 
modifiers ranging from 1 and 10, so that you can later calculate the average and variation of 
the scored values. The values of the range are shown in the Codes window under the 
modifier group name.

To score numerical modifiers, score the behavior that is linked to numerical modifiers. The 
column of the modifier becomes highlighted. Score the numerical modifier (click the Start 
column in the Codes window or type in the corresponding code). 

edit data and correct scoring errors

You must first score the modifier group name before scoring the actual values of 
the modifiers in the following cases:

 When you have two or more groups of numerical modifiers attached to a 
behavior, and you have just scored that behavior.

 When you enter the modifier values of an initialized state.

Always make a backup of your project before editing data (see page 450).

If you find many errors in the event log, that could be caused by some accidental 
change in the coding scheme, for example the removal of a subject-behavior 
combination (see page 95).
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Replace or delete an element in the Event log
1. Click the cell where the element is scored.

Result – The event line becomes highlighted and the Codes window displays the 
elements that can replace the selected one. 

2. Do one of the following:
- To replace the element, either type in the keycode for the new element or click the 

code in the Codes window.
- To delete the element, press Delete or right-click and select Delete, or click the Delete 

current element button at the top of the Event Log. 

3. Click another line to confirm.

Add an element to a scored event

Example – add one more Modifier 'Value' to the Behavior 'Initiate play' scored. 

1. Click the cell where you want to add the element.

The Codes window displays the elements that you can add in that cell. 

2. Either type in the keycode for the new element or click the code in the Codes window.

Result – The new modifier is added in a new cell that was inserted under the cell you 
wanted to edit. 

You can also use the arrow keys to reach the line and the cell you want to edit. 

You can also use the arrow keys to reach the line and the cell you want to 
edit. 
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Add a new event row in the Event Log

Example - You want to add an event between the event scored at 00:02:30 and the event 
scored at 00:02:35.

1. Click the row immediately above where you want the new row (in the example above,
the header of the row with 00:02:30). 

2. Click the Insert event button on the tool bar. 

Alternatively, right-click in the event row and select Insert event above, or Insert event 
below. 

Result – A new empty event is added above the selected row. The time stamp is the same 
as that of the selected row. 

3. Score the data as usual. If necessary, change the time stamp (see below). 

Remove one or more event rows from the Event log
1. Click the left-most cell of the row you want to delete.

Result – The entire row is highlighted in black.

2. Click the Delete Event button on the tool bar, press Ctrl+Delete, or right-click in the first 
column and select Delete event(s).

If you score events from video/audio, you can also insert a line in the 
following way: position the video/audio file to the time you require, then 
score the event as usual. The new event line is inserted between two existing 
lines.

To select more rows, drag across row headers, or click the header of the first 
row you want to delete, then hold down the Shift key and click the header of 
the last row you want to delete. 
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Change the time code for a scored event

Example – You have scored an event composed of many elements, however it was scored 
slightly later (or earlier) than the 'real' time. Instead of deleting the event and re-score it on 
the right time, just change the time of the existing record. 

1. Locate the event line you want to change and double-click the cell in the Event Time
column. 

Result – The time cell is highlighted in blue. 

2. Click the time number you want to change and type the new time, or use the two arrow 
buttons to adjust its value. 

3. Press Enter.

The new time has to be between the previous and the next event times. If you 
set an earlier or later times, the row changes position according to its time.

If you have scored an event slightly earlier or later than it occurs in the video/
audio, you can click the left cell of the event line to select the line, move the 
video/audio to the correct time and use <Ctrl+T> to update the time in the Event 
log to the correct timestamp from the video/audio. Alternatively, right-click the 
row and select Update Time.

The timestamp copied from the video/audio to the event log cannot be earlier or 
later than the timestamp of the previous or next event from the same Behavior 
group. 
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Undo coding actions

Example – You have coded the first element of an event. You realize that the event should not 
be scored, so you want to cancel that action. 

 When recording – Click the Undo button on the tool bar. To make a correction undone, 
press the Redo button. 

 When inserting an event between two existing events – Select the event line and click 
the Delete Event button on the tool bar. Alternatively, right-click in the first column of 
the event you want to remove and select Delete event(s). 

re-open an observation or event log

Example – You want to re-open an observation to watch the video/listen to the audio and 
add or edit data.

1. Do one of the following:

To open an observation – 
- From the Observe menu, select Observation, then Open or press Ctrl+Alt+F6. Select the 

observation and click Open. 
- In the Project Explorer, click the observation name under Observations.
- In the Project Explorer, right-click an Observation folder and select Open. 
- If you want to continue with the last observation you were working on, in the Project 

Explorer, click the Observations folder and click Continue last observation in the 
overview window of The Observer XT that appears. 

To open an event log within an observation, open first the observation which contains 
the event log (see above), then – 
- From the Observe menu, select Event Log, then Open or press Ctrl+Alt+O. Select an 

event log and click Open. 
- Click the arrow sign in front of the observation name in the Project Explorer, click Event 

Files, and then click the event log. 

2. Start the observation to edit the data (see page 101). 

If your observation consists of two or more event logs, opening an observation results in 
opening the most recent event log.
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change the observation's start time and duration

No matter what and how many data files an observation is made of (Event Log, Video, Audio 
and External Data), the Start time and Stop time are the earliest Start time and the latest 
Stop time of any data set, respectively (see the picture on page 98). The Start Time, Stop 
Time and Duration are a property of the Observation. You can view those times in the 
Independent Variable List (from the Setup menu, select Independent Variables). This section 
describes how to change those times. The synchronization between individual files will not 
change.

Changing the Start Time and/or Duration of an observation does not "move" the single Event 
Log, Video, Audio and External Data files. If for example, you reduce the Start time (that is, 
you move the Start to the left in the figure above), the files belonging to that observation are 
not moved accordingly. This results in a larger gap between the Start time and the starting 
point of the single files. 

If you want to change the synchronization between two or more files (that is, change the 
start time of one file relative to others'), see the next section. 

Why should I change an observation's Start Time and Duration? – You may want to change 
Start and/or Stop time if for any reason the Start and/or Stop time of an observation is 
wrong. 

Figure 4.7 Changing the Start and/or Stop time of an observation. 
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How to change the observation's Start Time and Duration?
1. Do one of the following:

- From the Setup menu, select Independent Variables.
- Click the Independent Variables button on the Component tool bar.

- In the Project Explorer, open the Setup folder and click Independent Variables.

Result – The Independent Variable List window appears. 

2. Click Show Independent Variables and in the Show Independent Variables window make 
sure that Start Time, Stop Time and Duration are selected, then click OK. 

3. Locate the observation in the list and the cells corresponding to Start Time and Duration.

4. To change the observation's start date and time, edit the content of the Start Time cell.

To change the observation's duration, edit the content of the Duration cell accordingly 
(Stop time= Start time+Duration). The observation stop time is changed automatically, 
according to the changes in the observation start time and duration. Events that are 
recorded before the start time or after the stop time of the observation are shown in grey 
in the Event Log. 

The Stop Time cell cannot be edited. 
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5. Press Enter to confirm.
- If you change the Start/Stop time of an observation, the single files within that 

observation are not 'moved' together with the Observation. Therefore, if you set the 
observation start time later than the start time of an event log, you might exclude 
event logs (or part of) from the Observation itself. 
For example, if your observation is one-hour long and you change the Start date to the 
day after (from May 24 to May 25), the event log still starts on May 24. The Observation 
is now starting on May 25 and lasts one hour, but no data are included in that interval. 

- When part of your event log data are excluded because they fall outside the 
Observation duration, they are shown in grey. For example, this is an event log scored 
from 00:00:00, after the Observation Start time was changed to 00:02:00. The events 
scored before this time are grayed out: 

- If you want the event logs and other data streams to start at the new Observation 
start time, adjust the offset of each file (Event Log, Video, Audio, External Data; see 
Enter directly the Offset time in the next section).

change the synchronization point between event logs, 
video, audio and external data sets

This section describes how you can change the Start time of a data set (Event Log, Video, 
Audio, External Data) relative to others.

You can change synchronization between data sets at any time, before or after scoring data.  
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Example 1 – Before starting scoring data, synchronize two video files in such a way that one 
video starts when the other is positioned at 30 seconds.

Example 2 – After scoring data, change the offset time between two event logs.

1. Open an existing observation, and make sure that the video, audio and external data
linked to the observation are visible on your screen. 

How? 
- For video files. open View Settings on the tool bar and click Video files. Make sure that 

the correct video file is selected. 
- For audio files, open View Settings and click External Data and Audio and 

subsequently Show Audio. Make sure that the correct audio files are selected.
- For external data, open View Settings and click External Data and Audio and 

subsequently Show External Data. Make sure that the correct external data files are 
checked. 

2. You can change the synchronization point in two ways: (1) Numerical offset, or (2) Manual 
offset. See below for details. 

You can change the synchronization point between external data and other data (video, 
audio and event logs) only after you have imported external data in the current 
observation (see Chapter 5). Once you have imported them, follow one of the two 
procedures below.

Figure 4.8 Changing the synchronization point of one file relative to another within an observation. 

If you use the Media Recorder to record video, the video files are automatically 
synchronized with your observation. 
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Numerical Offset
1. Click the Offset button on the Component tool bar, then choose Numerical Offset.

Result – The File Synchronization window appears. 

This window lists the event log currently open, the video and audio files and the external 
data linked to it. 

2. Locate the data set (event, video, audio or external data) of which you want to change the 
synchronization point relative to others, and click the Offset cell.

3. Enter the offset value. 

Example – If you want to have the start of the event log synchronized with the position 
of the video file at 20 seconds, then locate the row of the video file and enter -20 in the 
seconds group of the Offset column. 

4. Click Apply.

Manual Offset (only for video/audio files or external data)
1. Click the Offset button on the Component tool bar, then choose Manual Offset. 

Result – The Synchronize window appears explaining the next three steps. Click Start 
Synchronization.

2. Click the video image (for modifying the synchronization of a video relative to the rest of 
the observation), the audio graph (for modifying the synchronization of an audio file 
relative to the rest of the observation) or the external data graph (for modifying the 
synchronization of external data relative to the rest of the observation). 

Result – The video/audio/external data window is highlighted in red. 
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3. Use the Playback Control buttons to play the video or audio to the new position, or drag 
the cursor in the external data window to the new position. The aim is to position the 
video/audio/external data to the point that you want to correspond to the start of the 
event log. 

4. Click the Offset button again. 

Result – The highlighting edges disappear. The files are now synchronized as you have 
specified.

You can use the File Synchronization window to check that the time difference between 
video, audio, event log and other data streams is the one you require. You can change this 
difference at any time (see Numerical offset above).

score action-reaction data (triggering behavior)

If you want to score data in a sequence like the following:

Subject1 - Behavior A - Subject 2 - Behavior B

Where Subject 2 performs Behavior B as a response to Behavior A by Subject 1, make sure that 
you define a group of modifiers (see page 78) containing all subjects reacting (like Subject 2 
in the example) and another group of modifiers containing all response behaviors (like 
Behavior B). Next, score the data in sequence (Subject - Behavior - Modifier of first group - 
Modifier of second group).

scoring reciprocal behavior 

To score reciprocal behavior (that is, behavior that has no specific direction, for example Mark 
Plays with James), you must score two event lines (Mark Plays with James, and James Plays 
with Mark). If necessary, pause the video/audio or edit the time in the event log (see page 
169) afterwards to ensure the events receive the same time value.

score data after importing external data

1. Create a new observation (see page 99). 

2. Import the external data (see Chapter 5). 

3. If necessary, change the synchronization of the external data files relative to the (still 
empty) Event Log file by adjusting the Offset (see page 129). 

4. Start the observation and score data (see page 101).
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modify the name and description of an observation or 
event log

1. For observations: In the Project Explorer, open the Observations folder, right-click the
observation and select Properties. 

For event logs: In the Project Explorer, open the Observations folder, then click the arrow 
sign next to the observation containing the event log, and open the Event Files folder. 
Right-click the event log and select Properties. 

2. Edit the name of the Observation or Event Log (max 64 characters) and Description (max 
255 characters), then click OK.

import data into an observation

Import event data

You can import event data in form of:

 Observational data files from The Observer 4/5 projects, Pocket Observer 3 and Observer 
XT projects.

 External observational data files – That is, any data files in which events are organized in 
rows. 

For the detailed procedure, see page 424. For transferring files between The Observer XT 
and Pocket Observer 3, see the Pocket Observer Reference Manual.

Import external (physiological) data

For the detailed procedure see Chapter 5.

Import video files

Make sure that your observation is open, and from the Observe menu, select Video 
and then Open in Current Observation or click the Import video button in the 
Component tool bar. Browse to the folder where you stored your video files, select 
the appropriate file and click Open.

Import audio files

Make sure that your observation is open, and from the Observe menu, select Audio 
and then Open in Current Observation or click the Import audio button in the 
Component tool bar. 

Browse to the folder where you stored your audio files, select the appropriate file and click 
Open.
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If your observation already contains media files, or you want to import multiple media files, 
or you want to show the audio from video in form of waveforms, see page 158.

export observational data

You can export observations to The Observer XT files (XML format), to Microsoft Excel format 
(*.xlsx format) or to text files. 

From the File menu, select Export and Observational Data, then choose the observations to 
export. If you want to export one observation, open the observation and click the Export 
current observation button on the tool bar. For more information, see page 411.

detect that an observation is being recorded

When an observation is being recorded, you can detect this by looking at the Playback 
Control window: The Stop Observation button is available.

You can also check that the observation is being recorded in the following way:

Locate The Observer XT icon in the system tray (next to the clock):

If the icon is green, The Observer is not recording an observation. If you hover the mouse over 
this icon, a small text "The Observer XT" is shown.

If the icon is red, The Observer is recording an observation. If you hover the mouse pointer 
over this icon, a small text "The Observer XT Recording" is shown.
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4.4 The windows on your observation screen

You can change the look-and-feel of your observation screen according to your needs: 

 Choosing the windows you want to view (below).

 Positioning the windows on the screen (see page 134).

 Customizing the properties of each window (see the information at the end of the 
section about each specific window).

 Showing or hiding playback control buttons (see page 145)

choosing the windows to view

View Settings (located in the upper-right corner of your tool bar) lists the elements you can 
visualize during the observation. You can undock this window by clicking the dots under the 
header View Settings. Subsequently you can drag the window to a new location.

Select the objects you want to view during the observation.

 Codes – Keep this selected if you want to view the Codes window, which you can use to 
score data with mouse clicks. 

 Event Log – Click this if you want to choose to view Subjects, Behaviors, Modifiers or 
Comments in your Event Log.

 Video files – (only if video files have been selected in the project) Select the video files 
you want to view. 

Figure 4.9 View Settings in the Observation window.
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 External Data and Audio – Select this if you want to view the External Data window or 
the audio files. Click Show External Data to select the external data files to be displayed. 
Click Show Audio to select the audio files (or audio from video) to be displayed.

External data (for example physiological data) is imported after the observation is 
completed. During data recording, the external data are not shown in The Observer 
screen. 

 Data points - Select this option if you want the data points to be displayed in your 
external data or audio window.

 Playback Control – Select this if you want to view the Playback Control window (see 
page 141). 

 Comment – Select this if you want to view the Comment window (see page 118).

 Timers – Select this if you want to see the Timers window with the absolute and relative 
time while scoring. 

 Time formats – Select this if you want to change the format of your time stamps in the 
Event log.

positioning and resizing the windows on the screen

By default, all the windows displayed in the observation screen are docked. You can change 
their position and resize them according to your needs.

 To re-position a window, click its title bar and drag it to the new position. To 
undock a window, click its title bar and drag anywhere until you see its 
margins no longer constrained by other windows. Docking icons appear, to 
show you where you can position the undocked window. 

If you hover with your window over one of the docking icons, the new position of the 
window is shown in blue. 

If you release the window, the window is positioned at the chosen location. 

 To resize a window, hover the mouse on one of its margins until the cursor changes to 
the symbol as outlined here. Next, drag the margin to adjust window size.
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timers window

The Timers window (see Figure 4.10) can display both the Relative and Absolute time. You can 
select to display one or two columns by right-clicking the Timers window and selecting/de-
selecting a column.

The Timers window contains the following counters:

 Observation - Current Time – The current, absolute time during an observation. This time 
is also displayed during playback. 

When you stop the observation, the Observation - Current Time timer shows the same 
time as the Event Log - Stop Time, and no longer runs. 

 Observation - Elapsed Time – The elapsed, relative time during an observation.

 Observation - Observed Time – The observed, relative time during an observation. This 
counter pauses when you suspend an observation (see page 149), and starts again when 
you resume the observation.

 Observation - Remaining Time – The remaining, relative time in the observation. If you 
have defined a Maximum duration for the observation (see page 53), this is the amount 
of time left in the observation.

If you display the Observation - Remaining Rime, it is possible that the Observation - 
Remaining Time + Observation Elapsed Time in the event log is not exactly the Event Log 
- Stop Time. This is due to the rounding of time decimals.

 Observation - Start Time – The minimum start time of all data sets in the current 
observation.

If you score data from one media file, this is usually 00:00:00.000. However, if you have 
opened two or more media files, and these are not all synchronized on the first frame, 
this counter shows the time of the earliest media file when the latest media file is 
positioned on zero. That is, the minimum time at which data is available for all media 
files.

 Observation - Stop Time – The maximum end time of all data sets in the current 
observation.

If you score data from one video file, this is usually the time of the last frame. If two or 
more media files are opened, it shows the end time of the longest media file.

 Event Log - Start Time – The minimum start time of the current event log in the 
observation.

 Event Log - Stop Time – The maximum end time of the current event log in the 
observation.
Chapter 4 - Carrying out an Observation 135



 Interval - Elapsed time (hidden by default, also for interval sampling). This timer is for 
instantaneous sampling and shows the elapsed time, since the previous interval. To 
show this timer, right-click in the Timers window and select Interval - Elapsed time. 

 Interval - Remaining time (hidden by default, also for interval sampling). This timer is for 
instantaneous sampling and shows the time until the next interval. To show this timer, 
right-click in the Timers window and select Interval - Remaining time. 

How to customize the Timers window

 The time format of the Relative and Absolute time can be set in the Time formats tab of 
the Project Settings (see page 60).

 To hide one of the timers, right-click in the middle of the Timers window and de-select 
the appropriate timer from the list. To restore a timer, right-click and select the timer 
from the list.

codes window

The Codes window displays the elements of the coding scheme and of their properties. To 
score data, click a code or press the corresponding keys. The Codes window contains three 
tabs:

 Subjects – Lists the Subjects defined at that time, and their code under Start. If one or 
more state events are active for a certain subject, these are shown under Status, 
separated by a comma.

 Behaviors – Lists the behaviors defined at that time, and their start and stop code under 
Start and Stop. Behaviors in a mutually exclusive and exhaustive group only have a code 
under Start. If a state behavior is active for one or more subjects, the Status column 
shows those subjects separated by a comma.

Figure 4.10 The Timers window.
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 Modifier – Lists the modifiers defined at that time, and their code under Start. If state 
behaviors are active for a certain subject, these are shown under Status, separated by a 
comma.

If you add a new element to the coding scheme during an observation (see page 114), the 
new element is shown in the last row of the corresponding tab. 

How to customize the Codes window 

To change the width of a column, point to the boundary on the right side of the column and 
drag it accordingly. 
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event log window

The Event Log is the window in which you score and edit your data. When you score data, 
what you see in this window is essentially your data file. 

The Event Log tool bar includes the following buttons:

Figure 4.11 The Event Log window.

Undo (Ctrl+Z) - Click this button to undo your latest entry.

Redo (Ctrl+Y) - Click this button to undo your latest correction to your Event
log.

Check Event Log – Click this button when you want to check for errors in the
data. For more information, see page 147.

Insert event – Click this button when you want to insert an event between two
existing events. For more information, see page 121.

Delete event (Ctrl+DEL) – Click this button when you want to delete the
selected event from the event log (not from the coding scheme). You can also
delete an event from the event log by selecting the event line and pressing
Delete.

Delete element (DEL) – Click this button when you want to delete the selected
element from the event log (not from the coding scheme). You can also delete
an element from the event log by clicking the cell and pressing Delete.
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Finish sample – Click this button (or press Ctrl+Enter) when you want to finish
scoring the current sample without scoring all subject-behavior combinations.

Find (Ctrl+F) - Click this button to find events (see page 151 for the detailed
procedure).

Import Video – Click this button when you want to import video files in the
current observation. Use this button also to show audio from video in the form
of waveforms. Select the checkbox Visualize audio in the Select Video window. 

Import Audio - Click this button when you want to import audio files in the
current observation. 

Import data - Click this button when you want to import observational data,
external data, and other types of data in the current observation. For more
information, see page 131.

Settings - Click this button when you want to open the Project Settings (see
page 99).

Independent Variables (Alt+F3) - Click this button when you want to open the
Independent Variables (see page 86).

Offset (Ctrl+Shift+=) – Click this button when you want to change the offset of
one video/audio/external data file relative to other data sets in your
observation. See page 127 for the detailed procedure.

Visualize (Alt+F8) - Click this button to visualize your current observation (see
Chapter 7 for the detailed procedure).

Mouse pointer – Click this button to select or deselect the zoom in or zoom out
button.

Zoom in (Ctrl+.) – Click this button to zoom in the external data plot. This
button is available when an observation is open that contains external data
(see page 114). 

Zoom out (Ctrl+,) – Click this button to zoom out the external data plot. This
button is available when an observation is open that contains external data
(see page 114). 

Export current observation – Click this button to export the observation to
another project in The Observer XT, Microsoft Excel, or a text file. 

Quick help – Click this button for more information on carrying out an
observation. 

View settings – Click this button to choose which windows to display. 
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How to customize the Event Log window

 Choosing the time format – You can change the format of the time in the Event Time 
column. 

a Right-click one of the rows of the event log and select Project Settings, or select Time
Formats in View Settings. 

b In the Time formats tab of the Project Settings window, from the Project time format
list, select Absolute (absolute clock time) or Relative (elapsed time). If you choose Abso-
lute and want to include the date in your time stamps, select the check box Show date
with absolute times. 
Alternatively, select Show frame numbers while observing from videos to display 
frames in the event log window.

c Next, click the corresponding Edit button to specify the time format.

If you do not use video files for the current observation and select Show frame numbers 
while observing from videos, Event Time shows the time mode selected in the Project time 
format list.

For more information on time formats, see page 60. 

 Hiding columns that are not of interest 

By default all elements defined in the coding scheme appear in the event log. Also a 
Comment column is visible. To hide a column 

a Right-click one of the column headers of the event log.
b De-select the category you want to hide.

If you hover over the Time column with your mouse, a tool tip shows the time 
format.

To show columns that were previously removed, right-click and select the 
corresponding element. 

You cannot score an element that is hidden in the Event log anymore. If you click 
the tab of that element in the Codes window, the column re-appears in the 
event log. You can then score the element again.
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 Changing column width

To change column width, point to the boundary on the right side of the column
 header until the cursor changes to a double arrow, and drag it until the column
 is the width you want.

playback control window

With the Playback Control window you can: 

 Start, pause and stop an observation.

 Control playback of video files, audio files and other data sets (event log, external data).

 Review segments of video, audio and other data sets.

Playback control buttons

Start Observation (Ctrl+Alt+B) – Starts the observation in the current event
log. Corresponds to the menu item Observe, Start Observation. 

Stop Observation (Ctrl+Alt+Q) – Stops the current observation. It corresponds
to the menu item Observe, Stop Observation. 

Pause/Still (Ctrl+0 or spacebar) – Pauses the video/audio. 
When you pause the video, the video stops at the current frame and the
event log and other modalities are aligned with the video.
Pressing spacebar toggles between Pause and Play forward at speed 1.

Play forward at speed 1 (Ctrl+4 or spacebar) – Plays the video at the normal play
speed.
Pressing spacebar toggles between Pause and Play forward at speed 1.
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Increases the forward or backward playback speed with one step. 
The speed ranges from 1/25 or 1/30 depending on your video standard to +16
if the video plays forward, or from -1/25 or -1/30 to -16 if the video plays
backward. 
If the audio is spoken language, you will not be able to hear what your
subjects say when you play the audio slower or faster. In most cases you
won’t hear any sound when playing forward at 2x or faster and backward at
any speed.
Occasionally, during scoring the playback of the audio file appears to jolt a
bit. This is purely a cosmetic effect; the data you are scoring still have
accurate time stamps.
Not all playback speeds might be available. Depending on the video format,
you may not be able to play video at a specific speed. If you open multiple
video files and one of them can be played at fewer speeds than others, only
those speeds are available for all videos.

Decreases the forward or backward playback speed with one step. See also
the notes in the row above about increasing the playback speed with one
step. 

Quick review (Ctrl+Backspace) – Click this button when you want to review the
latest segment of video/audio, for example to check that an event was scored
at the correct time or to add/edit event lines. You can also press the button
multiple times to let the video jump back more. 
You can specify the review length and speed (see page 64). This button can be
hidden (see page 145).
Quick Review is also useful when you carry out Instantaneous Sampling during
an Offline observation. After you click the Next and Previous sample button,
use the Quick Review button to get more information about which behavior
the subjects are performing
Tip: To pause the video before quick review, set the quick review playback
speed to 0. To pause the video after quick review, select the checkbox in front
of Pause playback after quick review. You make these settings in the
Playback control options tab of the Project settings (see page 64). 
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Loop (Ctrl+L) or (Ctrl+Shift+Home) – Click this button when you want to
activate a loop to replay a fragment a number of times. The procedure depends
on whether you chose User defined, or Fixed interval for Loop options in the
Playback Control Options tab of the Project Settings window (see page 65). 

 User defined – Play back the entire observation, or a segment a number of 
times. Upon clicking this button, two flags appear, one at the start and one 
at the end of the slider. Move these flags if you want to select a segment of 
your observation.
 

Alternatively, you can position the video and click Ctrl+J to set the start of 
the loop and Ctrl+K to set the end of the loop. You can also right-click an 
event in the event log and select Start loop here, or Stop loop here. To reset 
the start and end of the loop to the start and end of the slider, click Ctrl+H, 
or right-click an event and select Reset loop. 
Click the Loop button again to stop the loop. The Loop button can be 
hidden (see page 145).  

 Fixed interval – A fixed interval can, for example, be useful to score 
whether an event occurs in fixed time fragments or not (1-0 sampling). The 
flags show an interval with the length you specified in the Playback 
Control Options tab of the Project Settings window (see page 65). Move the 
flags to the episode you want to replay. You can move the flags with 
intervals that have the interval length you defined in the Playback Control 
Options tab of the Project Settings window (see page 65). If you defined an 
interval length of 10 seconds, you can position the start of the loop at time 
0 s, 10 s, 20 s etc. If you defined an interval length of 30 seconds, you can 
position the start of the loop at time 0 s, 30 s, 60 s etc. This way you can 
score the entire video accurately, after scoring the first interval, position 
the loop at the next interval. You can use the shortcut key Ctrl + K (next 
interval) and Ctrl + J (previous interval) to jump to another interval. 

Step forward (Ctrl+Right-arrow key) – Moves the video one frame forward with
each click of the button. Moves audio files 1 second forwards. When you click
this button during video playback, the video is paused and moves one frame
forward. This button can be hidden (see page 145).

Step backward (Ctrl+Left-arrow key) – Moves the video one frame back with
each click of the button. Moves audio files 1 second backwards. When you click
this button during video playback, the video is paused and moves one frame
backward. This button can be hidden (see page 145).
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Optional playback control buttons

The following buttons are hidden by default. To show them on the Playback control window, 
open the Setup menu and select Project Settings. Click Playback Control options in the left 
pane. Alternatively press Ctrl+M to open this window. Select the checkbox in front of the 
button you want to visualize. 

Playback control buttons for live scoring

The following buttons are only available when you selected Live Observation under 
Observation Source in the Project Setup.  

Time – Shows the time elapsed from the start time of the observation (the
latter is shown in the Timers window as Observation - Start Time).
If you select to display Remaining time, it is possible that the remaining time+
elapsed time in the event log is not exactly the total duration. This is due to the
rounding of time decimals.

The playback speed. 

 Play backward at speed 1 (Ctrl+Shift+4 or Shift+spacebar) – Plays the video/
audio/event log backward at the normal play speed. 
Pressing Shift+spacebar toggles between Pause and Play backward at speed 1.

Jump to begin (Ctrl+Up-arrow key) – Advances the video/audio/event log to the
beginning. 
If an offset exists between video/audio/data streams, clicking the Jump to begin
button results in positioning to the start of the earliest. For example, if the event
log starts one minute after the first video frame (that is, the offset between
event log and video is +60 s), clicking Jump to begin results in positioning at the
start of the earliest stream, that is the video.

Jump to end (Ctrl+Down-arrow key) – Advances the video/audio/event log to the
end.
If an offset exists between video/audio/data streams, clicking the Jump to end
button results in positioning to the end of the latest stream.

Volume control – Move the slider to increases or decreases the volume of the
audio file. The volume control in The Observer XT works independent from the
Windows volume control. Click the speaker icon to mute or unmute the sound. 

Suspend Observation (Ctrl+Alt+X) – Suspends the current observation. It
corresponds to the menu item Observe, Suspend Observation. This button turns
blue upon clicking. 

Resume Observation (Ctrl+Alt+V) – Resume the observation. It corresponds to
the menu item Observe, Resume Observation.
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Playback control buttons for instantaneous sampling. 

The following buttons are only available when you selected Instantaneous sampling, or 
Combine Continuous and Instantaneous sampling under Observation Method in the Project 
Setup. 

How to customize the Playback Control window

 To show and hide buttons, see below.

 To move and resize this window, see page 134.

 To customize the time interval represented by the slider, see page 64.

Showing and hiding playback control buttons

Three playback control buttons are hidden by default: (see Optional playback control buttons 
on page 144). Four other buttons can be hidden, which are:

 The volume control.

 The Play backward button.

 The Jump to begin button.

 The Jump to end button.

To show or hide buttons, open the Setup menu and select Project Settings. Click Playback 
Control options in the left pane. Alternatively press Ctrl+M to open this window. Select the 
checkbox in front of the button you want to visualize. 

videos window

The Videos window only applies if you score data live with a video camera, or offline from 
video files. If you score data from more than one video file or video device, additional Video 
windows appear on your screen. 

 Video Properties – To display the properties of the video currently selected, right-click 
the video image and select Properties. You can view the file location, video image size 
and duration. Under Video codec and Audio codec, the file formats The Observer XT reads 
from the video file are given. In addition, under Filter details, the filters and codecs that 
The Observer XT uses to play back the video file are listed. If the video file was created 

Previous sample (Ctrl+Shift+Up-arrow key) – Moves the video/audio to the
previous Instantaneous sample. 

Next sample (Ctrl+Shift+Up-arrow key) – Moves the video/audio to the next
Instantaneous sample. 
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with the Media Recorder, the Video Properties contain a field Recording details. This field 
contains the start time of the recording with the Media Recorder and the offset between 
the video file and the observation. This offset is applied automatically. 

 Time – It is possible that the time displayed in the Video window is not exactly the same 
as the time in the Event Log, Playback Control and Timers window. The difference may 
vary from 0 to 0.04 s. This happens because each data stream, be it video or event data, 
has its own time running. If you want to make sure that an event gets exactly the same 
time stamp as the video time, click the arrows next to the time in the Video window, 
until the time equals that shown in the Current line of the Event Log.

How to customize the Video window

 Resizing the window - Drag the window's borders until you are satisfied with the video 
size. The aspect ratio of the original image is maintained. 

 Docking/undocking a window - To undock a window, click its title bar and 
drag anywhere until you see its margins no longer constrained by other 
windows. Docking icons appear, to show you where you can position the 
undocked window. 

If you hover with your window over one of the docking icons, the new position of the 
window is shown in blue. If you release the window, the window is positioned at the 
chosen location (see also page 134).

 Docking/undocking multiple videos - If you have multiple videos, to undock a window, 
right-click the image in the window and select Undock. The Video is displayed at 100% 
size. If you have two monitors, move this window to the second monitor for better view. 
To dock a window back, right-click and select Dock, or click this window and press Alt+F4 
or click the Close button.

If you just have one video, you cannot select Undock. You can undock the window by 
double-clicking it’s title bar. If you have two monitors, you can drag the whole video 
window to the second monitor for better view.

 Turning the audio on/off - Click the speaker symbol on the top right corner of the 
Video window for a specific video file. 

Alternatively, right-click the video window and select Mute. If your observation includes 
two or more video files, keep the audio on only for the video file you want to hear. 

If your observation has audio files, you can mute their sound by 
clicking the speaker symbol in the External Data and Audio window. 
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 For multiple video: switching between video files - If your observation is associated with 
two or more video files, one video file is positioned on the right half of the window, and 
the remaining on the left half.

Click one of the video files on the left to have it displayed on the right half, or right-click 
and select Swap. Drag the margins of the separation bar between the videos to adjust 
the picture size. 

4.5 Additional functions

checking the event log for errors and correcting errors 
automatically

This function allows you to check an event log for errors and to fix the errors automatically. 
Errors may occur when for example you stop a behavior that was not active at that time. You 
can also use the event log checker to see what states are currently active.

An event log error is also indicated by a warning sign next to the 
observation in the Project Explorer.

To check an event log, click the Check Event Log button in the Event Log window. 

If the event log contains errors, a window will open with a description of the errors. 
You can let The Observer XT fix the errors by clicking the Fix Errors Automatically button. The 
Observer can fix the following types of errors:

Figure 4.12 Multiple video files displayed in the Video window.\
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 Missing stop codes – These will be added.

 Stop codes without corresponding start code – These will be deleted.

 Gaps between mutually exclusive, exhaustive behaviors – These will be corrected. If no 
initial state event has been scored, this will be added. If there is a gap further on in the 
event log, it will be corrected by extending the behavior that was active before the gap.

 Overlaps between mutually exclusive behaviors – These will be corrected. The stop code 
of the overlapping behavior will be moved to the start of the behavior it overlaps with.

These errors may occur in event logs made in The Observer 6, 7 or 8.

 Missing combinations - You may have removed combinations between subjects and 
behaviors or behaviors and modifiers in your Coding Scheme, while these have been 
scored in an observation. The events with these combinations will be deleted. 

If you do not choose to fix the errors automatically, The Observer will indicate how many 
errors have been found. The event rows with errors are highlighted in red. Point the mouse to 
those rows to know more about the error they contain. See page 120 for information on 
correcting coding errors manually.

If you have multiple event logs within one observation, the event log checker checks for 
errors between all event logs, for example whether there are overlapping events in the event 
logs. Such errors cannot be fixed automatically. 

Another possible error is that a behavior was not scored with all the required modifiers (see 
the picture below).

To check what state events are currently active during an observation, in the 
Codes window click the Behaviors tab and look in the Status column which 
behavior is active. Alternatively, in the event log point the mouse on the red 
rows. States that are active are indicated by 'No matching stop event'.
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If you find many errors in the event log, that could be caused by some accidental change in 
the coding scheme, for example the removal of a subject-behavior combination (see 
page 68).

suspending an observation

You can only suspend a live observation. You can do this at any time, for example when a 
subject is out of view. When you suspend an observation, the currently active states for all 
subjects are stopped. The Observer is put in standby awaiting that you resume the 
observation.

1. To suspend an observation, do one of the following:
- From the Observe menu, select Suspend Observation.
- Click the Suspend Observation button in the Playback Control window or press 

Ctrl+Alt+X.

Result – 
- In the Timers window, the Observation - Observed Time timer stops and the 

Observation - Elapsed Time timer continues. In the Playback Control window, the 
status is Suspended (below the Stop button).

- In the Event Log, two lines are added: Suspend (marked by the time when the 
observation was suspended) and Resume (with time 'not defined yet'). For each state 
that was active at the time the observation was suspended, the program adds a row 
below the Resume row. The program assumes that those states are active when you 
resume the observation. You can change these states immediately before you resume 
the observation if the subjects have changed state in the meantime, or confirm them 
and resume the observation.

Example for mutually exclusive behaviors – In a chimpanzee study, the observation was 
suspended at 17:07 when the subject went out of sight. At that time, the states Walk and 
No consumption of two different mutually exclusive behavior groups were active. After 
the line Resume, the start events for those states are added automatically. These are the 
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states that The Observer XT assumes to be active when you resume the observation. You 
can change them immediately before or after resuming the observation (see below).  

Example for Start-Stop behaviors– In the example below, the observation was suspended 
at 20.65. Before the line Suspend, stop codes are added for the active behaviors. Below 
the line Resume, two start codes are added for the behaviors that were active at the 
moment the observation was suspended. These start codes cannot be changed into stop 
codes, since this would lead to errors in the Event Log. If the behaviors are not active 
immediately after suspension, after resume the observation, immediately score the 
correct behavior. 

2. When your subject comes back into view or when you are ready to resume, update the 
behaviors in the lines below the Suspend line. If the states do not need to be updated, go 
to the next step. 

To update the behaviors, click the cell you want to update, and score the new state. In the 
example below, the state Play was changed to Groom (compare with the previous 
picture). 

3. When you are ready, to resume the observation from the Observe menu, select 
Resume Observation, or click the Resume Observation button.

4. Continue scoring data as usual. 

The time period between suspending and resuming an observation is not considered for 
analysis.
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You cannot suspend Instantaneous Sampling. If you use both Continuous and Instantaneous 
Sampling, when you suspend the observation, only Continuous Sampling is suspended.

finding events

Use the Find function to:

 Find a specific event type (for example, Twin 1 - Imitates - Twin 2).

 Find multiple event types which share the initial part of the name of the subject/
behavior (for example: Twin 1 - Play and Twin 2 - Play.

 Find multiple event types which share modifiers (for example Play - Duet and Play - 
Alone).

 Find free text entered in the Event log’s Comment column (for example,”I want to play”).

You can specify to search one or multiple observations simultaneously. The Observer creates 
a list of events that correspond to your search criteria. You can then:

 Position video, audio, event log and external data at the time corresponding to one of the 
events found. 

 Copy the list of evens found. 

You can only search for events in the event log, not in the event plots. 

The Find function does not create a subset of data ready to be analyzed (for example, to 
calculate statistics). For this purpose, select data in the data profile (see Chapter 6).

Procedure
1. Click one of the observations in the Explorer, or from the Observe menu, select

Observation, then Open and select one of the observations. 

2. Click the Find button on the tool bar, select Find from the Edit menu, or press 
Ctrl+F. The Find window appears. 

3. Choose the option that applies: 
- To search for a specific event type, select the subject, the behavior and the modifier 

(when applicable) from the corresponding lists Subjects, Behaviors and Modifiers. 
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To select an element of the coding scheme, click the down-pointing arrow in the 
corresponding list and select that element. 
To search for an event type independent of the subject, leave <Any subject> selected in 
the Subjects list.
To search for an event type independent of the behavior, leave <Any behavior> 
selected in the Behaviors list.
To search for an event type independent of the modifier 
entered for one group, select the name of the modifiers 
group. All modifiers in this group are automatically selected.  

To search for an event type that contains one modifier OR 
another of the same group, and exclude others, select the 
modifiers that you require.    
If you select a group of numerical modifiers, you can choose 
to search for a specific value or a range of values. See page 154 for more information. 

- You can also search for multiple subjects and behaviors, provided that these share the 
initial part of the name. For example, to find all events with subject Twin 1 or Twin 2 
(“Twin” is shared), or to find all events with behavior Sitting or Standing (“S” is shared). 
In the Subjects or Behaviors list, type in the initial part of the name that is shared by 
the subjects/behaviors (for example, Tw). If the text is completed automatically, delete 
the part that is not shared. 

If the first character of the subject/behavior name is not shared, you cannot find 
events with this option. Rather, do the search for the different subjects/behavior 
separately. 

- To search for an event containing specific text in the Event log’s Comment column, 
enter this text in the Comments field. 
To search for a specific sequence of words, type the words between quotes, for 
example “Where is the puppet?”. 
To search for any of specific words, type in those words without quotes. (for example, 
puppet ball cards). 
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4. From the Find events in list, select the observations you want to search.

5. To start searching, click Find. 

The window lists the events found with their time and duration. The number of events 
found is displayed at the bottom of the window. If no events are found, the message is 
shown <No events found>. 

6. To position the video, audio, event log and other data at the time corresponding to an 
event, click the Open event button at the bottom of the list, double-click the event in the 
list, or right-click it and select Open event.
If the event is stored in an event log other than that currently open, the new event log 
opens and the current one closes.

Notes

 You can either select one subject (or behavior) from the corresponding list, or all 
subjects/behaviors by selecting <Any subject> or <Any behavior>. You cannot select 
some subject/behaviors, not others. 

 If you select modifiers in two or multiple groups, the program searches for the events 
which contain any of these modifiers. For example, if you select Play alone for the 
modifier group Play mode and Play imaginary for the group Play type, all the events 
containing either Play alone or Play imaginary are found.

 If you select a subject, a behavior and/or a modifier, the program searches for the events 
which contain all these criteria. For example, if you select the Subject Child, the Behavior 
Play and the Modifier Play alone, only the events containing Child, Play and Play alone are 
found. 

 Once you select modifiers to search for, the Modifiers list shows the name of the 
modifiers group if all modifiers in this group are selected, otherwise it shows the 
selected modifiers. 

 If your observation contains multiple event logs, search is done in all event logs. You 
cannot directly search specific event logs within the same observation. However, you can 
view which event log an event corresponds to by sorting the Find results according to 
Event Log (see below). 

 You can hide columns that are not of interest. Right-click one of the column headers and 
de-select the column you want to hide. To show columns that were previously removed, 
right-click a header, click Show column and select the corresponding element.

 If you have start-stop groups in your coding scheme, you can hide stop events in the Find 
window. This can be useful if you want to export the list of events and use those data in, 
for example a statistical package. Select the Hide stop events checkbox. 
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 Using wildcards – 
- Type one or more characters in one of the coding scheme lists. The name of the coding 

scheme element which starts with those characters appears in the list. If two or more 
element names start with the same characters, the name of the element created first 
in the coding scheme appears.

- Search for coding scheme elements is case sensitive. For example if you type in “T”, The 
Observer finds all events beginning with T. 

- Typing a character in the Comments field results in finding all events containing that 
character. Search for free text in Comments is not case-sensitive. If you type in 
“watch”, you may get results like “Watch out!” and “watch out”. 

- Characters like * and ? cannot be used as wildcards, The Observer will search for those 
literal characters. 

 To reset the search criteria, click Reset.

 If Find is in progress and you want to stop it, click the Stop button. 

 To close the Find window, click the Close button at the lower-right corner of the window, 
or right-click the window title bar and select Close.

 When you reopen the Find window, the search criteria last used are selected 
automatically, until you open another project or restart the program.

 Searching for numerical modifiers -

From the Modifiers list of the Find window, select the group of numerical modifier you 
want to search.
- If you want to search for events with a specific value of the modifier, select Exact value 

and enter that value. 

- If you want to search for events with multiple values, select Range and enter the 
from... to... limits of the range in which the values lie. 
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Sorting the Find results

To sort the results, click the header of the column click the header that you want to use as a 
sorting criterion (for example, Behavior). If you click once, the events are sorted in 
descending order. Click again to sort in ascending order.

Exporting the Find results

To export all the events from the Find window, click the Export all events button in the 
bottom-right corner of the Find window. 

To export a selection of events, make your selection. Use the Shift key to select a range of 
events and the Ctrl key to select multiple single events. View the number of selected events 
in the lower-left corner of the window. Click the Export selected events button in the 
bottom-right corner of the Find window. You can export the events to Excel and as a text file. 

To copy the events and paste them into another program: 

1. Right-click one of the events in the list, and select Copy All. 

2. In the other program, click Ctrl+V or from the Edit menu, select Paste.

With the Find function you can very quickly obtain a text file of the selected 
data. Select the events you are interested in and copy them into another 
program. 

Figure 4.13 Exporting events. 
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4.6 Carrying out observations with external 
data

What is external data?

In The Observer XT, external data is any numerical data set acquired with a separate Data 
AcQuisition (DAQ) system and stored in form of an ASCII file. Examples of external data 
include physiological data like EEG, ECG, blood pressure, etc. or environmental data 
(temperature, humidity, etc.), or quantities like speed.

How do I work with external data?
1. Connect your DAQ system to its dedicated computer (that is, the computer that records

such data) and the Observer computer, and select DAQ co-acquisition in Project Setup
(see below). Next, you start an observation and code the behaviors as usual, while the
DAQ system records the external data. 

The external data are saved in the computer dedicated to the DAQ device, not in the 
Observer PC. However, you must connect The Observer PC to the DAQ device in order for 
The Observer to send its synchronization signal (see below). 

2. In The Observer XT, import the external data file(s) and associate each of them with an 
observation (see page 173). 

Therefore, The Observer PC only records the manually coded data (events). During the 
observations, you do not see the external data on your Observer screen. 

External data are always stored in form of ASCII files in the computer dedicated to the 
DAQ device. These data files must be imported in The Observer in order to be displayed.

Specifying external data acquisition in The Observer XT
1. Open the Project Setup and select Live Observation under Observation source (see

page 48). 

2. Select Live scoring. Select DAQ settings (or any other name indicating the external data 
acquisition device) and double-click the text under Status, or click the Edit Settings 
button. 

You can co-acquire external data only when you score data live.

If you score data from previously-recorded video files, you can still import external data 
that were recorded while you recorded video, but you must make sure that video and 
external data can be synchronized in some way. 
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3. In the DAQ Hardware Settings window under Predefined Settings, select the item 
corresponding to your Data Acquisition device, or create a new one (see page 187).

4. Click OK. 

Start the observation as usual. The Observer asks you to start data acquisition on your 
DAQ device. Make sure that your DAQ device is connected to your PC and recording data, 
then click OK. 

5. The program sends a synchronization signal to the Data acquisition device.

6. After stopping the observation, import the external data (see page 173). 

For more information on how to work with physiological data in The Observer XT, see 
Chapter 5. 

4.7 Carrying out observations with external 
programs

What is an external program?

In The Observer XT, an external program is software that you can use in combination with 
The Observer to record additional data. For example, Media Recorder can be used to record 
high-quality video files. 

When do I need this information?

You need this information if you want to make a program start or perform an action when 
you do something in The Observer (for example, start recording with Media Recorder when 
you start an observation). 

Automatic linking of digital video files

When you carry out an observation you can simultaneously start making a video file with 
another program. This program, for example, the Media Recorder, can be started and 
stopped from within The Observer. After you have carried out the observation, the media file 
generated by Media Recorder can be automatically linked to the associated observation.

If you click Cancel the observation starts anyway, but the synchronization 
signal is not sent to the DAQ device! 
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Procedure

The procedure to carry out observations with external programs is described in detail in The 
Observer XT Service Manual. 

Start and stop recording with Media Recorder

If you defined the Media Recorder as external program to start and stop recording 
automatically when starting and stopping an observation, the video files are automatically 
synchronized with the observation. 

4.8 Using multiple media files simultaneously

You can select up to two video or audio files for a specific observation (or four if you have the 
Multiple Media module). However, depending on the computer, it is possible that more than 
four video/audio files can be played back smoothly. 

Level of association of media files and data sets

Media files are always associated with data files at the Observation level. All events scored in 
an observation are associated with those media files, no matter of how many event logs and 
subjects that observation includes. The scope of the Video and Audio variable in the 
Independent Variable List is always Observation. 

Note for users of previous versions of the Observer XT

In the Observer XT 12.5 it is not possible to set the scope of media files at Event Log level, 
Subject level or to set the scope of different media files at different levels. 

selecting media files

Selecting multiple media files 
1. Choose the option that applies:

- If you still have to create the observation in which to import the media files – From the 
Observe menu, select Observation, then New. Name the observation and click OK in 
the Observation Properties window. 

- If you have created an observation and you want to add media files – Make sure the 
observation is open on your screen. Next, from the Observe menu, select Video /Audio 
depending on the media file, then Open in Current Observation. Alternatively, click the 
Import video or Import audio button on the tool bar.
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2. Browse to the location where you stored the media files and select the files you want to 
open for that observation.
- To select non-adjacent files, click one file and then hold down the Ctrl key and click 

each additional file.
- To select adjacent files, click the first file in the sequence and then hold down the Shift 

key and click the last file.

3. Click Open.

replacing or removing a media file

Replacing a media file
1. Open the Independent Variable List (see page 86). In the Video or Audio column, click the

ellipsis button in the cell corresponding to the observation for which you want to replace
the media file. 

2. Select the new media file and click Open. When opening the observation, the new media 
file is displayed.

Removing a media file

Removing a media file makes sense if no data have been collected for the observation 
associated with that media file. 

Open the Independent Variable List and check that each media file is selected in 
one of the Video/Audio columns for that observation. 

To replace or remove a media file from an observation, see the section Replacing 
and removing a media file below.
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Open the Independent Variable List. In the Video or Audio column, right-click the cell 
corresponding to the observation for which you want to delete the media file. Select Delete 
and click OK to remove the file from the observation. 

The media file is not removed from other cells where it is selected. Note that the media file is 
never deleted from the hard disk.

visualizing audio waveforms from a video file

1. Open the observation in which you want to display the audio waveforms.

2. Click the Import video button on the tool bar. 

3. Select the video file you want to open. Select the Visualize audio option next to 
the Open button.

4. Click Open. A conversion dialog is shown for a few seconds.

5. The audio waveforms are displayed in the External Data and Audio window. 

Figure 4.14 An example of audio waveforms obtained from a video file. Note that the title of the plot is 
Video file, contrary to when importing real audio files.
160 Chapter 4 - Carrying out an Observation



Notes

 If the video was already in the observation, open the Independent Variables List, click the 
button next to the cell containing the name of the video name (in the Video column), 
select the Visualize audio option and click Open. Next, re-open the observation.

 The title of the audio waveforms plot from video is Video File (dB). Contrary to audio 
files, the audio waveforms from a video is not an independent variable. Only audio files 
imported into an observation are shown in the Independent Variables list.

 To show/hide audio waveforms from a video file:
- If you have two or more video files in your observation, make sure that the 

corresponding video is visualized on the thumbnail panel on the left side of the Video 
window. From View Settings select Video Files, then Show Video. Select the video files 
whose audio you want to view, de-select the others and click Apply. Note that when 
you de-select a video file name, both video and audio waveforms are hidden.

- If you have one video file in your observation, from View Settings select Video Files, 
and de-select Show External Data and Audio Window. 

 To mute audio from video, click the speaker icon in the External Data and Audio 
window, or in the Video window.

 To remove the audio completely, remove the video file (see page 159).

 Synchronization between audio visualization and video images is within 2 frames (80 ms 
for PAL, 67 ms for NTSC).

 For each video file you can show up to two channels (Left and Right). If video contains 
more channels, only the first two are visualized.

 You can visualize audio for each video file allowed by your license. For example if you 
have a Media Files add-on license, you can visualize two videos and the two 
corresponding audio waveforms (plus two audio files).

 Whether audio can be visualized, depends on its format inside the video file. See the 
Observer XT Service Manual for a list of audio formats supported. Audio formats other 
than those supported may be visualized, depending on the audio decoders installed on 
your computer.

4.9 The Software Development Kit

The Software Development Kit (SDK) is a set of development tools that allows software 
engineers to create applications for use in combination with The Observer XT. The Observer 
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XT SDK includes a debugging aid, an example tool plus C++ sample source code and 
supporting technical documentation.

To obtain the SDK, please contact support@noldus.nl. Please note that support on the SDK 
(see the description below), including help with making them, is strictly only available to 
customers with a service contract.

At the time of publication an SDK for the applications listed below is available. 

It is possible that after publication of this manual more applications may become available. 
Please contact support@noldus.nl for more information about the SDK.

external applications

The Observer XT contains a mechanism for executing other (external) applications during 
certain actions taken by the user in The Observer XT.

These user actions in The Observer XT are: New observation, Start observation, Stop 
observation, Close observation. When these user actions are carried out, you can execute a 
command with optional parameters. Furthermore, you can execute several external 
applications using a batch file or Visual Basic scripting.

The SDK contains documentation with background information, examples of how to execute 
one or more applications and a summary of batch file processing. The SDK also contains 
three pre-programmed command files.

plug-in viewer com-object

With the SDK you can create a custom viewer and visualize the viewer in The Observer XT 
during an observation of visualization. To create a custom “The Observer XT”-viewer plug-in 
it must be a COM (Component Object Model) object according to the specifications described 
in the SDK document. Such a viewer can be used, for instance, to visualize the movement of 
a shoulder prosthesis in The Observer, while simultaneously viewing a video recording of the 
patient and physiological data.

Using the plug-in mechanism requires the ‘Media Files’ add-on in The Observer XT.

The SDK contains documentation describing how to Plug-in viewer COM-object works and 
how to work with plug-ins in The Observer XT. The SDK also contains a Microsoft Visual 
Studio 2003 C++ sample COM-project for an audio-player plug-in, a MFC sample COM-
project for a simple test viewer plug-in and two DLLs (audio player plug-in and a simple 
testviewer plug-in).
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observational data xml (odx)

The SDK explains how to create an ODX file that can be imported into The Observer XT. An 
ODX file is an Observational Data file in XML format. Most files created in The Observer XT 
are XML-based and are used to transfer data to and from The Observer XT. With The SDK you 
can create your own ODX file to exchange information between your own application and 
The Observer XT.

The SDK contains documentation describing the contents/format of an ODX file. The SDK 
also contains an exported ODX file from The Observer XT, XSD schema definition files for an 
ODX file and a C++ header file with all tag names used in ODX files.

automatic synchronization

The Observer XT uses a serial binary data exchange mechanism for automatic 
synchronization of observational and external, physiological data. Two types of Sync Out 
signals are available to achieve this automatic synchronization. The SDK describes in detail 
the mechanism for automatic synchronization and the Sync Out signals. It enables you to 
decode the Sync Out signal and to use it with your own application.

The SDK contains a document describing the synchronization method, the Sync Out signals 
and a sample synchronization data file.

event data plug-in

This plug-in offers the possibility to obtain event data from an external program while you 
carry out a live Observation in The Observer. The external events are imported 
simultaneously with your manually scored data in The Observer. 

In The Observer, these event data are stored in a separate Event Log. You can visualize and 
analyze the event data like any other event data in The Observer.

external data plug-in

This plug-in offers the possibility to obtain external data while you carry out a live 
Observation in The Observer. The external data are imported simultaneously with your 
manually scored data in The Observer. 

In The Observer, these external data are stored in the External data Files folder of the 
observation. You can visualize and analyze the external data together with event data in The 
Observer.
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4.10 Working with observations containing 
multiple event logs 

Note for users of previous versions of the Observer XT

In the Observer XT 12.5 it is not possible to manually add an Event log in an existing 
observation. However, external event files can be imported as separate Event logs into one 
Observation. Hence, although you cannot create a second Event log within one Observation 
in the Observer XT 12.5, Observations can still contain more than one Event log. 

definitions

Observation

An observation is a container of data and video/audio files, rather than a file itself. An 
observation can contain one or more event log files. When you create a new observation, an 
empty event log Event log0001 is created automatically. 

Observation Start and Observation Stop

You can view these two values in the Timers window (page 135). 

 Observation - Start Time is the point marking the earliest time that you started 
observation, when you clicked the Start Observation button (Ctrl+Alt+B).
- For a live observation, this is the clock time at which you started the observation. 
- For an observation from video/audio, this is usually 0:00:00.00 or another time in the 

video/audio. 
- The time also depends on the time settings (page 60). 

Example – Create an observation, open a video file, position video at five minutes. Then, 
start the observation. This time (A) is the Observation Start. 

If you want to separate data, create separate observations. You can then group 
the observations and carry out behavioral or numerical analysis. 
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- You can view the Observation Start Time in the Independent Variable List. Click 
Independent Variables in the Project Explorer, then Show Independent Variables and 
select Start Time under System. The Start Time column shows the Observation Start 
Time of each observation.

- If you import an event log that has a start (relative to video/audio) earlier than that of 
the event logs currently in the observation, this time becomes the new Observation 
Start Time. 

 Observation - Stop Time is the point in time that marks the latest stop of an observation, 
when you clicked the Stop Observation button (Ctrl+Alt+Q).

Notes
- You can view the Observation End time in the Independent Variable List. Click 

Independent Variables in the Project Explorer, then Show Independent Variables and 
select Stop Time under System. The Stop Time column shows the Observation - Stop 
Time of each observation.

- If you import an event log that has a stop (relative to video/audio) later than that of 
the event logs currently in the observation, this time becomes the new Observation - 
Stop Time.

Event log

An Event log is a file containing data scored manually or imported in The Observer XT.

Each event log has a Start time and Stop time (see below). The duration of an event log is the 
difference between those times. 

Event Log Start Time and Event Log Stop Time

You can view these two values in the Observation Timers window (page 135).

 Event Log - Start Time is the time that you started observing for that event log relative to 
Observation - Start Time.

 Event Log - Stop Time is the time that you stopped observing for that event log relative to 
Observation Start Time.

Observation Duration

Observation Duration is defined by the difference between Observation Stop Time and 
Observation Start Time. 

Observation Duration is a System variable named Duration in the Independent Variables List, 
in Data Selection, and in Analysis results. Please do not confuse this with Analyzed Duration 
(see below). 

 Observation Duration can also include gaps in the time line with no data. 
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This can happen in the following cases:

a If you deleted parts of Event Logs. 
b If you have imported a project from a previous version of The Observer which con-

tained non-overlapping Event logs within Observations. 
c If your data acquisition started later than you ended your manually scored Observa-

tion. 

  Usually the Observation Duration is the time from the earliest start of an event log to 
the time of the latest stop of an event log. However, if you change the Offset between 
event logs some data may fall outside the Observation Duration:
- If you change the Offset in such a way that the start time of an event log falls earlier 

than the Observation Start Time, the latter is not moved to an earlier time. The time 
between this event log's start time and Observation Start Time is excluded from 
analysis and showed in gray in the event log. 

- If you change the Offset in such a way that the stop time of an event log falls later 
than the Observation Stop Time, the latter is not moved to a later time. The time 
between Observation Stop Time and this event log's stop time is excluded from 
analysis and showed in gray in the event log. 

If you want to analyze the data that exceeds the Observation Start Time or Observation Stop 
Time, see page 168. 

Analyzed Duration

Analyzed Duration is the sum of the duration of event logs within the Observation Duration, 
minus the time that the observation was suspended, minus the time filtered out by the 
active Data profile. 

 If you analyze the event logs in an observation separately, Analyzed Duration does not 
include the gaps between event logs. For this reason, sometimes Analyzed Duration is 
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shorter than Observation Duration, even if your Data profile selects all data for analysis. 
Consider the example of the previous page:

Analyzed Duration is the sum of the durations of the two event logs, therefore shorter 
than the observation duration. 

For information on analyzing event logs separately or as one data set, see page 330.

managing observations with multiple event logs

In The Observer XT 12.5 it is not possible to create a new Event log within the same manually 
scored Observation, for example when you change the subject observed. To keep those data 
separated, create a new Observation instead. 

Importing event logs into an observation
1. Export the event logs as ODX files (see page 411).

2. Copy the ODX files to the destination computer.

3. Open the observation, and click the Import Data button, then Import 
Observational Data. 

4. Select The Observer XT Data File (*.odx) from the Files of Type list, then select the ODX file 
you require and click Open. 

If the odx file contains more than one observation, only the event logs from the first 
observation are imported. To make sure that each ODX file contains one observation, 
select Create separate file per observation when exporting the event logs.

Checking that data are imported correctly
1. Make sure that the observation you have imported data to is selected in the data profile,

and that no intervals are defined. 

2.  Click the Visualize icon on the tool bar. 
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3. Check that the alignment of the different event logs is as expected, and that the data you 
want to analyze fall within the white area. The left margin of the white area is 
Observation Start Time. The right margin is Observation Stop Time. Make sure that all 
your data fall in this interval. 

4. If the alignment is not correct, re-open the observation and click the Offset button 
to adjust the time between event logs. For more information, see page 127.

If some data are missing from the white area, you may need to expand the Observation 
duration (see the next section).

Extending the Observation Duration to include data currently outside the observation

If for any reason you have changed the offset between data files in your observation, some 
data may fall outside the observation boundaries (Observation Start Time and Observation 
Stop Time). You can check this in the event log. In the example below, an offset of -10 seconds 
has excluded the data in the first 10 seconds of the event log: 

Data occurring before Observation Start Time or after Observation Stop Time are greyed out. 
To recover and analyze those data:

 If grayed out data occur before Observation Start Time – In the Timers window, take note 
of the Event Log - Start Time (this is negative when the event log starts before 
Observation Start Time). Open the Independent Variables List and locate the Start Time 
column. Click the cell corresponding to the observation, and decrease the time value as 
much as the Event Log Start Time.
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 If the grayed out data occur after Observation Stop Time – In the Timers window, take 
note of the Event Log Start Time (this is positive when the event log starts after 
Observation Start Time). Open the Independent Variables List and locate the Duration 
column. Click the cell corresponding to the observation, and increase the time value as 
much as the Event Log Start Time.

Reducing the Observation Duration

When you delete the earliest or the latest event log in an observation, the Observation 
duration does not change. In such cases you may want to reduce the observation duration in 
such a way that it only covers the event logs currently present in the observation. 

 To move Observation Start Time to a later time – Open the Independent Variables List 
and locate the Start Time column. Click the cell corresponding to the observation, and 
increase the time value. 

 To move Observation Stop Time to an earlier time – Open the Independent Variables List 
and locate the Duration column. Click the cell corresponding to the observation, and 
decrease the time value.

Be careful when adjusting the observation time boundaries, that may exclude 
data!
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Chapter 5 
External Data

5.1 What is external data .......................................................................... 172
What is external data and how can you import it into The Observer XT

5.2 Importing external data ...................................................................... 173

5.3 Synchronizing logged events and external data ................................ 186
Synchronization can be carried out automatically or manually.
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5.1 What is external data?

External data can be data that have been acquired with a separate Data AcQuisition (DAQ) 
system, such as the MindWare or BIOPAC system. This can be, for example, physiological 
(e.g., ECG, EEG, blood pressure, skin temperature), environmental data (e.g., temperature, 
humidity) or eye-tracking data.

what can I do with external data?

With The Observer XT you can import any external data which has been acquired with a 
constant sample rate and has been stored in ASCII-format. It is possible to synchronize 
logged events and associated physiological or eye-tracking data in The Observer XT. You can 
then visualize, select and analyze the external data. Subsequently, you can export the event 
data and external data to one file.

The current chapter focuses on the import of physiological data and the synchronization 
with logged events.

For selecting external data, see Chapter 6 Selecting Data.

For visualizing external data, see Chapter 7 Visualizing Data.

For analyzing external data, see Chapter 8 Calculating Statistics.

how do I work with external data?

Working with external physiological data involves the following basic steps:

 Carry out a live observation and simultaneously send a synchronization signal from 
The Observer XT computer to the external DAQ system. The time information in this 
synchronization signal is stored in the physiological data file.

You can also import European Data Format (EDF) files or BioSemi Data Format 
(BDF) files into The Observer XT. See Section 11.5 on page 435 for details. The 
imported data can be synchronized with the event log in the same way as 
external data in ASCII format. See page 190 for the procedure. 

You need the External Data Module (see Additional licenses on page 21) to import 
external data in ASCII format, EDF, or BDF data. 
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 Import the external data (including the time information from the synchronization 
signal) into The Observer XT and link it to an observation. The time information is used to 
synchronize observational and external data.

 Make a selection of external data in a data profile.

 Visualize the data.

 Calculate statistics in the Analyze menu on behaviors/modifiers and/or external data.

 Export event log data and associated physiological data in one file.

5.2 Importing external data

To import external data you need to add it to an existing Observation.

1. Do one of the following:
- From the File menu, choose Import, then External Data.
- Open an existing observation (see page 124). Click the Import Data 

button on the tool bar and select Import external data. The external 
data are linked to the selected observation.

- Open the Independent Variable List. Right-click on an Observation, Event Log or 
Subject and select Import Data. The external data are linked to the selected 
observation.

The scope of the external data file is always Observation. See page 90 for more information. 

All external data is imported in one step. The Observer XT offers Import profiles for a number 
of DAQ systems (MindWare, BIOPAC, DataScience, Polar). 

2. The Import External Data window opens (see Figure 5.1). Select the type of external data 
file you want to import under Files of type. Next, locate the external data file and select 
the filename.

In the Files of type list, select All Files (*.*) if you want to see all files in the folder.

If your type of file is not in the list of predefined files of type you can create a new 
Custom Import Profile (see below).

3. In the Import to group, select an Existing observation from the list or select New 
observation.

This option is only available when you import external data via the File menu.

4. If you want to import specific data sets from the external data file, continue at “Importing 
a specific data set” below.
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5. To import the complete file including all data sets, click Open.

Importing a specific data set

If your external data file contains more than one data set and you want to import only 
specific data sets:

1. From the File menu, choose Import and External Data. 

2. Next, follow the instruction above until step 3 then click the Manual import... button.

A new Import External Data window opens showing one or more data sets (see Figure 5.2 
below). The Independent Variable List also appears. 

Figure 5.1 The Import External Data window.
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3. To link external data to an Observation, select on or more Data Set rows and drag-and-
drop to the Independent Variable List window; you can choose to drag-and-drop to an 
Observation, an Event Log or a Subject (see Figure 5.3).

4. Click Import in the External Data window to finish the import of external data.

Figure 5.2 The second Import External Data window. This window shows all the data sets acquired 
through the external DAQ system and, in this example, the corresponding file name, start date and 
start time.

Figure 5.3 Data sets are selected in the Import External Data window. In this example Data sets are 
linked to Observation001 by drag-and-drop.
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Creating a new Custom Import Profile
1. From the File menu, click Import, then External Data.

2. In the Import External Data window, click the Custom Import Profiles button. The Import 
Profiles window opens; here you see a list of available import profiles. Click the Create 
New button.

3. To select an external data file, in the Profile Definition window, click the Browse button in 
the Select sample file section at the top of the window, locate and select the file and press 
Open.

4. The Observer XT automatically detects header and data information in the external data 
file. This information is visible in the File content section of the Import Profile Definition 
window (Fig. 6.4).

If automatic header detection does not work, see header detection on page 185 how you 
can manually detect header and data information.

Figure 5.4 The Import Profile Definition window with instructions on the right. This example shows 
electrodermal activity (EDA) data acquired with the MindWare system.
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5. The Observer XT uses the comma as the default delimiter to separate text in the header 
and data sets. However, if text that should be in separate columns is still in one column, 
you can separate the text by selecting the appropriate delimiters from the list under 
Select header delimiters and Select data delimiters.

Some DAQ software enables you to select the type of delimiter when saving the DAQ 
data to an ASCII export-file. In that case you select the same delimiter in the File content 
section of the Profile Definition window. A comma or semicolon are advised as 
delimiters.

6. Now you can assign the information from the Header and the Data Sets in the File content 
section to the appropriate cells in the Profile Definition section.

Under Data definition in the Profile definition section there are two parts. The lilac part 
is labeled Header Data where you enter Header information from the lilac cells in the File 
content section. The green part is labeled Raw data where you enter Data sets from the 
green cells in the File content section.

First you define the sample rate of the external data acquired by the DAQ system.

a If the Header contains the sample rate, select the Sample rate button under Timing
based on in the Profile definition section. Drag the sample rate to the Sample rate box
and select the appropriate unit (Hz or kHz) from the list.

b If the Header contains the sample interval, select the Sample interval button in the
Profile definition section. Drag the sample interval to the Sample interval box. Select
the unit of time from the list.

Figure 5.5 The File Content section of the Profile Definition window. In the top image, all header text 
is in one column. The bottom image shows the same header, with the Comma and Space delimiter 
selected; the same text is now in separate columns.
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c If the Header does not contain information on sample rate, select the Time series
button under Timing based on. Under Data sets in the File content section, select one
of the green cells in the column with time stamps and drag this to the Time series box
(Figure 5.7).

 

Figure 5.6 Example of a sample rate in the Header that is assigned to the Sample rate box in the 
Timing based on group.
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 The Select Time Format window opens. If the time matches one of the predefined 
formats, The Observer automatically selects one. Converted time shows the 
converted time and Conversion is OK. Click OK.

 You can also define your own format by typing an 'H' for each number representing 
'hour', an 'm' for 'minute', an 's' for second and a 'f' for each number representing 
millisecond (see the next picture). If Conversion is OK, then click OK.

 Under Import Time, select one of the options. 
 Relative to time zero - Suppose the first row in the imported external data set 

has time 00:00:05. When the option Relative to time zero is selected, the time 
stamp of the first row of the imported data set will remain 00:00:05.

Figure 5.7 Part of the Import Profile Definition window. In this example, the Data sets sheet 
contains a column with time stamps. The contents of this column is assigned to the Time series 
box in the Timing based on group. The format of the Time series is Numerical value - seconds.
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 Relative to the time of the first data line - Suppose the data set you want to 
import starts at 14:28:00 and sample every 5 seconds. With the option Relative 
to the time of the first data line, the first row of the imported data will get the 
time stamp 00:00:00. The second row will have time stamp 00:00:05. The 
options under Import Time are greyed out when your time stamps contain the 
date the file was created. In this case the option Relative to time zero is used.

The column with time stamps now appears grayed. You can drag-and-drop only one 
column at a time.

7. Next you can define the Data set(s).

A Data set consists of time-ordered values of a variable, e.g. EEG, heart rate, body 
temperature. A data file can contain more than one Data set.

8. Drag one of the green cells under Data Sets in the File content section to one of the empty 
cells in the Raw data - Data Set column. As a result, the letter of the original column 
appears in the cell and the column under Data Sets in the File content section is greyed.

The Observer XT assumes that your header and data set info are ordered in a regular way 
in your external data file (e.g., left-right, with/without empty cells in between).

9. Drag the first two columns with data to the first two rows of the Raw data column in the 
Data definition group. Next, the Validity Check button becomes active. When you click 
this Validity Check button, The Observer automatically assigns the other columns from 
the Data sets group to the remaining rows in the Data Definition group.

Example - your external data file contains four Data Sets in columns A, C, E and G. 
Columns B, D, F are empty. When you drag columns A and C to the first two rows in the 
Raw Data column and next click the Validity Check button, The Observer automatically 
assigns columns E and G to rows 3 and 4, thereby taking into account the empty columns 
between Data Sets. 

The distance between the columns should be the same. For example dropping columns 
A, B, and C and pressing the Validity Check button works. The columns D, E, F, and G are 
then automatically added to the other rows. Dropping A, and C and pressing the Validity 
Check button also works, the columns E and G are automatically added. However, 
dropping A, C, and D does not work, because there is an empty column between A en D, 
but not between C and D. Pressing the Validity Check button then gives an error 
message.    
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10.Next, you can assign information to the Header Data part of the Profile definition section.

a Dataset Name - You can drag the name of the Data sets under Header (the top lilac
window) in the File content section to the Dataset Name column under Data definition
(the bottom lilac window) in the Profile definition section.
The Dataset Name in the original location is greyed. You can return the Dataset Name 
to its original cell by selecting the Dataset Name in the Data definition field and 
pressing delete.

Figure 5.8 The Data definition sheet in the Import Profile Definition window. In this example, the Raw 
Data column shows the letters of the columns with data sets from the Data sets sheet.

Figure 5.9 The Import Profile Definition window. In this example, one of the Data Set Names is 
moved from the Header to the Data definition sheet.
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b Start Date - Select the date under Header in the File content section and drag it to the
Start Date column under Data definition.
If the date matches one of the predefined formats, The Observer XT automatically 
selects one in the Select Date Format window. In that case it says Conversion: OK in 
the Conversion section. Click OK to proceed.
You can also define a date format yourself. For example, your date in the header is 
formatted as: 15032005 (March 15 2005). This date format does not match a 
predefined format. In the format box, type 'dd' for the numbers representing 'day', 
'MM' for month and 'yyyy' for 'year'. Behind Converted date is now the correct date 
and Conversion shows OK. Click OK to set the format.

Start time - select the start time under Header in the File content section and drag-
and-drop it to the Start time column under Data definition.
In the Select Time Format window a predefined format is selected automatically. Click 
OK if this is the right one. If not, type in a new format in the Format box. Click OK.

c Type - Drag-and-drop the type of measurement from the Header part of the File
content section to the Type column in the Data definition part, in the Profile definition
section.

d Unit - Drag-and-drop the unit of measurement from the Header part to the Unit
column in the Data definition section.

11. When all the information is in the Import Profile Definition sheet, click the Save As 
button.

Type a profile name in the Profile Name box of the Save Import Profile window. You can 
add a description of the import profile in the small Description window. Click OK.

This import profile has the extension *.eip and is saved in the specified Destination 
folder.
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12. Click OK to close the Import Profile Definition window.

In the Import Profiles window the newly created import profiles is now in the list of 
import profiles.

13. Close the Import Profiles window by pressing the Close button.

14. In the Import External Data window, the new import profile is now selected in the list of 
Files of type list. If not, click the drop-down button and select the newly created import 
profile.

15. Locate the external data file and select the filename. Follow the instructions starting from 
4 (page 173) to import the external data.

Missing data

In The Observer XT 12.5, it is possible to import external data with missing samples.  

However, there are some prerequisites. 

1. The external data must be sampled with time stamps that vary 10% from being
equidistant. 

Example 1 – Timestamps 1.05, 1.99, 3.08 can be used and will be converted into 1, 2, and 3.

Example 2 – Timestamps 1.0 1.5 , 3.0, 4.0 cannot be used. 

2. The time series should have at least one decimal more than the resolution of the sample 
rate. So with a sample rate of 1 Hz, the time stamps should be in seconds with one decimal. 

3. The file should not contain entire empty rows. 

4. In the Import profile definition window, drop the column with the time information in the 
Time series cell (see step c on page 178). Do not use the Sample rate, or Sample interval 
option. 

5. If the file does not contain a column with time stamps, the data sets should not contain 
missing rows. Otherwise the data behind the missing rows will be shifted forward and will 
be associated to the wrong timestamp. 

If your Data set contains missing samples indicated by non-numeric symbols, you need to 
specify this symbol in the Import profile definition window (see Creating a new Custom 
Import Profile on page 176). 

 Select the Treat as number checkbox.

 Type in the non-numeric symbol in the Treat as number field or click the button next to it 
to select one or more predefined symbols. 

 To select a specific text, click <User Defined>, click OK enter this text after 
a comma (,). 

 If text is identified by a character, select this from the Text qualifier list.
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A missing sample is converted to a NaN symbol. 

When you import a data set with missing samples, you will get the following warning. 

Choose Import and ignore and click OK.

In previous versions missing samples were converted into a zero. In The Observer XT 12.5 the 
missing samples are converted into a NaN value, which are not present in the visualization 
and are ignored in the analysis. In the example below, the sample at timestamp 7 is missing.

Editing a Custom Import Profile

If you want to import an external data file that is very similar to, but not exactly the same as, 
another data file for which you already have an Import Profile, you can edit the existing 
Import Profile.

1. In the Import External Data window, click the Custom Import Profiles button.

2. Select the Import Profile from the list in the Import Profiles window and click Edit.

In the Select Sample File group you see the original sample file behind Profile based on.

Please note that missing samples may indicate that something is wrong with 
the setup of your DAQ system
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3. Click Browse in the Select Sample File group to select the new external data file and 
click Open.

4. Follow the instructions 4-8 under “Create a new Import profile” above.

5. Click Save Profile As when you are finished filling in the Data definition sheet.

6. Type in the name for the Import Profile.

7. Click OK.

8. Close the Profile Definition window.

9. Close the Import Profiles window. Make sure you select the right import profile.

10.Select the external data file and click Open to finish import.

header detection

When you create a Custom Import Profile to import an external data file, The Observer XT 
usually automatically detects header and data information in the file. In some cases, 
however, the format of the file prevents The Observer from automatically detecting header 
and data. For these cases, new Header detection methods have been added to the Import 
Profile Definition window.

The methods for Header detection are:

 Automatic – This method is selected by default and works most of the time.

 Specify tag - If automatic detection does not work, you can specify the line (with either 
nominal or numerical information) that indicates the end of the header part of the file. If 
necessary, you can also specify the number of rows between this ‘header end line’ and 
the data.

 Specify row number - If automatic detection does not work but the data file always has 
the same number of rows in the header, you can specify the number of header rows.

Specify tag

Select this method if the external data file has a variable number of header lines rows and 
header and data are always separated by the same ‘header end line’.

Example - The header always ends with a line containing the following text: “[Data]”. After 
this header end line there is always an empty line before the data starts. So, in the End tag 
box you enter: “[Data]” and in the Extra rows box you enter a value of ‘1’.
Chapter 5 - External Data 185



Specify row number

Select this method if the contents of the header information is variable but the header 
always has the same number of rows. So, in the Fixed rows box, you enter the appropriate 
number of rows.

5.3 Synchronizing logged events and external 
data

If you score events and simultaneously acquire external data, you can synchronize external 
and event log data with The Observer XT. This is done by sending a synchronization signal 
from the Observer XT PC to the external DAQ system. This synchronization signal contains 
time information from The Observer XT PC. This time information is used to synchronize the 
event log data and the associated external data after import of the external data file.

 

You have two options for the synchronization of event data and external data:

 If your DAQ system can receive the synchronization signal, you should preferably use 
Automatic synchronization (see below).

 Otherwise, you can use Manual synchronization (see page 190).

Figure 5.10 Schematic overview of the setup for automatic synchronization of observational and 
external data.
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automatic synchronization

The automatic synchronization of external data and event log data involves three steps:

 Select DAQ co-acquisition when your Observer XT computer can be connected to your 
DAQ system.

 The Observer XT sends a synchronization signal to the DAQ system.

 Import the external data.

Settings for live scoring with external data acquisition
1. Click Project Setup in the Project Explorer. 

2. Select Live Observation. The Devices window opens. Select DAQ Settings. Double-click the 
field next to it or click the Edit Settings button at the bottom of the table. This opens the 
DAQ Hardware Settings window.

3. Under Predefined Settings, select the profile corresponding to your DAQ system or create 
a new one (see below).

4. Click OK.

Creating a new DAQ Hardware Settings profile
1. In the DAQ Hardware Settings window, click the New (Insert) button or click in the

Predefined Settings window and press <Insert> on your keyboard. 

2. A new field appears at the bottom of the list in the Predefined Settings window. Type the 
name of the new profile.

3. Under Output Device, select how you want your Observer XT PC to be connected to the 
DAQ system. You can choose one of you PC's COM ports.

Figure 5.11 The DAQ 
Hardware Settings 
window.
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The selected device sends the synchronization signal to the DAQ system.

The synchronization signal is an analog signal which is fed into the free analog input of 
the DAQ system. In the DAQ device this signal is configured equally as a standard 
physiological signal (e.g. ECG, EEG, EMG).

The Output Device is the port through which the synchronization signal, via a custom 
Noldus cable, is sent to the DAQ system. You can select one of the RS232 COM ports that 
sends out the synchronization signal.

If the COM port is Offline, check that other programs (also those not running) are not 
controlling that port. Change the port settings in those program or uninstall them when 
not necessary. When you use a USB-to-COM converter, search for the COM port from the 
list that is Online. 

4. Under Signal Type select:
- On-Off if your DAQ system uses a low sample rate (< 10 Hz) or samples continuously 

(without regular intervals). Also select this option if you use the Noldus mini USB-IO 
box for synchronization (see the note above). 

- Time Code (TCAP) in all other cases. If you choose Time Code, type in the Sample rate of 
your DAQ device in the corresponding field. As you enter the sample rate, the program 
calculates the Minimal sampling time in seconds, which depends on how much time 
The Observer XT needs to send the complete synchronization signal to the DAQ device 
with that sample rate. (see Time Code in the next pages for more information).

5. Click OK.

Notes

 The information of the synchronization signal is stored in the external data file. In 
the Import External Data window, the Data Set has a small clock icon, if it has been 
correctly identified.

If the DAQ system uses a filter for incoming external data, it might also affect 
the synchronization signal from The Observer XT! Watch the sync signal on 
your DAQ system; it should display square pulses.

You can also connect a your computer with The Observer XT with a USB cable 
to a Noldus mini USB-IO box. The synchronization cable connects your DAQ 
system to one of the TTL ports of the Noldus mini USB-IO box. Select Noldus 
Mini IObox sync in the Output device list of step 3 on page 187. Select On-Off 
in step 4 below. Contact your Noldus sales representative if you are interested 
in this option. 
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 See Importing external data (page 173) to import these external data and 
synchronization information. 

 When you import the external data, you need to import both the Data Set with the 
external data and the XT synchronization information. This way the associated Event Log 
is automatically synchronized with the external data.

Name your synchronization data as 'sync' or use 'sync' as the type of Unit. The Observer 
XT automatically recognizes your synchronization data upon import.

 When in your Project Setup DAQ co-acquisition is selected, the Synchronization Settings 
button in the second Import External Data window becomes active. Click the Manual 
import button in the first Import External Data window to open the second window. In 
the Synchronization Settings you can set values for a number of parameters that 
determine how the information from the synchronization signal is extracted from the 
imported DAQ data.

The information in the synchronization signal is sampled by the DAQ system. On import 
into The Observer XT some digital signal processing takes place to deal with noise, signal 
distortion, spikes etc.

 Click on Synchronization Settings to open the Synchronization Settings window. Here 
you can set values for the following parameters with default values between brackets:
- Number of offset values (10) - corresponds to the number of discrete samples of the 

DAQ system containing synchronization information. These offset values are used for 
the calculation of average offset and gain. A higher value increases the accuracy of 
synchronization, but also increases calculation time.

- Smoothing factor (1) - corresponds to the number of samples over which an average is 
calculated. A higher value reduces spikes on the signal, but also reduces the time 
accuracy of the synchronization.

- Signal-to-noise-ratio (20) - determines the tolerance for detecting high-low signal 
transitions. A higher value increases this tolerance, but also increases the chance of 
detecting false transitions.

- Number of samples prescan TCAP (180000) - corresponds to the maximum number of 
samples used for auto-detection of a time code in the DAQ samples. For example, 180 
seconds at 1 kHz or 30 minutes at 100 Hz.

Click in the boxes to set a value for each of the parameters. Click Defaults if you want to 
return to the default values or click OK to finish. In most cases, you do not need to adjust 
the Synchronization Settings.
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manual synchronization

Manual synchronization of logged events and associated external data can be facilitated 
during the logging of events in the following ways:

 You can start a live observation and the acquisition of external data at exactly the same 
time. As a result, the imported external data have the same starting point and a similar 
duration as the associated event log.

 You can have a specified interval between the start of event logging and data 
acquisition. For example, you switch on your DAQ system and start your observation 
exactly 10 seconds after that.

 When you record events in a digital video file for later logging, you can either film 
pushing the button which marks the start of external data acquisition or you can mark 
the start of external data acquisition by a visual cue or sound signal. Simultaneously, you 
log this cue or signal as an event in The Observer. When you log events from the video 
file afterwards, the visual/sound signal determines the start of your observation.

 You can create a peak in the external data signal by, for example, swiping a magnet past 
the sensor and simultaneously log this as an event in The Observer. Afterwards, you can 
synchronize the event log and the external data by aligning the peak and the scored 
event.

Carrying out Manual synchronization

There are three methods for manual synchronization:

 You can use Numerical offset (see below) if you know how many seconds the 
observational and external data are out of sync.

 You can use Manual offset (see page 192) for visual synchronization. This can be used 
when you score from a media file and the start of the observation or external data 
acquisition is signaled by a visual or auditory cue.

Example - you observe an animal's reaction to a sudden encounter with an unfamiliar 
object and at the same time monitor its heart rate. The encounter is characterized by a 
sudden increase in heart rate. This peak in heart rate can be used as an offset point for 
the observational and physiological data.

 You can set the start time or end time in the Import External Data window upon import.

By changing the start time you set the offset of a file. By changing the end time and/or 
start time you set the gain by stretching your file.
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Numerical offset
1. Import the external data file and link it to an Observation (see Import external data,

page 173).

If your external data file does not have a start date/time, the start position of the 
external data file is set at the start of the event log. If your external data file does have a 
start date/time, the start position is at the start of the external data file.

2. Open the Observation to which you linked the external data. 

3. On the component tool bar, click the Offset button and select Numerical Offset to 
open the File Synchronization window.

4. You can now set the start (Offset) of either the Physiological Data or the Event Log. 

Example - You started your observation 3 seconds before you started acquisition of 
external Heart Rate data.
- Click the numbers representing the seconds in the Offset column of the Heart rate row.

- Type '03' in the time stamp and click Apply to set the time to 3 seconds
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The result is that when you play back the event log and external data (see Playing back 
observation data on page 114), the External Data window starts running 3 seconds after 
the Event Log Data (see Figure 5.12).

Manual offset
1. Import the external data file and link it to an Observation, Event Log or Subject (see

Import external data, page 173).

By default, the start of both the event log and external data file are used as the point of 
synchronization.

2. Open the Observation to which you linked the external data. By default all available 
windows open.

Make sure the Event log, Playback control, Video or Audio Files and Visualize Data 
window are open. Observer windows can be displayed by selecting them from the View 
Settings list at the top-right corner of your screen.

A blue line in the Start row of the Event log and a vertical line in the External Data 
window indicate the position in both files.

When Observer XT is not in Offset mode, clicking on a behavior in the Event Log window 
will move the vertical line in the External data window to a new position. When you 
place your cursor on the marker at the top of the vertical line in the External Data 
window, a double moving-arrow appears. With this double arrow you can move the red 
line; this makes the gray bar in the Event log window jump to another behavior.

3. In the component tool bar, click the Offset button and click Manual offset.

The Synchronize window appears. This window shows instructions how to set the 
Offset in a video, audio file or external data window.

4. Click Start Synchronization.

Figure 5.12 Part of the External Data window. The arrow indicates the start of the observation. The 
offset of the external data is set to 3 seconds.
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5. Click in the External Data window; the border of this window turns red and the cursor 
becomes an offset-icon. Keep the left mouse-button pressed to drag the graph window to 
the left and the right.

- You synchronize the external data and the start of the Event log by dragging the 
external data graph to a position where the peak is at the vertical line (i.e. the offset of 
the observation).

- Click the Offset button in the component tool bar to finish synchronization.

If a specific behavior in the video coincides with a specific peak in the external data (for 
example, an animal jumps and shows a corresponding peak in heart rate), do the 
following:

a In the Videos window, go to the specific behavior by using the controls in the Playback
Control window or by moving the slider in the Videos window.

b Click the Offset button in the component tool bar, click in the External Data window
and move the external data graph so that the specific peak coincides with the vertical
line, i.e. the location of the specific behavior in the Videos window.

c Click the Offset button again to finish synchronization.
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6.1 Why select data?

There are four good reasons why you may want to select data before carrying out the real 
analysis (for example, visualizing data or calculating statistics).

analyze specific events in groups

 Example 1 – Visualize behaviors of the group Play type as one behavior. 

Solution – Merge the data, then run the analysis. See page 206.

analyze some observations, subjects or events, 
not others

 Example 1 – Calculate the average duration of speech of the subject Child, not the subject 
Mother.

 Example 2 – Visualize data in observations of female subjects, not males.

 Example 3 – Calculate the rate of occurrence of events of the group User Error, not others.

Solution – Filter the data, then run the analysis. See page 210.

analyze events that occurred in specific time intervals

 Example 1 – Visualize the data from 1 minute to 10 minutes of observation. 

 Example 2 – Calculate the number of times the child smiled when the state event Play 
was active.

 Example 3 – Calculate statistics of events when the heart rate was higher than 60 beats 
per minute.

Solution – Select intervals by manual selection (example 1; see page 221), select intervals by 
state events (example 2; see page 218) or select intervals by external data (example 3; see 
page 235), then run the analysis.
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analyze regular time intervals

 Example 1 – Split your observations in 10-minutes intervals and calculate statistics for 
each of them. 

 Example 2 – Split your observations in three equal intervals and calculate statistics for 
each of them.

Solution – Define Time bins, then run the analysis. See page 236.

The terms Subject, Behavior, Modifier, and Independent Variable listed in this chapter may 
not be the same as those on your screen. This depends on what terms you have specified in 
your project's Terminology Preferences (see page 93).

definitions

Merging

Merging or grouping means that two or more behaviors or modifiers are analyzed as one 
entity. For example, group the behaviors Left wrist extension and Right wrist extension to 
calculate the overall rate of wrist extension occurrence. 

Filtering events

Filtering events means that you choose a subset of elements to be displayed or used in 
quantitative analyses. You can filter observations, event logs, subjects, behaviors and 
modifiers. You can also filter data indirectly, by choosing the values of independent variables 
(see page 86). For example, filter the subjects with the value of variable Age class =1.

Selecting intervals

Selecting intervals means that you analyze time intervals based on an event (or a 
combination of events) scored for one or more subjects. Furthermore, you can select time 
intervals based on values of external data. Analysis is done on the intervals in which the 
event (or combination of events) occurs and/or the external data had the specified values.

Time bins

Time bins means that you choose to divide the observation in two or more intervals of equal 
length. Analysis is done for all events in those intervals.

You can combine two or more selection criteria, for example Select interval Task 
1 and Filter events User Error, and Negative emotion for analysis (see page 54). 
Chapter 6 - Selecting Data for Analysis 197



6.2 The Data Selection screen

To start data selection:

1. Do one of the following:
- From the Analyze menu, choose Select Data, then New Data Profile (or press 

Ctrl+Alt+F7).
- In the Project Explorer, right-click the Data Profiles folder and select New 

Data Profile.
- Click the New button on the Data profile tool bar. 

2. In the New Data Profile window, type the name you want to give to the new profile or 
accept the default name and click OK.

Result – Two more objects appear on your screen: the Components pane (next to the Project 
Explorer) and the Data Selection pane (on the right; see Figure 6.1). 

Figure 6.1 The Data Selection screen with the Components pane (left) and the Data Selection window 
(right). In the Components pane: 1 – Buttons for filtering observations, 2 – Button for filtering events, 3–
Buttons for selecting intervals, 4 – Button for selecting intervals with external data, 
5 – Button for creating additional Result containers.
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What is a Data Profile?

A data profile is a collection of settings that specify which data you selected for analysis. You 
can create as many data profiles as you want, containing different selection criteria.

The Data Selection pane shows the content of the currently open data profile (You find the 
name of the open data profile on the title bar of The Observer XT). 

You can open and edit one data profile at a time.

The Components pane

The Components pane has the following groups of buttons:

 Filter Observations – Allows you to filter observations and event logs. It also allows you 
to filter observations by independent variables (including system variables) associated 
with those observations (1 in Figure 6.1).

 Filter Events – Allows you to filter events according to the name of subjects, behaviors or 
their modifiers. You can also filter subjects by means of the independent variables 
associated with those subjects (2 in Figure 6.1). 

If the scope of an independent variable is Subject (see page 90), the variable is listed 
under Filter Events, otherwise it is listed under Filter Observations. 

 Select Intervals – Allows you to select intervals by manual selection, intervals based on 
subjects, behaviors, modifiers, or duration (3 in Figure 6.1).

 Select Intervals with External Data – Allows you to select intervals based on values or 
ranges of external data (4 in Figure 6.1).

 Result Containers – Allows you to create multiple selections in the same data profile, by 
inserting additional Results boxes (5 in Figure 6.1) (see page 245)

If you do not see the Components pane, select Components with View Settings on the far-
right side of the tool bar.

The Data Selection pane

By default, the Data Selection pane contains two boxes connected by an arrow:

 The Start box (left) containing all the observations currently stored in your project. The 
Start box does not make any data selection except for merging data (see page 206). 

 The Results box (right), containing the data used for analysis. The Results box shows the 
number of selected Observations, Subjects, Behaviors and Intervals.

Since there is no selection box between the two, all event data in your project are used for 
analysis. This is the default selection sequence. It is now up to you to add selection boxes to 
refine your selection. 
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You can auto-arrange the boxes from the Data Profile by selecting the option Snap to Grid in 
View Settings. The grid becomes visible if you select the option Show Grid in View Settings. 

creating your own data selection

To refine your data selection and focus on a smaller data set, insert selection boxes between 
the Start and the Results box and connect them, so the data are progressively filtered while 
they 'flow' from the first to the last box (you can view each intermediate box as a sieve that 
reduces the amount of data). 

1. In the Components pane, click the button next to the criterion you want to use 
(see 1 in Figure 6.3). 

2. A new window opens on your screen, listing all values of the chosen criterion. Choose the 
values that specify your selection (see 2 in Figure 6.3).

Example – To filter behaviors, click the button next to By Behaviors under Filter Events. 
Choose the behaviors you want to analyze. 

3. Click OK. A new box appears in the Data Selection window. Drag the box over the arrow 
that connects the pre-existing boxes. When the arrow turns white, release the mouse 
button (see 3 in Figure 6.3).

Figure 6.2 The Start box (left) and the Results box (right). In this example, the Start box contains 6 
Observations, 1 Subject and 10 behaviors.

The name of the Results container is shown in the analysis results, so you always 
know which data selection the results come from. To display the name of the 
Results container in an analysis result, make sure that Result Container is 
selected in the Layout page of the analysis settings window (see page 349 for an 
example about calculating statistics). 
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Creating complex data selections

You can create complex data selections by inserting two or more selection boxes in the 
sequence (more details on page 240).

 Example 1 – In a study of parent-child interaction, the age of the child and the age of the 
mother have been entered as User-defined independent variables. You want to analyze 
data for children ages between 3 and 5 years old and mothers older than 30.

Solution – Under Filter Observations by Independent Variables, click the button next to 
Age of Child. Choose the appropriate age values and insert the Filter box in the sequence. 
Next, click the button next to Age of Mother. Choose the appropriate age values and 
insert the Filter box in the sequence. 

Figure 6.3 Visualization of the basic steps you must follow to select data. See the text for details.
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 Example 2 – In a usability study, the type of task has been scored as a state behavior. You 
want to analyze the events User Error and Confusion when the test participant was 
performing Task 1. 

Solution – Under Select Intervals, click the button next to By Behaviors, select Task 1 and 
insert the Interval box in the sequence. Next, under Filter Events click the button next to 
By Behaviors, select User Error and Confusion and insert the Filter box in the sequence.

 Example 3 – In an open-field test in which exploratory behavior is measured, the heart 
rate of an animal is also recorded. You want to analyze events when the heart rate was 
above a certain value.

Solution – Under Select Intervals with External Data, click the button next to By Heart 
Rate. Select External data is Higher than and enter the appropriate value. Click OK and 
insert the Interval box in the sequence.

Merging and Time bins

To define analysis groups and time bins, you do not use the buttons in the Components 
pane. 

To group or merge data, click the Merging button in the Start box. For details, see page 206.

To define time bins, click the Settings button in the Results box. For details, see page 236.

Zooming in and out

You can zoom in and zoom out the Data Selection window with the following icons 
on the tool bar:

 Zoom in icon, Zoom out icon, Zoom to fit icon, Reset zoom icon.

You can also use Ctrl+scrollwheel to zoom in and out.

Creating a screenshot of the data selection

When you click the camera icon at the right-hand side of the tool bar, the complete data 
selection is saved to an image file (*.png, *.emf, *.jpg, *.bmp, *.gif).

The order of boxes in a data selection sequence is important! For more 
information, see page 246.

The maximum number of selection boxes is 128 and of Results boxes is 32. This is 
to prevent long calculation times.
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working with selection boxes

This section contains procedures about how to work with selection boxes, not the 
procedures for selecting data. For the actual selection procedures, see page 206, page 210, 
page 221, page 218, page 236.

Selecting boxes

You can select a box by clicking its colored border. As a result, a black border appears around 
the box. To select multiple boxes, hold the Ctrl key and click the boxes you want to select. To 
select all boxes in the Data Selection window, press Ctrl+A.

Moving a selection box
1. Click the colored border of the box.

As a result, a black border appears around the box and the mouse 
cursor changes to a four-headed arrow.

2. Drag the box to the position you want.

Moving a group of selection boxes
1. Draw a box around the boxes you want to move or click on the boxes you want to select

while holding the Ctrl key.

As a result, a black border appears around the selected boxes and also the selected, 
connecting arrows turn black. The mouse cursor changes to a four-headed arrow.

2. Drag the boxes to the position you want.

Inserting a box in a data selection sequence
1. Drag the box between two pre-existing boxes, until the connecting arrow turns white.

2. Release the mouse button. The new box is inserted. 
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Connecting two selection boxes
1. Point to the center of the first box, press and hold the left

mouse button and drag toward the center of the other
box.

2. Release the mouse button when the cursor has reached 
the center of the other box. 

As a result, the two boxes are connected. 

You cannot create connections: 

 From the Results box to any other box.

 From any box to the Start box. 

Copying a selection box

You can copy a selection box within the same Data Profile, not to another Data Profile. You 
cannot copy the arrows.

Deleting a selection box
1. Click the title of the box so the mouse pointer changes to a four-head arrow. 

2. Press Delete.

You cannot delete the Start box. You can delete a Results box only if another one is present in 
the Data Selection window. 

If you delete in a box within a sequence, the arrows connecting the adjacent boxes are lost. 
You must then re-connect the adjacent boxes (see the previous page).

Deleting a group of selection boxes
1. Draw a box around the boxes you want to delete or click on the boxes you want to select

while holding the Ctrl key.

2. Press Delete.

You cannot delete the Start box. You can delete a Result box only if another one has been 
inserted in the Data Selection window. If you delete a box within a sequence, the arrows 
connecting the adjacent boxes are lost. Therefore, you must re-connect the adjacent boxes 
(see above).

Deleting a connecting arrow
1. Click the connecting arrow you want to delete. As a result, the arrow

turns bold. 

2. Press Delete.
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Changing the selection criteria in a selection box

Follow the instructions below when you have inserted a selection box in a sequence, and you 
want to restrict/widen your selection. For example, you have filtered observations by Drug 
dose =0.001 and 0.005 in the first instance, and you want to remove 0.005.

1. Locate the box that specifies the selection criteria you want to change. Tip: You find the
name of the name of the criterion in the central area of selection boxes. 

2. Click the Settings button in the bottom-right corner of the box.

3. Select the appropriate values in the window that appears. 

Creating a new Results box

Create multiple Results boxes everytime you want to display analysis results obtained from 
different data sets.  

Example – You want to calculate statistics of the behavior Driver speed in two different 
periods, Looking at left mirror and Looking at right mirror. Those phases reflect two 
independent intervals, therefore you must create two selection sequences, each ending in a 
separate Results box. When you run the analysis, results are shown for both intervals and 
readily compared. 

1. Do one of the following:
- In the Components pane, click the button next to Results.
- Select a Results box, press Ctrl+C and next Ctrl+V.

2. Type a new name / accept the suggested one, or click the Settings button to change the 
name of the new Results box.

Figure 6.4 An example of creating multiple data selections. Top: a sequence selecting an interval 
according to "Gaze at left mirror". Bottom: a second Results box “Right mirror” has been added.
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3. Build your data selection sequence as usual. In the example below, two selection criteria 
have been defined in such a way that statistics are shown for Gaze at left mirror and Gaze 
at right mirror independently.

Changing the Results box name 

The Results boxes are named automatically as you create them: Results 1, 
Results 2, etc. If you want to change that name, click the Settings button in 
the box and type in the new name. 

6.3 Selecting data - Merging

what is merging?

The aim of merging or grouping is to treat two or more coding scheme elements (behaviors 
or modifiers) as one. For example:

Figure 6.5 An example of two independent selection criteria from the same data set.

Merging in The Observer XT 12.5 is the same as merged Grouping in The Observer 
XT 11 or earlier versions.

In The Observer XT 12.5, you cannot group observations or subjects with the Start 
box in the data profile (see below). You can group observations or subjects in the 
Behavior analysis (Collapsing Category elements on page 313) For grouping of 
observations for visualization, see Chapter 7. 
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 Treat the behaviors Grab antennae, Grab mandibles, Grab head as one behavior and 
calculate the total frequency.

 Treat the behavior modifiers Manipulative, Imaginary and Constructive as one and 
calculate the total duration.

The elements are truly merged on the time line and counted as one. Consider the following 
example (see also the figure below). Behaviors A and B both have a duration of 5 seconds and 
they overlap for 1 second. After merging, the frequency of the merged behavior is 1 and its 
duration is 9 seconds.

Another example is the merging of behavior modifiers. The top part in the picture below 
shows three occurrences of Behavior Walk, each with a duration of 3 sec, scored with 
consecutive modifiers Slow, Normal and Fast. Merging the modifiers into one modifier Speed 
results in one occurrence of Behavior Walk with a duration of 9 seconds (bottom picture). 

merging procedure in short

1. Make sure that your data profile is open. If not, create a new data profile or open an
existing one (see page 248).

When you import a project that was made with The Observer XT 11 or earlier 
versions, which contains a Data Profile with grouping, the grouping is 
automatically reset upon opening the project in The Observer XT 12.5. If you 
want to use summed grouping with The Observer XT 12.5, you should export the 
data and do the summed grouping, for example, in Excel.
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2. Click the Merging button in the Start box.

3. In the Merge Elements window, click the tab for the elements you want to 
group.

The Behaviors tab shows the Behavior groups and their elements. 

The Modifiers tab shows the Modifier groups and their (nominal or numerical) elements.

4. To create a merged group:

a For Behaviors, click the Add button at the bottom.
A new line appears at the bottom of the list marked with a folder icon. 

For Modifiers, select the Modifier group name in which you want to merge Modifiers 
(see also notes about merging on page 209).

b Type in the name you want to give to the group, and press Enter.
c Drag an element you want to include in the group to the group line, until the line is

highlighted. 

Result – the element is placed in the group. Repeat the step above to add more 
elements. See also the Notes on merging below.

5. If necessary, repeat the steps above to create more merged groups. Click OK to confirm the 
groups. 
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notes about merging

Behaviors

 You can merge Behaviors from different Behavior groups into one Merged group.

 Adding a Behavior to a Merged group means that it is removed from its original 
Behavior group.

 You cannot place a Behavior in more than one Merged group.

 When you merge Behaviors with modifiers into a new Behavior, this new Behavior does 
not have any modifiers.

 The number in brackets next to each group indicates the number of elements in that 
group.

 To remove a Merged Behaviors group, select the group name and click the Remove 
button at the bottom. To removed all Merged groups in one of the tabs at once, click the 
Reset to default button.

Modifiers

 You can only merge Modifiers from the same Modifier group.

 To remove a Merged Modifiers group, select the group name and click the Remove 
button at the bottom. To removed all Merged groups in one of the tabs at once, click the 
Reset to default button.

 If you create a Merged group of numerical modifiers, this group is considered as nominal. 
If you want to calculate the frequency distribution of numerical modifiers, create one 
group per value, then start a Behavior Analysis and calculate the Total number 
(see page 301). 

Effects of changes in the coding scheme on grouping

 If you add an element to the coding scheme – The element is added to the Merge 
Elements window at the appropriate level, however it is not automatically part of any 
analysis group. 

 If you delete an element in the coding scheme – The element is deleted from the Merge 
Elements window. 
Chapter 6 - Selecting Data for Analysis 209



6.4 Select data - Filtering

what is filtering?

The aim of filtering is to pick out the data that will be subject to analysis (visualization or 
statistical analysis). You can filter the data directly (for example, choose a specific subject or 
behavior), or indirectly according to the value of independent variables (for example, filter 
the observations with subject age less than 10). 

Below you will find all the possible filtering methods. Remember that you can use just one 
filter method, or combine more in one data profile.

Filtering methods

You can filter data (see the buttons in the blue area of the Components pane on your screen):

 By choosing the observations/event logs/subjects to analyze:
- Directly, by the Observation name (see page 212).
- Indirectly, by values of Independent Variables (for example, the observation's start 

time, or the age of the subject) (see page 213). 

Result – Analysis is done on the observations you have selected or those matching the 
values of the independent variables you have selected.

Whether analysis is done on observations, event logs or subjects depends on the scope of 
the User-Defined Variable (see page 90).
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 By choosing the events to analyze: 
- By Subjects (see page 214).
- By Behaviors (see page 215).
- By Modifiers (see page 216).
- By Duration (see page 217).

Result – Analysis is done on all the events that contain those subjects, behaviors and 
modifiers. You can also select events longer or shorter than a given duration (see filter 
by duration on page 217).

How do I combine two or more filtering criteria?

Simply filter more element types and connect the corresponding boxes. See page 240 for 
more information. 

filtering procedure in short

1. Make sure that a data profile is open. If not, create a new data profile or open an existing
one (see page 248).

2. Locate the item in the Components pane (See figure on page 210) that you want to use for 
filtering data, and click the corresponding button in the blue area.

3. In the Filter window that opens, choose the values of the independent variable, the 
observations or the coding scheme elements you want to analyze, and click OK.

For example, click the button next to By Behaviors if you want to analyze a subsample of 
events. Click the button next to By Gender if you want to analyze observations referring 
to one gender, not the other (Gender must be defined as independent variable). 

See the next sections for details on the different criteria for filtering. 

4. A new box appears in the Data Selection window. Drag the box to the desired position 
between the Start and the Results Box, so it is connected to other boxes (see page 204 for 
how to connect selection boxes).

5. Repeat steps 2 to 4 to make more complex selections.

See page 240 for information on how to create a complex data selection. 
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filter observations

Aim – Choose observations or event logs directly from a list. Without any other filtering or 
interval criterion, all events scored in the filtered observations or event logs are considered 
for analysis.

1. Under Filter Observations, click the button next to By Observation name.

The Filter (Observations) window displays listing the observations and event log files 
currently present in your project (see Figure 6.6). 

2. Select the observations and event logs you want to analyze. By default, all observations 
and event logs are selected. 
- Event logs are listed under the observation they belong to.
- If you select an observation, all event logs in that observation are selected 

automatically. 
- If you de-select an observation, all event logs in that observation are de-selected 

automatically. 
- If you select at least one event log, the observation it belongs to is selected 

automatically.
- If you de-select all event logs in one observation, that observation is de-selected 

automatically.

If you want to edit an existing selection box instead of creating a new one, click 
the Settings button in that box. 

To make sure you analyze all items, click the Select all check box. To select 
quickly one or few items, click Select all until all boxes are cleared, then select 
the items you want to analyze. 

If you create an unwanted Filter box, click its title and press Delete. To copy a 
Filter box, click its title, press Ctrl+C and then Ctrl+V.

Figure 6.6 The Filter (Observations) window.
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3. Click OK. Insert the box at the required position in the sequence between the Start box 
and the Results box. 

filter by independent variable values

Aim – Filter observations according to the values of one or more Independent Variables, 
either System Variables or User-defined Variables.

All System Independent Variables (Start Time, Stop Time, Duration) have Observation as 
scope (see page 90). Therefore, you can only filter observations, not event logs or subjects by 
values of System Independent Variables. 

Each User-Defined Variables has a scope (Observation, Event Log Data, or Subject; see 
page 90). Depending on its scope you can filter observations, event logs or subjects 
according to the values of the selected User-Defined Variable. 

Example 1 – If the scope of the variable Temperature is Observation, selecting values of 
Temperature results in selecting those observations (therefore, all events in them) 
corresponding to the Temperature values you have selected.

Example 2 – If the scope of the variable Subject Experience is Subject, then selecting values of 
Subject Experience results in selecting events for those subjects corresponding to the values 
of Subject Experience you have selected. 

1. Under Filter Observations, click the button next to By <Independent Variable name>.

The Filter (Independent Variables) window displays. The Filter window shows the range 
of values of that Independent Variable available for filtering.

2. Choose one of the following:
- If you want to filter observations according to specific variable values, select Select by 

Value. The Filter window lists the values of the variable available for filtering.
- If you want to filter observations according to a range of variable values, select Select 

by Definition. The Filter window shows two fields, From and To. 
The Select by Definition option is not available for variables of type Text and Boolean 
(see page 88). 

If you want to filter data by User-defined Variable values on a Subject level, 
make sure that you enter a value for that Variable for each Subject in the 
Independent Variable List. If you do not do this, you might get a wrong selection.
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3. If you have chosen Select by Value, select the values you want.

If you have chosen Select by Definition, type the lowest value of the range under From, 
and the highest value under To.

4. Click OK. Insert the box at the required position in the sequence between the Start box 
and the Results box.

5. Click OK. Insert the box at the required position in the sequence between the Start box 
and the Results box. 

filter by subjects

Aim – Choose subjects directly from a list. Without any other filtering or interval criterion, all 
events scored for those subjects are considered for analysis. 

1. Under Filter Events, click the button next to By Subjects.

Figure 6.7 The Filter (Independent 
Variables) window for System Variable 
Start Time.

Figure 6.8 The Filter (Independent 
Variables) window for the User-defined 
Variable ‘Age of twins’.
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The Filter (Subjects) window displays listing the subjects currently present in your coding 
scheme. 

2. Select the subjects you want to analyze. By default, all subjects are selected. 

3. Click OK. Insert the box at the required position in the sequence between the Start box 
and the Results box. 

filter by behaviors

Aim – Choose behaviors directly from a list. Without any other filtering or interval criterion, 
all behaviors of that type scored are considered for analysis. 

1. Under Filter Events, click the button next to By Behaviors.

The Filter (Behaviors) window displays listing the behaviors currently present in your 
coding scheme.

Figure 6.9 The Filter (Subjects) window.

If you create a new subject in the coding scheme, and then re-open the data 
profile, the new subject is not selected automatically. The subject is analyzed if 
there is no Subject filter in your Data Profile.

Figure 6.10 The Filter (Behaviors) window.
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2. Select the behaviors you want to analyze. By default, all behaviors are selected. 

To filter behavior Modifiers, see page 216.

3. Click OK. Insert the box at the required position in the sequence between the Start box 
and the Results box.

Notes on filtering Behaviors

 Each behavior and behavior group is listed in a separate row (please note that here by 
groups we mean groups defined in the coding scheme, not groups in data selection).

 If you select a behavior group and de-select one or more behaviors forming that group, 
you analyze only the data scored for the selected behavior. 

 If you de-select a behavior group, the behaviors forming that group are also de-selected. 

 If you re-select a behaviors group, make sure that the behaviors you are interested in are 
selected, and those you want to ignore are de-selected. 

 If you create a new behavior in the coding scheme and then re-open the data profile, the 
new behavior is not selected automatically. You must select the new behavior in the 
Filter window if you want to consider it for analysis. 

filter by modifiers

Aim – Choose modifiers directly from a list. Without any other filtering or interval criterion, 
all modifiers of that type scored are considered for analysis. 

1. Under Filter Events, click the button next to By Modifiers.

The Filter (Modifiers) window opens.

If you de-select a behavior or behavior modifier group, the group name is not 
visualized nor analyzed.

Figure 6.11 The Filter (Modifiers) window.
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2. Select a Modifier group from the Modifier list.

3. Select the Modifiers you want to analyze.

4. Repeat steps 2 and 3 to select Modifiers from other Modifier groups.

5. Click OK. Insert the box at the required position in the sequence between the Start box 
and the Results box.

filter by duration

You can select events that are longer or shorter than a given duration. For example, if you 
observe aphids, you can select only the feeding events that are longer than 10 seconds. This 
way you can distinguish the events during which the aphid tests the leaf content from the 
events during which the aphid is actually eating. 

To do so:

1. Insert a By behaviors (see page 215) or By modifiers (see page 216) box with the event of
interest in the sequence between the Start box and the Results box. If you do not choose
to do so, you apply the minimum or maximum duration to all events. See page 240 for
more information on combining selection boxes.

2. Under Filter Events, click the button next to By Duration.

The Select Events (Duration) window opens.

3. Select a duration and from the list select Higher than, Higher or equal to, Lower than, or 
Lower or equal to. In the example above, select Higher than 10 s. 

Figure 6.12 The Select Events (Duration) window.
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4. Click OK. Insert the box after the other filter boxes in the sequence between the Start box 
and the Results box.

6.5 Select data - Intervals

what is selecting intervals?

With selecting intervals you analyze events that occur in time periods defined by an event or 
a combination of events (interval conditions). 

Example – You want to analyze the events occurred when the user was performing Task 3. 
You select intervals based on behavior Task 3. This way analysis is done on all events scored 
when the state Task 3 was active.

Criteria for selecting intervals

You can select intervals by Manual selection, by Subjects, Behaviors, Modifiers, Duration, 
and External data:

 Manual selection (see page 221) – Analysis is done on the events occurring in the defined 
time interval. The start and stop of the interval can be based on time, any event, or the 
value of external data. 
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Example – You define an interval that starts when a child starts running, and ends when 
its heart rate exceeds 110 beats per minute. Analysis is done on all events occurring in 
this interval. 

 Subjects (see page 231) – Analysis is done on the events occurring in the time intervals 
covered by any event by the subjects selected.

Example – If you select intervals by the subject Mother, analysis is done on the events 
occurring in the time intervals when Mother was scored as a subject, no matter which 
behavior was scored.

 Behaviors (see page 228) – Analysis is done on the events occurring in the time intervals 
defined by the behaviors selected.

Example – If you select intervals by the state behavior Zone 1, analysis is done on the 
events occurring when the state Zone 1 was active. 

 Modifiers (see page 233) – Analysis is done on the events occurring in the time intervals 
defined by the modifiers selected. 

Example – If you select an interval by the modifier Parallel play, analysis is done on the 
events occurring when the modifier Parallel play was active. 

 Duration (see page 234) – To select those intervals that are longer or shorter than a given 
duration. Use this interval criterion in combination with selecting intervals by a behavior 
or modifier. 

Example – If you select intervals with a duration Lower or equal than 30 s in combination 
with selecting intervals by the behavior Smiling, analysis is done over the time intervals 
during which the subjects were smiling maximally 30 s. 

 External data (see page 234) – Analysis is done on the events occurring in the time 
intervals defined by the external data values selected.

Example – If you select intervals by skin temperature in the index finger with a range 
between 36.5 and 37.5 degrees Celsius, analysis is done on the events occurring when the 
temperature was within that range.

Selecting complex intervals

Example – Analyze all events that occurred when the rat was in Zone 1 OR Zone 2, AND the 
light was on. 

You can define and combine interval criteria. See page 240 for more information.
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interval procedure in short

1. Make sure that a data profile is open. If not, create a new data profile or open an existing
one (see page 248).

2. In the Components pane, do one of the following:
- Under Select Intervals, click the button next to By Manual selection, By Behaviors, By 

Subjects or By Modifiers, or By Duration.

- Under Select Intervals with External Data, click the button next to the appropriate 
external data signal.

3. In the Select interval window that opens, choose the selection criteria you want to use to 
define the intervals and click OK.

See the next sections for more details and how to select items.

4. Insert the Interval box in the sequence between the Start and the Results box, (see 
page 204 for how to connect selection boxes).

5. Repeat steps 2 to 4 to make more complex selections. 

If the observation was suspended, defining an interval based on a state event that was active 
at the moment you suspended the observation may lead to incorrect intervals. This is 
because suspend/resume creates extra stop and start events for that behavior, respectively. 
For example, if you suspended the observation when Play was active and then select an 
interval by Play, the resulting interval will be from the start of Play to the suspend time, not 
the time that you actually score the stop of Play. 
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select intervals by manual selection

The aim of selecting intervals manually is to analyze events in time periods from a Begin 
point to an End point. Both Begin and End points can be:

 A time (for example, one minute after the start of the observation).

 An event (for example, the start of Task 1).

 When an external data value becomes higher/lower than a set value, for example, when 
the heart rate becomes higher than 100 bpm.

You can combine time, events or external data to define, for example, the following:

 From time t to event E.

 From event E to when the external data becomes lower than value x.

 From when the external data becomes lower or equal to value y to time t.

You can also combine time and events in a single Start or Stop point. For example: From 1 
minute after the event Start Test to 1 minute before the event Stop Test. 

For time intervals the left border is used in the analysis and the right border is not used (see 
page 328 for details).

How are intervals applied?

 Manually selected intervals are defined for each observation independently:
- If you define intervals based on time, and observations have different durations, then 

the time periods subject to analysis can differ between the two observations. 
Example – Define an interval from the start of the observation to 10 minutes. If an 
observation lasts 12 minutes, the first 10 minutes are analyzed. If an observation lasts 
9 minutes, analysis is done on 9 minutes. 

- If you define intervals based on events, and events occur at different times in two 
observations, then the time periods subject to analysis differ between the two 
observations. 
Example – Define an interval from the start of the observation to the event Correct 
Answer. If Correct Answer occurs at five minutes in observation 1 and at 10 minutes in 

If you want to edit an existing selection box instead of creating a new one, click 
the Settings button in the box.

If you create an unwanted Interval box, click its title and press Delete.

To copy an Interval box, click its title, press Ctrl+C and next Ctrl+V.
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observation 2, then the time period analyzed for observation 2 is twice as long as for 
observation 1. 

 If an observation includes two or more event logs, an interval defined in one event log is 
also applied to other event logs within that observation. 

Example – An interval is defined from the start of the observation to the event End of 
Task. If this event occurs at 5 minutes in one event log and at 10 minutes in another event 
log in that observation, then data are analyzed from 0 to 10 minutes for both event logs. 

 If the time t exceeds the duration of the observation or the event E does not occur in the 
observation, the interval is not defined, and analysis not done for that observation.

How many intervals in an observation?

The number of intervals defined per observation depends on what you specify as Begin and 
End: 

 From time t1 to time t2 – This defines one interval per observation. Analysis is done 
between the two times.

 From time t to event E – This defines one interval per observation. Analysis is done on 
events occurring between time t and the first occurrence of E. Other occurrences of E do 
not define intervals.

 From time t to when the external data becomes higher/lower than value x – This defines 
one interval per observation. Analysis is done on events occurring between time t and 
the first time the external data becomes higher/lower than value x. Subsequent 
occurrences of when the external data becomes higher/lower than value x do not define 
intervals.

 From event E to time t – This defines one interval. Analysis is done on events occurring 
between the first occurrence of event E and time t. Other occurrences of E do not define 
intervals.

 From event E to when the external data becomes higher/lower than value x – This 
defines one or more intervals. Analysis is done:
- From the first occurrence of E to the first time the external data becomes higher/lower 

than value x.
- From the first occurrence of E after the external data became higher/lower than value 

x above, to the next time the external data becomes higher/lower than value x, and so 
on.

 From event E1 to event E2 – This defines one or more intervals. Analysis is done:
- From the first occurrence of E1 to the first occurrence of E2.
- From the first occurrence of E1 after the E2 above, to the next occurrence of E2, and so 

on.
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Example – The behavior of male sticklebacks has been recorded when they were 
presented with females of different size classes. You want to analyze the time from 
the moment when Female 1 was presented (scored as Female 1) to the occurrence of 
male Display.
The first interval is considered from 0.00 Female 1 to 0:50 Display (see Figure 6.13). The 
second interval goes from 1:12 Female 1 to 1:52 Display. The instance of Female 1 at 0:30 
is not considered as a starting point of an interval, because it occurs before the ending 
point of a previous interval (0:50 Display). 

- If you define an interval using the same event type (“From E1 to E1”), each interval 
generated will have its begin and end based on the same instance of the event. For 
example, your data include two point events P at 3 s and 5 s. If you define an interval 
"From 3 s before P to 3 sec after P", this results in an interval going from 0 s to 8 s, 
merging the intervals 0 - 6 s (for the first event P) and 2 - 8 s (for the second event P).

 From when the external data becomes higher/lower than value x to when the external 
data becomes higher/lower than value y – This defines one or more intervals. Analysis is 
done:
- From the first time the external data becomes higher/lower than value x to the first 

time external data becomes higher/lower than value y.
- From the next time the external data becomes higher/lower than value x to the next 

time the external data becomes higher/lower than value y, and so on.

intervals by manual selection: procedure 

1. Make sure that your data profile is open. If not, create a new data profile or open an
existing one (see page 248).

Figure 6.13 An example of selecting intervals: From ‘Female 1’ to ‘Display’. The second occurrence of 
‘Female 1’ is ignored as it occurs before ‘Display’.
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2. Under Select Intervals, click the button next to By Manual selection. The Select Intervals 
(Manually) window opens.

3. Under Interval Start Criteria, select the point marking the begin of the interval to be 
analyzed.
- Select Observation time if the start of your interval is the start/stop of the observation 

+/- a certain time, for example, At the start of the observation, One minute from the 
start of the observation or Five minutes before the stop of the observation. Type this 
time in the appropriate field (hh:mm:ss), and select the option that you require (after 
start/before stop).

- Select Observational Data if the start of your interval is a scored event +/- a certain 
time, for example, At the start of Task 1, One minute after the event Intruder in Arena or 
Five minutes before the stop of the state Test 2. Type this time in the appropriate field 
(hh:mm:ss), then choose the before/after and start/stop option and select the event 
you require (subject, behavior and modifiers if applicable).

- Select External data if the start of your interval is an external data value +/- a certain 
time, for example, At the moment the heart rate becomes higher than 100 beats per 
minute (bpm) or 1 minute before the heart rate becomes lower than to 65 bpm. Type the 
time in the appropriate field (mm:ss:ff), choose the before/after option, select the 
external data, select one of the Becomes lower/higher options and enter the external 
data value.

Figure 6.14 The Select Intervals (manually) window.
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4. Under Interval Stop Criteria, select the point that marks the end of the interval to be 
analyzed.
- Select Observation time if the end of your interval is the start/stop of the observation 

+/- a certain time, for example, 10 minutes after the start of the observation.
- Select Observational Data if the end of your interval is a scored event +/- a certain 

time, for example, At the stop of Task 1, One minute after the event Intruder out of 
Arena. Type this time in the appropriate field (hh:mm:ss), then choose the before/
after and start/stop option and select the event you require (subject, behavior and 
modifiers if applicable).

- Select External data if the end of your interval is an external data value +/- a certain 
time, for example, 5 minutes after the heart rate became higher than 100 bpm. Type the 
time in the appropriate field (mm:ss:ff), choose the before/after option, select the 
external data, select one of the Becomes lower/higher options and enter the external 
data value.

5. Click OK. Insert the Interval box in the selection sequence between the Start box and the 
Results box. 

If the observation was suspended, defining an interval based on a state event that was 
active at the moment you suspended the observation may lead to incorrect intervals. This is 
because suspend/resume creates extra stop and start events for that behavior, respectively. 
For example, if you suspended the observation when Play was active and then define an 
interval from the start of the observation to the stop of Play, the resulting interval will be 
from the start of the observation to the suspend time, not the time that you actually score 
the stop of Play. 

Manual intervals based on external data

The manual interval based on external data is generated as follows:

1. The Start point at which the external data becomes higher than/higher or equal to or
lower than/lower or equal to the set value is determined.

2. The offset (before or after) specified in Start interval at field is applied.

3. The End point at which the external data becomes higher than/higher or equal to or lower 
than/lower or equal to the set value is determined.

4. The offset (before or after) specified in Stop interval at field is applied.

5. Steps 1 to 4 are repeated until the end of the observation.

Example – You have measured a subject’s heart rate with values ranging between 60 and 
120 bpm. You want to generate intervals from the point at which the heart rate becomes 

If you want to analyze an interval starting from the start of an observation, 
leave 00:00:00 selected. 
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higher than 100 and next, after the heart rate has dropped below, becomes higher than 80 
again. To do this, make the following settings in the Select Intervals (Manually) window:

 Under Interval Start Criteria, select Start interval at 00:00:00, after Heart rate Becomes 
higher or equal to 100.

 Under Interval Stop Criteria, select Stop interval at 00:00:00, after Heart rate Becomes 
higher or equal to 80.

See Figure 6.15 below for a visualization of the selected interval.

If either the Interval Start Criteria or the Interval Stop Criteria is not met in the 
observation, no interval is selected. So if the observation ends before the interval 
stop criteria are met, no interval is selected. 

If the external dataset has missing samples, these missing samples are not 
taken into account in both the start and the stop of the interval. The first valid 
sample determines the start or stop of the interval. 

In the analysis, the left borders of the time intervals are used and the right 
borders are not used (see page 305 for details).

Figure 6.15 Example of Select Intervals by Manual selection based on external (heart rate) data. The arrow 
labeled ‘Start’ shows the start of the interval when the heart rate Becomes higher or equal to ‘100’ bpm. 
The arrow labeled ‘Stop’ shows the end of the interval when the heart rate Becomes higher or equal to 
‘80’.
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The difference between ‘Selecting intervals by manual selection based on external data’ 
and ‘Selecting intervals with external data (page 235)’

With Selecting intervals with external data you select a static interval with a set upper and/
or lower limit whereas with Selecting intervals by Manual selection the range of the interval 
is dynamic.

Example – You have measured a subject’s heart rate with values ranging between 60 and 120 
bpm. You want to generate intervals when the heart rate was between 80 and 100 bpm. To 
do this, you Select Intervals By heart rate (see select intervals by external data on 
page 235) with a range between Higher or equal to ‘80’ and Lower or equal to ‘100’ (also see 
Figure 6.16).

Depending on the sample rate of the external data, in the event plot it can sometimes seem 
as if the interval does not include external data values that should have been included. This 
is because in the event plot samples are connected by a line as if the external data is 
continuous, while in fact it consists of discrete samples. See also Visualizing external data on 
page 263.

Selecting complex events

 If the event that marks the begin/end of an interval includes specific modifiers, specify 
these in the appropriate field. 

Figure 6.16 Example of Selecting intervals with external data. The shaded areas indicate the intervals based 
on the external data range between 80 and 100 bpm. Compare this figure with Selecting intervals by 
Manual selection based on external data in Figure 6.15.
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Example – You want to define an interval ending when the level of aggression scored as 
a numerical modifier of the event Aggression reaches 2 or 3. In the Behavior field, specify 
Aggression. Next, from the list that becomes available below select Aggression level (the 
modifier group). Click the button next to the modifiers to choose the values of the 
modifier group.

The data are analyzed up to the first occurrence of aggression level = 2 or 3. It is not 
possible to use a combination of different modifier groups to define the start or the stop 
of the intervals. 

 If you want to analyze data at the intersection of two or more intervals, define one 
Interval box for each interval definition, and line up those boxes in a sequence (see also 
page 245). 

 For more information on multiple selections, see page 240.

select intervals by behaviors

Aim – Analyze data as long as one or more state events occurred. Optionally, you can specify 
whether to consider a specific subject that performed those behaviors, or any subject 
(see below).

Example – To analyze all time segments when the subject is not playing, select intervals by 
No Play behavior:

1. In the Components pane, under Select Intervals, clicking the button next to By Behaviors.

The Select Intervals (Behaviors) window appears listing all behaviors currently defined in 
your coding scheme. 
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2. Select the behaviors you want to use as interval criteria.

For Selecting Intervals by Modifiers, see select intervals by modifiers on page 233.

3. From the The selected Behaviors occur in list at the bottom, choose the subjects that form 
the criteria together with the behavior selected in the previous step:
- <Any Subject> – Select this item if you want to consider the time intervals as long as 

the behaviors occurred, independent on what subject performed those behaviors.
Example – To select the time intervals when either subject Large Cricket or Small Cricket 
was in the center of the arena, select the behavior Center of Arena and then <Any 
Subject>. 

- <All Subjects> – Select this item if you want to consider the time intervals as long as 
the behaviors occurred for all subjects simultaneously.
Example – To select the time intervals when both subjects Large Cricket and Small 
Cricket were in the center of the arena, select the behavior Center of Arena and then 
<All Subjects>.

- <Individual subject> – Select one of the subjects in the list if you want to consider the 
time intervals as long as the behaviors occurred for that subject.
Example – To select the time intervals when the subject Large Cricket was in the center 
of the arena, select the behavior Center of Arena and then Large Cricket. 

Figure 6.17 The Select Intervals (Behaviors) window.
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4. Click OK. Insert the Interval box in the place of the sequence you require between the 
Start box and the Results box. 

Notes

 Selecting intervals by a subset of subjects – If you want to select intervals based on the 
behaviors performed by a subset of subjects, not just one or all, you need to create 
multiple selection conditions (see page 240). 

Example – To select intervals based on the behavior Eye contact scored for subjects Mark 
and Derek, select the behavior Eye contact and, from the The selected Behaviors occur in 
list, select Mark. Then, repeat the selection procedure and in a new Interval (Behaviors) 
box select Eye contact, then from the The selected Behaviors occur in list select Derek. 
Next, combine the two Interval boxes (see page 240). 

 Each behavior and behavior group is listed in a separate row (please note that here by 
groups we mean groups in the coding scheme, not groups in data selection).

 If you re-select a behavior group, make sure that the behaviors you are interested in are 
selected, and those you want to ignore are de-selected.

Figure 6.18 Choose a subject from the list if 
you want to consider the time segments when 
the selected behavior was scored for that 
subject.

Figure 6.19 An example of selecting intervals by behaviors. A - Event Plot of all data scored in an 
observation. B - Event Plot of the data in the intervals selected by Play behaviors (red bar in the event 
plot). The events occurring at the same time as Play behavior are selected for analysis. The semi-
transparent area on the left indicates that the behaviors inside this area are not part of the data 
selection.
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 If you create a new behavior in the coding scheme and then re-open the data profile, the 
new behavior is not selected automatically. You must select the new behavior in the 
Select Intervals (Behaviors) window if you want to include it in the selection criterion. 

 Selecting a certain combination of behaviors and subjects in the Interval (Behaviors) 
window is the same as selecting the same combination in the Interval (Subject) window 
(see page 231). First, select the subject in the upper part of the window, then the behavior 
from the list at the bottom. 

select intervals by subjects

Aim – Analyze data as long as one or more subjects were scored. Optionally, you can specify 
whether to consider a specific behavior performed by those subjects, or any behavior (see 
below). 

1. In the Components pane, under Select Intervals, click the button next to.

The Select Intervals (Subjects) window appears (Figure 6.20). 

The Select Intervals (Subjects) window lists all subjects in your coding scheme. Select all 
subjects you want to use as selection criteria. For example, if you select Suspect 1 and 
Investigator 1, the time segments when either subject was scored are considered for 
analysis. By default, all subjects and subject groups are selected. 

Figure 6.20 The Select Intervals (Subjects) window.
Chapter 6 - Selecting Data for Analysis 231



2. From the The selected Subjects are doing: list at the bottom, choose one of the following:
- <Any Behavior> – Select this item if you want to consider all the time intervals when 

the subjects selected were scored, independent on their behavior.
- <Individual behavior> – Select one of the state behaviors in the list if you want to 

consider all the time intervals when the subjects selected were performing that 
behavior. 

If is not possible to select intervals by behaviors without duration, but you can define 
intervals starting or ending a defined time before/after a a behavior without duration 
(see page 221). 

If you want to select intervals by two or more subjects when performing a subset of 
behaviors, not just one, then you need to create multiple interval conditions in the Data 
Selection window (see page 240). 

Example – To select intervals by the subject Test participant when performing behaviors 
Task 1 or Task 2, select the subject Test participant and, from the The selected Subjects are 
doing list, select Task 1. Then, repeat the interval procedure and in a new Select Intervals 
(Subjects) box select Test participant, and from the The selected Subjects are doing list 
select Task 2. Next, combine the two Interval boxes (see page 240). 

3. Click OK and insert the Interval box at the required position in the sequence between the 
Start box and the Results box.

Notes

 Each subject and subject group is listed in a separate row (please note that here by 
groups we mean groups in the coding scheme, not groups in data selection).

 If you re-select a subject group, make sure that the subjects you are interested in are 
selected, and those you want to ignore are de-selected.

 If you create a new subject in the coding scheme and then re-open the data profile, the 
new subject is not selected automatically. You must select the new subject in the Select 
Intervals (Subjects) window if you want to include it in the selection criterion.

 Selecting a certain combination of subject and behavior in the Select Intervals (Subjects) 
window is equal to selecting the same combination in the Select Intervals (Behaviors) 

Figure 6.21 Choose a behavior from 
the list if you want to consider the 
time segments when the subjects were 
performing that behavior.
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window. First select the behavior in the upper part of the window, then the subject from 
the list at the bottom of the window (see above).

select intervals by modifiers

Aim – Analyze data when a Modifier has a certain value. For example, to analyze all time 
segments when Interaction type was Parallel, select intervals by the Parallel Modifier value in 
the Modifier group Interaction type.

1. In the Components pane, under Select Intervals, clicking the button next to By Modifiers.

The Select Intervals (Modifiers) window appears listing all Modifier groups currently 
defined in your coding scheme. 

2. First select a Modifier group from the Modifier list and then select the Modifier values 
from that group you want to use as criteria to define the intervals.

Figure 6.22 The Select Intervals 
(Modifiers) window.

You can only select Modifier values from one Modifier group per Interval box. 
See Rule 1b – Filtering by multiple modifiers on page 243 how to select 
intervals based on multiple modifiers from different Modifier groups.

Any Multiple Modifier value selected in a Modifier group results in selection 
of the connected behavior (OR logic).
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select intervals by duration

Aim – Analyze intervals that have a minimum or maximum duration. For example, to analyze 
those intervals when the behavior Smiling occurred for at least 30 seconds. First create an 
interval criterion for the behavior or modifier of interest. Then add an interval criterion By 
duration. 

1. Insert a By behaviors (see page 228) or By modifiers (see page 233) box with the event of
interest in the sequence between the Start box and the Results box.  

2. Under Select intervals, click the button next to By Duration.

The Select intervals (Duration) window opens.

3. Select a duration and from the list select Higher than, Higher or equal to, Lower than, or 
Lower or equal to. In the example above, select Higher or equal to 30 s. 

4. Click OK. Insert the box in the sequence after the boxes with the other selection criteria.

Always use the Select intervals by duration option in combination with the By 
Behavior or By Modifier option. Adding only a By duration interval box in the 
sequence between the Start box and the Result box selects entire observations 
with that minimum or maximum duration. See page 240 for more information 
on combining selection boxes.

Always place the By duration interval box after the interval boxes with the other 
selection criteria. 

Figure 6.23 The Select intervals (Duration) window.
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select intervals by external data

Aim – Analyze data when external data values are above/below a specific value (for example, 
heart rate above 100 bpm) or when external data is within a specific range of values (for 
example, skin temperature between 36 and 37.5 degrees centigrade).

1. In the Components pane, under Select Intervals with External Data, click the button next
to the appropriate By <external data signal>.

The Select Intervals (external data signal) window appears (see figure below).

2. You can now select:
- External data is Lower than / Lower or equal to / Higher than / Higher or equal to – if 

you want to analyze events when the external data signal was above or below a 
specific value. Choose one of the above-mentioned options from the list and enter a 
value.

- External data is Higher than / Higher or equal to and Lower than / Lower or equal to – 
if you want to analyze events when the external data signal was within a specific 
range. To set the lower limit, select one of the above-mentioned options from the top 
list and enter a value. To set the upper limit, select one of the above-mentioned 
options from the bottom list and enter a value.

3. In the Minimal interval length field, enter a duration.

By setting the Minimal interval length, you can avoid the selection of many, short 
intervals when the signal is noisy around the selected external data values. When the 
Minimal interval length is ‘0’ seconds, no minimal interval length is used. By default, the 
Minimal interval length is ‘1’ second.

4. Click OK and insert the Interval box at the required position in the sequence between the 
Start box and the Results box. 
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Notes

 On the Interval box, the external data values are displayed with three decimals, but for 
the actual selection of external data the original values are used.

 When you delete an external data signal in the Independent Variable List, the 
corresponding Interval box is deleted from the Data Profile.

 Depending on the sample rate of the external data, in the Event Plot it can sometimes 
seem as if the interval does not include external data values that should have been 
included. This is because in the Event Plot samples are connected by a line as if the 
external data is continuous, while in fact it consists of discrete s. See also Visualizing 
external data on page 263.

 An interval based on external data should contain at least two samples. If only one falls 
within the set range, no interval is created.

 If the external dataset has missing samples, these missing samples are not taken into 
account in both the start and the stop of the interval. The first valid sample determines 
the start or stop of the interval. 

 In the analysis, the left borders of the time intervals are used and the right borders are 
not used (see page 305 for details).

6.6 Selecting data -The Results box

The Results box shows the result of the data selection. When your project contains 2 
observations and you defined 3 subjects and 7 behaviors in the Coding Scheme, both the 
Start box and the Result box show 3 subjects and 7 behaviors. The Results box also shows 2 
intervals, one for every observation.
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Filtering

When you filter over subjects, behaviors, modifiers, or duration, the 
numbers in the Results box match the numbers you have selected in the 
filter box. Filtering has no effect on the analyzed observation time and no 
intervals are created. So the number of intervals in the Results box remains 
the same as in the Start box and represents the number of observations. 
When your data selection contains no data, this is shown in red on the 
Results box.

Intervals

When you select intervals by subjects, behaviors, modifiers, or duration, you 
create time intervals based on the selected data. No subjects, behaviors, or 
modifiers are filtered out, so this number remains unchanged in the Results 
box. The number of intervals is changed, it shows the total number of 
intervals over all observations. If the data selection contains no data because 
the selected subject, behavior, or modifier has not been scored, the Result 
box shows 0 intervals in red. 

time bins

What are time bins?

The aim of time bins is to divide your data sets in time intervals of equal length. The results 
of your analyses will be shown for each interval in separate tables or cells.

You can specify intervals of a specific length (for example, to split your observations in 10-
minutes units) or the fixed number of intervals. In the latter case, the duration of each 
interval is determined by the program. 

If you do not define time bins, the whole observation is analyzed, unless your data profile 
specifies intervals (see page 218). 

In the analysis, the left borders of the time intervals are used and the right borders are not 
used (see page 305 for details).

The difference between Time bins and other intervals

 With Time bins, you analyze data in regular time segments. Each observation is split in 
such a way that no data is excluded.

 When you use intervals as well, the time bins are generated per interval. The data 
outside the intervals are not analyzed. For example, you have two intervals, from 0 - 9 sec 
and from 20 - 32 sec. If you define Number of Time bins = 3, you get the following Time 
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bins: three 3-sec time bins for the first interval (0 - 9 sec), three 4-sec Time bins for the 
second interval (20 - 32 sec).

defining time bins in short

1. Make sure that a data profile is open. If not, create a new data profile or open an existing
one (see page 248).

2. Click the Settings button on the Results box. 

The Result Container Settings window appears.  

3. Select Use Time bins and select one of the following:
- Duration – if you want to specify a fixed interval length.
- Nr of Time Bins – If you want to specify a fixed number of intervals to analyze. 

Enter the length of the interval (in hours, minutes, or seconds; choose the time unit 
from the list) or the number of intervals.

4. If the duration of the observation/event log is not an exact multiple of the interval length, 
the last time bins will be incomplete. Select the Ignore last Time Bin if incomplete option 
if you do not want to analyze this last interval. 

Example – You have defined a fixed duration of 10 minutes, but your observations last 
around 35 minutes. You can choose to analyze only the first three complete 10-minutes 
intervals and ignore the last, five-minutes interval. 

5. Click OK. 

The Results box shows the duration of the time bins. For example, ‘Time bins: 10 
minutes’.

Figure 6.24 The Result Container 
Settings window.
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Notes

 Make sure that the total number of time bins is less than 1000. Also, make sure that you 
define time bins after you have recorded all your observations.

 Consider the following case where a state behavior occurs across two five-minutes time 
bins (marked by dotted lines):

Although the behavior occurs once, it is counted once in the first interval and once in the 
second interval. 

 If your observations contain two or more event logs, the time bins are defined across 
event logs beginning from the start time of the observation. This means that if an event 
log starts later than another, the time bins defined before the start of the late event log 
do not show results for that event log.

 If your data profile contains two or more result containers (see an example on page 245), 
you can choose whether to apply the time bins to the current Results box only, or to all of 
them. 

By default, time bins are applied to one Results box. 
- To apply the time bins to all results containers, click Settings in the Results box in 

which time bins are applied, and click the Apply to All button. 
- To apply different time bins to different results containers, repeat the procedure above 

for each Results box.

Intervals and Time bins 

The border of two connecting intervals can only be used for analysis in one of the two 
intervals. Otherwise the data for this data point would be duplicated. The Observer XT uses 
the left borders of the time intervals, while the right borders are used in the analysis of the 
next interval. In the example below the exact data point 0.0. is used in the first interval, 10.0 
in the second, 20.0 in the third and 30.0 is not used in any interval. 
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6.7 Complex data selections

Selection boxes can be combined in a variety of ways to create complex data selections. For 
example, select intervals by the behavior Playing, AND Filter the behavior Talk to parent. This 
way you analyze Talking to parent when the subject was playing. Below you find a few basic 
rules to combine selection boxes. 

See page 246 for information on the correct order of selection boxes. 

A very general rule – AND, OR and Multiple results logic

 AND logic – When you line up boxes in a sequence, the data in the Results box satisfy all 
criteria defined by the boxes.

 OR logic – When you split a sequence in two or more branches, the data in the Results 
box satisfy either one or the other selection criterion (see Figure 6.26). 

Figure 6.25 The data selected in this example are those scored when the Behavior Gaze was active 
(second box), AND for the observations with the value of the Independent variable Age = 2 and 3 years 
(third box).

Figure 6.26 The data selected in this example are those scored when the behavior Modifier Prey 
size was between 0.0 and 1.0 or when Behavior Modifier Prey type was Caterpillar or Spider.
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 Multiple results boxes – When you split a sequence in two or more branches and those 
end in different Results boxes, there will be as many analysis results as Results boxes, 
each referring to its own selection criterion. 

Rule 1 – Filtering by multiple values of the same variable or element type

To create a filter using multiple values of the same independent variable or multiple 
elements of the same type, specify them in one Filter box.

Example 1 – Your project contains a number of observations made at different subject ages 
(5, 6 and 10 years). We assume here that Age has been entered as user-defined variable. You 
want to analyze observations made on subjects five and six years old. 

Example 2 – Your project contains data of a number of behaviors. You want to analyze all the 
Agonistic behaviors carried out by the Marked (see Figure 6.28).

Figure 6.27 The data selected in this example are Results, containing all data in the project (no 
filtering, no intervals), and Before Grooming, containing the data scored from the start of each 
observation to the event ‘Grooming’. Analysis is done on both data sets, and results indicate 
which Results box they refer to (either Results or Before Grooming).
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Figure 6.28 Edit a Filter box to refine filtering based on one independent variable or type of elements of the 
coding scheme.
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Rule 1b – Filtering by multiple modifiers

This is a special case of Rule 1. 

If you want to filter events with at least one of the modifiers you are interested in, select 
those modifiers in one Filter box. 

Example – The behavior Feeding is attached to two modifier groups: Prey type (with values 
Caterpillar, Spider, and others) and Prey size (with values 1, 2, 3). 

To filter events with either Prey type = Caterpillar OR Prey size = 1.0-2.0:

It is also possible to select events that contain a specific combination of modifiers. For 
example, Prey Type = Caterpillar AND Prey size = 1.0 - 2.0:

Rule 2 – Filtering by multiple variables or element types

To create a filter using multiple independent variables or elements (observations, subjects, 
behaviors, external data), create one Filter box per variable/element type, and line up the 
boxes between the Start box and the Results box. 
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Example – In a parent-child interaction study, you want to calculate statistics of a few 
behaviors for the observations of Boys and for verbal behaviors. We assume here that Gender 
of child was defined as an independent variable. 

Rule 3 – Defining intervals based on multiple subjects/behaviors not occurring 
simultaneously (OR logic applied)

To define intervals based on multiple subjects or behaviors in such a way that data is 
considered for analysis when at least one subject/behavior occurred, specify those subjects/
behaviors in the same Interval box.

Example – In a study of social interaction between children and a parent, the gaze direction 
of the children is scored. You want to analyze the data when a child was either looking at the 
other child or at the parent. 

Figure 6.29 Select the events in 
the same Interval box to analyze 
the time segments when either 
one or the other event occurred.
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Rule 4 – Defining intervals based on multiple subjects/behaviors occurring simultaneously 
(AND logic applied)

To define intervals based on multiple subjects or behaviors in such a way that data is 
considered for analysis when all subjects/behaviors occurred simultaneously, select each 
subject/ behavior in a separate Interval box, then line up the boxes between the Start box 
and the Results box.

Example – In a study of mother-child interaction, the duration of specific phases is coded as 
state events. You want to calculate statistics on various behaviors recorded during the phase 
coded as Episode 1 AND, within that phase, when the behavior Play was scored for the subject 
Child.

If you want to analyze the time when one or more state events are active for all of the 
subjects in each observation simultaneously, you can insert just one Interval box that 
specifies the behavior for the interval, and select <All Subjects> from the The selected 
Behaviors occur in list.

Rule 5 – Selecting independent data sets in the same Data Profile

To show results for different data selections, connect each selection sequence to a separate 
Results box. 

Example – In a study of mate choice in fish, the position of the male relative to three females 
has been recorded as state events (Next to Female 1, Next to Female 2, Next to Female 3). You 
want to calculate statistics on various behaviors recorded when the male was next to each 
individual female. Statistics will be shown for each female in a separate section of your 
report.

Given that each interval condition (position of the male) should lead to a separate result, it 
must be connected to a separate Results box. 

Figure 6.30 Select the events in different Interval boxes to analyze the time segments when the events 
occurred at the same time.
Chapter 6 - Selecting Data for Analysis 245



order of selection boxes

The order in which you place boxes in a selection sequence is very important. Please read this 
section carefully. 

If your data profile is made of several sequences, please check them carefully according to 
what is stated below. 

If your sequence contains Filter boxes only...

 If each Filter box refers to a different type of element...

Example – One Filter box for an independent variable, one for subjects, one for behaviors.

...Then the order you place the boxes does not matter. 

Figure 6.31 If you want different data selections to produce separate results in your analysis, connect each 
selection criterion to a separate Results box. To create additional Results boxes, click the button 
next to Results.

If you wish to calculate the statistics for when the male was next to any female, 
select the three events Next to Female 1, Next to Female 2 and Next to Female 3 in 
the same Interval box. You do not need to create separate Results boxes.
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 If Filter boxes refer to the same type of element...

Example – One Filter (Behaviors) box filtering Speech behaviors, and another Filter 
(Behaviors) box for Facial Expression behaviors.

...Then the selection only works if the elements you have filtered in one box are also 
selected in the previous box.

If your sequence contains Interval boxes only...

...Then the order in which you place the boxes does not matter.

If your sequence contains Interval and Filter boxes together

Example – One Filter (Subjects) box to filter the subject Child, and one Filter (Behaviors) to 
filter the behavior Emotion, and one Interval box to select the time from the start of Mother 
out of Room to the end of the observation. 

...Then the selection will only work if the Interval box is placed before the Filter box.

This is because a Filter box placed before an Interval box may filter out the subjects and 
behaviors specified in the Interval box.

The correct sequence in the example above is:

 The Start box.

 The Interval box.

 The Filter boxes.

 The Result box. 

If you want to create a filter based on different Subjects or Behaviors, make sure 
that those elements are selected in one box. If you want to create a filter based 
on Modifiers from different Modifier groups, make sure to create a separate 
Filter box for each Modifier group.

As a general rule, insert the Interval boxes immediately after the Start box and 
then insert the Filter boxes, ending with the Results box. 
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6.8 Managing your data profiles

Viewing all data profiles

You can view all the data profiles in your project by opening the Data Profiles folder in the 
Project Explorer:

Creating a new data profile
1. Do one of the following:

- From the Analyze menu, choose Select Data, then New Data Profile or press 
Ctrl+Alt+F7. 

- In the Project Explorer, right-click the Data Profiles folder and select New. 
- Click the New button on the Data Profile tool bar. 

2. In the New Data Profile window, type the name you want to give to the new 
profile or accept the default name and click OK.

Opening an existing data profile

In previous versions of The Observer XT, you had to open an existing data profile to activate 
that data profile, so analysis is done on the data specified in that profile. See Activating an 
existing data profile below, if you just want to activate a data profile without opening it.

1. Do one of the following:
- From the Analyze menu, choose Select Data, then Open Data Profile. In the Open Data 

Profile window, select the data profile you want to open, and click OK.
This window lists the data profiles saved in your project (you can view them in the 
Project Explorer). The profile marked with an asterisk indicates the currently open data 
profile. 

- In the Project Explorer, right-click the Data Profile and select Set as Current. 

Figure 6.32 Data profiles in the Explorer. The active data profile “Crash and other events” is highlighted.
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Activating a data profile

In the Project Explorer, simply click the data profile you want to activate.

Editing and saving a data profile
1. Open the data profile (see above). The Data Selection window displays showing the

content of the data profile.

2. To add filters and interval conditions, follow the instructions on page 200. 

To change an existing filter/interval condition, click the Settings button on the bottom of 
the corresponding selection box in the Data Selection window. In the window that 
appears, edit your selection criteria and click OK. 

To delete a selection box, see the instructions on page 204.

To delete a connecting arrow, see the instructions on page 204.

For general information on how to work with selection boxes, see page 203.

3. To save the data profile, from the File menu, select Save Project.

Resetting a data profile

If you reset a data profile, all your selection criteria in that profile are deleted. As a result, the 
data profile contains all observations of your project and all data within them.

1. Make sure the data profile you want to reset is open on your screen. If another data
profile is open, open the data profile you want to reset (see above). 

2. From the Analyze menu, select Select Data, then Reset Current Data Profile.

If you have selected Data Selection: reset Data Profile in the Warnings tab of the 
project's Preferences window (see page 94), The Observer shows a warning message. 
Click Yes if you want to reset the data profile.  

The active data profile is highlighted in the Data Profiles folder of the Project 
Explorer. 

To open the data profile currently active, from the Analyze menu, select 
Select Data, then Show Current Data Profile, or press Alt+F7.

If you create an unwanted Filter or Interval box, click its title and press Delete.
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Renaming a data profile

To rename a data profile, right-click the name of the data profile in the Project Explorer, and 
select Rename. Then, enter the new name. 

Copying and pasting a data profile

To copy an existing data profile, right-click a Data Profile and select Duplicate, 
or click the Duplicate button on the tool bar.

Deleting a data profile

Deleting a data profile does not result in deleting your data. It removes the data selection 
settings. 

To delete a data profile, right-click it in the Project Explorer under Data Profiles and select 
Delete. 

Alternatively, do one of the following: 

 From the Analyze menu, choose Select Data, then Delete Data Profile.

 In the Project Explorer, right-click the Data Profiles folder and select Delete. 

This window lists the data profiles saved in your project (you can view them in the Project 
Explorer). The profile marked with an asterisk indicates the currently open data profile.

6.9 What next?

Please make sure that when you start the analysis the data profile you want to use as data 
source is selected in the Project Explorer. 

In the Project Explorer, click the Analyses folder. The Analyze tab in the overview window 
appears.

You cannot undo a data profile reset.

You cannot restore a deleted data profile.
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 To visualize data, create episode selections and highlights video clips – See Chapter 7.

 To calculate statistics – See Chapter 8.

 To carry out lag sequential analysis – see Chapter 9.

 To carry out reliability analysis – see Chapter 10.

 To export observational and/or external data – See Chapter 11. 
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7.1 Before you start

This chapter describes the functions of data visualization in The Observer XT. Before carrying 
out quantitative analysis of your data, you can look at it by means of the Visualize function. 
You can also create an Episode Selection based on certain events or Data Selection criteria 
and generate a media file from the original video that contains the selected episodes.

Prior to visualizing data, you can create a data profile by selecting the data to be visualized 
(see Chapter 6). If you do not create a selection profile, The Observer visualizes all events and 
external data included in an observation.

The terms Subject, Behavior and Modifier listed in this chapter may not be the same as those 
on your screen. This depends on what terms you have specified in your project's Terminology 
Preferences (see page 93). 

what is data visualization?

When you visualize data, The Observer XT produces an event plot in which events and 
external data are plotted horizontally against a time axis (elapsed time). Each multi-colored 
bar represents a sequence of behaviors. Each event type is plotted in its own color. State 
events are represented by horizontal bars whose length is proportional to the state's 
duration. Point events are vertical segments. Video files, audio files and external data files 
are synchronized with the observational data (see the example below).

You can visualize observations when it either contains events (or when the data active profile 
contains events) or when the observation contains external or audio data. So, when your 
observation only contains comments but also external data, the observation can be 
visualized. However, the comments itself are only visualized when they are scored together 
with an event. 
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Figure 7.1 An example of visualization of event data (coded manually with The Observer XT), video, audio 
and imported external data (see Chapter 5).
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what is an episode selection?

An Episode Selection (see page 273) is a summary of events from your observations. You can 
select specific events manually (for example, by dragging them from the event log) or 
according to a criterion specified in the data profile. Events are organized in sequences called 
episodes. You can view an Episode Selection as a book, where episodes are chapters and 
events are single paragraphs. 

If you have scored observations from video or audio, you can play back the video 
corresponding to the episodes selected. If you like, you can have different episodes separated 
by a transition.

Furthermore, you can generate a media file from the original video, based on the episodes 
included in your Episode Selection. This way, you create a new media file that contains the 
scenes you are interested in. You can also add subtitles and transitions with text. You can 
then use this media file in presentations, to create behavior libraries, etc.

Figure 7.2 An example of Episode Selection. Right-click an event and select Play to view the 
corresponding scene.
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7.2 Making an Event Plot

You can visualize data from one or more observations. See the procedure below how to 
visualize a single or multiple observations.

procedure

1. Make sure that the data profile you want to use as a source of data is highlighted in the
Project Explorer (under Data Profiles). If your data profile is not highlighted, right-click it
and select Set as Current. 

Visualizing a single observation

2. Do one of the following:
- When the observation is open, click the Visualize current observation icon in 

the tool bar.  
- In the Project Explorer, right-click the observation you want to visualize and select 

Visualize.
When you select an Event line before you visualize the observation, the video will be 
positioned at that moment in the visualization.  

To go back to the observation, click the Open current observation button on the tool bar. 
The Event log will open with the cursor at the time where the hairline was in the time 
event plot. 

Visualizing multiple observations simultaneously

3. If your project contains two or more valid observations, do one of the following:
- From the Analyze menu, select Visualize Data or press Alt+F8.
- In the Project Explorer, under Analyses, click Visualization.
- In the Project Explorer, click the Analyses folder. In the overview window, click Visualize 

Data.

The Visualize Data window appears. Select the observations you want to visualize, and 
click OK.
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4. A few windows appear on your screen depending on which data are in your observation: 
- The Visualization window, showing one or more plots: an event plot (with colored bars 

for Continuous Sampling data and colored dots for Instantaneous Sampling data) for 
each event log and subject in the observation, and a x-y plot for each audio file, audio 
from video and external data file linked to that observation.

- One or more Video windows, showing the video files linked to that observation (this 
applies if you have scored data from video files).

- The Playback Control window, with which you can play back the data (see page 141), or 
edit the data (see page 120).

5. You can now do the following (optional):
- Play back the data (see below).
- Customize the event plot, for example change the order of the plots, or change the 

colors of bars or dots (see page 267).
- Edit the data (for example, to correct scoring errors; to do so, re-open the observation, 

see page 120).
- Export the event plot (see page 266). 

Figure 7.3 The Visualization window showing four behavioral data plots. The plot at the top shows the 
behavioral data scored using Continuous Sampling for the focal animal. The other plots show the 
behavioral data scored using Instantaneous Sampling for three other animals.
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Notes

 If your observation contains two or more event logs or subjects, these are visualized in 
separate event plots (see below). 
- If your coding scheme contains no behaviors, you cannot make an event plot. In that 

case you can only visualize video, audio and external data.
- If you add or remove a variable in the Independent Variable List (see page 86), the 

corresponding object (for example, a Physiological Data window if the variable refers 
to external data files) is displayed or removed, respectively.

 If you cannot visualize an observation, it could be due to the observation containing 
errors. See page 120 for information on how to correct errors in the data. Alternatively, 
the active data profile does not contain data for that observation.

 If you need to re-synchronize the different data files, re-open the observation and change 
the offset (see page 127). 

interpreting the event plot

The event plot always shows the data selected in the active data profile. If the plots do not 
correspond to the data you expected, it may be that you selected another data profile. 

 The hairline in the plot corresponds to the current position of the hairline in the event 
log. The hairline is fixed in the middle of the plot area.

 If the hairline is at the start of the observation, a transparent light blue area is shown to 
the left of the observation start to indicate that this area is not part of the observation. 
A similar area is also shown to the right of the observation end. 

 If the observation has been suspended, the same transparent light blue area is used to 
mark those parts.

 When there is an offset between the start of an observation and, for instance, external 
data, the excluded data are shown in the transparent area.
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 Use the scroll bar at the bottom to run through the visualization. You can also click 
anywhere in the visualization, hold the mouse button and drag the background.

 When the cursor is kept still above a colored bar, a tool tip will be shown with the 
behavior name, the modifiers scored (if applicable), the comment (if free text was 
entered for that event line) and the duration (for state events).

 Events that are filtered out are not visualized.

 When you select intervals by events, the selected intervals are shown with a white 
background. The non-selected intervals are shown semi-transparent enabling you to see 
the excluded data in these intervals.

 If you have merged behaviors, these are visualized under a new group Merged Behaviors. 
The modifiers of merged behaviors are not visualized.

 If you have merged modifiers, these are visualized under the Behavior, with the name of 
the merged group.

Figure 7.4 An example of a plot with the hairline at the start of the observation. External data 
acquisition was started before the start of the observation.
260 Chapter 7 - Visualizing Data



 If you define intervals and time bins, then time bins are visualized per interval. If you 
select the option Use number of time bins in the data profile, then the time bin length 
will vary with the interval length (see the screenshot below). 

 If your Data Profile contains more than one Result container, intervals and time bins are 
shown in the corresponding plot (note that the grey column in the plot shows the name 
of the Results container).

 For more information on data selection, see Chapter 6.

Visualization of audio

Audio files and audio streams from video are visualized as waveforms:

The peaks are short, loud bursts of sound. In spoken dialogue, letters like P, T and K at the 
beginning of words can result in peaks if the person speaking is close to the microphone. In 
music, peaks occur at the very beginning of sounds from percussive instruments such as 
drums. The average loudness generally determines its overall perceived volume. In the 
waveform above, the level of average loudness appears as the densest, darkest part around 
the middle.

The audio plot shows two channels (left and right) for stereo signals, and one channel for 
mono signals. The first audio signal you add to an observation is not muted, additional audio 
files are muted (Indicated by the red line through the speaker icon). Click the icon to make 
the sound audible.
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With the master volume control in the Playback Control you can adjust 
the volume for all media files. This volume control works independent 
from the Windows volume control. By default, the volume control is 
hidden. To show it on the Playback Control, open the Setup menu and select Project Settings 
and then the Playback control options. Select the checkbox in front of Show volume control. 
Click the icon on the Playback control to mute/unmute all the media files. Use the slider to 
increase/decrease the volume.

 The title of the audio plots is Audio file (dB) for audio files and Video File (dB) for audio 
imported from a video file. Contrary to audio files, the audio waveforms from a video is 
not an independent variable. Only audio files imported into an observation are shown as 
independent variables in the first column of the plot grid:

The first plot is for the audio file Z1775.wav, and is marked with the <Audio File 1> 
independent variable. The second plot is for audio imported from the video file Baby talk 
023.mpg. This audio is not labeled as an independent variable.

 The Observer XT only supports audio files with a maximum of 2 audio channels. If an 
audio/video file contains more channels, only the first two are visualized.

 Synchronization between audio from video files and the corresponding and video images 
is within 2 frames (80 ms for PAL, 67 ms for NTSC).

 You can change the color of the audio plot by clicking the colored square in front of the 
audio file name or by clicking the audio waveform.

 To hide some audio waveforms, not others, from View Settings select Show audio. 
Choose the video file name that you want to view and click Apply.

 You can see the value of a data point in the audio plot by visualizing the data points: in 
the View Settings, select Data Points. When you move the hairline to the right of a data 
point, the data point becomes bigger and its value appears behind the name of the audio 
file (see Figure 7.5). Values are shown in dB. These are dBFS, Decibel Full Scale, which is 
commonly used for digital signals.

 You can visualize audio for each video file allowed by your license. For example if you 
have a Media Files add-on license, you can visualize two video files and the two 
corresponding audio waveforms (plus two audio files).
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 Whether audio can be visualized depends on its format inside the video file. See the 
Observer XT Service Manual for a list of audio formats supported. Audio formats other 
than those supported may be visualized, depending on the audio decoders installed on 
your computer.

 If your Data Profile contains more than one Result container, audio data are plotted only 
once. If the Result containers specify different intervals, the boundaries between 
intervals are shown as vertical lines in the audio plot.

Visualizing external data

External data imported into The Observer XT usually consists of discrete samples. In the 
visualization in The Observer XT, the samples are connected by a line. However, the external 
data points are not interpolated and do not become continuous. For data selection and 
analysis, the discrete samples are used. Because of the latter, in the visualization it 
sometimes seems as if the selected samples do not exactly match the selection made in a 
data selection.

Note: If your Data Profile contains more than one Result container, external data are plotted 
only once. If the Result containers specify different intervals, the boundaries between 
intervals are shown as vertical lines in the external data plot.

Example of Selecting intervals based on Polar heart rate data – In the sample project Parent-
Child interaction, the heart rate of the child was acquired using Polar equipment (sample 
rate: 0.2 Hz). In a data profile, you select intervals by Polar heart rate Higher or equal to 100 
bpm. Figure 7.5 below shows part of the visualization based on the above-mentioned data 
profile. The selected data (heart rate > 100) are shown with a white background, the 
unselected intervals (heart rate < 100) have a blue background. For this example, the 
horizontal line indicating the 100-bpm threshold have been added to the plot in an image 
editing program.

At the end of the selected interval in Figure 7.5 (the white area), it looks as if a heart rate 
value of <100 bpm is included in the selection. However, the line that connects the last 
sample (value: 98) and the previous sample (value: 102), ‘belongs’ to the sample with 
value ‘102’.

You can see the value of external data in the event plots by visualizing the data 
points: in the View Settings, select Data Points. When you move the hairline to 
the right of a data point, the data point becomes bigger and its value appears 
behind the name of the external data plot (see Figure 7.5). 

By hovering over a data point with the mouse pointer, a small window pops up, 
showing the external data label, the time stamp and the value of the 
corresponding data point. 
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The data point at the end of an interval is not included in the selection.

At the start of the second interval, it looks as if a heart rate value >100 bpm is not included in 
the selection. The 100-bpm line crosses the line which connects sample with value ‘98’ and 
sample with value ‘102’. The latter one is the first sample included in the interval.

Visualizing numerical modifiers

Numerical modifiers are shown as one colored bar with the name of the modifier group. The 
height of this bar is 20 pixels (identical to the height of behavior bars and nominal modifier 
bars). The numerical modifier values are indicated by the height of the darker-colored area 
within the bar (see the screenshot below). By moving the hairline over a bar you can see the 
exact value of a numerical modifier after the modifier name on the Y axis.

The values that are scored are categorized. For instance, you defined a range from -50 to 50 
and coded the following 10 values: -50, -35, -20, -15, -5, 5, 10, 15, 25, 40. Each category gets a 
height of 2 pixels. So, for the value of -35, a bar height of 4 pixels is used

Visualizing comments

By default, comments are not shown in the time event plot. If you entered comments in your 
event log and want to visualize them in the time event plot, click the View Settings button 
on the tool bar and select Show Comments. The comments are now shown in the bars of 
state events, or next to the point events. If a comment is longer than the bar of the state 
event, or the space between two point events, only part of the comment is shown. Zoom in 
to show the full comment.

Figure 7.5 Example of an event plot of data selection of external data. For an explanation, 
see the text above.
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Playing back the data
1. Move the data to the point where you want to start playing back the data.

If you want to start from the earliest time among all data sets of your observation, 
click the Jump to begin button in the Playback Control window or press Ctrl+Up-
arrow key. 

2. You can select the speed at which you want to play back the data by selecting a playback 
speed from the list (see page 141). 

3. Click the Play forward button or press Ctrl+9.

To play frame by frame, click the Step frame forward button or press Ctrl+right-
arrow key.

For instantaneous sampling, go to the next sample by clicking the Next sample 
button or press the Ctrl+Shift+Down-arrow key. This button is not available when 
you have selected Continuous Sampling in the Project Setup.

For instantaneous sampling, go to the previous sample by clicking the Previous 
sample button or press the Ctrl+Shift+Up-arrow key. This button is not available 
when you have selected Continuous Sampling in the Project Setup.

For information on the other playback buttons, see page 141.

When you play back data, all data files are played synchronously. If you need to change the 
synchronization point between different data, see Edit data (see page 141).

Creating Episode selections

You can select time fragments in the Event plot and create Episode selections from these 
fragments. See Method 4 – Creating an Episode selection from Visualization on page 278 for 
a detailed procedure. 
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Editing the event data

If you want to edit the event data, for example when you want to add events or correct a 
scoring error, do the following: 

1. If you have only one observation visualized, click the click the Open current observation
button on the tool bar. The cursor will be positioned at the time where the hairline was
in the time event plot. 

If you visualized more observations, click the observation you want to edit in the Project
Explorer under Observations. The observation opens on your screen.

2. Edit the data as explained on page 120.

In The Observer XT, you can only edit observational data, not external 
(physiological) data.

3. To save the data, from the File menu, select Save Project. To return to the event plot, click 
the Visualize current observation button on the tool bar or right-click the observation in 
the Project Explorer and select Visualize.

Exporting the Event Plot

You can export an Event Plot by creating a screenshot. 

1. Make sure the part of the Event Plot you want to export is visible on your screen. 

2. Click the camera button on the Component tool bar. 

3. Choose the location and picture format.

4. Accept the default file name or enter another one and click OK. 

The screenshot only contains the part of the Event Plot that is visible on your screen. 

To export the Event Plot as a table:

1. Click the Export visualization data button on the Component tool bar. 

2. Choose the file format (Excel or text).

3. Choose the observations to export.

You can also copy the Event Plot and paste it into another program. Make sure 
that the Event Plot is open on your screen. From the Edit menu, select Copy or 
press Ctrl+C. In the other program, from the Edit menu, select Paste, or press 
Ctrl+V. 
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4. Select the destination folder and enter the export file name, and click OK.

If you selected data before creating the plot, only the time intervals specified in the Data 
Profiles are exported. For more information, see Exporting observational data in Chapter 11.

customizing the event plot

Summary

 Zooming in and out (see below).

 Specifying the time mode (see page 269).

 Specifying the time format (see page 269).

 Showing/hiding events (see page 270).

 Sorting plots within an event plot (see page 270).

 Showing/hiding plots, video, audio, and comments (see page 271).

 Changing colors (see page 272).

 Changing the vertical range in a plot (see page 273). 

It is not possible to make changes in an event plot if the project is read-only, for example:

 The project is stored on a CD/DVD.

 The project is already open in another Observer XT window (that is, two or more 
instances of The Observer XT are active at the same time, and one shows the same event 
plot). 

Zooming in/out

To change the level of detail of your plots you can zoom in or out.

If your event plot includes only event data (colored bars), you can zoom in/out the data 
relative to time (that is, change the time interval shown on the X-axis). 

If your event plot also includes external data, you can zoom in/out relative to time (X-axis), or 
the amplitude (Y-axis), or both time and amplitude. 

It is not possible to export the Event Plot of multiple observations with the 
Export visualization data option if the observations contain external data. 
Instead, choose File > Export > Observational data. See Section 11.3 on page 411 
for more information. 
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To zoom in/out relative to time:

Do one of the following:

 Right-click the plot and select Zoom in or Zoom out.

 Click the Zoom in or Zoom out button on the tool bar.

Result – When you move the mouse pointer over the time axis, it 
changes to a magnifying lens icon (with + or –).

a Click the plot one or more times to reach the desired zoom level.
b To return to the normal mouse pointer, click the mouse pointer on the tool bar.

 In the View Settings, select Time span and select the desired length of the X-axis.

The time scale changes for all the plots.

Every time you click the plot with the pointer as a magnifying glass or click Ctrl +. or Ctrl +, 
the plot is enlarged/reduced by a factor of 2, respectively. The scale changes accordingly.

If you have selected the option Show frame numbers while observing from videos in the 
Time formats tab of the Project Settings window, frame numbers are shown in the Event 
Plot. If you zoom in too much, it may happen that there are more tick marks with data labels 
on the time axis of the Event Plot than there are actual video frames. If this is the case, the 
same frame number is shown several times on the time axis. 

You can also press Ctrl+. or + (to zoom in) or Ctrl+, or – (to zoom out). With these 
shortcut keys you immediately zoom in or out along the time line. 

If your mouse has a mouse wheel, you can zoom relative to time by using the 
mouse wheel while you keep the Ctrl-key pressed. 
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To zoom in/out relative to amplitude (only for external data and audio):

1. Do one of the following:
- Right-click the Y-axis scale of the plot you want to zoom in/out and select Zoom In or 

Zoom Out.

- Click the Zoom in or Zoom out button on the tool bar.

Result – The mouse pointer changes to a magnifying lens icon (with + or –).

2. Click the Y-axis scale of the plot one or more times to reach the desired zoom level.

3. To return to the normal mouse pointer, click the mouse pointer on the tool bar. 

Every time you click the plot with the pointer as a magnifying glass, the plot is enlarged/
reduced by a factor of 2, respectively, and the scale changes accordingly.

The amplitude scale changes only for the plot that you clicked.

Specifying the time mode and time format
1. From the Setup menu, select Project Settings, then click Time formats in the left pane.

2. To set the time mode, in the Time formats list, select Absolute if you want to have 
absolute (clock) time displayed. If you want to include the date in your time stamps, select 
the check box Show date with absolute times. Select Relative if you want to have elapsed 
time displayed. 

3. To set the time format, click the Edit button next to the option you have chosen to specify 
the format in detail.

4. Click OK when done.

For more information, see page 60.

You can also press Ctrl+Shift+. (to zoom in) or Ctrl+Shift+, (to zoom out). With 
these shortcut keys you immediately zoom in or out in all the external data and 
audio plots.
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Showing and hiding events

Events are shown according to the hierarchical structure in the coding scheme. Behavior 
groups are listed in the left-most column of a plot. By default, all events are shown.

To collapse a behavior group, a behavior or modifiers attached to a behavior, click the – sign 
in front of the behavior group name, behavior name or modifier name. To expand again, 
click the + sign. 

 Once in an event plot, single behaviors cannot be hidden anymore. To do so, you must 
first remove those behaviors from the data profile (see Chapter 6).

 If events in a group are mutually-exclusive and exhaustive, once you collapse them they 
form a complete multi-color bar.

 If events in a group are of start-stop type, once you collapse them they may result in gaps 
(for the time when no state event was scored), or overlaps (when more state events were 
active simultaneously).

Sorting plots in an Event Plot

You can change the order in which plots are displayed by moving them up and down in the 
event plot. 

1. Click the header (left-most cell) of the plot you want to move. The header shows the
name of the result box in the data profile and the subject name (for event log data) and
the external data/audio label (for external data/audio plots). 
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Result – The border of the plot is highlighted in blue. 

2. Drag the plot to the desired position. Release the mouse button to confirm the position. 

Showing and hiding plots, video, audio, and comments

You can choose what plots to display in the event plot by selecting the appropriate option in 
the View Settings on the far-right side of the tool bar. 

Plots

1. If you want to show/hide event plots, click the View Settings button and select Events.

Result – A list of check boxes appears. Each item corresponds to a specific combination of 
result container, event log and subject (see Figure 7.6). If your coding scheme contains no 
subjects, the combinations are formed by result containers and event logs. 

2. To hide a plot, clear the corresponding box. To show a plot, make sure that the 
corresponding box is selected.

Video

1. In the View Settings, select Videos. 

Result – The videos that are linked to the observation that is visualized are shown. 

2. To hide the videos, deselect Videos.

Audio

1. In the View Settings, select Show Audio. 

Result – The audio files that are linked to the observation that is visualized are shown. 

2. To hide the audio plots, deselect Show Audio.

Figure 7.6 An example of the options shown, if Events is 
selected in the View Settings.
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Comments 

1. In the View Settings, select Show comments.

Result – The comments that are entered in the observations are shown in the time event 
plot. 

2. To hide the comments, deselect Show Comments.

Changing the color of event bars or dots
1. Do one of the following:

- In the Event Plot, click the colored square in front of the appropriate behavior or 
modifier.

- In the Event Plot, click the appropriate bar or dot.
- In the coding scheme, right-click the Behaviors panel and select Show all columns. 

Double-click the Color cell for the behavior whose color you want to change.

2. In the Value Color window, select a new color in one of the following ways: 
- Click a color in the Basic Colors section.
- Click a color in the palette and change its luminosity with the slider on the right 

(optional).
- Type in the HSL values.
- Type in the RGB values.

3. Click OK.

Changing the color of lines in external data/audio plots:
1. Do one of the following:

- Click the colored square in front of the external data/audio name.
- Double-click the external data/audio plot whose color you want to change.

2. In the Color window, choose a new color in one of the following ways:
- Click a color in the Basic Colors section.
- Click Define Custom Color, click a color in the palette and change its luminosity with 

the slider on the right (optional).
- Type in the HSL values.
- Type in the RGB values.

3. Click OK.
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Changing the vertical range of a plot
1. In the left-most column, point to the lower separation line, so the mouse

pointer turns to a double-arrow.

2. Drag to the desired position (down to have a larger plot, up to have a 
narrower plot). 

If the height of the plot becomes smaller than the range of the behaviors (or 
external data/audio values), use the scroll bar on the right margin of the plot 
to view the data.

7.3 Creating an Episode Selection

four ways of creating an episode selection

You can create an Episode Selection in four ways:

 Method 1 – Create a Blank Episode Selection (that is, an Episode Selection containing no 
events) and then fill it by dragging and dropping events from one or more event log data 
files (see page 274). Default, there is a blank Episode Selection in your project (see the 
Project Explorer under Episode Selections).

 Method 2 – Create an Episode Selection from a single event log file, that is, let The 
Observer create an Episode Selection containing all events you scored in a specific event 
log (see page 275).

 Method 3 – Create an Episode Selection from the Current Data Profile, that is, let The 
Observer create an Episode Selection containing all events selected in the currently 
active data profile (see page 276).

 Method 4 – Create and Episode Selection from the Visualization, that is select the start 
and end of an episode in the event plot and create an episode selection from the selected 
intervals. 

What is the difference among the four methods?

The difference only lies in the starting point.

 In Method 1, the Episode Selection is initially empty, and it's up to you to fill it with data. 
Choose this method if you want to insert few, very specific events in your Episode 
Selection.

 In Method 2, the Episode Selection is automatically filled up with the data scored in one 
event log. Choose this if you want to make an Episode Selection from just one event log.
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 In Method 3, the Episode Selection is automatically filled up with the data you have 
selected in the data profile. Choose this method if you want to create an Episode 
Selection reflecting a specific data selection (for example, an interval condition). 

 In Method 4, you select fragments of your observation based on time. This means that 
the Episode selection does not necessarily start and end with a start and end of an event, 
but can contain event fragments. 

You can always edit the episode selection after you have created it, for example by adding or 
removing events, etc. (see page 282).

Important assumptions

In order for you to be able to create an Episode Selection, the following conditions must be 
met:

 You have scored events in one or more observations.

 Your event log files should not contain any errors. You can check this by opening 
an event log and clicking the Check Event log icon.

 If you want to view the events selected in a certain data profile (see Chapter 6), that data 
profile must be active (that is, highlighted in the Project Explorer under Data Profiles).

When you have created an Episode Selection and subsequently open an observation and 
continue scoring, these new events are not included in the Episode Selection. Create a new 
Episode Selection after you have finished your observation.

procedure

Choose one of the following methods (see above for an explanation of the difference 
between the methods):

Method 1 – Creating a blank Episode Selection
1. Do one of the following: 

- From the Analyze menu, select Episode Selection, then New.
- Press Ctrl+Alt+F9.
- In the Project Explorer, under Analyses, click Episode Selection under 

Episode Selections. 
- In the Project Explorer, under Analyses, right-click Episode Selections and select New. 

Result – The Event Log window and the empty Episode Selection window appear.
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2. Add events by dragging and dropping them from the Event Log to the Episode Selection 
window. To do so, click the number of the event row so the entire row becomes 
highlighted, then drag it to the Episode Selection window. For more information on how 
to edit the Episode Selection, see page 282. 

If the observation is associated with video files, a Video window opens for each association 
(that is, each time a video file is associated with a subject, event log file or observation). 
Audio files associated with an observation are not visualized.

Method 2 – Creating an Episode Selection from a single event log file
1. In the Project Explorer, right-click the Event Log file you want to create an Episode

Selection from, and select Create Episode Selection. 

You must right-click an event log, not an observation. Event logs are indicated by 
the icon below.

To find an event log, first open the Observations folder in the Project Explorer, then the 
Observation containing the event log, and finally the Event Files folder. 

Figure 7.7 The Event Log window and the empty Episode Selection window.
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2. The Episode Selection window and the Event Log window appear. The Episode Selection 
window lists all events in the event log, grouped in an episode. The light blue line is the 
title of the episode, and is named after the event log.

Method 3 – Creating an Episode Selection from the current data profile
1. Make sure that the data profile you want to use as a source of data is highlighted in the

Project Explorer (under Data Profiles). If your data profile is not highlighted, click it. For
more information on data profiles, see Chapter 6. 

2. Do one of the following:
- From the Analyze menu, select Episode Selection, then New From Current Data Profile. 
- Press Ctrl+Shift+F9.
- In the Project Explorer, right-click Episode Selections, and select New from Current 

Data Profile.

Result – The Episode Selection window and the Event Log window appear. The Episode 
Selection window lists all events selected in the currently active data profile (see Figure 
7.9).

Figure 7.8 The Episode Selection window filled in with the data of an event log file. The original event data 
are shown in the Event Log window (above).
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If the observation is associated with video files, a Video window opens for each 
association (that is, each time a video file is associated with a subject, event log file or 
observation). Audio files associated with an observation are not visualized.

If your data profile includes two or more observations, events are placed in separate 
episodes (indicated by light-blue title rows). If your data profile includes observations 
with two or more event logs, the events from the event logs are placed in one episode.

If your data profile includes intervals defined by interval conditions (see Select Data - 
Intervals in Chapter 6), events belonging to different intervals are placed in separate 
episodes (indicated by light-blue title rows). If the same event is included in two or more 
intervals defined by different interval conditions, the event is repeated in the Episode 
Selection, each instance in a separate episode.

3. Edit your Episode Selection, for example add events by dragging and dropping them from 
the Event Log window, or remove events. For more information on how to edit the Episode 
Selection, see page 282.

Figure 7.9 The Episode Selection window displaying the events selected in the active data profile.
Chapter 7 - Visualizing Data 277



General notes

 Within each episode, event lines are numbered beginning from 1. Events are ordered 
chronologically in an episode.

 The Event Log window has two lists from 
which you can select an observation and an 
event log within an observation. The Event Log 
window shows the content of one event log file at a time.

 If you do not see the Video window on your screen, make sure that Video Window is 
selected with View Settings on the Component tool bar. If this does not solve the 
problem, it may be that The Observer does not find the videos in the usual location. 

a Click the observation name in the Project Explorer. 
b A window appears. Select the video file and click Open.
c Re-open the Episode Selection (click the Episode selection in the Project Explorer).

You can also open the Independent Variable List and in the Video column browse to 
the correct location.

 In the Episode Selection window, each event is represented by one line. The line 
representing a state event contains information about the state's duration.

 Events within one episode can only be selected from the same observation.

Method 4 – Creating an Episode selection from Visualization

You can select fragments from your observation in the time-event plot that is created when 
you visualize your observations. You can create an Episode selection from these fragments. A 
big difference between this method and the three methods above is that this way you can 
select event fragments, based on time. With the three methods above it is only possible to 
select entire events. Each episode selected with this method represents one video segment 
from one observation. Episodes defined with this method cannot overlap.

1. Scroll the video to the position where you want to start the Episode Selection. Then do
one of the following. 
- Right-click the Event plot and select Start episode. 

- Click the Start episode button on the tool bar. 
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2. Move the slider, or click and drag the Event plot. The selected area is shown in orange in 
the Event plot. 

3. When you made your selection, do one of the following:
- Right-click the Event plot and select Stop episode. 

- Click the Stop episode button on the tool bar.  

4. Optionally select more areas of interest. When done, do one of the 
following. 
- Right-click the Event plot and select Create Episode selection. 
- Click the Create Episode selection button on the tool bar.  

The Episode selection window now opens with the events or event 
fragments in the selected time intervals.

Selecting episodes outside data selection criteria

If you created a data profile, the data that fall outside the selection criteria are displayed in 
grey in the visualization. If you select Episodes that fall (partly) within the area in grey and 
create an Episode selection, the video of the entire interval is selected. However, the events 
that do not meet the selection criteria are not included in the Episode selection. See also the 
figure below. 
Chapter 7 - Visualizing Data 279



Removing an episode

To remove the latest created area of interest, click the Remove episode button on the 
tool bar, or right-click the Event plot and select Remove episode.  

To remove all areas of interest, click the Remove all episodes button on the tool bar, 
or right-click the Event plot and select Remove all episodes.  

episode selection and video

If the observation is associated with a video file, this video is shown in the 
Video window of the episode selection view. If the observation contains 
multiple video files, the ones that are associated with the selected episodes 
are all shown in the Video window. Select which video to use for the episode 
video in the in the Video column of the episode selection.  

This video is used for the episode video (see Generating an Episode video on page 290). You 
can only select one video for each Episode. Audio files associated with an observation are not 
visualized.

All episodes are removed when you exit an Event plot. When you leave the 
Visualization window, when you selected episodes, The Observer XT will show a 
warning that all episodes will be removed.
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saving an episode selection

The Episode Selection is saved as soon as it is created. It is 
named as Episode Selection N where N is an incremental 
number. You can check this in the Project Explorer, in the 
Episode Selections folder.

You can rename an Episode Selection by right-clicking it 
in the Project Explorer and selecting Rename.

When you save your project, each Episode Selection is saved to a separate file with extension 
*.esr, within your project's Episode Selections folder.

customizing the episode selection screen

Why customize the screen? – During the editing of your Episode Selection you may want to 
show some windows, not others. For example, you may want to show the External Data 
window in order to check what values of heart rate the selected episodes correspond to. You 
can customize your screen with View Settings (see below). You can also customize the 
appearance and content of the Episode Selection window. For example, show the Comment 
column in the Episode Selection window (see page 287).

 Event Log – Select this if you want to display the Event Log window. 

 Videos – Select this if you want to display the content of the video files, each in its own 
Video window.

If the events in your Episode Selection are associated with more than one video, you can 
select which video you want to include in the preview for that event. With View Settings, 
select Videos, and make sure the checkbox in front of Video window is selected. Then 
select one of the options:

Figure 7.10 The View Settings for the Episode Selection.
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- Show all videos per Episode – The Videos window shows all videos that are associated 
with the events in the episode. The video that is selected in the Video column for that 
episode is shown in the middle of the Videos window. This is the video that is used to 
generate the episode video. The other videos are shown on the left side of the Videos 
window. 

- Show videos selected for Episode video only – Only the video that is selected in the 
Video column for that episode is shown in the Videos window. This is the video that is 
used to generate the episode video. 

 External Data – Select this if you want to display the External Data window. A window 
with check boxes appears in which you can select which External data to display. 

The areas in the External Data window with a white background show the data which 
are included in the Episode Selection. The blue areas show the data which are excluded.

You cannot display different external data sets in separate windows. 

External Data is only available if you have the extra module for external data acquisition.

 Playback Control – Select this if you want to display the Playback Control buttons. See 
page 141 for details about the Playback Control functions.

 Show column – Select which columns you want to show in the Episode Selection. For 
more information see page 287.

7.4 Editing the Episode Selection

Before you can edit an Episode Selection, it must be opened. If that is not the case, open the 
Episode Selection by doing one of the following:

 In the Project Explorer, under Episode Selections, click the Episode Selection you want to 
open.

 From the Analyze menu, click Episode Selection and then click Open. Select the Episode 
Selection you want to open and click OK.

Adding events
1. In the Event Log window, select an observation from the first list and an event log from

the second (if the selected observation contains more than one event log).
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Result – The Event Log window lists all events scored in that event log, independent of 
the current data selection.

2. Click the left-most cell of the event line you want to add to the Episode Selection. The 
event line is highlighted. Release the mouse button.

3. Drag the line to the Episode Selection window:

For state events with start and stop lines, you do not need to drag and drop the stop line. 
Just drag the start line (with the green triangle  next to the behavior name). The 
information about the duration of that state is copied anyway.

In the following example, the event ‘Outstretched arm’ is placed in the same episode as the 
two other events. The event ‘Outstretched arm’ just needs to be dragged to Episode 1: the 
event will appear as first event in Episode 1, because events are sorted chronologically.

Add multiple events from the Event Log
1. Click the leftmost cell of the first event line you want to add, so the event line is

highlighted.

2. If you want to add multiple successive events, press Shift and click the leftmost cell of the 
last event line you want to add. If you want to add multiple, non-adjacent events, press 
Ctrl and click the leftmost cell of each event line you want to add.

Result – The group of event lines becomes highlighted.

3. Drag to the Episode Selection window.

Removing events from the Episode Selection
1. Right-click the event line in the Episode Selection window. 

2. Select Delete event, or click the Delete event button on the tool bar.

3. The event is deleted. The remaining events in the Episode Selection window are re-
numbered accordingly. 

Removing events from the Episode Selection does not affect events in the Event Log window. 
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To select multiple adjacent event lines in the Episode Selection window, click the first line, 
hold Shift down and click the last event line. Next, right-click and select Delete event.

To select multiple non-adjacent event lines in the Episode Selection window, hold Ctrl and 
click the event lines you want to delete. Next, right-click and select Delete events.

defining episodes

Inserting a transition in the Episode Selection

What is a transition? – A transition is a label that you can insert to distinguish events or 
groups of events. In the Episode Selection, a transition is indicated by a light-blue title row. 
The group of event lines between two consecutive transition rows is called an Episode. In the 
example of Figure 7.11, the Episode Selection contains three transitions, one at the start and 
one for each new observation. The three transitions define three episodes. An episode is 
therefore defined by a transition plus one or more event lines immediately following the 
transition title row. The episode ends at the next transition title row.

A transition title row can also be viewed as a time segment between two episodes, like a 
transition in video editing. You can specify a certain duration for each transition row (see 
page 296). 

Figure 7.11 An example of an Episode Selection with three transitions.
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When do I need to insert a transition? – Transitions are not mandatory. You need them every 
time you want to have different episodes (or single events) separated by a time interval, 
perhaps with an introductory title. This can be useful when you play the Episode Selection 
(see page 289), or the episode video (see page 290)

To insert a transition:

1. Click the first event line in the Episode Selection that you want to have in the episode. 

2. Right-click and select Insert transition (or press Ctrl+I), or click the Insert transition 
button on the tool bar.

Result – A light-blue transition row is added immediately before the event selected.

Renaming an episode

You can rename the Episode title row by double-clicking the name.

moving events and episodes in the episode selection

Moving an event to another episode
1. Click the leftmost cell of the event line you want to move, so the event line is highlighted.

2. Drag the event line to the row below the transition title row of the episode to which you 
want to move the event. A red line appears below the transition title row.

3. Release the mouse button to add the event. The events in the episode are re-numbered 
and ordered chronologically.

You cannot move an event to a new position within the same episode, because events in an 
episode are ordered chronologically.

Moving an episode

You can move episodes in an Episode Selection to change the order they are played back. 

1. Click the transition title (light-blue row) for the episode you want to move (Episode A), so
the event line is highlighted. 

2. Drag to the row before the appropriate transition title (light-blue row of Episode B). The 
new position of Episode A is indicated by a red line.

For example, if you have three episodes and therefore three transitions labeled Episode 1, 
Episode 2 and Episode 3, to move Episode 1 before Episode 3, drag the light-blue row of 
Episode 1 to the row before the light-blue row of Episode 3.

3. Release the mouse button. Episode A is moved to its new position, before Episode B.
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To move an episode to the beginning of the Episode Selection, drag its title row to the header 
row of the Episode Selection.

To move an episode to the end of the Episode Selection, drag its title row to the last 
transition title row in the Episode Selection.

deleting transitions and episodes from 
the episode selection

To delete a transition, right-click it and select Delete transition, or click it and click the 
Delete transition button on the tool bar.

When you delete a transition, the events in the episode are moved to the previous episode.

Deleting a transition does not affect the events in the Event Log window. 

After deleting a transition, you may need to re-name some of the remaining episodes. To do 
so, double-click the name of the transition row for that episode and type in the new name.

To delete an entire episode right-click the episode’s transition row and select Delete 
episode, or click the transition row and click the Delete episode button on the tool bar. 

copying episodes and events

Copying an episode

To copy an entire Episode A:

1. Right-click Episode’s A transition row and select Copy.

2. Right-click the episode below which you want to add Episode A and select Paste.

3. Episode A will be copied and added to the Episode Selection.

Copying an event

You cannot copy an event within the same episode.

You can copy an event to another episode:

1. Click an event line in the Episode Selection.

2. Press the Ctrl key.

3. Drag the event line to the appropriate episode. A red line appears below the episode’s 
transition row.

4. Release the mouse button to copy the event. The events in that episode are re-numbered 
and ordered chronologically.
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You can also use the following method: 

1. Right-click the appropriate event and select Copy.

2. Right-click any position in the episode to which you want to add the event and click Paste. 
The event will be added to the episode. The events in that episode are re-numbered and 
ordered chronologically.

customizing the episode selection

At this point we assume that your Episode Selection is complete and includes only the events 
you want to visualize, or generate an episode video from. You can customize the Episode 
Selection in a variety of ways:

 Show columns in the Episode Selection window (see below).

 Hide a column in the Episode Selection window (see page 288).

 Edit the contents of the cells. Note: Only columns that are not grayed out can be edited 
(see page 289). 

 Sort the columns of the Episode Selection (see page 289).

Showing columns

The Episode Selection window may include more information than you currently view. This 
additional information can be displayed by adding more columns to the table. 

To show more columns:

1. Right-click one of the column headers and select Show
column.

2. In the Show columns window, select the boxes for the 
columns you want to visualize and clear the ones for the 
columns you do not want to view, and click OK. See below for more information on the 
single items. 
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You can edit the content of some columns. Only columns that are not grayed out can be 
edited. 

The Video, Subtitle Text, Subtitle Duration and Roll-on/Roll-off time columns are not 
available in the Basic version of The Observer XT, because the basic version does not 
contain video.
- Observation – The name of the observation the event was scored in. 
- Event Log – The name of the event log data file in which the event was stored.
- Episode Selection Time – The start time of the event relative to the start of the Episode 

selection. This includes the duration of the first transition at the start of the Episode 
selection (see the time in the subtitle duration column in the transition row). 

- Start Time – The start time of the event.
- Stop Time – The stop time of the event.
- Relative Event Time – The start time of the event relative to the start of the Event log.
- Event Duration – The duration of the event. For point events and events scored with 

Instantaneous Sampling, the duration is zero.
- Subject – The Subject in the event line.
- Behavior – The behavior in the event line. 

The terms Subject, Behavior and Modifier may not be the same as those on your 
screen. This depends on what terms you have specified in your project's Terminology 
Preferences (see page 93). 

- Modifier – The behavior modifier in the event line.
- Comment – The comment in the event line. 
- Video (editable) – The name of the video file associated with the 

observation. If the episode is associated with more videos, the Video 
cell in the episode title row contains a list with the available videos. 
You can only select one video per episode.  

- Roll-On Time (editable) – The time that playback starts before the 
actual start of the event.

- Roll-Off Time (editable) – The time that playback continues after the stop of the event.
The Roll-On/Roll-Off time has a limit of 9 hours, 59.999 minutes.

- Subtitle Text (editable) – The text that appears during playback of the media file 
generated from the Episode Selection. You can specify a text for each event or 
transition. By default, it shows the name of the Behavior.

- Subtitle Duration (editable) – The duration of display of the subtitle text of events and 
transitions. For transitions, the default duration is 4 seconds. For events it is 2 seconds.

Hiding a column

Right-click the column header and select Hide column. Note that you cannot hide the 
leftmost (numbered) column.
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Editing the cell contents
1. Double-click the cell you want to edit.

2. Type in the text.
- For time/duration cells – Click one of the numbers (s.dd) and use the arrow keys to 

change it to the desired value or type in the value.

Sorting the columns of an Episode Selection

You can sort the columns of the Episode Selection by dragging and dropping the column 
header to any position.

7.5 Playing the Episode Selection

Click the playback buttons to play an Episode Selection. Segments of video and external data 
are played synchronized with the events highlighted in the Episode Selection.

Make sure that with View Settings on the Component tool bar, the option, Videos and 
subsequently Video Window is selected. Also select Playback Control and (if applicable) 
External Data.

For information about the Playback Control functions, see page 141.

The event lines in the Episode Selection window currently played are highlighted in blue. 

With the Step forward and Step backward buttons you can jump to the next/
previous event in the Episode Selection.

Playing the Episode Selection

Right-click the line of the event where you want to start, and select Play. 

Playing a Point event

By definition, events scored with Instantaneous Sampling have no duration (see page 73). 
The Stop Time of these events is equal to the Start Time. When you want to play a point 
event, make sure that its Roll-On Time or Roll-Off Time is > 0 (if both are zero, they are 
shown in red). By default, the Roll-On Time for all events is 3.0 seconds and the Roll-Off Time 
is 2.0 seconds.

Changing the Roll-on/Roll-off times for all events
- On the tool bar, click the Settings button.

3. Select the Duration tab. Click on one of the numbers in the Roll-On or Roll-
Off Time box and use the arrow keys to change it or type in the desired value.
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4. Select Apply to all.

5. Click OK or press Enter.

See page 294 for more information.

exporting the episode selection

You can export Episode Selections to ASCII (text) files. If your observation includes external 
data, these are exported together with the Episode Selection in separate ASCII files. You can 
export the episode selection that is currently active, or all episode selections. 

 Exporting the currently active Episode Selection:

a Click the Export Selected Data button on the tool bar. 
b Type in a file name in the File base name field, choose a destination location from

the Save in list, choose the type of text file and list separator and click Export.

 Exporting all Episode Selections:

a From the Analyze menu, select Episode Selection, then click Export. 
b Type in a file name in the File base name field, choose a destination location from the

Save in list, choose the type of text file and list separator and click Export.

Episode Selections are saved as <base name> - Episode Selection 001(1).txt, <base name> - 
Episode Selection 002(1).txt, etc. Associated physiological data are saved as <base name> - 
Episode Selection 001 - physiological data 001(1).txt, etc.

If you have set roll-on and roll-off times, the external data samples within these intervals are 
also exported.

7.6 Generating an Episode video

You can generate a video file from your selection of video episodes that you specified in the 
Episode Selection. Note that the format of the video file generated depends on the video 
compressor (codec) you choose, not the format of the original video file (see page 292). 

If you have a Basic version, you cannot generate media files from within The Observer XT.

The Observer XT only supports generating media files in standard definition (SD) 
(704 x 576 Pal, 704 x 480 NTSC). At higher resolutions the video generation may 
not be stable.
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procedure

1. To first preview the video file from the Episode Selection, open the Analyze menu and
select Episode Selection and then Preview Episode Video. Alternatively, click the Preview
episode video button on the Episode Selection tool bar.  

A Preview window opens showing the video scenes selected. The Preview window 
closes after the end of the selection has been reached. To close it manually, click 
this button.

2. To create the video file, open the Analyze menu, select Episode Selection, then click 
Generate Episode Video or, when an Episode Selection is open press Ctrl+Shift+G, or 
press the Generate episode video button on the tool bar.

 The Generate Episode Video window appears.

3. In the Codec field, select a Video codec from the list. We recommend to use DivX MPEG4. 
See ‘Which codec should I use’ on page 292 for more information about the options.

4. In the Name field, either type in the name of the resulting video file or accept the default 
one. Next, click the Browse button and navigate to the location where you want to save 
the video file. 

By default, the output video file is named as the Episode Selection used to generate it, 
and is stored in the Video Files folder. The default path is:

C:\Users\Public\(Public) Documents\Noldus\The Observer XT\Video Files.

You can change the path in the Preferences. From the File menu, choose Preferences and 
then Files locations in the left pane.

5. Click Preview if you want to view the resulting video, without generating a media file 
(optional). 

A Preview window opens showing the video scenes selected. The Preview window 
closes after the end of the selection has been reached. Click this button to close it 
manually. 

Figure 7.12 The Generate Episode Video window.
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6. Click Generate to generate the media file. A Progress window appears.

If you want to cancel the operation, click Abort.

7. After the video file has been generated and stored on disk, the Progress window shows 
the message ‘Generate video file finished successfully’. Click Close to exit the Progress 
window and the Generate Episode Video window.

Video codecs

What is a Video Codec? – Codec stands for Compression Decompression. It is software that 
decompresses the original video file and recompresses it to create the new video file. 

The format of the video file generated depends on the video compressor you choose, not the 
format of the original video file.

Which Codec should I choose? – 

 DivX MPEG4 – Choose this codec if you want to create MPEG-4 files of good quality and 
moderate size (with extension *.avi). This is the default and recommended codec. The file 
size of DivX MPEG4 videos is 0.5- 3 GB per hour.

 DV AVI – Choose this codec if your research requires superior quality. Be aware, however, 
that DV AVI files are generally very big (12.5 GB per hour), so make sure you have enough 
disk space on your PC.

 Other – If you select Other, a list of other codecs available on your computer is shown.

Please note that the quality of the generated video file depends on the quality of the original 
video. If your original video is an MPEG-4 video it does not make sense to choose DV AVI as 
the codec to generate a highlight video clip.

Video Codec Settings – By clicking Settings next to Video codec in the Generate Episode 
Video window, a Configure/Configuration window appears. In this window you can specify a 
number of settings (video format: PAL or NTSC, resolution etc.) that influence the quality of 
the resulting video file. The settings are codec-dependent. For some codecs, a Settings 
window is not available. For more information, see the documentation provided by the 
manufacturer of the codec. 
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subtitles

You can add subtitles to the Episode video. Please note that you cannot show subtitles when 
you play the Episode Selection (see page 289). 

By default, subtitles are shown for all events. The text shown is that in the Subtitle Text 
column of the Episode Selection.

To select what to show as subtitles do one of the following:

 Open the Analyze menu and select Episode Selection and then Settings. 

 Click the Settings button on the tool bar. 

The Episode Selection Settings window opens (Figure 7.13).

Click the Subtitles tab and select one of the following options for the subtitle text:

 Behavior name – To display the content of the Behavior column.

 Behavior name and comment – To display the content of both the Behavior and 
Comment columns.

 Comment – To display the text in the Comment column for each event.

 None – To not display subtitles.

 Include time – To display the time corresponding to the event/transition. Next, select 
one of the two time formats from the list:
- Absolute – For example, 12:35:06.
- Relative – Time from the start of the event log, for example 00:02:34.

You can change the time format in the Project Settings (see time formats on page 60).

Figure 7.13 The Episode Selection Settings 
window.
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 Apply to all – Click this button to overwrite the text in the Subtitle Text column of the 
episode selection. If you edited the subtitle text and you want to keep this text, then do 
not click this button. In that case, the setting only applies to events you later add to the 
episode selection.

Subtitle duration

Durations are shown in the format defined in the Project Settings. To change the format, 
from the Setup menu, select Project Settings and then Time formats. For more information, 
see page 60.

To change the subtitle duration: 

The episode video can display subtitles of point events and state events at the 
same time. However, If two or more events of the same type start at the same 
time, only the subtitle for the one that comes first in the Episode selection will 
be shown. This is likely to happen when you select episodes in the time event 
plot, because all events that are active at the start of the episode will have the 
same start time in the episode selection.To show the subtitle of another event 
with the same time stamp, click the other events in the episode selection and 
drag them to below the event you want to show. The Observer XT will show the 
following warning: 

Click OK. The event you want to show will now be the first of the ones with the 
same time stamp and its event name will be shown as subtitle in the episode 
video. 

Alternatively, set the duration of the subtitles shorter, so that one ends the one 
of the still active event will be shown. 
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1. Click the Duration tab in the Episode Selection Settings window. 

2. Set the duration in the Subtitles field. The default value is 2.0 s. Please note that the 
duration of a subtitle cannot exceed the duration of the event plus roll-off time.

Example 1 – a state event has a duration of 5 seconds, and a roll-off time of 2 seconds. The 
subtitle duration can be maximally 7 seconds. 

Example 2 – a point event has a roll-off time of 2 seconds. The subtitle will only last for 2 
seconds. Increase the roll-off time to increase the subtitle duration. See page 296 how to 
change the roll-off time.

3. Click the Apply to all button to apply the values in the Duration tab to all the rows in the 
Episode selection and overwrite the current values. If you want to keep the values for the 
current events and transitions in your episode selection and want these settings only to 
apply to events/transitions you add later, then do not click this button.

Subtitle layout

To change the appearance and the position of the subtitles, click the Properties button on 
the tool bar, or open the Analyze menu and select Episode selection and then Properties. 
Open the Subtitles tab.

For the color you can choose between two options:

 Use coding scheme colors – If you choose this option the subtitles will be shown in the 
color of the behaviors which are listed in your episode selection. See page 307 for 
changing the color of behaviors.

 Use single color – If you select this option, you can select one color for all the subtitles.
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transitions

To change the transition duration:  

1. Click the Settings button on the tool bar, or open the Analyze menu and
select Episode Selection and then Settings.

2. Click the Duration tab in the Episode Selection Settings window. 

3. Change the time in the Transitions field.

4. Click the Apply to all button to apply the values in the Duration tab to all the rows in the 
Episode selection and overwrite the current values. If you want to keep the values for the 
current events and transitions in your episode selection and want these settings only to 
apply to events/transitions you add later, then do not click this button.

Transition layout

To change the appearance of the transition text, click the Properties button on the tool bar, 
or open the Analyze menu and select Episode selection and then Properties. Open the 
Transition tab and select the appearance.

roll-on and roll-off time

Durations are shown in the format defined in the Project Settings. To change the format, 
from the Setup menu, select Project Settings and then Time formats. For more information, 
see page 60.

To change the duration of roll-on, or roll-of time: 
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1. Click the Settings button on the tool bar, or open the Analyze menu and
select Episode Selection and then Settings. 

2. Click the Duration tab. 

3. Change the time in the Roll-on, or Roll-off field.

4. Click the Apply to all button to apply the values in the Duration tab to all the rows in the 
Episode selection and overwrite the current values. If you want to keep the values for the 
current events and transitions in your episode selection and want these settings only to 
apply to events/transitions you add later, then do not click this button.
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Chapter 8 
Calculating

Statistics

8.1 Before you start .................................................................................. 300

8.2 Procedure overview ............................................................................ 301
Here you can find how to carry out Behavioral analysis and 
Numerical analysis.

8.3 The statistics result............................................................................. 306
Here you can find how the results of your calculations are displayed in the 
Analysis Results sheets and how you can customize the way the results 
are displayed.

8.4 Statistics available .............................................................................. 316
Here you can find all the statistics for the different types of analyses.

8.5 Analyzing observations containing multiple event logs................... 330

8.6 Creating charts.................................................................................... 336
Here you can find out how to create charts to visually display your 
analysis results.
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8.1 Before you start 

In The Observer, the term statistics refers to descriptive statistics, which provide a numerical 
summary of the properties of the observed frequency distribution. You can calculate the 
following descriptive statistics:

Behavior Analysis 

With Behavior Analysis, you calculate statistics for events scored in the observations. 

See page 319 for a description of the Behavior Analysis statistics.

Example 1 – Calculate the average duration and standard deviation of the behavior Play for 
the subject Child. 

Example 2 – Calculate the number or times the subject Test participant requested help.

Numerical Analysis

With Numerical Analysis, you can calculate statistics for numerical modifiers (see page 80) 
and external data in the observation. Note that you can also use numerical modifiers as 
categories (see one of the notes below).

See page 326 for a description of the Numerical statistics.

Example – Calculate the average value of the numerical modifier Speed. If this modifier was 
scored 3 times, with values 10, 20 and 25, then the result will be (10+20+25)/3 = 18.33.

For both types of analysis, before calculating statistics you can restrict the data to analyze by 
creating a data profile (see Chapter 6). If you do not select data, The Observer calculates 
statistics on all events and external data in all observations in your project.

The terms Subject, Behavior, Modifier, and Independent Variable listed in this 
chapter may not be the same as those on your screen. This depends on what 
terms you have specified in your project's Terminology Preferences 
(see page 93).
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Modifier combinations

 Analyzing Modifier combinations – If behaviors are attached to modifiers, you can 
analyze modifiers:
- In specific combinations as they were scored. For example: calculate the number of 

times this combination occurred: Play (behavior) Duet (modifier 1) Constructive 
(modifier 2) etc. If you want to do so, make sure that you keep the Show combined 
modifiers option selected in the analysis settings (see page 303). 

- Independently of other modifiers scored in the same event. For example: calculate the 
number of times that Duet occurred independent of other modifiers. To do so, clear the 
Show combined modifiers option in the analysis settings. 

 Analyzing numerical modifiers as categories – It is possible to analyze a numerical 
modifier as a category, for example to calculate the number of times that the modifier 
'0.1' was scored. To do so, make sure that your numerical modifiers are included in the 
Data profile and carry out Behavior Analysis. 

8.2 Procedure overview

1. Make sure that the data profile specifying the data you want to analyze is set to active,
that is, highlighted in bold and blue in the Project Explorer. 

If you defined a range of numerical modifiers instead of predefined values, many 
different values may have been scored. If you subsequently carry out a Behavior 
Analysis and analyze the numerical modifiers as categories, this may result in 
many cells in the analysis result. This can especially happen if you have 
numerical modifiers with several decimals, or if you have imported external data 
as numerical modifiers. The maximum number of columns and rows is 1000 x 
1000. If the number of numerical modifiers exceeds 1000, The Observer XT will 
show a warning and no numerical analysis is carried out. You can reduce the 
number of cells with a Data Selection.

To activate a data profile, click it’s name in the Project Explorer. For more 
information on how to select data, see Chapter 6. 

You can specify the format of time in your results. From the Setup menu, 
select Project Settings, then Time formats in the left pane. Select the time 
format you require (see page 60 for more information).
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2. Do one of the following to display the Analysis Settings window:
- From the Analyze menu, select Behavior Analysis or Numerical Analysis, then New. 
- In the Project Explorer, click the Analyses folder. In the overview window, click Analyze 

Data, in the window that appears, click Behavior Analyses or Numerical Analyses.
- In the Project Explorer, under Analysis, click Behavior Analyses and then New 

Behavior Analysis or click Numerical Analyses and then New Numerical 
Analysis.

3. A table appears with question marks. To show the results, click the Calculate button on 
the tool bar. By default the following items are present in the table. 
- For Behavior analysis and continuous sampling – Mean, Total duration, Rate per 

minute (observation duration), Total number. See statistics for behavior analysis on 
page 319 for available statistics and details about the statistics.

- For Behavior analysis and instantaneous sampling – Proportion (all samples), Scored 
samples. See For Instantaneous Sampling on page 325 for available statistics and 
details about the statistics.

- For Numerical analysis - Minimum, Maximum, Mean, Total duration. If you scored with 
instantaneous sampling, the column Total duration contains the missing value symbol 
“-”, because instantaneous samples do not have a duration. See statistics for 
numerical analysis on page 326 for available statistics and details about the 
statistics. 

The table with statistical results also contains the columns Duration, Start time and Stop 
time that contain details about the observation. 

Changing the missing values symbol or number of decimals

To change the missing value symbol, or the number of decimals, click the Settings button on 
the tool bar. Select the following:

 Show missing values as – Choose the character you want to have displayed for missing 
values in the statistics result

 Number of decimals – Choose the number of decimals for the non-time values.

Changing the table layout
1. To specify what to show on rows or columns, click the Layout button on the tool bar.

Select the element category you want to view on rows, columns and separate sheets.
Clear the selection for any element type you do not want included in the table.

De-selecting one of the categories (except External data and Independent Variables) 
equals to calculating the results for the elements summed. For example, if Subjects is not 
selected, all subjects in an observation are treated as one. See also Collapsing Category 
elements on page 313.
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Result Container specifies the name of the Results box in your data profile (see 
page 200). If your data profile contains two or more of such boxes, you cannot de-select 
this option. You can rename the Result boxes in the data selection. 

2. Sort the table (optional) – You can sort the table by the main categories by 
changing their position within each box (top= highest hierarchical level) with 
the Up or Down button at the bottom of the box.

3. Select the elements you want to view in the table (optional) – Click the category 
name and click the Settings button. 

The Category window appears. Select the elements you want to view in the table. 

4. Select the following:
- Show combined Modifiers – Make sure this option is selected if you want to have 

results for all combinations of modifiers. By default this option is selected. 
Example – In a study of interactions among children, the type of play is coded with two 
modifier groups, Play 1 to specify whether the subjects play as a Duet or In parallel, and 
Play 2 to specify whether play is Manipulative, With rules etc. A typical event scored is 
for example Play - Duet - With rules.

To move a category to a different box, click its name and then click the 
appropriate arrow button, or drag it to the destination box.

Example – If you select Statistics under On Sheets, each type of 
statistic will be shown in its own sheet. To place statistics on the 
columns of the results table, click Statistics, then click the arrow 
button pointing to the On Columns box.

Figure 8.1 The Analysis Settings window for 
behavior analysis.
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If you select Show combined Modifiers, the statistics are calculated for each 
combination of modifiers scored. For example: Play-Duet-With rules Frequency=4.
If you do not select Show combined Modifiers, the statistics are calculated for each 
modifier separately, regardless of which other modifiers were scored with it. For 
example: Play-Duet Frequency=3; Play-With rules Frequency=2.
Note that the results obtained with Show combined Modifiers are not necessarily the 
sum of the separate results. In the example above, Play-With rules may also refer to an 
event where With rules was scored with a modifier other than Duet of the Play 1 group. 

- Show elements not scored – Select this option if you want the result to include the 
elements of the coding scheme that you have not scored in some observations, or if 
they are not present in intervals created in your data profile. For those elements, the 
cells in the result will contain zeros or the missing value symbol.

Selecting statistics

To select the statistics, click the Statistics button on the tool bar and make your 
selection. It is also possible to select statistics in the Layout window (see above). To do 
so, select the statistics, and then the Settings button. 

Select the statistic you want to view in the table. For a detailed description of the statistics, 
see page 316.

What next?

 See page 306 for how to read your statistics result.

 See page 311 for how to customize your result.

 See page 438 for how to save and export your result.

Saving your analysis settings

You can save the settings specified in the steps above by clicking the Set Default button in 
the Analysis Settings window. If this window is gone, click Settings on top of the result 
window.

Applying settings to a new analysis

If you are about to run a new analysis and want to recall the settings you have specified 
earlier, click the Reset to Default button in the Analysis Settings window. The new settings 
are applied. Click OK to update the results. 

Notes

 If the active data profile does not contain any data, the menu items and buttons for the 
analysis are not available. 
304 Chapter 8 - Calculating Statistics



 An element category is not available on the Layout page if it does not occur in your 
coding scheme or is filtered out in the current data profile.

 Make sure that if you select statistics for numerical modifiers or external data, you also 
select at least one item in the corresponding category.

 The Show combined Modifiers option is not available if you choose Numerical Analysis. 
In that case, numerical modifiers are analyzed separately, that is, each group will 
produce a numerical result. 

 In the Layout page, you cannot de-select behaviors and move behaviors without moving 
their modifiers.

 If you put two or more categories On Sheets, each sheet will contain the statistics related 
to a combination of those elements. For example, if you select On Sheets for both 
Observations and Statistics, each sheet is labeled with the name of an observation and a 
statistic. 

 If you select Independent Variables under On 
Sheets, a separate sheet for each variable is 
appended to the result. In the example below, Statistics and Independent variables have 
been placed under On Sheets. As a result, each statistic and independent variable gets its 
own sheet. 

 If you select Observations under On Sheets and keep Intervals selected, each sheet 
includes the layout for all observations, but only the results for the corresponding 
observation (You have to scroll down the result to find them). To reduce the size of the 
sheets, de-select Intervals. 

 Formats – The number of decimals under Analysis Settings refers to non-time values in 
the statistics result. For example, the mean rate per minute. If you want to specify the 
decimals of time values, see Specifying the time format on page 316.

 Missing values – Missing values are shown for:
- Statistics for events not scored.
- Statistics for events that were scored or external data that was acquired, but not 

included in the active data profile.
- Statistics that cannot be calculated, for example the duration of point behaviors 

(which do not have duration by definition). 

 Time Intervals and Time bins – The border of two connecting time intervals can only be 
used for analysis in one of the two time intervals. Otherwise the data for this data point 
would be duplicated. In general, the Observer uses the left borders (start) of the time 
intervals, while the right borders (end) are used in the analysis of the next interval. In the 
example below the exact data point 0.0 is used in the first interval, 10.0 in the second, 
20.0 in the third and 30.0 is not used in any interval.  
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If your project contains external data, the sample at the exact end of an interval is also 
not included in the analysis. 

 Events scored at the stop of the observation – Events scored at the exact stop of the 
observation are not included in the analysis. This is the case for events scored with 
continuous sampling. Instantaneous samples cannot be scored at the exact stop of the 
observation. 

8.3 The statistics result

The statistics result is created when you click Calculate button on the tool bar, and updated 
every time you choose options in the Layout, Settings or Statistics window and click OK. 

Depending on what you have selected under On Sheets in the Analysis Settings window, the 
analysis result has one or more pages, each containing a table. For example, if you have 
selected Observations in the On Sheets box, each page refers to one observation.  

For information on saving and exporting your results, see page 438. 

reading the statistics result

The data

In each sheet, you can distinguish two main groups of white cells:

 Statistics – Cells containing a statistic for a combination of results container, observation, 
event log, subject, behavior and modifier (see A in Figure 8.3).

Please note that the statistics are rounded. The Observer takes more decimals into 
account than are shown in the results table. 
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 Variables (optional, if you have selected Independent Variables on the Layout page) – 
Cells containing the value of an independent variable linked to a certain observation, 
event log or subject (see B in Figure 8.3). See the note about missing values on page 325. 

The position of the two areas depends on whether the elements are placed in rows, columns 
and sheets (see page 311). For example, if Variables are placed on the columns, the Variables 
area (B) is displayed on the right side of the statistics. If the Variables are placed on Sheets, a 
number of sheets are added where each of them contains the values of an independent 
variable associated to an observation, event log or subject.

The headers

 Main (in blue) – The names of the main categories (Data selection Result Containers, 
Intervals, Observations, Event Logs, Subjects, Behaviors and their Modifiers, and 
Variables; see C in Figure 8.3).

 Secondary (in black) – Show the single element values, for example the name of the 
behaviors (see D in Figure 8.3). 

Figure 8.2 An example of the effect of rounding in the Behavior Analysis depending on how many 
decimals are displayed. The top row shows the results in three decimals, the middle row in two decimals 
and the bottom row in one decimal, with different results for Total duration.
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Header rows and columns are placed in a hierarchical way - Elements of a certain level are 
always below (if placed in columns) or to the right (if placed in rows) of the header of higher 
level. For example:

Observations may contain one ore more Event logs. In the picture below, Observation0002 
includes three event log files. The statistics are shown for each event log. 

Since Observation0001 and Observation0002 have both an event log named Event log0001 
(though it is different data), this name is written only once (“merged”) in the table.

A behavior may be associated with several modifier values. In the picture below, statistics are 
shown for each value of a modifier associated to the behavior Navigation: 

If you add or remove a variable in the Independent Variables List (see page 86), the 
corresponding variable is displayed or removed, respectively.

Figure 8.3 An example of statistics result. A - Cells containing statistics. B - Cells containing the values of 
independent variables. C - Main headers (for example, Observations, Behaviors, etc.). D - Secondary headers 
(list the single values of the elements under a certain main header)
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Understanding <Result Containers>

The Result Containers column or row shows the name of the Result boxes specified in the 
currently active data profile. If you have specified more than one Results box (see page 200 
for an example), each name corresponds to the name of a Results box. Statistics are 
calculated for each data set. 

Understanding Intervals

The Intervals row or column shows the start and end time of the time segments analyzed if 
you have specified intervals or time bins in your data profile. The format is:

 For live observations, the actual time of start and end.

 For observations from video or audio files, the time elapsed since the start of the 
observation. 

Understanding <Missing Subject> and <Missing Behavior>

The <Missing Subject> and <Missing Behavior> rows/columns show the statistics for records 
you have scored with no subject or no behavior. For example, when you score an event with 
no subject, or when you scored comments only. You can only calculate the frequency, rate per 
minute and latency of Missing Behaviors and no durations. This is because durations are 
only calculated for State behaviors that are defined in the Coding Scheme.

 

If you want to view intervals, make sure that Result Containers and Intervals are 
selected in the Layout page of the Analysis Settings window.
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The statistic for that event is shown in the cell corresponding to the behavior row/column 
and the <Missing Subject> column/row.

Understanding <Any Subject>, <Any Behavior>

The <Any Subject> rows/columns show the statistics of events scored for any subject in that 
event log/observation. In the table below, the highlighted cell contains the total duration of 
the behavior Out for <Any Subject>, which equals the sum of the behavior Out for the 
subjects Male and Female. 

The <Any Behavior> rows/columns show the overall statistics of any behavior selected in the 
data profile. In the example below, the <Any Behavior> cell contains the total duration of all 
behaviors. 

You can hide the <Missing Subject> column/row by selecting Subjects with View 
Settings at the far-right on the Component tool bar. In the Subjects window that 
appears, deselect the check box behind <Missing Subject>.
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 The percentage statistics of <Any Behavior> can be greater than 100%. This occurs 
because the percentage of <Any Behavior> is the sum of the percentages of each 
behavior taken separately. If two or more behaviors overlap with each other, the sum 
does not reflect the actual time segment covered by the behaviors. For example, if A lasts 
from 0 s to 60 s, and B from 20 s to 80 s, and the observation duration is 100 s, then the 
sum of the percentages is 60%+60%= 120% even if neither A or B covers the entire 
observation. To have a correct result, merge behaviors in a Data Profile (see page 206). 

 The statistics for <Any Subject> and <Any Behavior> are independent of which behaviors 
you select to display in the Category window (see step 6 on page 303). For example, if you 
de-select a few behaviors in the Category window, the total duration of <Any Behavior> 
is no longer the sum of the durations of the behaviors shown in the table.

Editing the result

You cannot edit the content of the statistics result. If you want to make any changes to the 
result, export it to another program like Excel (see page 440) and then edit it in that 
program. You can alter the layout of the statistics result (see page 302).

Saving a result

To save a result, click the Archive button on the tool bar of the result window. 

To re-open a saved result, from the Analyze menu, select Behavior Analysis or 
Numerical Analysis, then Open Archive. For more information on saving, opening and 
exporting results, see page 438.

Printing a result

To print a result, from the File menu, select Print. We advise you to select the Landscape 
mode prior to printing. Do this in the printer settings or properties.

customizing your result

If you like you can change the decimal symbol, from e.g. point to comma. In the Control 
Panel, select Clock, Language and Region, click Region and Language and open the tab 
Formats. Select a language or click Customize and change the decimal symbol.

Changing your regional settings does not take effect until you restart The Observer XT.

You can customize the following in the Analysis Results:

 Select and sort elements within a Category (see below) – Select Categories and their 
elements to display in the Analysis Results.

To change the position of the main Categories relative to each other, see page 302.
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 Collapse Category elements (see page 313) – You can collapse rows and columns for 
Category elements and display the results as if those elements were grouped. 

 Hide/show single row and columns (see page 315).

 Specify the time format (see page 316).

Selecting and sorting a Category

You can select and sort elements within the following categories: Result Containers, 
Observations, Subjects, Behaviors, Statistics and Independent Variables.

To select and sort one of the Categories:

1. Do one of the following:
- Select the Category with View Settings on the Component tool bar.
- Click the Layout button on the tool bar, make sure that the category is selected and 

then double-click that option.
- To open the Statistics Category, you can also click the Statistics button on the tool 

bar.

2. Next, you can do the following:
- Select the Category elements you want to display in the Analysis Results, de-select the 

Category elements you want to ignore. 
De-selecting elements in this window does not result in removing those Result boxes 
from the data profile.

- To change the order of display, click the Category element you want to move so it 
becomes highlighted and then click the Up or Down button. 

3. Click OK to refresh the Analysis Results.

Notes

 De-selecting a Category element does not result in removing the element in a data 
profile.

 Results Containers – If you de-select Result boxes in the Analysis Settings window, 
intervals are hidden in the Analysis Results.

 Observations – You cannot remove single event logs from observations, or sort them in 
the result. To remove results for event logs, remove those event logs from the data 
profile.

 Subjects – Select <Any Subject> if you want to display statistics for events independent 
of the subject. Select <Missing Subject> if you want to calculate the statistics for the 
missing subject (for example, events for which you only scored the behavior).
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 Behaviors – Select <Any Behavior> if you want to display statistics for events 
independent of the behavior. Select <Missing Behavior> if you want to calculate the 
statistics for events in which the behavior was not scored. You can only calculate the 
frequency, rate per minute and latency of Missing Behaviors and no durations. This is 
because durations are only calculated for State behaviors that are defined in the Coding 
Scheme.

 Statistics – The number and type of statistics displayed depend on whether you have 
chosen Behavior Analysis or Numerical Analysis (see page 300).

 Intervals – If you defined intervals in your data profile and want to have statistics for 
each interval separately, make sure you select the check box in front of Intervals.

Collapsing Category elements

Collapsing Category elements allows you to lump the statistics for different Categories. For 
example, calculate the total number of times an event was scored across all observations. 

1. Do one of the following:
- With View Settings on the Component tool bar, select Rows/Columns/Sheets and de-

select the category you want to collapse.
- Click the Layout button on the tool bar, and de-select the option for the category you 

want to collapse.

2. Click OK to refresh the Analysis Results.

You cannot collapse results for Result Containers and Behaviors. To analyze behaviors as a 
group, merge them first in the data profile (see page 206). 

To collapse statistics for modifiers, click the Layout button and clear the appropriate 
Modifiers option.

Do not group categories if you want to calculate statistics for the external data. 
Doing so may give unexpected results. 

To calculate overall results, you can also group data (see page 245).
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Example 1 – Collapsing observations. In the result below, statistics are displayed per 
observation. For example, the total duration of each behavior. 

After de-selecting Observations, statistics are collapsed into one group, and the 
Observations header is removed. Now the total duration is the duration of each behavior 
across all observations. 

If your observations contain multiple event logs, you can collapse all event logs within each 
observation, and still show observations separately. To do so, click Layout and select 
Observations and de-select Event Logs.

Example 2 – Collapsing modifiers. In the example below, statistics are displayed per modifier 
of the behavior named Navigation. 

Click Layout and in the Analysis Settings 
window clear the Modifiers option under 
Behaviors. After clicking OK, statistics are now 
collapsed into one group for each behavior 
and the Modifiers header is removed. Now the 
total number of occurrences of Navigation is 
shown. 
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Merged numerical modifiers 

Behavior Analysis

If you merge part of your numerical modifiers in a data profile 
and carry out a Behavior Analysis, you get separate results for 
the group and for the modifiers outside the group. As an 
example, you have a numerical modifier Speed, with 
predefined values 1,2,3,4,5,6, and 7. Furthermore, you have 
created a group Slow, which contains the modifiers 1,2, and 3. 
If you carry out a Behavior Analysis, you get the results for 
the group Slow. In addition, you get the results for the modifiers that are not part of the 
group (see picture below).

Merging numerical modifiers makes a nominal group, which means you cannot carry out a 
numerical analysis on the group to calculate for example mean, maximum and minimum 
values.

Hiding and showing rows and columns

To hide rows and columns of your statistics result, 
point the mouse to the header of the row or column 
that you want to remove, right-click and select Hide 
row or Hide column. 

When you hide rows or columns, the row/column 
deleted is always the one at the lowest level selected, 
independent of which cell you right-click. In the 
example below, right-clicking the cell Play under Behaviors results in hiding the row 
corresponding to the modifier Manipulative, not the group of rows corresponding to Play, 
because the mouse pointed the row of the modifier Manipulative.

To show hidden rows and columns, point the mouse to the header of one of the remaining 
rows/columns, right-click and select Show hidden rows or Show hidden columns.
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Specifying the time format

You can customize the format of the time values displayed in the analysis result.

1. From the Setup menu, select Project Settings, then Time formats in the left pane.

2. To set the time mode, select Absolute or Relative from the Project time format list.

3. To set the time format, click the Edit button for the time mode you selected in the previous 
step.

This way you also set the time formats for the lag sequential analysis and reliability 
analysis.

See page 60 for more information.

4. Click OK twice. Next, re-open the analysis.

8.4 Statistics available

The Observer offers a range of statistics that are important to behavioral researchers. For an 
extensive description of these statistics, see, for example, Zar, J.H., Biostatistical Analysis, 
Pearson Education, 2007.

The statistics available depend on the type of analysis you are performing.

Behavior Analysis

If you choose Behavior Analysis, the following statistics are available:

For Continuous Sampling:

 Minimum – See page 319. 

 Maximum – See page 319. 

 Mean – See page 319. 

 Total duration – See page 319.

 Standard deviation – See page 320. 

 Standard error – See page 320. 

 Rate per minute (observation duration) – See page 320.

 Rate per minute (interval duration) – See page 321.

 Rate per minute (observation duration) – See page 320.
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 Rate per minute (interval duration) – See page 321. 

 Rate per minute (analyzed observation duration) – See page 321

 Rate per minute (analyzed interval duration) – See page 321.

 Total number – See page 321.

 Percentage (observation duration) – See page 322.

 Percentage (interval duration) – See page 322.

 Percentage (observation duration) – See page 322.

 Percentage (interval duration) – See page 322.

 Percentage (analyzed observation duration) – See page 322.

 Percentage (analyzed interval duration) – See page 322).

 Latency – See page 323.

 25th percentile – See page 323.

 Median – See page 323.

 75th percentile – See page 323.

For Instantaneous Sampling:

 Proportion (all samples) – See page 325.

 Proportion (scored samples) – See page 325.

 Scored Samples – See page 325.

 Total number (all samples) – See page 325.

 Total number (scored samples) – See page 325.

For Intervals:

 Minimum interval – See page 325.

 Maximum interval – See page 325.

 Number of intervals – See page 325. 

 Interval duration – See page 325. 

 Total interval duration – See page 325.

 Analyzed interval duration – See page 325. 

 Analyzed observation duration – See page 325.
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Numerical Analysis

If you choose Numerical Analysis, the following statistics are available:

 Minimum (both for numerical modifiers and external data) – See page 327. 

 Maximum (both for numerical modifiers and external data) – See page 327. 

 Mean (both for numerical modifiers and external data) – See page 327. 

 Total duration – See page 329. 

 Total value – See page 329. 

 Mean (per minute) – See page 329. 

 Number of samples (only for external data) – See page 327.

 Number of valid samples (only for external data) - See page 327.

 25th percentile – See page 327.

 Median – See page 327.

 75th percentile – See page 327.

You can calculate statistics for Numerical Modifiers only if you have defined a modifier group 
as Numerical (see page 80). 

Note on normally-distributed data

Statistics like the mean and the standard deviation are meaningful when your data are 
normally distributed. However, behavioral data are often not normally distributed. We 
therefore recommend to check whether your data are normally distributed with a statistical 
package. If the data are not normally distributed, you should first transform your data before 
analysis, or use statistics suited for non-normally distributed data, like the median. If you 
have defined intervals in your data selection, this can result in only a small number of 
samples (both in observational and external data), which often is not normally distributed. 
For instance, a mean of values ‘1’, ‘10’ and ‘10’ is not meaningful.

Calculating frequencies of Numerical modifiers – If you want to calculate the 
frequency with which each value of numerical modifiers was scored, or the 
duration of the corresponding event scored, carry out Behavior Analysis instead. 
Make sure that the numerical modifiers are included in the data profile. 
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statistics for behavior analysis

See also important notes on page 325.

Merged data

If you have grouped or merged data in the data profile, the analysis results show the merged 
results. If you have merged data by de-selecting a category in the Layout-page of the Analysis 
Settings window (see page 302), see below under each specific statistic how the number and 
duration are calculated. 

For Continuous Sampling

 Minimum – The shortest duration of each behavior with duration, selected for analysis. 

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the minimum duration is the shortest duration across 
the events in that category.

 Maximum – The longest duration of each behavior with duration, selected for analysis. 

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the maximum duration is the longest duration across 
the events in that category.

 Mean – The total duration divided by the total number of each 
behavior with duration, for each observation/event log selected for 
analysis: 

Where D is the duration of the individual behavior, and N is the 
number of times the behavior occurs. 

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), D and N are summed across all elements in that 
category.

It depends on your sample size how close the calculated mean is to the mean μ of the 
entire population of events. If your data are not normally distributed the statistic mean is 
less meaningful. Since behavioral data are often not normally distributed, we 
recommend you check whether they are with a statistical package. 

 Total Duration – The sum of the duration of all behaviors with duration selected for 
analysis, for each observation and event log. Duration is the observed time between the 
start and the end of a state. 

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total duration is the summed duration of the events 
in that category. 
Chapter 8 - Calculating Statistics 319



 Standard deviation – The sample standard deviation of duration of behaviors selected 
for analysis. 

The standard deviation of a sample expresses to what 
extent the individual measurements of durations depart 
from the overall mean. It is defined as the square root of the 
average of the squared differences between each individual 
value D of the sample and their mean D. 

The formula above is equal to

Where D is the duration of the individual behavior, D the mean duration, N the number 
of occurrences of the behavior.  

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), D and N are summed across all elements in that 
category.

 Standard error – The standard error of the mean (s.e.m.) is the 
measure of the amount of error in the prediction of the 
duration of a particular event from a mean of a sample of size 
N drawn from the population of all possible events. 

Where s is the standard deviation of a sample, and N is the number of occurrences 
(sample size). 

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), D and N used to calculate s and the standard error are 
summed across all elements in that category.

 Rate per minute (RPM) –

The general formula of Rate per minute is:

Rate per minute = (Total number of occurrences / Duration in seconds) * 60.

The value of Rate per minute depends on whether you calculate it over the entire 
observation duration, the analyzed duration or the selected intervals duration. 
- Rate per minute (observation duration) – The mean number of occurrences of a 

behavior (either with or without duration) per minute over the total duration of the 
observation:
RPM (observation) = Total number of occurrences * 60 / Duration of Observation (sec).
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If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total number of events and the total duration 
across the elements in that category are used to calculate the mean rate.
Example – If a behavior was scored 5 and 10 times in two observations of five minutes, 
then the rate will be 1 and 2, respectively. If you de-select Observations in the Layout 
page, the mean rate is:
5+10 occurrences divided by 5+5 minutes = 1.5. 

- Rate per minute (interval duration) – The mean number of occurrences of a behavior 
(either with or without duration) over the total duration of the interval considered. 
The interval is the one you specified in the active data profile:
RPM (interval) = Total number of occurrences * 60 / Interval Duration (sec).
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the rate are summed across all elements in that category.

- Rate per minute (analyzed observation duration) – The mean number of occurrences 
of a behavior (either with or without duration) over the total of the analyzed duration. 
This excludes the time filtered out by data selection and the time the observation was 
suspended.
RPM (Analyzed observation duration) = Total number of occurrences * 60 / Analyzed 
Duration (sec)
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the percentage are summed across all elements in that category.

- Rate per minute (analyzed interval duration) – The mean number of occurrences of a 
behavior (either with or without duration) over the total duration of the interval 
considered. The interval is the one you specified in the active data profile. This 
excludes the time the observation was suspended:
RPM (analyzed interval) = Total number of occurrences * 60 / 
Analyzed Interval Duration (sec).
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the rate are summed across all elements in that category.

 Total number – The number of times the selected event occurs in the observation or 
event log. 

If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total number is the number of times the event 
occurs in all elements in that category.
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 Percentage –

The general formula of Percentage is:

Percentage = Duration of event * 100 / Duration in seconds.

The value of Percentage depends on whether you calculate it over the entire observation 
duration, the analyzed duration or the selected intervals duration.
- Percentage (observation duration) – The percentage of time of an event type (or group 

of) calculated over the total duration of an observation:
Percentage = Duration of event * 100 / Duration of Observation (sec).
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the percentage are summed across all elements in that category.
Example – In two observations of 10 minutes each, the behavior Play is scored for 8 
minutes in the first and 7 minutes in the second. When deselecting Observations in 
the Analysis Setting window, the percentage is (8+7) /(10+10) = 75%. 

- Percentage (Interval duration) – The percentage of time an event type (or group of) 
calculated over the total duration of the interval considered. The interval considered is 
the one specified in the active data profile:
Percentage (interval) = duration of event * 100 / Interval duration.
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the percentage are summed across all elements in that category.

- Percentage (analyzed observation duration) – The percentage of time of an event type 
(or group of) calculated over the total analyzed duration of an observation. This 
excludes the time filtered out by data selection and the time the observation was 
suspended.
Percentage (Analyzed duration) = duration of event * 100 / Analyzed duration 
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the percentage are summed across all elements in that category.

- Percentage (analyzed Interval duration) – The percentage of time an event type (or 
group of) calculated over the total duration of the interval considered. The interval 
considered is the one specified in the active data profile. This excludes the time the 
observation was suspended.
Percentage (analyzed interval) = duration of event * 100 / analyzed interval duration.
If you have grouped data by de-selecting a category in the Layout page of the Analysis 
Settings window (see page 302), the total durations of the events and the observations 
used to calculate the percentage are summed across all elements in that category.
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 Latency – The time from the start of the observation to the first occurrence of a behavior.

When you have created intervals based on data selection, the latency is only calculated 
for the behavior within one of the intervals.

When you want to calculate the time between a behavior and the moment another 
behavior starts, do not use latency. Latency is always calculated from the start of the 
observation. Instead, create an interval by manual selection and calculate the interval 
duration. For example, you want to know the time between the moment the mother 
leaves the room and the baby first starts crying. Create an interval by manual selection 
with the start and stop criteria both based on observational data. Carry out a behavior 
analysis and from the statistics select Analyzed Duration. 

 25th percentile – Twenty-five percent of the events of this type has this duration or lower. 
For more details see Figure 8.5. The 25th percentile is also called the first quartile. 

 Median – Fifty percent of the events of this type have this duration or lower. See Figure 
8.5 for an explanation. The Median is the same as the 50th percentile or 2nd quartile. 

 75th percentile – Seventy-five percent of the events of this type have this duration or 
lower. See Figure 8.5 for an explanation. The 75th percentile is also called the 3rd quartile. 

Calculation of percentiles

The concept of percentiles is explained in Figure 8.4. In this example, 25% of the events 
scored has a duration of 2 s or lower. 50% of the events has a duration of 3 s or lower. The 50th 
percentile is the Median, which is represented by an M in Figure 8.4. 75% Of the events has a 
duration of 4 s or lower. 
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Figure 8.5 explains the calculation of percentiles in more detail. For clarity, a small number of 
events is used in the example. In reality, the percentiles are not meaningful when they are 
based on such a small number of events.  

The event Play was scored eight times. When the duration of the events is sorted, the Median 
(50th percentile) divides the scored events equally. In this example it lies halfway between 4 
and 5 s, which is 4.5. Fifty percent of the events, which is four events, has a duration lower 
than 4.5. In the same way, 25% has a duration lower than 2.5 and 75% has a duration lower 
than 8.

Figure 8.4 The 25th, 50th (Median=M), and 75th percentile. 

Figure 8.5 How the 25th percentile, Median (50th percentile) and 75th percentile 
are calculated. For the Nth percentile, N percent of the events of this type has 
this duration or lower. 
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For Instantaneous Sampling

 Proportion (all samples) – The number of times a behavior has been scored divided by the 
total number of samples in the observation.

 Proportion (scored samples) – The number of times a behavior has been scored divided 
by the number of scored samples. 

 Scored Samples – The number of times a behavior has been scored in an observation.

 Total number (all samples) – The total number of samples in an observation.

 Total number (scored samples) – The total number of scored samples.

Example – A group of 10 animals is observed during an hour with a sample interval 
length of 5 minutes. The Total number (all samples) is ‘12’. For a specific animal, 4 samples 
are missing. Total number (scored samples) for this animal is ‘8’. For this animal behavior 
‘Sit’ has been scored ‘4’ times. Scored samples for ‘Sit’ is ‘4’. Proportion (all samples) = 4/
12=0.33. Proportion (scored samples) = 4/8=0.50.

For intervals

 Minimum interval –   The shortest interval duration.

 Maximum interval – The longest interval duration.

 Number of intervals – The total number of intervals.

 Interval duration – The duration of each interval.

 Total interval duration – The duration of all intervals together.

 Analyzed interval duration – The total interval duration minus the time that the 
observation was suspended.

 Analyzed observation duration – The observation duration, minus the time filtered out 
by the active data profile, minus the time that the observation was suspended.

To analyze each interval separately, select the check box in front of Intervals in the Layout 
page of your Analysis settings.

Notes

 Missing values – Missing values (-) are given for events that did not occur in the 
corresponding observation or interval, or for events that have no duration (see page 73) 
when the statistic describes a duration (Mean, Total duration, Minimum, Maximum, 
Standard deviation, Standard error, Percentage (observation duration) and Percentage 
(interval duration).
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 If your data profile contains intervals or time bins:

Defining intervals or time bins in the data profile (see Chapter 6) may result in an 
interval boundary being somewhere in the middle of an event (Figure 8.6). An event is 
counted twice, once for the first interval and once for the next. When calculating the 
statistics, the Total number statistic is the number of occurrences that an event overlaps 
with an interval or time bin. This means that when you define intervals or time bins the 
total number shown in the result may be greater than the 'true' number of occurrences 
of that event.

 If you have suspended an observation:

If you have suspended an observation (see page 149), the time when the observation is 
suspended is not considered for analysis. For example, if your observation lasted 5 
minutes and it was suspended for 1 minute, then the observed time is 4 minutes. The 
observed time is used for example to calculate the rate per minute. 

statistics for numerical analysis

The statistics listed below are available for numerical modifiers and external data values. For 
calculating the statistics for grouped data, see the note for the specific statistic in Behavior 
Analysis Statistic on page 319). To analyze each interval separately, select the check box in 
front of Intervals in the Layout page of your analysis settings.

Figure 8.6 When you define intervals or time bins, an interval or time bin boundary (dotted line) may be 
placed in the middle of an event (filled bars; see for example the behavior indicated by B). In such a case 
the Total number is the number of unique combinations between events and intervals/time bins. 
Behavior B is counted twice as it occurs in different intervals or time bins.
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 Minimum – The lowest value of a numerical modifier scored.

To calculate the lowest value of external data, select Minimum under External data.

 Maximum – The highest value of numerical modifier scored. 

To calculate the highest value of external data, select Maximum under External data.

 Mean – The arithmetic mean of the values of a numerical modifier scored.

Example – If you have defined the modifier group Face Score as Numerical with values 
ranging from 1 to 5 and you scored values 3, 4, 4, 5 during an observation, then the mean 
reported is 4.

To calculate the arithmetic mean of the values of external data, select Mean under 
External data.

 Number of samples (only for External data) – The number external data samples that are 
included in an interval. This number includes the samples that have a NaN value (missing 
samples).

 Number of valid samples (only for External data) – The number external data samples 
that are included in an interval and have a valid value. The number of valid samples is the 
Number of samples minus the number of samples with a NaN value (missing samples).

 25th percentile – Twenty-five percent of the modifiers of this type has this value or lower. 
For more details see Calculation of percentiles on page 323, with the difference that the 
percentiles in numerical analysis represent modifier values instead of durations. The 25th 
percentile is also called the first quartile. 

To calculate the 25th percentile of the values of external data, select 25th percentile under 
External data.

 Median – Fifty percent of the modifiers of this type has this value or lower. For more 
details see Calculation of percentiles on page 323, with the difference that the 
percentiles in numerical analysis represent modifier values instead of durations. The 
Median is the same as the 50th percentile or 2nd quartile. 

To calculate the median of the values of external data, select Median under External 
data.

 75th percentile – Seventy-five percent of the modifiers of this type has this value or 
lower. For more details see Calculation of percentiles on page 323, with the difference 
that the percentiles in numerical analysis represent modifier values instead of durations. 
The 75th percentile is also called the 3rd quartile.

To calculate the 75th percentile of the values of external data, select 75th percentile under 
External data. 
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Examples of calculation of External data statistics

The calculation of statistics for external data is based on the actual sample points; the 
external data is not interpolated.

The first sample point that coincides with the start of an interval is included in the analysis, 
the last sample point that coincides with the end of the interval is not included in the 
analysis.

Example 1 – You have an observation with external data. In a data profile, you create intervals 
based on observation time / event log data. As a result (see the visualization below), one of 
the intervals contains a number of sample points. For this interval, the numerical statistics 
values of the external data are:
Minimum = ‘98’, Maximum = ‘100’, Mean = ‘98.77’, Number of samples = ‘3’.

Example 2 – You have the same observation with external data as in the previous example. In 
a data profile, you create an Interval by Manual selection with External data values Higher or 
equal to ‘92’. As a result, an interval contains a number of sample points (see the 
visualization below). For this interval, the numerical statistics values for the external data 
are:
Minimum = ‘92’, Maximum = ‘100’, Mean = ‘97.07’, Number of samples = ‘4’.

For external data, all statistics, except for the Number of samples are based on 
the Number of valid samples. Hence missing samples do not influence the value 
of the statistics. 

Do not group categories (see Collapsing Category elements on page 313) if you 
want to calculate statistics for the external data. Doing so may give unexpected 
results. 
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 Total Duration – The total duration of the time when the numerical modifier was scored. 
This corresponds to the sum of the duration of the state behaviors associated to the 
numerical modifier. 

Example – The modifier Score contains five possible values, 1 to 5. After scoring the value 
2 for 1.5 minutes, and the value 4 for 3 minutes, the statistics results show the total 
duration of Score 4.5 minutes in the row/column Score, and the total duration of the 
single values in the corresponding row/columns.

 Total value – The sum of the values of a numerical modifier scored.

The total value for a numerical modifier does not correspond to the Total number of a 
behavior or non-numerical modifier. 

Example – You have scored a numerical modifier four times, with values 12, 13, 18, 17. The 
total value is 60, while the total number (of occurrences) would be 4. 

 Mean (per minute) – The sum of the values of the numerical modifier, weighted by their 
duration (that is, the time the state behavior associated with each value was active), 
divided by the total duration of the state behavior associated. 

Example – The numerical modifier Aggression level was associated with a state behavior 
scored a number of times with values 1 (for a total of 10 seconds), 2 (for 15 seconds), and 3 
(for 5 seconds. Since the total duration of the associated behavior is 30 seconds, the 
Mean is [(1*10) + (2*15) + (3*5)]/30 = 1.83.

The mean is therefore calculated for events with duration only, not for events without 
duration. If a numerical modifier is associated with an event without duration, the mean is 
zero. 
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independent variables

In the Layout window of your Behavior, or Numerical Analysis, double-click Independent 
variables to select them. If you want the observation Start-time, Stop time, or Duration, 
select the check box in front of these independent variables. In addition, the following 
options are available:

 User defined – Select this check box if you want to calculate the effect of your used 
defined independent variables. For example if you want to see whether there is a 
difference in behavior between males and females. Also select the check box in front of 
Independent Variables in your analysis layout tab. You get separate analysis results for 
each independent variable. If you de-select the check box the data are grouped. 

 System variables – Select this check box if you want to show the system defined variables 
Start time, Stop time and Duration. 

8.5 Analyzing observations containing multiple 
event logs

There are two possibilities:

 Event logs overlap in time within an observation – There is no gap between start and 
stop of different event logs in the same observation. 

Choose this option also when the stop time of an event log is the same as the start time 
of another event log (see below). 

 Event logs do not overlap in time (see page 333) 
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event logs overlapping in time

This section applies to those cases when there is no gap between event logs within an 
observation (see the first picture on the previous page). 

How do you want to analyze the event logs in each observation? 

 As separate data sets, so each event log produces one result – See below. 

 As one data set, so all event logs within an observation are collapsed in one result – See 
page 332.

Event logs as separate data sets

In the Project Explorer under Analysis, click Behavior Analysis. Click Layout and make sure 
that both Observations and Event Logs are selected. Next, click OK. 

 If you have not defined intervals and time bins in your data profile:
- Total number and duration statistics – These are calculated per event log. 
- Rate per minute (observation duration), Percentage (observation duration) – These are 

based on the duration of the corresponding event log.
- Rate per minute, (analyzed observation duration), Percentage (analyzed observation 

duration) – These are based on the duration of the event log, excluding the time that 
the observation was suspended and the time filtered out by data selection. 

 If you have defined intervals or time bins in your data profile: 
- Total number and duration statistics – They are calculated per interval and event log. 
- Rate per minute (interval duration), Percentage (interval duration) – These are based 

on the duration of the interval. 
- Rate per minute, (analyzed observation duration), Percentage (analyzed observation 

duration) – These are based on the duration of the event log, excluding the time that 
the observation was suspended and the time filtered out by data selection. 

- Rate per minute (analyzed interval duration), Percentage (analyzed interval duration) – 
These are based on the time line set by data selection, excluding the time that the 
observation was suspended. The duration of the interval is not necessarily the same as 
analyzed duration, for example when more than two or more separate intervals split 
the event log in different sections.

To analyze each interval separately, select the check box in front of Intervals in the Layout 
page of your analysis settings.
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Event logs as one data set

In the Project Explorer, under Analyses, click New Behavior Analysis. Click Layout and make 
sure that (1) Observations is selected, and (2) Event Logs is NOT selected. Next, click OK. 

 If you have not defined intervals and time bins in your data profile:
- Total number and duration statistics – They are calculated per event log, then summed 

up. 
- Rate per minute (observation duration), Percentage (observation duration) – These are 

based on the time from the earliest start of any event log to the latest stop of any 
event log. 

- Rate per minute (analyzed observation duration), Percentage (analyzed observation 
duration) – These are based on the time from the earliest start of any event log to the 
latest stop of any event log, excluding the time the observation was suspended and 
the time filtered out by data selection. 

Percentage (interval duration) is calculated over the entire duration of the 
interval, not the part of the event log falling within the interval. This may give 
unexpected results when the event log does not cover the entire interval 
duration. If you want to calculate the percentage relative to the event log only, 
select a different type of interval (for example with Selecting intervals by 
behavior) or use Percentage (observation duration).

If there is much overlap between event logs and the same event type is 
scored in different event logs, Rate is overestimated. For example, two 
event logs of one minute each are completely overlapping and each 
contains four instances of Play. When analyzing event logs as one data set, 
Rate is (4+4) events / (1 minute) = 8 instances per minute, while in each 
event log it would be 4/minute.

If there is much overlap between event logs and the same event type is 
scored in different event logs, Percentage (observation duration or 
analyzed duration) may exceed 100%. For example, two event logs of one 
minute each are completely overlapping, and each contains the event Play 
scored for 40 seconds and 30 seconds respectively. When analyzing event 
logs as one data set, Percentage is (30+40 s) / 60 s = 117%, while in each 
event log Play cannot be more than 100%.
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 If you have defined intervals or time bins in your data profile: 
- Total number and duration statistics – They are calculated per interval and event log, 

then summed up. 
- Rate per minute (interval duration), Percentage (interval duration) – These are based 

on the summed duration of the intervals. To analyze each interval separately, keep 
Intervals selected in the Layout page of your Analysis settings.

- Rate per minute (analyzed observation duration), Percentage (analyzed observation 
duration) – These are based on the time from the earliest start of any event log to the 
latest stop of any event log, excluding the time the observation was suspended and 
the time filtered out by data selection. 

- Rate per minute (analyzed interval duration), Percentage (analyzed interval duration) – 
These are based on the time from the earliest start of any event log to the latest stop 
of any event log, excluding the time the observation was suspended. If overlapping 
event logs generate overlapping intervals, these are merged along the time line to 
calculate the analyzed duration. 

To analyze each interval separately, select the check box in front of Intervals in the Layout 
page of your Analysis settings.

event logs not overlapping in time

This section applies to those cases when there is a gap between event logs within an 
observation (see the second picture on page 330). 

How do you want to analyze the event logs in each observation? 

 As separate data sets, so each event log produces one result – See below. 

 As one data set, so all event logs within an observation are collapsed in one result – See 
page 334. 

Event logs as separate data sets

In the Project Explorer under Analyses, click New Behavior Analysis. Click Layout and make 
sure that both Observations and Event Logs are selected. Next, click OK. 

Percentage (interval duration) is calculated over the entire duration of the 
interval, not the part of the event log falling within the interval. This may 
give unexpected results when the event log does not cover the entire 
interval duration. If you want to calculate the percentage relative to the 
event log only, define an interval that only includes the event log.
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 If you have not defined intervals and time bins in your data profile:
- Total number and duration statistics – They are calculated per event log.
- Rate per minute (observation duration), Percentage (observation duration) – These are 

based on the duration of the corresponding event log. 
- Rate per minute (analyzed observation duration), Percentage (analyzed observation 

duration) – These are based on the time line set by data selection, excluding the time 
that the observation was suspended.

 If you have defined intervals or time bins in your data profile: 
- Total number and duration statistics – They are calculated per interval and event log. 
- Rate per minute (interval duration), Percentage (interval duration) – These are based 

on the duration of the interval. To analyze each interval separately, keep Intervals 
selected in the Layout page of your analysis settings. 

- Rate per minute (analyzed observation duration), Percentage (analyzed observation 
duration) – These are based on the time line set by data selection, excluding the time 
that the observation was suspended.

- R ate per minute (analyzed interval duration), Percentage (analyzed interval duration)- 
These are based on the time line set by data selection, excluding the time that the 
observation was suspended. The duration of the interval is not necessarily the same as 
analyzed duration, for example when more than two or more separate intervals split 
the event log in different sections.

To analyze each interval separately, select the check box in front of Intervals in the Layout 
page of your Analysis settings.

Event logs as one data set

In the Project Explorer under Analyses, click New Behavior Analysis. Click Layout and make 
sure that (1) Observations is selected, and (2) Event Logs is NOT selected. Next, click OK. 

Keep Intervals selected in the Layout page of your Analysis settings.

Percentage (interval duration) is calculated over the entire duration of the 
interval, not the part of the event log falling within the interval. This may give 
unexpected results when the event log does not cover the entire interval 
duration. If you want to calculate the percentage relative to the event log 
only, use Percentage (observation duration).
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 If you have not defined intervals and time bins in your data profile:
- Total number and duration statistics – They are calculated per event log, then summed 

up.
- Rate per minute (observation duration), Percentage (observation duration) – These are 

based on the time from the earliest start of any event log to the latest stop of any 
event log, excluding the gaps between event logs. 

- Rate per minute (analyzed observation duration), Percentage (analyzed duration) – 
These are based on the time from the earliest start of any event log to the latest stop 
of any event log, excluding the gaps between event logs, AND the time filtered out by 
data selection and the time that the observation was suspended. 

 If you have defined intervals or time bins in your data profile: 
- Total number and duration statistics – They are calculated per interval and event log, 

then summed up. 
- Rate per minute (interval duration), Percentage (interval duration) – These are based 

by the total duration of the intervals. To analyze each interval separately, keep 
Intervals selected in the Layout page of your analysis settings. 

If two or more intervals have been defined, you can get unexpected results 
in the calculation of the Rate in the following cases:

 If one or more event logs partly fall outside some intervals. Since the Rate 
is calculated over the entire duration of all intervals, the duration also 
includes intervals that fall outside these event logs. So the Rate is 
underestimated. To correct for this, click Layout and de-select Intervals. 

 If the same events occur in the same intervals in different event logs. If you 
select Intervals in the Layout tab, the events are summed. This may result 
in a Percentage (interval duration) higher than 100%. If you deselect 
Intervals in the Layout tab, the events are Merged. If the same event 
occurs at the same time in different event logs these are only counted 
once. So the Rate is underestimated. To correct for this, select Event log in 
the Layout tab.

Percentage (interval duration) is calculated over the entire duration of the 
interval, not the part of the event log falling within the interval. This may 
give unexpected results when the interval is longer than the event logs. If 
you want to calculate the percentage relative to the event logs only, define 
an interval that only includes the event logs.
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- Rate per minute (analyzed observation duration), Percentage (analyzed duration) – 
These are based on the time from the earliest start of any event log to the latest stop 
of any event log, excluding the gaps between event logs AND the time filtered out by 
data selection and the time that the observation was suspended. 

- Rate per minute (analyzed interval duration), Percentage (analyzed interval duration) 
– These are based on the time line set by data selection, excluding the gaps between 
event logs AND the time that the observation was suspended. The duration of the 
interval is not necessarily the same as analyzed duration, for example when more than 
two or more separate intervals split the event log in different sections.

To analyze each interval separately, select the check box in front of Intervals in the Layout 
page of your Analysis settings.

8.6 Creating charts

From the analysis results, you can create charts to visually inspect your results. 

In order to create a chart, you must have analysis results in your project, either archived or 
currently open on your screen.

The procedure for creating charts is as follows:

1. Do one of the following:
- In the Project Explorer, click New Behavior Analysis or New Numerical Analysis to 

display the data you want to use to create a chart.
- From the Analyze menu, select Behavior Analysis or Numerical Analysis and select 

Create Chart. Select one of the archived results. This option is only available if you have 
archived analysis results. 

2. If necessary, change the layout of the analysis results sheet (see below), so the data is 
sorted appropriately for the type of chart you want to create.

3. Select the data in the analysis results sheet (see selecting data on page 339), click the 
Charts button in the tool bar and select the type of chart (see selecting a chart type on 
page 339).

4. Next, you can:
- Add or remove series from the chart (page 340).
- Edit the chart (page 339).
- Save the chart within The Observer XT (page 341).
- Export the chart as an image (page 342).
- Print the chart (page 343).
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customizing the analysis results sheet

Depending on the type of chart you want to create and how you want to display your data, 
you might need to change the layout of the analysis results sheet.

What layout do I need?

The Observer XT uses the data in rows in the analysis results sheet for the Series values and 
the row headers closest to the data are used for the Horizontal Axis (Categories) names. 
Furthermore, the column headers closest to the data are used for the Legend (Series) names.

To create this layout, make sure that in the Layout tab of the Analysis settings window:

 Behaviors (and Modifiers) are On Columns;

 Groups you want to compare are On Columns.

 Statistics are On Rows.

 Behaviors (and Modifiers) or groups are at the bottom in the order of categories On 
Columns (see Figure 8.7 for an example).

For more details about how to customize the layout of the Analysis Results see page 311.

Figure 8.7 Example of Analysis settings layout (top-picture) and the corresponding analysis results 
(bottom-picture).
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The resulting chart for the mean values for the different types of Play behavior (based on the 
layout as displayed in Figure 8.7) is shown in Figure 8.8 below.

Example 1 – You have three observations which contain event data of the same group of five 
animals. The observation were carried out in three consecutive weeks. You have used 
Instantaneous sampling as the observation method. You want to create a bar chart with the 
statistic for locomotion averaged per group, per observation. To do this, use the following 
Layout in the Analysis Settings:

 On Columns – Behaviors.

 On Rows – Statistics, Observations (at the bottom in the order).

Do not select the Instantaneous Sampling Subjects in the Analysis settings Layout tab. As a 
result, the statistics are averaged per observation and not displayed per animal.

Example 2 – You have observed groups of children containing only boys or girls. Type of group 
(boy, girl) is a user-defined Independent Variable. You want to display the play behavior of 
the groups based on the Type of group. First, in the data selection, you need to create two 
Results boxes, one containing the boy groups, the other one the girl groups. Next, use the 
following Layout in the Analysis settings:

 On Columns – Behaviors.

 On Rows – Statistics, Result Containers (at the bottom in the order).

Do not select the Instantaneous Sampling Subjects in the Analysis settings Layout tab. As a 
result, the statistics are averaged per Type of group and not displayed per group.

Figure 8.8 Example of a bar chart in 
The Observer XT. The chart is based on 
the data layout as depicted in 
Figure 8.5. 
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selecting data

To create a chart:

1. Select values in one or more adjacent columns in the analysis results as follows: click the
top-cell of a column with the mouse, keep the mouse-button pressed and move it to the
bottom-cell of the same or an adjacent column.

selecting a chart type

2. Next, click the Charts button to select a chart. 

You can select one of the following:
- Column chart – with five different methods to display multiple series.
- Line chart – with or without markers.
- Pie chart – 2D or 3D.
- Scatter chart.

3. Click OK to create the chart.

You cannot change the chart type of an existing chart. If you want to change the chart type, 
you need to create a new chart.

If you close the Chart window by using the close button, you get the option to save the chart. 
If you click No, the chart is deleted. See page 341 for how to save a chart.

editing a chart

Adding Series
1. In the Chart window, click Select Data.

2. In the Select Data window, click Add.

3. In the Add Series window, in the Series Values box, click the Select Range button.

4. In the analysis results sheet, select the values as described in selecting data on 
page 339.

To select multiple, non-adjacent columns, press the Ctrl-button and select the 
columns as described above.
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5. Click Select Range again.

The header of the column is now automatically added in the Series name box. If you 
want, you can change this name.

6. Click OK to add the series.

Go back to step 1 to add another series.

7. Click Close when you are done adding series.

Removing Series
1. In the Chart window, click Select Data.

2. In the Select Data window, select the Legend (Series) name and click Remove.

Editing Category names
1. In the Chart window, click Select Data.

2. Click a Horizontal Axis (Categories) name and click the Edit button (or press F2).

Formatting a chart

To change the format of a chart, in the Chart window, click Format.

In the Chart Properties window, the menu on the left shows the Chart Properties items. 
Simply click on a item or sub-item to select it. The pane on the right shows the options for 
the selected item or sub-item.

The main items are:

 General – in which you have the following options:
- Chart Title – Display the chart title, you can enter a title and select the font type, size, 

color and position of the chart title.
- Legend – Display the Legend (Series) name and select the font type, font size and 

position of the legend. You can also select to Show the legend without overlapping the 
chart.

- Data Labels – Display the value for each data point in the chart.
- Smoothing – Smooth-line charts are similar to line charts. The main difference is that 

the line segments between the successive data points are not straight lines but 
interpolated cubic splines.

You can immediately see the effect without closing the Properties window by 
clicking the Apply button at the bottom-right.
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 Axes – in which you have the following options:
- Vertical – Under Axis title, you can choose to display the axis title, you can enter a title 

and you can select the font type, size and color. Under Scale, you can set the scaling of 
this axis to Auto or setting the Minimum and Maximum manually by selecting Fixed 
and entering the minimum and maximum. Under Gridlines, you can choose to display 
major and minor gridlines. For the major gridlines, enter a value (for example, a value 
of ‘10’ displays a major grid line at every external data value ‘10’). For the minor grid 
line, enter the number of lines you want to display between two major gridlines.

- Horizontal – The Horizontal axis has the same options as the Vertical axis.

 Series – For each series (listed under Series), you have the following options:
- Fill – You can choose between Solid fill and Pattern. Depending on what you select 

here, you can next choose a Color and/or a Pattern. You can also select the 
Transparency of the chart.

- Borders – Display borders and also select the border Color, Style and Weight.
- Trendline – You can add a linear trendline for column charts (except stacked and 3D 

charts), line charts and scatter plots. You can add a trendline for each series separately 
by selecting the option Display linear trendline. Optionally, you can specify the name 
of the trendline and its line style (color, style and weight).

saving a chart

You can save a chart in the corresponding Analysis Results:

1. In the Chart window, click Save Chart in Archive.

If the analysis results have not been saved in an archive yet, Save archive window 
appears in which you can save the Analysis Results.

2. In the Analysis Chart window, you can type in the name of the chart you want to save.

3. Click OK to save the chart.

The chart is added to the corresponding archived analysis result in the Project Explorer.
Chapter 8 - Calculating Statistics 341



Opening a chart

To open an archived chart, in the Project Explorer, click an archived chart. 

Deleting a chart

To delete an archived chart, in the Project Explorer, right-click an archived chart and 
select Delete.

Renaming a chart

To rename a chart, in the Project Explorer, right-click an archived chart and select Rename 
and enter a new name.

Notes

 Make sure that the Analysis Results name and the Chart name do not contain any of the 
following characters: \ / : ; * ? " < > |.

 You can create multiple charts in an archived Analysis Results.

 If the legend overlaps with the chart, make sure to select the option Show the legend 
without overlapping the chart in the General item, under the Legend sub-item of the 
Chart Properties (see the previous page).

exporting a chart

You can export a chart to the clipboard. Make sure the Chart window is active, press Ctrl+C 
and press Ctrl+V to paste it into another program.

You can also export a chart to disk as a graphics file:

1. In the Chart window, click Export.

2. Enter a File name and select a image type from the Save as type list: JPEG (*.jpg), 
Portable Network Graphics (*.png), Windows Bitmap (*.bmp), Tagged Image File Format 
(*.tiff).

3. Click Save.

If you have saved a chart in the active analysis results, the program closes the 
active analysis results and opens the newly created analysis result. If you want 
to create multiple charts in the active analysis results, make sure you first open 
the archived analysis results.
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printing a chart

To print a chart:

1. In the Chart window, click Print.

2. In the Print preview window, make the necessary changes and press the Print 
button.
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9.1 Before you start

The terms Subject, Behavior, Modifier and Independent Variable in this chapter may not be 
the same as those on your screen. This depends on what terms you have specified in your 
project's Terminology Preferences (see page 93). 

what is lag sequential analysis?

In The Observer XT, Lag Sequential Analysis calculates the frequency of transitions between 
pairs of events within a certain lag. Lag Sequential Analysis allows you to answer questions 
like:

 How many times is the event Mother Smiles followed by the event Baby Smiles?

 How likely is the dog's behavior Ignores Trainer preceded by each type of command by 
the trainer? 

The first event of the pair is called Criterion and the second Target. Depending on what 
direction in time you choose (positive or negative), you can calculate how often the event A is 
followed by B, or how often A is preceded by B, and in relation to other behaviors (see Time 
lag below).

state lag vs. time lag analysis

Transitions between events can be of two ways (Figure 9.1):

 Transitions between events that directly follow each other or are separated by a specific 
number (lag order) of other events. For example, from an event to the next one (lag order 
1), or to the second next (lag order +2), the third next etc. This is State lag sequential 
analysis. You can calculate transitions with a lag order from -9 to +9. The time between 
the Criterion and the Target does not influence your results.

 Transitions between events within a specific time window, independent of how many 
events are between them. This is Time lag sequential analysis. You can calculate 
transitions for example from an event to those events occurring in the next 10 seconds. 
Since there may be more than one Target event in that 10-s window, Time lag analysis 
generates multiple transitions from the same Criterion (see Figure 9.1).

.
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9.2 Procedure overview

1. Make sure that the data profile specifying the data you want to analyze is active, that is,
highlighted in blue in the Project Explorer. 

To edit a profile, click it in the Project Explorer and make the necessary changes. For more 
information on how to select data, see Chapter 6. 

2. Do one of the following: 
- From the Analysis menu, select Lag Sequential Analysis, then New.
- In the Project Explorer, click the Analyses folder. In the overview window of The 

Observer XT that appears, select Analyze data. In the window that opens click Lag 
sequential analysis.

- In the Project Explorer under Analyses, click Lag Sequential Analyses and then New Lag 
Sequential Analysis.

Figure 9.1 State lag sequential analysis versus Time lag sequential analysis. This is a very general 
example - events may have duration or not, and may belong to the same or different behavior groups. 
For time lag analysis, a time lag is defined for each criterion event. Filled squares: criterion events (for 
simplicity, only the first event in the sequence is considered as Criterion). Arrows: transitions.
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Result – A table with question marks appears. Click the Calculate button on the tool bar 
to perform the analysis. By default, the table contains a State lag analysis with 
frequencies. 

Changing the Settings
1. To change the lag sequential analysis settings, click the Settings button on the tool bar.

The Settings window opens (see Figure 9.2). Under Lag Type select one of the following
(see page 346 for information on lag type):
- State Lag – To perform state lag sequential analysis.
- Time Lag – To perform time lag sequential analysis. 

Figure 9.2 The Settings page of the Lag Sequential Analysis Settings window.
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2. If you have selected State lag, enter the lag order you want analysis to be based on. For 
example, to analyze transitions from each event to the next one enter 1. If you want to 
calculate transitions from each event to the second next, enter 2. If you want to calculate 
transitions from each event to the previous third event, enter -3. By default, 1 is selected. 
Go now to step 6.

3. If you have selected Time lag, enter the limits of the time window (see an example in 
Figure 9.1). This time window will be applied to each Criterion event. By default, From 0 to 
1 sec is selected, that is, transitions are counted from each event to any event occurring up 
to 1 second later. Change the time unit if necessary (available: ms, sec, min, hr).

You have the following options:
- Ignore recurring criteria – Select this option if you want to exclude instances of a 

criterion event that occur in the same time lag. For more information, see page 355.
- Ignore recurring targets – Select this option if you want to exclude second, third etc. 

instances of a target event that occur within the same time lag. For more information, 
see page 355. 

4. Select Restrict lag to Subject-Behavior group if you want to calculate the transitions 
within subject and behavior groups.

Example – Select this option to calculate transitions within the behavior groups 
Locomotion and Social behavior, that is, from an event of Locomotion to another event of 
Locomotion, and from an event of Social behavior to another event of Social behavior, 
not from an event of Locomotion to an event of Social behavior (or vice versa). 

If you leave this option cleared, transitions are calculated regardless of which group 
events belong to.

5. Under Calculate, select one of the following:
- Frequency – Select this option if you want to calculate the number of transitions from 

the criterion event to the target event. Frequencies are computed for each 
combination of criterion event and target event. 

- Probability – Select this option if you want to calculate the probability of transitions. 
The transition probability is the number of transitions for a particular combination of 
criterion event and target event divided by the total number of transitions from that 
criterion event. The sum of the transition probabilities for each criterion event equals 
1. For information on how to read probabilities in the results, see page 357. 

Select the Only show when greater than option if you want to show only the transition 
probabilities that are greater than a specific threshold. Enter this threshold (1 - 100%) in 
the corresponding field.
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6. Select the following:
- Show missing values as – Choose the character you want to have displayed for missing 

values, that is, cells in which transitions are not calculated. For example, transitions 
between behaviors of different groups when you have selected the Restrict lag to 
Subject-Behavior group option.

- Number of decimals – Choose the number of decimals in the matrix cells. This option 
is only available if you have chosen Probability under Calculate. 

Layout
1. To change the table layout, click the Layout button on the tool bar. In the Layout window

that opens (Figure 9.3) you specify what the resulting transition matrix will look like.
Select the type of elements you want to view on rows, columns and separate sheets.
Clear the selection for any element type you do not want included in the matrix.
- Under Criterion, select the element types that you want to view on the rows.
- Under Target, select the element types that you want to view on the columns.
- Under On Sheets, select the element types you want to view in separate sheets.

Figure 9.3 The Layout page of the Lag Sequential Analysis Settings window.
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To move a category to a different box, click its name and then click the appropriate arrow 
button, or drag it to that box. 

Example – If Observations is selected under On Rows or On Columns, this will 
produce a single, very large transition matrix. To have a transition matrix for each 
observation, click Observations, then click the arrow button pointing to the On 
Sheets box.

If you select Observations under On Sheets and keep Intervals selected, each sheet 
includes the layout for all observations, but only the results for the corresponding 
observation (You have to scroll down the result to find them). To reduce the size of the 
sheets, de-select Intervals. 

2. Sort the matrix (optional) – You can sort the matrix by the main categories by 
changing their position within either the Criterion box or the Target box (Top = 
highest hierarchical level). To do so, select an item you wish to move and click the 
appropriate Up or Down button at the bottom of the list. 

Alternatively, drag the category that you want to place to a higher level to a category that 
you want to place to a lower level.

3. Select elements within a category (optional) – If you want to remove some items 
in a category, click that category and then click the settings button. 

De-select the option for the item you do not want to show in the matrix. 

De-selecting an entire category in the Layout page equals to calculate the results for the 
elements summed up (but see a note on event logs below). For example, if Subjects is not 
selected, all subjects in an observation are treated as one.

You can:
- Put independent variables either on rows or columns.

If you defined a range of numerical modifiers instead of predefined values, 
many different values may have been scored. If you subsequently carry out a 
Lag Sequential Analysis, this may result in many cells in the analysis result. 
This may especially happen if you have numerical modifiers with several 
decimals, or if you have imported external data as numerical modifiers. The 
maximum number of columns and rows is 1000 x 1000. If the number of 
numerical modifiers exceeds 1000, The Observer XT will show a warning and 
no Lag Sequential Analysis is carried out. You can reduce the number of cells 
with a Data Selection.
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You cannot:
- De-select behaviors. 
- Put subjects, behaviors, and modifiers on only one side of the matrix (Criterion or 

Target). Once you select them on one side, they are selected on the other side too.
- Put subjects, behaviors and modifiers on the sheets.
- Change the hierarchy between elements on one side. If you do so, it is changed on the 

other side.

4. Additional options – Select the following:
- Show not scored elements – Select this option if you want to have all elements of your 

coding scheme shown in the matrix, including those you have not scored in any 
observation. For not scored elements, cells will contain zeroes or the missing value 
symbol (see step 8). If you keep this option cleared, the matrix lists the elements 
scored in at least one observation. 

- Show intervals as – If you have defined intervals of time bins in your data profile (see 
Chapter 6), you can split your transition matrix in more parts, each corresponding to 
an interval or time bin. Select one of the options Intervals only, Time bins only or 
Intervals and Time bins according to how you want to split the matrix. If your data 
profile does not contain Intervals or time bins, any option has no effect on your result. 

What next?

 See page 360 for how to customize your result.

 See page 440 for how to export your result. 

more details and options

Transition with start and stop events

Transitions indicate a change from one event (Criterion) to another (Target) in a temporal 
sequence. In the case of state behaviors, which have a start and a stop event, transitions are 
always counted using start events only, even if you have coded the end event manually. 

Analyzing transitions across event logs

Lag sequential analysis is performed on each event log separately. If an observation contains 
multiple event logs, and you de-select Event Logs in the Layout page of the Lag Sequential 
Analysis window, transitions are counted within each event log, and then summed up in the 
transition matrix. Transitions across event logs are not calculated. 

To calculate transitions like for example from event Game starts, scored in the event log 
“Event log 0001”, to event Happy, scored in the event log “FaceReader States” imported from 
FaceReader, follow an alternative procedure:
352 Chapter 9 - Lag Sequential Analysis



1. In your data profile, define Intervals by manual selection (page 221). Under Begin Interval,
specify the event you want to use as a criterion (in the example above Game starts).
Under End Interval specify the end of the same event (if you want to analyze transitions
as long as the event occurs) or a time value (if you want to apply a time lag; do this if
Game starts is an event without duration).

2. Calculate statistics with this data profile. Make sure that you include the Total number as 
a statistic (see page 301). This is the number of times that a behavior occurs in the 
intervals specified. It provides results similar to time lag sequential analysis.

Defining the State lag

A positive value of lag order N means that the program counts N events forward in time from 
the Criterion event. The transition is established from the criterion to the Nth event. A 
negative lag order means that the programs counts events back in time. 

Example – The picture below shows events plotted along the time line. The example is 
general, including the case of a 'gap' between events - this occurs when events are filtered 
out in the data profile, or with event in a behavior group in which behaviors can overlap 
(start-stop).

 Entering +1 as State lag results in the following transitions to be counted (see the arrows 
in the picture above):

From [no event] to 0.0 Gaze elsewhere, from 0.0 Gaze elsewhere to 5.00 Gaze object, 
from 5.00 Gaze object to 7.00 Gaze mother, from 7.00 Gaze mother to 16.00 Gaze 
elsewhere, from 16.00 Gaze elsewhere to 18.80 Gaze mother, from 18.80 Gaze mother to 
[no event]. 

Transitions are also counted when a criterion is found but not the target, or the other 
way round. In the example above, from [no event] to 0.0 Gaze elsewhere, and from 18.80 
Gaze mother to [no event]. See page 358 for details.
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 Entering -3 as State lag results in the following transitions to be counted:

From 7.00 Gaze mother (first event available for counting backward with lag -3) to [no 
event], from 16.00 Gaze elsewhere to 0.0 Gaze elsewhere (third previous event), from 
18.80 Gaze mother to 5.00 Gaze object, from [no event] to 7.00 Gaze mother. 

If the state lag is negative, it is easier to count transitions from the end to the begin of a 
sequence. 

If there is a gap between events, the program does not count transitions from an event 
to the gap that follows. See also page 358 for special cases.

Defining the Time lag

The time lag can be negative, positive or partly negative and partly positive (for example, 
from -2s to +2s around each event). Transitions are counted from an event to another event 
starting within the time lag. 

Example – The picture below shows events are plotted along the time line. The example is 
general, including the case of a 'gap' between events - this occurs when events are filtered 
out in the data profile, or with events in a behavior group type in which behaviors can 
overlap (start-stop).

Entering From 0 sec to 5 sec next to Time lag results in the following transitions (in the 
picture, horizontal arrows indicate the 5-s time lag for each event):

From [no event] to 0.0 Gaze elsewhere, from 0.0 Gaze elsewhere to [no event] (this because 
no event is found in the 5-s lag), from 5.00 Gaze object to 7.00 Gaze mother, from 7.00 Gaze 
mother to [no event], from 16.00 Gaze elsewhere to 18.80 Gaze mother, from 18.80 Gaze 
mother to [no event]. 

Note that:

 Transitions are also counted when no event is found in the time lag, (in the example 
above, see the transition from 0.0 Gaze elsewhere to [no event]), or at the start and end 
of the observation. In the example above, from [no event] to 0.0 Gaze elsewhere, and 
from 18.80 Gaze mother to [no event]. See page 358 for details. 

 If there is a gap between events, the program does not count transitions from an event to 
the gap that falls in its time lag, unless there is no event at all in that lag. See also 
page 358 for special cases.

 When the time lag is partly negative and partly positive, transitions are calculated from 
the focal event to the events that precede or follow it.
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Ignoring recurring criteria

If you select the Ignore recurring criteria option, all events of the same type as the criterion 
that occur within the time lag are ignored as criterion events. Select this option when events 
of the same type occur next to each other, and you want to make sure that transitions from 
those events are not counted twice.

Example – In a time lag of 0-5 s of the criterion event 8.50 
Talk the program finds another occurrence of Talk at 11.66 
s. If you select Ignore recurring criteria, This event is 
ignored as a criterion. Therefore, the transition from 8.50 
Talk and 11.66 Talk is counted, however there will be no 
transition from 11.66 Talk to any event following it within 
its time lag.

If the time lag is at least partly negative, the recurring 
criteria are ignored that occur within a time interval 
around the focal criterion whose length is twice as long as the longest side of the time lag. 
For example if the time lag is set to from -10 s to +5 s, selecting Ignore recurring criteria 
removes the recurring criteria from -10 s to +10 s for each focal criterion. If the time lag is set 
to from -3 s to +5 s, recurring criteria are removed from -5 to +5 s around each focal criterion. 

Ignoring recurring targets

If you select the Ignore recurring targets option, the second, third etc. instances of the same 
target within the time lag are ignored. Select this option when events of the same type occur 
next to each other, and you want to make sure that multiple transitions to those events are 
not counted. 

Example – A 4-seconds time lag of the criterion 
event 7.30 Eye contact includes two occurrences 
of Talk, at 8.50 s and 9.50 s. If you select Ignore 
recurring targets, the second Talk is ignored as a 
target. Therefore, the transition from 7.30 Eye 
contact and 8.50 Talk is counted, not from 7.30 
Eye contact to 9.50 Talk.

Note that 11.66 Talk is outside Eye contact's 
time lag, therefore a transition from 7.30 Eye 
contact to 11.66 Talk is not counted. Rather, a transition from 8.50 Talk to 11.66 Talk is counted 
when 8.50 Talk is considered as a criterion. 

If the time lag is at least partly negative, the recurring targets are also removed in the 
negative part of the lag. 
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Lag sequential analysis and Instantaneous sampling

If you have collected data with Instantaneous sampling, samples not scored are not taken 
into account when calculating transitions. For example, the sequence of samples (sample 
interval = 10 s):
0.0 A
10.0 - (not scored)
20.0 B
Results in a transition from 0.0 A to 20.0 B. This is the same result as if A and B were scored 
with Continuous sampling. 

Saving your analysis settings 

You can save the settings specified in your analysis by clicking the Set to Default button in 
the Lag Sequential Analysis Settings window. If this window is gone, click Settings on top of 
the result window and click Set as Default in the window that appears. 

Applying settings to a new analysis

If you are about to run a new Lag Sequential Analysis and want to recall default settings 
specified earlier, click the Reset to Default button in the Lag Sequential Analysis Settings 
window. The new settings are shown in this window. 

Miscellaneous

 If you cannot visualize results for an observation, it could be due to the observation 
containing errors (see page 147).

 To re-run the analysis with different settings or matrix layout, click the Settings or Layout 
button, make the necessary changes and click OK.

 If an element category does not occur in your coding scheme or is filtered out in the 
current data profile, it is grayed out in the Layout page of the Analysis Settings window.

 Result Containers in the Layout page of the Lag Sequential Analysis Settings 
window specifies the name of the result containers in your data profile (see 
page 200). If your data profile contains two or more result containers, you cannot 
clear this selection. If you want to have some of the result containers, not others, in the 
result, in the Layout page double-click Result Containers or click Result Containers and 
then the cog button, then clear the selection for the result containers you want to 
ignore.

 Intervals and time bins – If you choose Intervals and time bins from the Show intervals 
as list, results are calculated only for the time segments where intervals and time bins 
overlap. This means that the result may refer to portions of the observation different 
from the original intervals you have specified. 
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9.3 The Lag Sequential Analysis result

The lag sequential analysis result is created when you click Calculate on the Lag Sequential 
analysis tool bar (see page 347). For more information on saving and exporting analysis 
results, see page 438.

Depending on what you have selected under On Sheets in the Lag Sequential Analysis 
Settings window, the lag sequential analysis result has one or more pages, each containing a 
matrix. For example, if you have selected Observations in the On Sheets box, each matrix 
refers to one observation.

If your observations contain two or more event logs, you can choose to display separate 
matrices for those event logs, or lump the result in one matrix. To show the results 
separately, keep Event Logs selected under Observations. To lump the results, clear the 
selection for Event Logs. 

reading the result matrix

In the result matrix each row represents a criterion event and each column a target event. 
Each cell (see B in Figure 9.4) contains, depending on what you have chosen in your analysis 
settings (step 7 in the procedure of page 347):

 If you have chosen Frequency, the number of transitions from the criterion (on the row) 
to the target event (on the column).

 If you have chosen Probability, the probability of transition from the criterion event to 
the target event. This is calculated by F/T, Where F is the number of transitions from that 
criterion to that target (Frequency, see above), and T is the total number of transitions 
from that criterion to any target, that is the sum of the cell contents for that row if you 
had chosen Frequency.

The independent variables appear in the results if the corresponding option is selected in the 
Layout page of the Analysis Settings window (see page 350). 

You can zoom the result matrix in and out. To do so, hold the Ctrl key down and move the 
mouse wheel. 
Chapter 9 - Lag Sequential Analysis 357



Understanding X0 and Y0

Transitions are also counted when there no criterion can be found for a target or vice versa. 
Such transitions can be found in the cells of the matrix indicated by X0 (last row) or Y0 (last 
column). 

 X0 refers to transitions where a target has been identified but the criterion is not found. 
This happens in the following cases:
- If the lag is positive – At the start of an observation (or interval defined within an 

observation). If the first event is 2.00 Sit, this event is considered to be the target of no 
event. A transition is counted from X0 to 2.00 Sit. 

- If the lag is negative – At the end of an observation or interval, where the last event is 
considered to be the target of no event. 

- Special case – In Time lag analysis, when an event is preceded by a gap longer than the 
time lag of the previous event. For example, the event Answer occurs after a gap. If the 
time lag is shorter than the time between Answer and any preceding event, then 
Answer is considered to be the target of no event. A transition is counted from X0 to 
Answer.

You can find X0 transitions at the intersection of the X0 row and the column of the 
target event. 

Figure 9.4 An example of a lag sequential analysis result. A - Cells containing the values of independent 
variables. B - Cells containing counts or probabilities of transition. C - Main headers for categories (for 
example, Observations, Subjects, Behaviors, etc. D - Secondary headers for the elements within a category.
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 Y0 refers to transitions where no target is found. This happens:
- If the lag is positive – At the end of an observation or interval, where the last event is 

considered to be the criterion of no event. 
- If the lag is negative – At the start of an observation or interval, where the first event is 

considered to be the criterion of no event. 
- Special case – In Time lag analysis, when there is no event within a time lag. For 

example, the event Play music is not followed by any other event in the next 10 
seconds. With a time lag of 5 seconds, the time lag of Play music does not cover any 
target event. A transition is counted from Play music to Y0. Note: when at least one 
event is found within a time lag, the gap is not considered, so the transition from Play 
music to Y0 is not counted. Instead, the transition from Play music to that event is 
counted. 

You can find Y0 transitions at the intersection of the row of the criterion event and the 
Y0 column. 

X0 and Y0 transitions are included in the probability calculations to quantify the 
probability that an event is not preceded nor followed by any events.

For instantaneous sampling – X0 and Y0 do not indicate transitions from/to samples not 
scored. In lag sequential analysis, samples not scored are ignored (see page 356).

Editing the result

You cannot edit the content of the statistics result. If you want to make any changes to the 
result, export it to another program like Excel (see page 438) and then edit it in that program. 

Saving a result

To save a lag sequential analysis result, click the Archive button on the tool bar of the 
result window. 

To re-open a saved result, from the Analyze menu select Lag Sequential Analysis, then Open 
Archive. For more information on saving, opening and exporting results, see page 438.

Closing a result

To close a statistics result, simply open another screen in The Observer. Please note that the 
result is not saved automatically. 

To return to your analysis, click the analysis in the Project Explorer. 

Printing a result

To print a result table, from the File menu select Print. We advise you to select the Landscape 
mode prior to printing.
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Time formats

If your result includes time values, for example when you have selected to show Intervals or 
Independent Variables in the Layout page of the settings window (page 357), some of the 
cells contain time values. You can specify the format of time from the Setup menu, selecting 
Project Settings and Time formats. For more information, see page 60.

Applying Windows regional settings

If you want to apply new Windows regional settings, for example when changing the 
decimal symbol, restart The Observer and then run the analysis.

customizing your result

To customize your result, click the Layout button in the Result window. After you made the 
necessary changes, click OK in the Lag Sequential Analysis Settings window to refresh the 
result. 

For more information on customizing tables, see also page 311.

Summary

 Sorting categories in the matrix (see below).

 Selecting and sorting elements within a category (see page 361). Note: To remove 
elements within a category from your results, you can also use the data profile's Filter 
function (see Chapter 6).

 Collapsing elements within a category to view overall results (see page 361). This option 
allows you to lump events for different observations, event logs, intervals, subjects and 
modifiers. For example, calculate the transitions from Play independent of the modifier 
Type of Play. 

To calculate overall results, you can also merge data (see page 206). 

 Hiding and showing rows and columns in the matrix (see page 362).

Sorting categories in the matrix

For example, put the Subjects at a level higher than the 
Behaviors, so each subject will be shown with the list of 
behaviors it was scored with. 

1. Click the Layout button on top of the result window.
Under Criterion, click the category that should be sorted
first. For example, if you want to sort Behavior first,
then Subjects, click Behaviors. 
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2. Click the Up or Down button at the bottom of the Criterion box until that category lies 
above those you want with lower priority. Next, click OK. Click OK in the Lag Sequential 
Analysis Settings window to refresh the result.

To make the matrix more readable, make sure that in the Criterion box Modifiers is just 
below Behaviors.

Selecting and sorting elements within categories 

For example: changing the order of behaviors in the matrix.

1. Do one of the following:
- With View Settings on the far-right side of the tool bar, select the category whose 

elements you want to sort.
- Click the Layout button on the tool bar, make sure that the category is selected 

in the Criterion or Target box. Double-click the category, or click the category 
and then the Settings button. 

A window appears listing the elements selected for that category. 

2. To add or remove subjects from the result, select the boxes under Select corresponding to 
the subjects you want to display, and de-select those you want to ignore. 

De-selecting subjects in the Category window does not result in removing them from 
your data profile. 

3. To change the order of display, click the element you want to move and click the Up or 
Down buttons to move it to the desired position.

4. Click OK. Click OK in the Lag Sequential Analysis Settings window to refresh the result. 
The element changes its position accordingly, in both rows and columns of the matrix.

For more information about selecting and sorting elements in a result table, see page 311. 

Collapsing elements in the matrix

Follow this procedure if you want to calculate transitions with elements of a category being 
grouped. 
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Example – The type of play has been coded with modifiers. Instead of having transitions 
calculated for each combination behavior*modifier, you want to collapse modifiers in one 
row/column. This way the program does not discriminate between two events made of the 
same behavior but different modifiers. 

1. Click the Layout button on the tool bar.

2. Under Criterion, clear the selection for the category whose 
elements you want to collapse.

3. Click OK in the Lag Sequential Analysis Settings window to refresh 
the result. 

If you de-select Event Logs, event logs are still analyzed separately. See page 352 for how to 
analyze transitions across multiple event logs in each observation.

You can also collapse the results for multiple observations and subjects. To do so, open View 
Settings on the far-right side of the tool bar and click Criterions/Targets/Sheets. De-select 
the category you want to collapse.

Hiding/showing elements

Hiding and showing elements in the matrix does not change the frequency nor the 
probability of transition for other elements. If you want to make new calculations by adding 
or removing elements, you must add/remove elements in the data profile before running the 
analysis.
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10.1 Before you start

what is reliability analysis?

In The Observer XT, Reliability Analysis assesses the extent to which measurements are 
precise and consistent. Precision indicates how free the measurement is from random errors. 
Consistency indicates the extent to which repeated measurements of the same event 
produce the same results.

Within The Observer XT, two or more observations can be tested on reliability. The outcome 
of reliability analysis tells you how the two data sets are similar to each other.

Reliability Analysis always works with pairs of observations. If you want to compare three or 
more observations with each other, you have to specify each combination of observations as 
the pairs for comparison.

Examples of typical applications of reliability are:

 Checking your own consistency (intra-observer reliability) – At the beginning of a study, 
you make a video of your study subjects, and code it with The Observer. You keep both 
the video and the observational data file as a reference. Periodically, for example once 
every six months, you score the same video again and measure the agreement between 
the new data set and the reference data set. 

 Training observers (inter-observer reliability) – If a new student joins your research 
group, he/she has to adopt the coding scheme used in your research. After one month of 
practice, test the trainee’s data with a reference data file. Reliability analysis helps 
determining when the trainee is ready for the real work.

how are events compared between observations?

In The Observer XT 12.5, four different methods for reliability analysis are available:

 Frequency/Sequence (this method was also available in The Observer XT 7.0 and later) - 
This method compares events with and without duration and instantaneous sampling 

The terms Subject, Behavior, Modifier and Independent Variable in this chapter 
may not be the same as those on your screen. This depends on what terms you 
have specified in your project's Terminology Preferences (see terminology on 
page 93).
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events between two observations and takes into account both the frequency and the 
sequence of events.

 Duration/Sequence - This method compares events with duration between two 
observations. It does not take into account events without duration and instantaneous 
sampling events.

 Frequency - This method compares the total number of occurrences of each event with 
and without duration or instantaneous sampling event. The duration or sequence of 
events is not taken into account.

 Duration - This method compares the total duration of each event with duration 
between two observations. The frequency or sequence of events is not taken into 
account.

Which method should I choose?

 The Frequency/Sequence method can be used as a detailed indicator of the 
correspondence between two observations when timing of the events is important.

 Use the Duration/Sequence method when you want to know to what extent two 
observers scored the same events with the same durations.

 Use the Frequency method when you want to compare observations and timing and 
sequence of events are not important in your study. This method is suited for 
observations with a relatively high rate of transitions between events.

 Use the Duration method when you want to compare the duration of events between 
observations and timing and frequency of events are not important in your study.

Observations are made of events in a time series. Whether events in two observations are 
scored as an agreement or as a disagreement depends on whether the subject, behavior and 
modifiers in those events are the same but also on your settings. The program considers each 
event selected for analysis and searches for a matching event in the other observation within 
a defined tolerance window. You can set the tolerance window in such a way that if the same 
event is found within the tolerance window, it is scored as an agreement, otherwise as a 
disagreement. For more information, see page 379. 
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Only the events selected in your active data profile will be compared to quantify agreement. 
If you run reliability analysis with the default data profile, all events in your observations will 
be used for comparison (depending on you Reliability Analysis Settings, see page 367).

10.2 Procedure overview

1. Make sure that the data profile specifying the data you want to analyze is active, that is,
highlighted in blue in the Project Explorer. 

2. Do one of the following: 
- From the Analyze menu, select Reliability Analysis, then 

New. 
- In the Project Explorer, click the Analyses folder. In the 

overview window that appears, select Analyze data and 
next Reliability Analysis.

- In the Project Explorer, double-click the Analyses folder 
to expand it. Click Reliability Analysis and, next, click 
New Reliability Analysis. 

The Reliability Analysis Settings window appears.

If you do reliability analysis on behavior groups that are not mutually exclusive 
and exhaustive, or behavior groups which only include events without duration, 
the gaps between events might give unexpected results. See Reliability analysis 
and gaps on page 396 for more information about reliability analysis when you 
have gaps between events or when an observation is suspended.

To activate a data profile, right-click it in the Project Explorer and select Set as 
Current. For more information on selecting data, see Chapter 6. 

Reliability analysis is meant to be applied to whole observations. It is 
recommended not to apply a data profile where data are merged or split in 
intervals or time bins. 

When you select intervals, only the behaviors in the interval are taken into 
account in reliability analysis.
366 Chapter 10 - Reliability Analysis



3. In the Pairs tab, add the pairs of observations you want to compare.

See pairs tab on page 367 for details.

4. In the Settings tab, select the Comparison method and additional settings.

See settings tab on page 370 for details.

5. Click OK to start calculation of the reliability statistics.

The results of the selected Comparison method are shown in the Reliability Analysis 
results sheet (see page 381). Depending on the method you selected, the Statistics view, 
Confusion matrix and Comparison List are displayed.

6. Optionally, you can save your reliability results to an archive or export them to an Excel or 
text file.

What next?

 See page 386 for how to customize your result. 

 See page 438 for how to save and export your result.

10.3 Reliability analysis settings

pairs tab

In the Pairs tab, pairs of observations can be selected for comparison.

Selecting pairs

To add an observation to the list with Observation Pairs, do one of the following:

 Click on an observation in the list with Observations and click the Add>> button.

 Double-click an observation.

Add as many pairs as you want.

Optionally, you can filter observations based on their observation name. For example, you 
have a large number of observations with the observation day (Day1, Day2, etc.) in the 
Observation name. In the Filter Observations box, type the name of the observation day. As a 
result, the list of observations only shows the observations with that observation day in the 
name (see Figure 10.1 for an example). To reset the filter, click the ‘x’ icon at the right of the 
Filter Observations box.
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Note:

 If your observations contain two or more event logs, you must select single event logs for 
comparison. See the note on page 379.

 If the list does not include an observation, it could be due to that observation containing 
errors. Open the observation and check for errors (see page 147).

 If your data profile contains more than one result 
container (see page 205), you need to specify one of them 
for each observation. The lists show all the combinations 
of observations and result containers. Make sure that you 
select the combination you require, for example Observation 0001_A / Locomotion.

Figure 10.1 Filtering observations in the Pairs tab of the Reliability Analysis Settings 
window. In this example, observations with “day2” in the name are filtered.
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Replacing observations

You can replace observations in a pair by doing the following:

1. In the Observation Pairs list, click on the observation you want to replace. The
observation name becomes highlighted in blue.

2. In the Observations list, double-click on the observation you want to add or select the 
observation and click the Add>> button.

Removing pairs

To remove a specific observation pair, click on one of the observations of that pair and click 
the Remove pair button.

To remove the whole list of observation pairs, click the Remove all pairs button.

Resizing the Observation Pairs list

If you have long observation names, the full name 
might not be completely visible in the Observation 
Pairs list. You can resize the Reliability Analysis Settings 
window to make long observation names visible.

Alternatively, when you hover over the observation 
name with the mouse pointer, however, a tool tip 
displays the complete observation name. 

 You can also add an observation pair in the Statistics view of the reliability 
analysis results by clicking the empty row at the bottom (indicated by “Click to 
add Observation”).

 Always select the observation that is the ‘gold standard’ as the first 
observation in a pair. This because when you view the paired events in the 
comparison list, you see the video image associated with the first observation, 
not the second. 
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settings tab

Below you find details about the settings. Tip: click on one of the Quick help buttons to 
read more about an option or setting.

Comparison method

Select one of the following comparison methods from the list:

 Frequency/Sequence - This method calculates to what extent the scored frequency of 
events with or without duration and instantaneous sampling events is comparable 
between observations. It takes into account the timing of the events. For details about 
the calculation for the Frequency/Sequence Comparison method, see How the 
Frequency/Sequence reliability analysis algorithm works on page 376.

 Duration/Sequence - This method calculates to what extent the scored duration of 
events with duration is comparable between observations. It takes into account the 
timing 
of the events.
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Example - 
Observation 1: 0.0 John-Play, 10.0 John-Run, 12.0 John-Sit.
Observation 2: 0.0 John-Sit, 2.0 John-Play, 12.0 John-Run.

In both observations the behavior John-Play lasts 10 seconds. However, the overlap of 
John-Play in the two observations lasts 8 seconds (from 2.0 to 10.0 seconds), the non-
overlap is 4 seconds. The Duration/Sequence method, therefore, results in an Agreement 
of 8 seconds and a Disagreement of 4 seconds.

 Frequency - This method compares the total scored frequency of each event with and 
without duration or instantaneous sampling event between observations regardless of 
whether the events were scored at the same time.

 Duration - This method compares the total scored duration of each event with duration 
between observations regardless of whether the events were scored at the same time.

Tolerance window

The Tolerance window setting is only available if you have selected the Frequency/Sequence 
comparison method.

The tolerance window defines how accurate the timing of an event (in the comparison 
between two observations) must be to be considered an agreement or not. For example, if in 
Observation 1 the event ‘Gaze at screen’ occurs at 4.0 s and stops at 6.0 s while in 
Observation 2 it starts at 6.5 s, that is counted as an agreement when the tolerance window 
is set to 3 s. However, if the tolerance window is set to 1 s, the two events are counted as a 
disagreement as the mismatch between their start times (2.5 s) is greater than the tolerance 
window.

Analyze gaps between events

With the option Analyze gaps between events, The Observer XT also takes gaps between 
events into account when comparing two observations. A gap is a time-interval in an 
observation in which no event was scored for a specific behavior group (see Figure 10.2).

Analyze gaps between events is only available if you select Frequency/Sequence or 
Duration/Sequence as a comparison method. By default, this option is selected.

If you do reliability analysis on behavior groups that are not mutually exclusive 
and exhaustive, or behavior groups which only include events without duration, 
the gaps between events might give unexpected results. We advise you to de-
select Analyze gaps between events.

See Reliability analysis and gaps on page 396 for more information about 
reliability analysis when you have gaps between events or when an observation 
is suspended.
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The example in Figure 10.2 shows the effect of including gaps in the reliability analysis. The 
figure shows two observations scored with two events with duration, A and B, which cannot 
occur at the same time, but the behavior group is not exhaustive. Similar effects can also be 
seen with behaviors in a behavior group type with behaviors that can overlap.

Comparison scope

Here you can select the following:

 Compare all events (default) – Select this option if you want to compare all the events no 
matter whether one observation is longer than the other.

Figure 10.2 A simple example of the effect of selecting/deselecting the Analyze gaps between events 
option. Top — The time-event plots of two observations. Observation 1 contains two gaps between events. 
Middle — Pairing of events when Analyze gaps between events is not selected. Reliability analysis results 
in two agreements between events of the same type (A - A, and B - B). 
Bottom — Pairing of events when Analyze gaps between events is selected. Besides the agreements found 
between A-A and B-B, the gaps present in Observation 1 are paired with the events in the Observation 2, 
resulting in two disagreements.
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 Compare time based intersection – Select this option if two observations are of different 
length, and you want to compare only the events in the time period shared by both 
observations. 

Example – Two observers score data from a video file. One observer stops at 30 minutes 
and the other at 35 minutes. The result is that the second data file will be longer then the 
other. If you select Compare time based intersection, The Observer compares the events 
in both observations from 0 to 30 minutes and ignores the extra 5 minutes in the second 
observation.

Synchronization

Here you can select the way two observations in a pair are aligned:

 Use absolute start times (clock times) – Select this option if your observations were 
scored live, and you want to align them according to their 'true' start time (for example, 
14h 23min 56s).

Figure 10.3 Schematic representation of the Comparison scope: Compare all events (at the top) and 
Compare time-based section (at the bottom).
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 Align the start of observations – Select this option if you coded from video and started 
your observations at exactly the same time point. The absolute observation start times 
(for instance 10h 37min 05s and 11h 02min 34s) are ignored. This is the default option if 
your observations do not have video files.

 Align first scored events – Select this option if you want to take the first event you scored 
in each observation as a synchronization point. For example, if a classroom carried out 
live scoring of a projected video, previously scored by an expert.

 Align video start time – With this option selected, the observations are aligned with the 
video. Choose this option if, for example, observer 1 started to code the video at 
t=0:00:00 and coded an event at t=0:01:00 and observer 2 started at t=0:00:50 and 
coded the same event about 10 seconds after that start.

Show extra Kappa statistics

Select this option to calculate the minimum, maximum and average Kappa of all the 
combined observation pairs. This enables you to easily see how much Kappa varies between 
your observation pairs.
374 Chapter 10 - Reliability Analysis



Note that the average Kappa is not the same as the Kappa obtained by summing up the 
agreements and disagreements from two or more pairs of observations (see Combining 
multiple pairs of observations on page 375), although those two values are often correlated.

Combining multiple pairs of observations

Select Include all results combined to get an additional row in the Reliability Analysis results 
sheet that sums up all agreements and disagreements from all pairs of observations.

When you select Include all results combined, each observation should occur in only one pair 
in the list. An overall Kappa or Rho value obtained with many pairs of observations is likely to 
be affected by bias and prevalence due to the large numbers in some cells of the matrix, not 
in others. Furthermore, an overall Kappa means losing information on single pairs of 
observations. In addition, it is always a good idea to export the Kappa values for each pair of 
observations, and then make a histogram of those values to see how they are distributed. 
Some observations or observers may be more associated with a lower Kappa than others. 
There may be observations in which some behaviors which are difficult to observe are 
prevalent, so they result in low Kappa values.

Modifiers

If you select Include Modifiers, behavior modifiers are included in the events to compare.

If some of the modifiers are numerical, you can enter a Margin on numericals as a tolerance 
value. Modifiers in two events of the same type that differ by less than the margin result in 
an agreement. See also the note analyzing modifiers on page 380.

Show missing values as

Choose the character you want to have displayed for missing values in the confusion matrix.

Number of decimals

Choose the number of decimals for the reliability statistics and significance. You can choose 
2 or 3 decimals.

Figure 10.4 Part of the Reliability Analysis results sheet. This example shows the result of the combined 
results in the bottom row.
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Saving your analysis settings 

The Reset to default and Set default buttons apply to the Settings tab and Layout tab.

You can save the settings specified in your analysis by clicking the Set default button. If this 
window is gone, click Settings on top of the result window and click Set default in the 
window that appears.

Applying settings to a new analysis

If you are about to run reliability analysis and want to recall the settings you have specified 
earlier, click the Reset to default button. The new settings are applied. Next, click OK to run 
the analysis.

layout tab

In the Layout tab, select Show not scored elements if you want the result to include the event 
types that were not scored in any observation. 

If the option is selected, the matrix of agreements and disagreements (see page 386 for an 
example) will be larger. The cells corresponding to not scored events will contain the missing 
value symbol.

If the option is not selected (default), only the event types that were scored in at least one 
observation are included in the result. 

10.4 How the Frequency/Sequence reliability 
analysis algorithm works

This section describes how the algorithm works for the Frequency/Sequence 
Comparison method.

For each pair of observations selected in the Pairs tab of the Reliability Analysis Settings 
window, The Observer analyzes the two observations in five runs. In each run, the program 
scans the events on a single time line, from the start to the end, switching from one 
observation to the other according to the timing.

In some cases the program analyzes the stop of events. For more information, see 
Understanding Gaps on page 384.
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 Run 1 – Find matches between overlapping events. The program searches for events of 
the same type in the two observations that overlap in time at least partially. The onset 
and offset times of the events needs not be the same. 

See the example below.

The following agreements are scored:

 Run 2 – Find matches between events within the tolerance window. The program 
searches for events of the same type among all those that have not been considered in 
the previous run, and scores agreements between those which do not overlap, but their 
onset time differ less than the tolerance window. 

Note – The stop times are not compared, however they are compared indirectly. When 
you score the stop of a behavior without starting a new one, there are gaps between 
events (like in the picture above). If you selected to analyze gaps between events (see 
Reliability analysis and gaps on page 396 for more information), The Observer XT treats 
such gaps as <Gap “Behavior name”> and find matches between them just like events. 
For more information, see page 74 and page 396.

In the example below a Tolerance window of 2 seconds is used.
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The onset times of ‘Keyboard’ and ‘Mouse pointing’ differ by less than the tolerance 
window (indicated by the arrows in the figure above). The following agreements are 
scored:

 Run 3 – Find disagreements: events not yet linked within the tolerance window. The 
program considers the events left out in the previous runs, and searches for any event in 
the other observation within the tolerance window that has yet to be scored as 
agreement/disagreement. If multiple events are available in the other observation, then 
the first event is considered. Pairing in run 3 always results in disagreements, because if 
the events are of the same type they would have been considered in run 1 or 2. 

Stop times are compared indirectly, see the note about stop times in Run 2.

In the example below a Tolerance window of 2 seconds is used.

The following disagreements are scored:

 Run 4 – Find disagreements: any event within the tolerance window. The program 
considers the events left out in the previous runs, however it searches for any event in 
the other observation within the tolerance window, even if that has been scored as 
agreement or disagreement in a previous run. If multiple events are available in the 
other observation, then the last event is considered. Pairing results in disagreements. 

Stop times are compared indirectly, see the note about stop times in Run 2.

 Run 5 – Find disagreements: events outside the tolerance window. The program 
considers the events that have not been considered in the previous runs, and searches for 
the most nearby event in the other observation that has yet to be scored as agreement or 
disagreement. If two events are equally far in time from the focal event, the first of the 
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two is considered. Pairing results in disagreements. If the paired events are of the same 
type, they are scored as 'Window Error' (see page 386).

The following disagreement is scored:

Note that 8.70 Duet Play (Obs 2) was paired to 8.00 Duet Play (Obs 1) during Run 1. This is 
one of the frequent cases in which an event produces one agreement and one or more 
disagreements.

References

For more information, please see the following paper: Jansen, R. G., Wiertz, L. F., Meyer, E. S., 
& Noldus, L. P. (2003). Reliability analysis of observational data: Problems, solutions, and 
software implementation. Behavior Research Methods, Instruments, & Computers, 35(3), 391-
399.

For general information about reliability analysis see Haccou, P., & Meelis, E. (1992). 
Statistical analysis of behavioural data: An approach based on time-structured models. Oxford 
University Press.

10.5 Notes about reliability analysis

For Observer 5 users

The algorithm for reliability analysis is essentially the same as the one in The Observer 5. 
The only differences are:

 In The Observer 5, an event could be scored as agreement with one or more events in the 
other observation. In The Observer XT, an event can be scored as agreement with only 
one event in the other observation. If other events in the second observation are close to 
the event in the first observation, these are scored as disagreements.
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 In The Observer 5, only the start, not the stop of a Behavior is considered for analysis, 
because the stop of one behavior coincides with the start of another one. In The 
Observer XT, any stop of a behavior that is not immediately followed by the start of 
another one (like when you score stop codes for Start-Stop behaviors), the stop event is 
analyzed as <Gap “Behavior name”>, where “Behavior name” is the name of the 
behavior just stopped.

 In contrast to The Observer 5, in The Observer XT an observation can have multiple event 
logs and multiple Results containers in the data selection. These are taken into account 
in the reliability analysis.

 In contrast to The Observer 5, in The Observer XT you can define numerical modifiers, 
which can be considered in the reliability analysis (see Modifiers on page 375).

Analyzing modifiers

 If behavioral modifiers are not defined in your coding scheme, the Behavior Modifiers 
options in the settings window is not available.

 If you select the Include Modifiers options, comparison of events is more discriminating, 
as two events with the same subject or behavior but different modifiers will result in a 
disagreement. De-selecting this option makes the comparison of events less selective. 

Choosing specific event logs for comparison

In the Reliability Analysis Settings window, you choose observation for comparison. If your 
observations include two or more event logs, this window does not distinguish between 
them. To select a specific event log, open your data profile (or create a new one) and create a 
Result container for each event log. Next, filter event logs in such a way that the event logs 
you want to compare end up in different Result boxes. Then, in the Reliability Analysis 
Settings window, choose the combination Observation*Result container to specify an event 
log for comparison.

Comments

If you have scored comments without associated behaviors, these rows in the Event log 
result in <Missing behavior> in the analysis, which are treated as events without duration in 
the reliability analysis. This affects the outcome of the reliability analysis. To avoid this, 
create a data profile (see Chapter 6) and use a filter box in which you select all behaviors. This 
filter box removes the lines in your event log that contain only comments. Then carry out the 
reliability analysis.
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10.6 The reliability analysis result

The reliability analysis result is created when you click OK in the Reliability Analysis Settings 
window (page 366). The result has a number of views (Statistics, Confusion Matrix, 
Comparison List), depending on the Comparison method you used.

The reliability analysis result consists of three different views, visible one at a time:

 Statistics (see below).

 Confusion Matrix (see page 382)

 Comparison List (see page 387)

The result is not automatically saved to your computer’s hard disk! 
To save the result, click the Archive button (see page 438).

To edit a result, first export it to another program (see page 440).

statistics view

To show the Statistics view, click the Statistics button (see the figure above, top-left corner) 
in the tool bar. The following statistics are calculated:

 Number of Agreements.

 Number of Disagreements.

 Index of concordance.

 Percentage of agreements.

 Cohen's Kappa and its statistical significance (p-value).

 Kappa Max.

 Pearson's Rho and its statistical significance (p-value).

 Prevalence Index.

Figure 10.5 Part of the Statistics view in the Reliability Analysis results sheet.
Chapter 10 - Reliability Analysis 381



 Confidence Interval low.

 Confidence Interval high.

The statistics are derived from the Confusion matrix. For more information on their 
computation, see page 390. 

If you add more observation pairs to the List of pairs and run analysis again, it could happen 
that the Rho value for the pre-existing pairs differs slightly from those obtained in the 
previous analysis. This happens because the confusion matrix, which is used to calculate the 
statistics, always contains all event types in the observations selected, regardless of which 
event types were scored in a specific observation. When you add more observations to the 
List of pairs, this could result in adding event types to the confusion matrix that were not 
scored in the pre-existing observations. Additional event types means extra rows and 
columns. Because of the way Rho is computed (see page 393), this changes the values of Rho 
in the Statistics page. If you want to keep the confusion matrix fixed, select the Show not 
scored elements option (see page 376). 

confusion matrix

To display the confusion matrix, click the Confusion Matrix button in the tool bar. The 
Confusion Matrix displays the observation pair that is selected in the Statistics view. If you 
have multiple observation pairs, you can select another pair from the list on the tool bar.

If you selected the option Include all results combined in the Settings tab (see page 384), 
there is an additional pair: Observations A combined - Observations B combined. 

The confusion matrix (Figure 10.6) shows a matrix of events from the two observations under 
comparison.
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Matrix layout

This matrix has one row and one column for each combination of Subject and Behavior, plus 
their Modifiers scored in those observations.

Cell values

The values of the confusion matrix can be understood as follows:

Figure 10.6 The Confusion Matrix view in the Reliability Analysis results sheet.
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 Light blue cells along the diagonals contain counts of agreements of events that differ in 
numerical modifiers by less than the margin (see page 371).

 Additional rows and columns indicate special cases: No Records, Window Error 
(see below). 
- If you have defined two or more observation pairs for comparison, the size of the 

matrix is constant across pairs of observations, because it includes the combinations 
of events in all pairs no matter whether a specific event was scored in a specific pair of 
observations. This means that if event A was scored in an observation of Pair 1 and in 
neither observation of Pair 2, the matrix of Pair 2 still contains the row and column for 
event A. 

- If you have selected Show not scored elements in the Layout page of the Reliability 
Analysis Settings window (see page 376), the matrix also includes those combinations 
of Subject, Behavior and their Modifiers that were not scored in those observations. 
Therefore, the matrix can be much larger. 

- If you select Include all results combined for multiple comparisons (see page 375), the 
confusion matrix of the Combined results page sums up all agreements and 
disagreements from all pairs of observations.

Understanding <Gap “Behavior name”>

<Gap “Behavior name”> is added to rows and columns in the Confusion Matrix in the 
following cases:
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 When no behavior is scored at the start of the observation.

 A <Gap “Behavior name”> state is added at the start of the observation for each 
Behavior of a Start-Stop group, ending with the start of the first behavior of that group.

 When a behavior with duration ends, that is, when you press the stop code for a 
behavior.

 A <Gap “Behavior name”> state is added that starts at the end of the event and ends 
at the start of the next occurrence of that behavior (see an example in the picture of 
page 388).

 When the behavior group type is set to Behaviors cannot occur at the same time and 
contains both events with and without duration, and you only have scored events 
without duration. 

 A <Gap “Behavior group name”> state for is added at the start of the observation, 
ending at the end of the observation. 

If you selected the option Analyze gaps between events, The Observer considers the start of 
such a gap for comparison and links them to an event in the other observation, resulting in 
an agreement (if there also is a gap for the same behavior group) or a disagreement in all 
other cases. With Analyze gaps between events you assess the co-occurrence of no events, 
not only the events you have scored.

For combined continuous and instantaneous sampling, a gap is not added when continuous 
sampling is temporarily suspended to allow scoring of a sample.

Understanding ‘No Records’

Rows and columns named No Records show the occurrences of events in one observation 
that cannot be paired with any event in the second observation. This happens in the 
following cases:

 There is no data from the same behavior group in the other observation. In the 
Comparison List, such instances are shown as <Nothing scored in combination>. 

See also Reliability analysis and gaps on page 396 for more information about 
reliability analysis when you have gaps between events or when an observation 
is suspended.
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 When you have selected Compare all events from the Comparison scope list in the 
Settings tab of the Reliability Analysis Settings window (see page 372), and one or both of 
the following is true:
- One observation is longer than the other.
- You have aligned the two observations in such a way that one starts earlier than the 

other. For example, two live observations started at different time, and you have 
selected Use the start of observations as Synchronization method (see page 373). 

Understanding ‘Window Error’ 

Rows and columns named Window Error show the disagreements between the events of the 
same type whose onset times differ for more than the tolerance window set in the Reliability 
Analysis Settings window (see page 371). 

Customizing the matrix

To obtain a smaller matrix containing fewer event categories:

 Do not select the option Show not scored elements in the Layout tab of the Reliability 
Analysis Settings window (see page 376).

 Filter data in the data profile (see Chapter 6), then run the analysis. 

Where do I find the events marked by No Records?

The No Records row shows the disagreements between events in observation 2 
(above the diagonal) and <Nothing scored in combination> in the Comparison 
List (see page 22).

The No Records column shows the disagreements between events in 
observation 1 (left of the diagonal) and <Nothing scored in combination>.

Where do I find the events marked by Window Error?

The Window Error row shows the disagreements between the same event types 
where the event in observation 1 (left of the diagonal) occurs earlier than that in 
observation 2 (you can check this in the comparison list; see page 22).

The Window Error column shows the disagreements between the same event 
types where the event in observation 1 occurs later than that in observation 2.
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comparison list

To show the comparison list of a pair of observations, select the pair from the list next to the 
Comparison List button. The Comparison List lists all agreements and disagreements of the 
compared observations. It contains from left to right:

 The Run number of the reliability analysis algorithm (see How the Frequency/Sequence 
reliability analysis algorithm works on page 376). If you hover over this number with the 
mouse pointer, a tool tip is displayed with a short explanation.

By default, the Run column is hidden. To show it, click the View Settings button at the 
right of the tool bar and select Run.

 The events with duration (with their start and stop time) and events without duration 
(with their start time) of the first observation of each pair selected in the analysis 
settings window.

 The Result of the comparison between the records of the two observations.

 The events with duration (with their start and stop time) and events without duration 
(with their start time) of the second observation.

If you select Include all results combined for multiple comparisons (see page 375), the 
Comparison List of the combined results lists the events from all the observation pairs, 
ordered according to the list of Observation Pairs in the Pairs tab of the Reliability Analysis 
Settings window.

Symbols

 Green triangle – Marks starts of events with duration (mutually exclusive and start-
stop), including the <Gap “behavior name”>. 

 Blue circle – Marks events without duration. 

 Green check mark – Marks an agreement between an event in the two 
observations.

 Red cross – Marks a disagreement between an event in the two observations.

Specifying the time format

By default, the Comparison List shows the event times as time elapsed from the point where 
the two observations are aligned. If you want to change the format, do the following:

1. From the Setup menu, select Project Settings, then Time formats in the left pane.

2. To set the time mode, select Absolute or Relative from the Project time format list.

3. To set the time format, click the Edit button for the time mode you selected in the previous 
step. See page 114 for more information.
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4. Click OK. Restart reliability analysis and display the Comparison List. The time and date 
format are applied to all the rows in the Comparison List. 

Applying Windows regional settings – If you want to apply new Windows regional settings, 
for example when changing the decimal symbol, restart The Observer and then run the 
analysis. 

Top rows: Observation start and Synchronization point

 Observation start – Marks the observation start time relative to the point where the 
program starts comparing the data files (Synchronization). It is shown in the format you 
specify in the Time formats tab of the Project Settings window (see above). Please note:
- If you have selected Use the start of observations from the Synchronization list (see 

page 373) and you are comparing live observations, Observation start shows the time 
difference between the two start times.

- If you have selected Align first scored events from the Synchronization list (see 
page 373) and there are no events starting at 0:00:00.000, the comparison starts later 
than 0:00. Therefore, Observation start is negative (for example, -0:00:5.30 if the first 
event starts occurs at 5.30 s). 

- If you have started observing from a point in a media file later than 0:00, and you 
select Align video start time from the Synchronization list (see page 373), Observation 
start shows the start of the observation relative to the video start time (for example, 
0:01.00.000 if you start observing at 1 minute in the video file). 

 Synchronization point – The point in time where the program starts comparing the two 
files. It is always the same for both observations. It is shown in the format you specify in 
the Time formats tab of the Project Settings window (see the previous page). By default, 
synchronization point is 0:00:00.000. 

Understanding <Nothing scored in combination>

Events in one observation are paired to <Nothing scored in combination> when there is no 
data from the same subject and behavior group in the other observation. This results in a 
disagreement. You can find such instances in the confusion matrix under No Records (see 
page 385). 

Understanding <Gap “Behavior name”>

Gaps in the observations are only analyzed when the option Analyze gaps between events 
has been selected (see page 371).

Events in one observation are paired to <Gap “Behavior name”> when the closest event in 
the other observation is the stop of an event with duration that is not followed by the start 
of a new one. For example, when you score the stop of a behavior by using the Stop code. 
These instances usually result in disagreements. 
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It is also possible to get an agreement between a pair of <Gap “Behavior name”>:

In this example, no event from the mutually exclusive behavior group ‘Locomotion’ was 
scored at the start of both observations. The two <Gap Run> states overlap, therefore they 
result in an agreement (see run 1 in the algorithm, page 377).

 If your Comparison list includes lots of pairings between <Gap “Behavior name”> and 
events without duration, it means that the behavior group in which point the events are 
scored is of type in which behaviors cannot occur at the same time. We advise you to de-
select Analyze gaps between events (page 371).

 For combined continuous and instantaneous sampling, <Gap “behavior name”> is not 
added when continuous sampling is temporarily suspended to allow scoring 
of a sample.

Understanding multiple occurrences of the same event

Sometimes you may find an event in one observation associated with two or more events 
(not necessarily of the same type) in the other observation. For example, 4.24 Walk in 
observation 1 is associated with 6.00 Walk (overlap = Agreement) and 0.00 Walk in 
observation 2 (no overlap and outside Tolerance window of 1 sec = Disagreement). 

This is an inevitable consequence of the fact that one observation contains more events that 
the other. In such cases only one agreement is counted (usually the one found in run 1 of the 
algorithm; see page 377). All other associations are scored as disagreements, no matter if the 
event type is the same. 

Understanding disagreements caused by modifiers

Events with the same subject and behavior result in disagreements if they have different 
modifiers. If the modifiers are numerical, they result in a disagreement only if they differ by 
more than the margin value set (see page 375). 

If numerical modifiers have been defined as predefined (see page 80), scoring modifiers that 
differ by more than the margin value result in a coding error, not a modifier error in the 
confusion matrix.
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Editing a result

You cannot edit the content of the Reliability Analysis Results sheet. If you want to make any 
changes to the result, export it to another program like Excel (see page 440) and then edit it 
in that program. 

Saving a result

To save a result, click the Archive button on the tool bar of the result window, or from the 
Analyze menu, select Archive Analysis Results. 

To re-open a saved result, click the Open Archive button on the tool bar or, from the Analyze 
menu, select Reliability Analysis, then Open Archive. For more information on saving, 
opening and exporting results, see page 438.

Closing a result

To close a result, simply open another window in The Observer XT. Please note that the result 
is not saved automatically.

To return to your analysis, click the item under Reliability Analysis in the Project Explorer.

Printing a result

To print a result, click the button corresponding to the page you want to print and from the 
File menu, select Print. 

10.7 Reliability statistics

Agreements 

The number of times the two observations showed a match between events. It is the sum of 
the values in the diagonal of the confusion matrix.

Disagreements

The number of times the two observations showed a disagreement between events. It is the 
total of the values in the off-diagonal cells, including Window Error, Modifier Error and No 
Records in the Confusion matrix (see page 382).

Index of concordance

The proportion of agreements between events, calculated as Agreements/
(Agreements+Disagreements). The values range between 0 (no agreements) and 1 (full 
agreement).
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Percentage of agreements

The Percentage of agreements between events, calculated as (Agreements/
(Agreements+Disagreements) * 100%). The values range between 0 (no agreements) and 100 
(full agreement). 

Cohen's Kappa ()

An overall measure of agreement, from Cohen J. (1960). A coefficient of agreement for 
nominal scales. Educational and Psychological Measurement 20(1), 37-46. 

Formula:

Where:

po is the observed proportion of agreements:

pc is the proportion of agreements expected by chance:

aij is the value of the matrix cell at row I and column j. 

ain and anj are the values of the cells of row i and column j (n ranges from 1 to the last item of 
the row/column). 

wij is the weight of the value at row i and column j. It has two possible values: 0 for 
agreements (in the diagonal and in the light blue cells, see page 375), and 1 for disagreements 
(the remaining cells).

pc 1

ain
n
 
  anj

n
 
 wij

j


i


aij
j


i
 
  2

------------------------------------------------------------–=
Chapter 10 - Reliability Analysis 391



When the events do not include numerical modifiers or the margin set for comparison is 
zero, the proportion of expected agreement is equal to 

The values of k range between -1 (non-random full disagreement) to +1 (non-random full 
agreement), but for practical purposes the range from 0 to 1.00 is of interest. A  of zero 
means that there is no agreement beyond chance, and a  of 1.00 means that there is perfect 
agreement. Interpretations of intermediate values are subjective. 

Kappa is scored as Invalid if it is based on one comparison, like one event in each observation. 
In this case agreement is 100%.

Significance of Kappa 

To test the significance of , a standard score z is calculated: 

A one-tailed test on this score is carried out, and the probability is shown next to . A one-
tailed test is considered appropriate when the null hypothesis states a value of zero for 
kappa because a negative value of kappa does not normally have a meaningful 
interpretation.

The common statement that kappa is a "chance-corrected measure of agreement" may be 
misleading. As a test statistic, kappa can verify that agreement exceeds chance levels. But as 
a measure of the level of agreement, kappa is not "chance-corrected"; indeed, in the absence 
of some explicit model of rater decision making, one cannot know whether or not a specific 
agreement was achieved by chance. For more information, see http://en.wikipedia.org/wiki/
Cohen%27s_kappa.
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Kappa max

A maximum value of Kappa is achieved when there is full agreement between two 
observations. The Kappa max is calculated as follows:

where aij is the matrix cell value at row i and column j and aji is the matrix cell value at row j 
and column i.

Pearson's Rho ()

A measure of the strength and direction of the linear relationship between the row totals 
and the column totals in the confusion matrix. It can be interpreted this way: If there are no 
disagreements in the confusion matrix, then the total for row 1 is equal to the total for 
column 1, the total for row 2 is equal to the total for column 2, and so on. This means that 
there is perfect correlation between the two observations.

Rho values range between -1.0 and +1.0, where -1.0 is the perfect negative (inverse) 
correlation, 0.0 means no correlation at all and +1.0 is the perfect positive correlation.

Formula:

Where N = the total number of rows (or columns) in the matrix.

 = the total of column jaij
i
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 = the total of row j

When you use numerical modifiers and accept agreements by a margin, such agreements are 
displayed within light blue cells (see page 375). These counts are summed up with the 
diagonal cell on the same row of the matrix (here below, left), so that the totals of the 
columns differ from those you see in the confusion matrix (right). The formula of Rho is 
applied on this new matrix. 

The correlation coefficient  represents the linear relationship between two variables. If  is 
squared, the resulting value  represents the proportion of common variation in the two 
variables, that is, the ‘strength’ or ‘magnitude’ of the relationship. In order to evaluate the 
correlation between variables, it is important to know this ‘magnitude’ as well as the 
statistical significance of the correlation (see below).

Cohen’s Kappa and Pearson’s Rho do not measure the same thing! A high Rho could result 
even when agreement measured by Kappa is low. 

Example – Events are coded by means of predefined numerical modifiers (10, 20, 30...). If one 
coder consistently codes 10 points higher than the other coder, Rho is high, but agreement is 
low (Kappa will even be negative!).

Significance of Rho

To test the significance of , a standard score t is calculated: 

A one-tailed test is carried out, and the probability is shown next to . 

The test of significance of  is based on the assumption that the distribution of the residual 
values (that is, the deviations of the column totals from the regression over the row totals) 
follows the normal distribution, and that the variability of the residual values is the same for 
all values of the independent variable. However, Monte Carlo simulations suggest that 

a ji
i
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meeting those assumptions closely is not absolutely crucial if your sample size is not very 
small and when the departure from normality is not very large. If the number or rows and 
columns of your confusion matrix is 50 or more then serious biases are unlikely, and if it is 
over 100 then you do not need to be concerned with the normality assumptions.

Prevalence index

Prevalence index is the degree to which a particular event occurs more in a group of subjects 
than another event. For example, when the number of agreements in one behavior group is 
higher than in another group, the Prevalence index is high but the Kappa is low. The 
Prevalence index is therefore useful to explain odd Kappa values.

The formula for the Prevalence index is:

where aji is the value in the agreements (diagonal) and the nc is the column count.

Please note that special columns in the Confusion Matrix, such as, No Records, Window Error 
and Total are not taken into account in the calculation of the Prevalence index.

Confidence interval

The 95%-Confidence interval low and high are given in the Confusion Matrix.

First, the standard error of Kappa is calculated:

where Ao is the observed proportion of agreements, Ae is the proportion of agreements 
expected by chance and n is the sum of the column totals is the number of columns. Then 
the Confidence interval is calculated:
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Extra Kappa statistics

Three extra statistics are available if you selected the option Show extra Kappa statistics in 
the Reliability Analysis Settings (see page 374). These are Minimum Kappa, Maximum Kappa 
and Average Kappa and is the summarization of Cohen’s Kappa for all the pairs.

Note that the Average Kappa is not the same as the Kappa obtained by summing up the 
agreements and disagreements from two or more pairs of observations (see Combining 
multiple pairs of observations on page 375), although those two values are often correlated.

10.8 Reliability analysis and gaps

A gap in an observation is the time interval in which no event was scored for a specific 
behavior group. This can occur 

 In groups of mutually exclusive, non-exhaustive behaviors (page 396).

 In start-stop behaviors.

 When suspending an observation

mutually exclusive, non-exhaustive behaviors

Definition of a gap

In the following example, a gap occurs before the start of M1, and another after the end of 
M2 for the group ‘Mutex’. Note that you do not see gap names when you make time-event 
plots. You will see these names in the Reliability Analysis’ Comparison List 

Note that if during an observation no behaviors from a mutually exclusive non-exhaustive 
group are scored, Reliability Analysis will consider a gap for that group from the start to the 
end of the observation.

Examples for mutually exclusive behaviors

The figure below shows the visualization of two observations, A and B with events (M1, M2) 
from a mutually exclusive non-exhaustive behavior group named Mutex. The lines with 
arrows indicate the gaps in both observations.
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Example 1 - Frequency/sequence method for mutually exclusive non-exhaustive events

Observation A contains two gaps.

When you de-select Analyze gaps between events in the Settings tab of the Reliability 
Analysis Settings window, only the start of behaviors are considered for linking.

Two agreements () and one disagreement () are obtained in the Comparison List:

 Agreement: 0.00 sec M1 (in observation A) - 0.00 sec M1 (in observation B).

 Disagreement: 1.34 sec M1 (A) - 0.00 sec M1 (B).

 Agreement: 5.07 sec M2 (A) - 5.27 sec M2 (B).

When you select Analyze gaps between events, the comparison of observations A and B 
results in two agreements () and three disagreements ():

 Agreement: 0.00 M1 sec (in observation A) - 0.00 sec M1 (observation B).

 Disagreement: 0.42 sec <Gap Mutex> (A) - 0.00 sec M1 (B).

 Disagreement: 1.34 sec M1 (A) - 0.00 sec M1 (B) (this is a disagreement because 0.00 sec 
M1 (in B) was already in agreement with another M1 event in A).

 Agreement: 5.07 sec M2 (A) - 5.27 sec M2 (B).

 Disagreement: 6.67 sec <Gap Mutex> (A) - 5.27 sec M2 (B).
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Example 2 - Duration/sequence based method for mutually exclusive non-exhaustive events

For this method, in this example it does not matter whether you include gaps in the analysis. 
The results of the comparison of observations A and B are an Agreement of 5.55 sec and a 
Disagreement of 2.73 sec:

Agreement – The two occurrences of M1 in observation A completely overlap with the 
occurrence of M1 in observation B: Agreement = 0.42 () + 3.73 () sec = 4.15 sec. The 
occurrence of M2 in observation A overlaps with M2 in observation B, except for the first 0.2 
sec: 1.6 () - 0.2 () = 1.4 sec. This results in a total Agreement of 4.15 + 1.4 = 5.55 sec.

Disagreement – For M1 in observation B, there is nothing scored at the start of observation A 
for a duration of 0.92 sec (). At the end of M1 in observation B, in observation A M2 is scored 
for a duration of 0.2 sec (). At the end of M2 in observation B, nothing is scored in 
observation A for 1.61 sec (). This results in a total Disagreement of 2.73 sec.

start-stop behaviors

Definition of a gap

In the example below, the group is named “Start-stop group” and the behavior names are S1 
and S2. A gap occurs before the start of S1, a second gap after the end of S1, and a third gap 
before the start of S2. Note the difference with the example above: the gaps are named 
according to the corresponding behavior, not the group. Each behavior determines its set of 
gaps.
398 Chapter 10 - Reliability Analysis



If during an observation a start-stop behavior is not scored, Reliability Analysis will consider a 
gap for that behavior from the start to the end of the observation.

Examples for start-stop behaviors

The figure below shows the visualization of two observations, C and D with events (s1, s2 and 
s3) from a behavior group in which behaviors can overlap. The lines with arrows indicate the 
gaps between behaviors. Note that event s3 was only scored in observation C and not in 
observation D. As a result, observation D contains a gap for behavior s3 throughout the 
observation (marked with <s3> in the figure below).

Example 1 - Frequency/sequence method for start-stop events

When you de-select Analyze gaps between events in the Settings tab of the Reliability 
Analysis Settings window, you obtain three agreements () and three disagreements ():

 Disagreement: 0.00 sec s1 (observation C) - 1.50 sec s1 (observation D).

 Agreement: 1.13 sec s1 (C) - 1.50 sec s1 (D).

 Agreement: 2.30 sec s2 (C) - 2.30 sec s2 (D).

 Disagreement: 7.88 sec s3 (C) - <nothing scored in combination> (D).

 Disagreement: 12.71 sec s2 (C) - 7.93 sec s2 (D).

 Agreement: 12.71 s2 (C) - 13.85 sec s2 (D).
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When you select Analyze gaps between events in the Settings tab of the Reliability Analysis 
Settings window, the comparison of observations C and D results in 8 agreements () and 5 
disagreements ():

 Disagreement: 0.0 sec s1 (C) - 0.0 sec <Gap s1> (D).

 Agreement: 0.0 sec <Gap s2> (in observation C) - 0.0 sec <Gap s2> (in observation D).

 Agreement: 0.0 sec <Gap s3> (C) - 0.0 sec <Gap s3> (D).

 Agreement: 0.49 sec <Gap s1> (C) - 0.0 sec <Gap s1> (D).

 Agreement: 1.13 sec s1 (C) - 1.5 sec s1 (D).

 Agreement: 2.3 sec s2 (C) - 2.3 s2 (D).

 Agreement: 3.27 sec <Gap s1> (C) - 3.0 sec <Gap s1> (D).

 Agreement: 5.93 sec <Gap s2> (C) - 5.93 <Gap s2> (D).

 Disagreement: 5.93 sec <Gap s2> (C) - 7.93 sec s2 (D).

 Disagreement: 7.88 sec s3 (C) - 0.0 <Gap s3> (D).

 Disagreement: 10.85 <Gap s3> (C) - 0.0 <Gap s3> (D).

 Disagreement: 12.71 sec s2 (C) - 10.92 sec <Gap s2> (D).

 Agreement: 12.71 sec s2 (C) - 13.85 sec s2 (D).

Example 2 - Duration/sequence based method for start-stop events
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When you de-select Analyze gaps between events in the Settings tab of the Reliability 
Analysis Settings window, comparison of observations C and D results in an Agreement of 
8.62 sec and a Disagreement of 8.23 sec:

 Agreement – s1 in observation D overlaps with s1 in observation C for 1.50 sec (first  in 
the picture). The first occurrence of s2 in observation D overlaps with s2 in observation C 
for 3.63 sec (). The third occurrence of s2 in observation D overlaps with s2 in 
observation C for 3.49 sec (last ). This results in a total Agreement of 8.62 sec.

 Disagreement – The first occurrence of s1 in observation C has no overlap with s1 in 
observation D for 0.49 sec (first  in the picture). The second occurrence of s1 in 
observation C has no overlap with s1 in observation D for 0.64 sec (second and third  in 
the picture together). The second occurrence of s2 in observation D has no overlap with 
s2 in observation C for 2.99 sec (fourth ). The occurrence of s3 in observation C has no 
overlap with s3 in observation D for 2.96 sec (fifth ). The second occurrence of s2 in 
observation C has no overlap with s2 in observation D for 1.14 sec (sixth ). This results in 
a total Disagreement of 8.23 sec.

When you select Analyze gaps between events in the Settings tab of the Reliability Analysis 
Settings window, the comparison of observations C and D based on the Duration/sequence 
method results in an Agreement of 43.79 sec and a Disagreement of 8.23 sec. The larger 
Agreement is due to the fact that all the overlapping gaps in the observations are now also 
taken into account in the calculation. You can check this in the Confusion matrix:

<Gap s1> - Total overlap of 14.71 sec between observations C and D.

<Gap s2> - Total overlap of 6.09 sec between the two observations.

<Gap s3> - Total overlap of 14.37 sec between the two observations.
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when suspending an observation

The interval during which the observation was suspended is treated as a gap. However, such 
a ‘suspend-resume’ gap leads to a different result in reliability analysis than a regular gap 
(when no behavior is scored from a mutually exclusive non-exhaustive group or a start-stop 
group). When you score, for example, behavior A and then suspend-resume the observation, 
you have one occurrence of behavior A with a gap. The reliability analysis, however, counts 
two occurrences of behavior A: one before suspend, and one after resume.

Consider for example the figure below. It shows part of the visualization of an observation 
which was suspended and resumed; behavior s1 was active before and after suspend-
resume. In the reliability analysis, this is counted as two occurrences of behavior s1 as if s1 
was scored again after resuming the observation.
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11.1 What is file management?

File management involves the handling of different type of files that you can open, save, 
rename, import or export. File management also involves the settings for file locations.

There is a difference between Import/Export and Open/Save. Open/Save means that when 
you open a file of a certain type you continue to work with that specific type of file. Import/
Export implies a conversion from a certain format to another type of format.

File types that can be managed in The Observer XT are:

 Project files (*.vop, or *.opp from previous Observer versions) – see below.

 Project backup files (*.vpb) – See page 408. 

 Template projects (*.tool barotb) – See page 407. 

 Observational Data (*.odx from The Observer XT 8, 9 or 10, *.odf from previous versions, 
or other observational data in text format) – See page 411 and page 424.

 External data – See Chapter 5. 

 European Data Format files (*.edf; *.bdf) – See page 435.

 Media files (*.avi, *.mpg, *.mpeg) – See page 436.

 Analysis Results including charts (*.arx, or *.arm from previous versions) – See page 438.

 Episode Selections (*.esr) – See page 441.

 Independent Variables – See page 444.

11.2 Projects

A project is based on your research question and contains different elements. These 
elements (Setup, Observations, Data Profiles, Episode Selections, Analysis) are visible in the 
Project Explorer. 

You should carry out all your file management in The Observer Project Explorer. 
If you delete, move or rename files using the Windows Explorer, The Observer 
may not be able to find the files again (because Observer files contain references 
to other files).
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The different elements (Setup, Observations, Data Profiles and Analysis) and their items can 
be opened either from the menu or by clicking an element or item in the Project Explorer.

creating a new project

You can create two types of projects:

 A new blank project – This empty project contains no settings.

 A project from a template – This existing template project contains settings that can be 
re-used in the new project.

Creating a new blank Project
1. To open a new project:

- In The Observer XT startup window, under Create a new project, click New blank 
project.

- From the File menu, select New Project (or press Ctrl+N).

2. Type in a new Project file name and click OK. 

The Project file is saved in a Project directory with the same name.

A Project file name cannot contain any of the following characters: \ / : ; * ? " < > | .

Creating a new Project from a template
1. To open a new project based on an existing template project:

- In The Observer XT startup window, under Create a new project, click New project from 
template.

- From the File menu, select New Experiment From Template.

2. In the New Project From Template window, click the Select button to select a template 
project (*.otb) from the Template folder (see “Saving a Project as a Template” below).

3. Type in a new Project file name and click OK. 

The Project file is saved in a Project directory with the same name.

A Project file name cannot contain any of the following characters: \ / : ; * ? " < > | .

You can still open a a template project (*.otx) from a previous version of The 
Observer XT (11/12) or a read-only project (*.vpx) from The Observer XT 8/9/10 
in this window. Make sure you have copied the otx or vpx file to the Template 
folder or browse to the file.
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saving a project

You have the following options to save a project in The Observer XT:

 You can save a project with all its settings and data (*.vop file) – See “Saving a Project” 
below.

 You can save a project with all its settings and data under a different name (*.vop file) – 
See “Renaming/Copying a Project” below.

 You can also save a project as a template (*.otb file) – A template project contains project 
settings, coding scheme and independent variables but no data. You can use a template 
project to exchange coding schemes or to re-use devices in the project setup. See “Saving 
a Project as a template” below.

The templates (*.otb) replace the templates and read-only projects (*.otx and *.vpx) from 
previous versions of The Observer XT.

Saving a Project

To save a project, select File and Save or press <Ctrl+S>.

You can use auto-save to temporarily save a Project:

1. From the File menu, select Preferences.

2. In the Auto recovery tab, select Save auto recovery and set the interval. 

Auto Recovery saves data to a temporary file. Your data are only saved in the Project file when 
you actually select Save Project from the File menu. Media files, or external data files are not 
saved to this temporary folder. When the program crashes, you get the choice to open the 
auto-saved project or to open The Observer XT. When you choose the latter option, you can 
open the manually saved project. 

Renaming/Copying a Project

You can rename or copy a project by saving it under a different name. From the File menu, 
select Save Project As and type in the new name of the Project.

Make sure the new project name does not contain any of the following characters: 
\ / : ; * ? " < > |.

See also “Creating a multiple coding station configuration” on page 409.
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Saving a Project as a template
1. From the File menu, select Save Project as Template.

2. Type in the name of the template project or use the current name.

3. Click the Save options button to open the Save Template Options window:
- Include Independent Variables – When you select this option, the Independent 

Variables are included in the template project.
- Include hardware and software devices – When you select this option, the hardware 

and software in the Devices list are contained in the template project. This is useful, 
for example, if you use The Observer XT in a observation lab and want to create a new 
project but use the standard hardware and software setup of your lab.

- Template information – Optionally, you can type in additional information about the 
template project.

4. Click OK twice to save the template project.

Opening a Project
1. Select File, Open Project or press <Ctrl+O>. In the Open project - Select file window,

browse to the folder where the project is stored. Open the folder with the same name as
the project.

2. Under Files of type, keep The Observer XT Project (*.vop) selected and select the *.vop file. 
Next, click Open. 

If you want to open a project from a backup file (*.vpb), see page 408 for 
more information.

If you open a project created in The Observer XT 11.0, it is automatically updated to an 
Observer 11.5 project. This then can no longer be read in The Observer XT 11.0. The 
Observer XT 11.5 automatically creates a backup (*.vpb) copy of the project in the Projects 
folder which can be opened in The Observer XT 11.0.

If your project includes Chinese/Japanese/Cyrillic language characters:

 You can view Chinese/Japanese/Cyrillic characters on a computer with an English 
language Windows system only when the correct Chinese, Japanese, or Cyrillic language 
pack has been installed.

 If the project was created on an English language Windows system (with Chinese, 
Japanese, or Cyrillic language pack installed), you can view it on a Chinese/Japanese/
Cyrillic language Windows computer.

See also “Creating a multiple coding station configuration” on page 7.
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 In all other cases the project opens but you cannot view the Chinese/Japanese/Cyrillic 
characters.

Backing up a Project

Follow this procedure to create a copy of your project that can be stored as a backup, sent to 
a colleague or to our Technical Support department in case of problems. 

1. Open the project and from the File menu, select Make Backup (or press <Ctrl+B>).

2. Select the following (optional):
- External data (selected by default) – Keep this option selected if you want to include 

the external (physiological) data files (*.pbi) in the backup file.
If you do not select this option, the backup still contains the name of the files (*.pbi). 
You can copy those files to the project’s External folder if necessary. If your project 
contains no physiological data, selecting/deselecting this option has no effect. 

- Import profiles – Select this option if you want to include the import profiles used to 
import the physiological data (*.eip) in the backup file. 

If necessary, change the file name and file location.

3. Click Save. Close the Information Message window.

The backup file contains a zipped copy of the Project folder and all its content (subfolders 
and files) and of the log file. References to media files and external (physiological) data 
outside of the Project folder and Preferences are always saved in the backup file.

To make you aware of the importance of creating backup files, a message appears after you 
saved and closed your project ten times asking whether you want to make a backup of the 
project. Click OK to make a backup or Cancel to close the project.

Restoring a Project

Follow this procedure to open a project from a backup file:

1. From the File menu, select Restore Backup (or press <Ctrl+R>).

2. Locate and select the backup file (*.vpb) you want to restore and click Open.

The Project directory and all associated files in the project are now restored.

The actual media files are not stored in the backup file. If you want to save these 
too, you should copy them to the Project folder before creating the backup file.

If you want to quickly copy observations, references to media files and external 
data, export them as ODX (see page 10).

You should store the backup file on a secure medium (CD, DVD, external hard 
disk or network drive), in a separate location.
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If your backup file includes external data and import profiles (see the options on the previous 
page), these are copied to the External project folder (page 447) and the Profiles folder 
(page 447), respectively. 

If you chose not to include the external data, you can still recover them. Open the 
Independent Variables List and point the mouse to the cells in the External data columns. A 
tool tip informs you about the name of the imported file (*.pbi). You can copy this file to the 
External project folder (see page 447 for its location).

Note that In The Observer XT 12.5 the space bar is not accepted as a key code. If your backup 
file from previous Observer XT versions contains key codes with “space” (for example “a b”), 
the space is automatically removed at import.

creating a multiple coding station configuration

A multiple coding station configuration is a way to collect and manage data from a number 
of coding stations that run the Coder license version of The Observer XT. You define a project 
with a coding scheme on the main Observer XT computer and save this as a template project. 
Each coding station receives a copy of this template project, where you can score events but 
not change the coding scheme (because of locked project settings). You can then import the 
observations from the coding stations in The Observer XT on the main computer (see Figure 
11.1).

To create a main project and copy it to the coding stations, do the following:

1. On the main Observer XT computer, create a project (see page 405) and define a coding
scheme.

2. From the File menu, select Save Project as Template. See Saving a Project as a template on 
page 407 for details.

3. Copy the template project to each coding station (see Figure 11.1). 

If the computers are on a network, you can do this with the Windows Explorer. 
Otherwise, use, for example, a USB stick. Make sure that The Observer XT 12.5 is installed 
on those PCs. If you copy the template project to the templates folder of The Observer XT, 
the program automatically locates the template. By default the location of this folder is: 
C:\Users\Public\Public Documents\Noldus\The Observer XT\Templates.
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4. On a coding station, start The Observer XT and from the File menu, select New Project 
From Template. If the project is stored in the templates folder, the correct location is 
selected automatically. Otherwise browse to the correct location. Click the Select button 
and open the template project (*.otb):
- If you open a template project in the Coder License version of The Observer XT, the 

suggested name for the new project is ‘[name of template project] - sub’.
- If you open the template project in a Full License version of The Observer XT, you can 

type in a name for the new project.

5. Click OK. The new project opens. Repeat steps 4-5 for all coding stations.

The Project Setup, Coding Scheme and Independent Variables in the new project are 
locked (indicated by a lock icon in the Project Explorer). 

You can only unlock the template project in a Full License version of The Observer XT: from 
the Setup menu, select Unlock Configuration, or right-click the Setup folder in the Project 
Explorer and select Unlock Configuration. We recommend to both keep the main project and 
template project locked, to make sure the settings stay the same!

To retrieve data (ODX files) from the coding stations, do the following:

1. On each coding station, export the observations as ODX files. From the File menu, select
Export, Observational Data. Choose the observations to export (see below) and specify
whether you want to export external data and media files. Make sure that ODX files have
unique names (for example: Coding Station 1 File 0001.odx).

2. Copy the ODX file from each coding station to the main PC (see Figure 11.1). 

Figure 11.1 A multiple coding stations configuration.
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3. Open the main project and from the File menu, select Import Observational Data (more 
details on page 424). 

The observations are imported in the main project, including the observational data, the 
independent variable values and the coding scheme (see page 424 for details). 

If your coding scheme or data contain special characters like ü or ç, before opening the *.otb 
and *.odx files make sure that your Windows Regional Options support those characters. 
Open the Control Panel and Region and Language. In the Administrative tab and click 
Change System Locale and choose your preferred language. Next, close and restart The 
Observer XT.

11.3 Exporting observational data

You can export logged events and related data by exporting observations. You can export 
observational data to:

 The Observer XT – To transfer event data from one project to another with The Observer 
XT data files (*.odx) (see below).

 Microsoft Excel – To export event data including external data to a Microsoft Excel 
workbook (*.xlsx) for further analysis (see page 413).

 Other software – To export event data including external data to other software for 
further analysis via text files (*.txt). Also use this option if you want to export part of 
your event data selected in a data profile (see page 414).

exporting data to observer xt data files (*.odx)

When you work with several researchers on the same project, you may need to export your 
data and import them into The Observer on a different computer. Follow this procedure to 
export observational data as ODX files (with extension *.odx) that can be imported to a 
project (see page 424).

See also an important note on time formats on page 61. 
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1. To export event data to Observer XT ODX files, you have the following options:
- To export multiple observations at once, from the File menu, select Export and 

Observational Data. In the Export Observational Data window, select The Observer XT. 
In the Export Observational Data window, select the observations you want to export.

- To export a specific observation, right-click that observation in the Project Explorer and 
select Export Observational Data and next The Observer XT.

2. Under Export options, choose the following (optional):
- Include media files – To include a copy of each media file associated with the 

observations in the same folder as the ODX file.
- Include external data – To include a copy of the external data files (*.pbi) associated 

with the observations. 
- Create separate file per observation – If you have multiple observations and you select 

this option, each observation is exported to a separate ODX file. Otherwise, all 
observations are exported to a single ODX file.

3. Click OK. 

4. In the Save As window, if necessary, change the file name and file location and click Save.

Notes on ODX export

 What an ODX file contains – All selected observations are included in one ODX file. If an 
observation contains multiple event logs, these are all included in the ODX file. You 
cannot choose to export some of the event logs from an observation. 

ODX files also contain the coding scheme, the coding scheme settings, the values of 
independent variables for the exported observations, event logs and subjects, and the 
current Project Settings for those observations. 

 Default names – If you export one observation, the suggested name is the name of the 
observation. If you export two or more observations, the name is formed by the first and 
the last observations you have selected in step 1. 

 Media files – The ODX file contains the path to the media files associated with the 
observations. Even if you choose not to include those media files in the ODX file, when 
you import the observations to another project, the program can find your media files 
and re-link them to the observations provided that the media files are on the same 
computer or a network server. For more information, see page 424. 

 External data – The ODX file contains a link to the location the external data files 
associated with the observations, not the external data itself. When you next import the 
observations into another project, make sure that the external data folder contains those 
files otherwise the program cannot open them.
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 If The Observer cannot find a media file or external data file in the project, a message is 
shown on opening of the observation linked to them. For media files, browse to the 
location on your PC where the file is stored. For external data, copy the data file (with 
extension *.pbi) to the folder which should contain the external data (see page 447).

exporting data to excel files (*.xlsx)

1. To export event data to an Excel file, you have the following options:
- To export multiple observations at once, from the File menu, select Export and 

Observational Data. In the Export Observational Data window, click Microsoft Excel.
- To export a specific observation, right-click that observation in the Project Explorer, 

and select Export Observational Data and Microsoft Excel.
- To export event data selected in the currently active Data Profile (indicated in blue and 

bold in the Experiment Explorer), from the Analyze menu, select Select Data, Export 
Selected Data and then Microsoft Excel.

- To export event data selected in a specific Data profile, in the Project Explorer, right-
click the Data Profile, select Export Data Profile and Microsoft Excel.

2. In the Export Observational Data window, in the Observations tab, select the observations 
you want to export.

If your project contains external data, the Export Observational Data window also 
contains an External Data tab. See page 416 for instructions how to export external data.

3. Under Export options, select the following:
- Create a single sheet with all observations – If you have multiple observations, with 

this option all observations are exported to a single Excel sheet.
- Create separate sheets per observation – If you have multiple observations, with this 

option each observation is exported to a separate Excel sheet.
- Create separate files per observation – If you have multiple observations, with this 

option each observation is exported to a separate Excel file.
- Include user-defined Independent Variables – If you select this option, one or more 

columns with user-defined Independent Variables are added to the export file.

When you click the Reset to Default button, the Export option Create a single sheet with 
all observations is selected and the option Include user-defined Independent Variables is 
de-selected.

You get a message when the maximum number of rows/columns of the Excel version 
installed is exceeded (Excel 2007/2010: maximum number of rows = 1.048.876, maximum 
number of columns = 16384, Excel 2003 and earlier: maximum number of rows = 65.536, 
maximum number of columns = 256.
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exporting data to text files (*.txt)

Event data are always exported to a single text (*.txt) file. For more information on how 
event data are exported, see page 415.

1. To export event data to a text file, you have the following options:
- To export multiple observations at once, from the File menu, select Export and 

Observational Data. In the Export Observational Data window, select Other software 
and click OK.

- To export a specific observation, right-click that observation in the Project Explorer and 
select Export Observational Data and Other software.

- To export event data selected in the currently active Data Profile (indicated in blue and 
bold in the Experiment Explorer), from the Analyze menu, select Select Data and 
Export Selected Data.

- To export event data selected in a specific Data profile, in the Project Explorer, right-
click the Data Profile and select Export Data Profile.

2. In the Export Observational Data window, in the Observations tab, select the observations 
you want to export.

If your project contains external data, the Export Observational Data window also 
contains an External Data tab. See page 416 for instructions how to export external data.

3. Under Export options, select the following:
- List separator – The selected list separator (comma, semicolon, tab or space, or the 

default Windows list separator) is used in the text file to separate columns. You can 
find and change the default Windows list separator in the Control Panel. Go to Region 
and Language and click Additional Settings. 

- Include user-defined Independent Variables – If you select this option, one or more 
columns with user-defined Independent Variables are added to the export file.

- Create separate file per observation – If you have multiple observations and you select 
this option, each observation is exported to a separate text file. Otherwise, all 
observations are exported to a single text file.

4. Click OK. In the Save As window, if necessary, change the file name and the file location. 

5. From the Save as type list, select Unicode Text (in case your data file contains Chinese/
Japanese/Cyrillic characters, or characters like "ä", "õ" etc.,) or ANSI Text (in all other cases). 
Choose ANSI if you want to import your data into SPSS.

6. Click Save.

When you click the Reset to Default button, the list separator is reset to the default 
Windows list separator and both Export options Include user-defined Independent 
Variables and Create separate file per observation are de-selected.
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How event data are exported

 All event data are exported to one text file. However, you can export observations to 
separate text files.

 Each event is exported with its original time stamp. All start and stops are exported, also 
for mutually exclusive behavior groups. For each behavior, the event type is indicated in a 
separate column.

 Coding scheme elements (Subject, Behavior, Modifier) that were not scored for any of the 
exported observations are not included in the text file.

 Modifiers of the same group are put in the same column. All observations contain the 
same number of modifier columns.

 Event logs of the same observation are merged. 

 Observations are written as contiguous block above each other without empty rows in 
between.

 The following columns are exported to both the Excel and text file (see Figure 11.2):
- Date/time columns – 

 Date_Time_Absolute_dmy_hmsf) – The day, month, year, hour, minutes, seconds 
with three decimals.

 Date_ dmy – The date (day - month - year) belonging to the absolute time.
 Time_Absolute_hms – The hours, minutes and seconds belonging to the absolute 

time. 
 Time_Absolute_f – The decimals belonging to the seconds of the absolute time. 
 Time_Relative_ hmsf) – The time since the start of the observation in hours, 

minutes, and seconds with decimals. 
 Time_Relative_hms – The hours, minutes, and seconds belonging to the relative 

time. 
 Time_Relative_f – The decimals of the seconds belonging to the relative time. 
 Time_Relative_sf – The seconds with decimals belonging to the relative time.
 Duration_sf – The duration of the current state in seconds with decimals. 

- Result Container – This column is only present if you exported the data selected with a 
Data profile (Analyze > Select Data > Export Selected Data). It contains the name of 
the result container in the Data profile.

- Observation – The Observation name.
- Event_Log – The Event Log name.

Merging of event logs assumes that a specific subject-behavior combination 
does not occur at the same time in two separate event logs within the same 
observation.
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- Coding scheme element columns (if scored) – Behaviors, Subjects or Modifiers.
- Event_Type – State start, State stop, Point, Sample, Suspend, Resume.
- Comment – Only present when comments were scored. 
- Independent Variable.

Notes on export of event data

 To export media files and external data together with observational data, choose ODX as 
export format (see page 411).

 Default names – The suggested name of an exported text file with multiple observations 
consists of the [Project name] - [first selected observation name]-[last selected 
observation name] - “Event Logs”. You can preview this name in the File name box.

exporting external data

You can export external data to an Excel file (*.xlsx) or an text file (*.txt). Export of external 
data can be done either with or without the associated event data.

If you export external data and event data combined, the time basis (that is, time-stamps at 
regular intervals) of the external data is used in the export file. For more information on how 
combined event data and external data are exported, see How combined external data + 
event data are exported on page 418.

A

B

Figure 11.2 Example of the columns of an text export file which was imported into Excel. A – Date/time 
columns, B – Event data and independent variable columns.
416 Chapter 11 - File management



1. From the File menu, select Export and Observational Data. In the Export Observational
Data window, select Excel or Other software and click OK.

To export a external data from a specific observation, open that observation, click the 
Export current observation icon in the tool bar and Excel or Other software.

To export external data selected in a Data Profile, open that Data Profile, click the Export 
selected data icon and select Export Data Profile.

2. If you also want to export event data, select your observations in the Observations tab.

If you want to exclude event data from the export, make sure you select the option 
Export external data only and exclude event data described in step 4 below.

3. In the External Data tab, select the External data signals you want to export.

4. Under Export options, you can select the following:
- Export external data only and exclude event data – If you select this option, no event 

data are exported.
- Point events with the same time-stamp are exported in:

 One column – If you select this option, point events and instantaneous samples, 
that have the same time-stamp after resampling, are exported to one column and 
separated by comma’s. Select this option if you have used Point events as markers.
Columns are separated by the List separator that you can select under Export 
options in the Observation tab (see page 414).
For details about the result of selecting this option see How event data and 
external data are resampled on page 418.

 Separate columns – If you select this option, point events and instantaneous 
samples, that overlap in time after resampling, are exported each to a separate 
column. Select this option if you have used Point events to score behaviors and 
want to analyze Point events.
This option is not available, if you have selected the option Export external data 
only and exclude event data.

- Missing value symbol – If the external data file contains missing values, you can select 
here “Blank”, “NaN”, “–” or “.” to replace the missing values. Missing values are ignored 
in the external data statistics.

5. Under Resample options, you can select the following:
- External data sample rate – Here you can select one of the available sample rates (Hz) 

based on the selected external data signals.
By default, the lowest available sample rate is selected.

- User defined sample rate – Here you can enter a user-defined sample rate (possible 
range between 0.001 and 2000 Hz).
See also How external data are resampled on page 421.
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How combined external data + event data are exported

 Event data and external data are resampled, based on the sample rate you selected. 
Therefore, time stamps are equidistant for both external and event data.

See How event data and external data are resampled on page 418 and How external data 
are resampled on page 421 for more information on resampling.

 For an event with duration, the value at a sample is exported. 

 For a point event (without duration) and an instantaneous sample, the value at the next 
sample after the event time of the point event/instantaneous sample is exported. If a 
point event was scored more than once in between two samples, only the last value is 
exported at the next sample.

 Each Subject - mutually-exclusive Behavior group combination is exported to a separate 
column, including modifiers. Each Subject - start-stop Behavior group combination is 
exported to a separate column.

 Observations are written as contiguous block above each other without empty rows 
in between.

 Each independent variable is exported to a separate column. Independent variables with 
event log or subject scope are exported to separate columns. For example, when you 
have an observation with two event logs and an independent variable ‘Task’, this results 
in two separate independent variable columns with headings ‘Task/Event Log 1’ and 
‘Task/Event Log 2’.

 The same columns are exported as when you export event data (see page 415) except for 
the columns Durations (s), Event Log, Event type, and Comments.

How event data and external data are resampled

Example – You study the response of a child to playing an online game. In the observation, 
two video files are recorded, one of the child’s face, one with the screen capture of the 
monitor. Simultaneously, the child’s heart rate is monitored. FaceReader is used to analyze 
the video recording of the child’s face. Both the FaceReader log files with the states as 
observational and external data (sample rate: 29.981 Hz) are imported into The Observer. The 
heart rate data are imported as external data (sample rate: 0.5 Hz) into the observation. After 
import of the FaceReader and heart rate data, you score the vocal behavior of the child 
manually, as point events (without duration).

You make a Data Profile in which only the first minute of the observation is selected, because 
you initially want to study the response of the child in the first minute of the test. 

In the export, besides the events in the observations, you include the external heart rate data 
and FaceReader’s external data signal ‘Happy’. Under Export options, you select ‘One column’ 
from the Point events with the same time-stamp are exported in list. Under Resample 
418 Chapter 11 - File management



options, you select External data sample rate with the value of external data ‘Heart rate’, 
which is ‘0.5’.

As a result, the event data and the heart rate data are resampled before they are exported.

In the export file (text or Excel) with event data and external data combined (see Figure 11.3 
for an example), the column with relative time contains the time stamps based on the 
chosen Sample rate (0.5 Hz in this case). Because ‘One column’ was selected (see page 418), 
the event with duration Unknown and event without duration Vocalization that occur at the 
same time are exported to the same column, separated by a comma. The event Vocalization 
is resampled at the first sample (8.0 s) following the original time the event occurred (7.07 s).

See How Point events are resampled on page 419 for more information.

How Point events are resampled

If you have mainly defined Point events (events without duration) in your coding scheme to 
score and analyze your data, you should export Point events to Separate columns (see 
page 417). As a result, Point events that have the same time-stamp after resampling are 
written to separate columns.

Figure 11.3 Example of part of an export Excel file with event data and heart rate data. In this example, the 
event data have been resampled to the sample rate (0.5 Hz) of the heart rate data. This Excel sheet shows 
the relative time, the observation name, the event log name, the behavior name of the two behavior 
groups and event type for each sample. For details, see the text above.

Different Subject - Behavior group combinations are always exported to 
separate columns.
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Example – You have a Coding scheme with two Subjects and two Behavior groups with only 
Point events (see figure below).

Part of the observation is shown in Figure 11.4 below.

Simultaneously, external data is acquired with a sample rate of 1 Hz.

Next, you export the event data and external data. You export the Point events to Separate 
columns and choose a sample rate of 1 Hz. Figure 11.5 shows what the export file looks like.

Figure 11.4 Example of an observation with only Point events.

Figure 11.5 Example of an export file, in which Point events (as scored as shown in Figure 11.4) are exported 
to Separate columns with a sample rate of 1 Hz (compare this with Figure 11.6 in which Point events are 
exported to One column.
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When you export the same event data + external data to One column, the same Subject - 
Behavior group combinations that have the same time-stamp after resampling are exported 
to the same column (see Figure 11.6 below and compare with Figure 11.5).

How external data are resampled

Figure 11.6 Example of an export file, in which Point events are exported to One column (compare with 
Figure 11.5 in which Point events are exported to Separate columns). As a result, Point events from the same 
Behavior group with the same time-stamp after resampling are exported to the same column.

For resampling external data, it is assumed that external data is continuous and 
therefore can be described by a continuous function.

Figure 11.7 Example of resampling external data. A - Original heart rate data (sample rate: 2 Hz), B - The 
same heart rate data resampled with a sample rate of 29.981 Hz.
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Example – You study the response of a child to playing an online game. You have imported 
heart rate data (sampled with 2 Hz) and FaceReader data (sampled with 29.981 Hz). You want 
to export event data + external data with a sample rate of 29.981 Hz. In this case, the heart 
rate data needs to be resampled. This is done by linearly interpolating the heart rate data at 
the sample time points for which heart rate data is missing.

In Figure 11.7 on page 421, picture A shows the original heart rate values (sample rate: 2 Hz) 
for the first 10 seconds of the observation. The picture B shows the resampled heart rate data 
(with sample rate: 29.981 Hz).

How missing values are resampled

If your dataset contains missing samples, the sample will also be converted into the symbol 
NaN. When such external data are exported the resampled samples will get a NaN value in 
the export file, when at least one of the samples used for interpolation has a NaN value. 
Figure 11.8 explains this in more detail. 

exporting data to text files with the find function

With the Find function you can quickly export your data by copying them and pasting them 
into another program. You can also export a specific selection of your events. You can use this 
method for a quick view of your events or a selection of events. 

Figure 11.8 Resampling a data file with missing samples. A cell in the export file will get a NaN 
value when at least one of the cells used for interpolation had a NaN value. 
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To export events into another program:

1. Open an observation.

2. Click the Find button on the tool bar, select Find from the Edit menu, or press 
<Ctrl+F>. 
The Find window appears.

3. Specify the selection in the upper part of the screen.

4. Click Find.

5. You can hide columns that are not of interest. To select which columns to show or hide, 
right-click a header.

6. If you scored Start-Stop events and want to hide the stop events, click the checkbox in 
front of Hide Stop events. 

7. To export all events, click the Export all events button. Otherwise, select the events you 
want to export and click the Export selected events button. You can export the events as 
a text file or to Excel. 

[

The Find function does not create a subset of data ready to be analyzed (for 
example, to calculate statistics). For this purpose, select data in the data profile 
(see Chapter 6).

You can also copy the events and paste them in another program. To do so, right-
click one of the cells and select Copy all. 

To use the exported data in a statistical package you may need the event start 
time together with the event durations. Make sure the Duration column is 
visible. If it is hidden, right-click a column header, select Show column and select 
the checkbox in front of Duration. 
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11.4 Importing observational data

You can import observational data into an existing Project (see also the previous page for 
importing data from multiple projects). Observational data can be:

 Exported Observer XT (*.odx) data files and Observer log files (*.odx) from FaceReader – 
See below.

 Other external data in text format containing a header, a column with time stamps and 
one or more columns with codes – See page 427. 

importing observer xt data files

When you work with several researchers on the same project, you may need to export your 
data and import them into The Observer on a different computer. Follow this procedure if 
you have exported observational data as ODX files (with extension *.odx; see page 411) and 
you want to import them to a project. 

An ODX file may contain two or more observations and event logs, depending on how many 
observations you have selected for export (see page 411). 

Chinese, Japanese or Cyrillic characters

If your coding scheme or data contain special characters like ü or ç or Chinese, Japanese, or 
Cyrillic language characters, before importing *.odx files make sure that your Windows 
Regional Options support those characters. Open the Control Panel and click Region and 
Language. In the Administrative tab and click Change System Locale and choose your 
preferred language. Next, close and restart The Observer. 

Note that In The Observer XT 11.5 the space bar is not accepted as a key code. If your 
observational data files exported from previous Observer XT versions contain key codes with 
“space” (for example “a b”), the space is automatically removed at import.

Importing ODX files as separate observations
1. From the File menu, select Import, then Observational Data. 

Alternatively, in the Project Explorer, click the Observations item, then in the overview 
window, click Import observations. 

Please note that The Observer 11.5 is compatible with odx output from 
FaceReader 3, 4, and 5, not from FaceReader 2.
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2. In the Import Observational Data window, make sure that The Observer XT (*.odx) is 
selected in the Files of type list.

3. Locate the folder where the exported ODX files are stored and click the one you want to 
import. Next, click Open. 

Result – The observations contained in the ODX file are imported and shown in the 
Project Explorer. Each observation can contain more than one event log, depending on 
how many event logs the exported observations contained. The first observation of this 
group is opened on your screen. Repeat the procedure to import more ODX files.

Importing ODX files to an existing observation
1. Open the observation you want the data to be imported to. 

2. Click the Import Data button in the Component tool bar, then choose Import 
observational data.

3. In the Import Observational Data window, make sure that The Observer XT (*.odx) is 
selected under Files of type.

4. Locate the folder where the exported ODX files are stored and click the one you want to 
import. Next, click Open. 

Result – A message informs you that event logs from the first observation in the ODX file 
have been added to the current observation. A check for errors in the Event logs is carried 
out. Correct the errors that were found. 

The imported event logs retain their original names. If the observation already contains 
event logs with that name, a suffix _imported [#] is added to the imported file names. 

If the ODX file contains multiple observations, data are imported only for 
the first observation.

When you import *.odx files from a coding station, the start time of the event 
logs will depend on the setup of your main project:

 If the Observation source in the main project is set to Offline observation, all 
event logs that you import into one observation are set to the same start 
time, in order for all observations to match the video/audio file. This 
overwrites the original start time of the coding station. If you have specified 
an offset, this relative offset stays the same.

 If the Observation source in the main project is set to Live, then the start 
times of each imported event log are not changed. In this case it is important 
that the clocks of all the coding stations are synchronized, so that relative 
differences in start time does not change after importing it into 
the main project.
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What happens to the coding scheme?

Elements are imported to the coding scheme – An ODX file contains information on the 
coding scheme of the project it was exported from. All elements of the coding scheme are 
imported, no matter whether they were scored in those observations. When you import an 
observation to a project, The Observer checks that the elements in that observation have 
exactly the same characteristics as the elements in the coding scheme of the destination 
project. For example, that a behavior has the same name, properties (with or without 
duration and belonging to the same group type or not, etc.) and modifiers. 

 If the element is exactly the same, the existing element is used. Note: any difference in 
Description, Sound file, Plot color and 'Always add comment' option is ignored. 

 If there is any difference in the properties, the new element is incorporated in the coding 
scheme. 

Possible conflicts between imported data and existing data – If your imported data contain 
restrictions between subject and behavior, or connections between a subject/behavior and a 
modifier that are not specified in your coding scheme, the data already present in your 
project may be invalidated. The Observer XT performs a check when you import 
observational data. If errors are found, a window appears in which the errors are listed. You 
can choose to let The Observer XT fix the errors automatically, or you can correct the errors 
yourself. checking the event log for errors and correcting errors automatically on 
page 147 for more information. 

Example 1 – You import an observation where the behavior Play can be scored for subject 
Child, not the subject Parent. If the project contains data like 'Parent Play', these are marked 
as errors.

Example 2 – You import an observation where the behavior Play is attached to the required 
group of modifiers Play type. If the project contains events like 'Play' without modifiers, 
these are marked as errors. 

Event logs with errors cannot be analyzed or visualized. Open those observations and edit 
the data to correct those errors. You can also export event logs with errors to edit them 
externally and then import them again after you have fixed them. To do this: from the File 
menu, select Export, Observational Data, No, OK, No, OK and then Other software (see 
page 414 for further instructions).

What happens to the independent variables?

An ODX file contains the independent variables and their values assigned in the original 
project. If a variable is already present in the Independent Variable List of the destination 
project, it is updated with the values from the imported observations. If it is a new variable, 
it is added to the Independent Variable List. 
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Importing media files and physiological data

If you have chosen to include media files or external data files in the exported observations 
(see page 411), the programs looks for those files in the folder where the ODX file was stored.

 Media files – The original path to the file that was written in the ODX file is stored in the 
Independent Variables List under Video or Audio if the media file was not found in the 
folder where the ODX is stored. When opening the observation, the program asks you to 
locate that media file. 

 External data – The name of the external data file is stored in the Independent Variables 
List under External Data. If the external data file (*.pbi) is not found, a message is shown 
'Physiological data file not found'. To restore the link between an observation and a 
external data file, copy the PBI file to the project's External folder.

How are the imported data synchronized?

When you import observational data that are collected offline from video, the absolute time 
stamps differ from the time stamps of the observation. Therefore, the time stamps of the 
imported data are not aligned with the time stamps of the Event log. This is also the case 
when you, for example, import data from FaceReader that were collected offline. See the 
table below in which case The Observer XT does or does not align the time stamps of the 
imported data with the time stamps of the Event log. 

importing other observational data

Follow this procedure if you want to import event data stored in a format different from 
Observer data. 

To import data with Chinese, Japanese, or Cyrillic characters or characters like “ü” or “ç”, 
make sure that the import file is Unicode UTF-16 encoded. 

Table 11.9 Alignment of time stamps of imported data to the Event log.

Live observation in 
The Observer XT

Offline observation in
The Observer XT

Imported ODX collected
in live observation

Time stamps are aligned Time stamps are 
NOT aligned

Imported ODX collected
in offline observation

Time stamps are 
NOT aligned

Time stamps are 
NOT aligned
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To import data recorded with Instantaneous sampling, see page 424. 

1. From the File menu, select Import, then Observational Data. 

Alternatively, in the Project Explorer, click the Observations item. In the overview 
window, click Import observations.

2. If you already have an Import Profile for the observational data file, select the name of this 
profile from the under Files of type.

In the Files of type list, select All Files (*.*) if you want to see all files in the folder.

3. If the data file does not have a column that specifies whether events have duration or not, 
choose how to import the behaviors by selecting Point events (no duration) or State 
events (mutually exclusive) (with duration) in the Treat new Behaviors as group.

You cannot specify the type of modifier which is imported. If you import multiple 
modifiers of different types, all modifiers are imported as Numerical ‘range’ Modifiers.

4. Select the external data file and click Open.

Creating a Custom Import Profile
1. In the Import Observational Data window, click Custom Import Profiles.

2. In the Import Profiles window, click Create New.

3. In the Import Profile Definition window (Figure 11.10), click Browse and select a 
representative file for defining your import profile. Next, click Open.

The Observer XT automatically detects header and data information in the observational 
data file. If automatic header detection does not work and you get an import error, you 
should use manual header detection. header detection on page 434 for more 
information.

Next, you can manually assign the file content from the File content section to the Data 
definition part of the Profile definition section. You do this by dragging-and-dropping 
the content from the File content to the Profile definition (see point 5, below).   

4. Select a delimiter or a combination of delimiters for both the file context in the Header 
and Data Sets. Double-click <user-defined> if you want to use a delimiter that is not in the 
list of delimiters. If the data file contains text between quotes, and you do not want to 
have that text split according to the data delimiters, select the quote from the Text 
qualifier list. 
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Figure 11.10 Part of the Import Profile Definition window. The window consists of two parts: the File 
content section and the Profile definition section. The File content section contains two groups: A - Header 
with header information from the imported observational data file, B - Data sets with the data 
information from the imported data file.
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5. If the data is correctly separated into different cells, you can drag-and-drop content from 
the File content section to the corresponding cells in the Profile definition section.

If the Header contains date and time information, drag-and-drop this to the Start date 
box and the Start time box in the Profile definition section (Figure 11.11). 
- Specifying the date format

 When you drop the date in the Start Date box, the Select Date Format window 
opens. If the date matches one of the predefined formats, The Observer 
automatically selects one. Converted Date shows the converted date and 
Conversion is OK. Click OK.

Figure 11.11 The original location of date and time 
information in the Header section and the new location in 
the Profile definition section you can drag-and-drop them 
to.
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 You can also define your own format by typing a 'd' for each number representing 
'day', an 'M' for 'month' and a 'y' for each number representing 'year'. If Conversion 
is OK, then click OK. 

- Specifying the time format:
 When you drop the time in the Start Time box, the Select Time Format window 

opens. If the time matches one of the predefined formats, The Observer 
automatically selects one. Converted time shows the converted time and 
Conversion is OK. Click OK.

 You can also define your own format by typing an 'H' for each number representing 
'hour', an 'm' for 'minute', an 's' for second and a 'f' for each number representing 
millisecond (see the next picture). If Conversion is OK, then click OK.
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 Under Import Time, select one of the options. 
- Relative to time zero - Suppose the first row in the imported event data set has time 

00:00:05. When the option Relative to time zero is selected, the time stamp of the 
first row of the imported data set will remain 00:00:05. 

- Relative to the time of the first data line - Suppose the event data set you want to 
import starts at 14:28:00 and sample every 5 seconds. With the option Relative to the 
time of the first data line, the first row of the imported event data will get the time 
stamp 00:00:00. The second row will have time stamp 00:00:05. The options under 
Import Time are grayed out when your time stamps contain the date the file was 
created. In this case the option Relative to time zero is used. This is also the case when 
a Start date is specified in the Custom Import Profiles window (see Figure 11.11).

6. Next, you can assign Data Set information to the corresponding columns in the Data 
definition part.
- Missing samples – If your data set contains missing samples indicated by non-numeric 

symbols, you need to specify this symbol first. If you do not do this, The Observer will 
interpret the symbols as indicating that all the file up to that point is the header.

- Select the Treat as number check box.
 Type in the non-numeric symbol in the Treat as number field or click the button 

next to it to select one or more predefined symbols. 
 To select a specific text, click <User Defined>, click OK and enter this text after a 

comma (,). 
 If text is identified by a character, select this from the Text qualifier list. 

- Time – Drag-and-drop one of the cells containing time stamps to the Time column (see 
Figure 11.12). The Select Time Format window opens. Under Select Format in the Select 
Time Format window you can select a Numeric Value or a Date/time format. Click OK if 
the Converted time shows the right format and Conversion is OK.

- Subject, Behavior, Modifier, Comment.
Drag-and-drop one of the cells containing information on Subject, Behavior, Modifier 
and Comment from the Data Sets sheet to the corresponding column in the Data 
definition sheet.
To import multiple modifiers, select multiple modifier columns in the Data Sets group 
and drag them to the Modifier column in the Data definition group.
Effects of import of modifiers on the coding scheme – The modifiers placed in 
different columns in the import file will be automatically organized in separate 
groups in the coding scheme. 
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- Event Type – If the import file contains a column that specify whether the event line is 
a start/stop of an event, drag this column to the Event Type column in the Data 
definition group. In the Define Event Keywords window that appears, under Keyword 
enter the text that identifies the start of a state event (with duration), the stop of a 
state event and the point event (without duration) in the import file, respectively. Click 
OK to confirm. 
After dragging the Event Type column, the Treat new behaviors as option (page 427) is 
disabled because the program recognizes events automatically.

7. Click OK. Type in the profile name. You can also add a Description. Next, click OK. Note: If 
you want to save the profile with a new name, click Save As instead of OK in the Import 
Profile Definition window. 

8. Close the Profile Definition window.

9. Select the newly created import profile and click Close.

10.Select the observational data file and click Open to finish the import of the observational 
data file.

Figure 11.12 The original location timestamps (column C) and the new location (Time column) in the Profile 
definition section. After drag-and-drop, data are grayed in the original location.

If the import file contains data collected with Instantaneous Sampling, the 
Define Event Keywords window does not recognize the samples. We advise you 
to import sample data via the ODX files (page 443).

In The Observer XT 11.5 you cannot use uLog and you cannot import uLog data. 
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Editing an existing Import Profile

If you want to import an observational data file that is very similar to another data file for 
which you already have an Import Profile, then you can edit the existing Import Profile.

1. In the Import Observational Data window, click Custom Import Profiles.

2. Select the Import Profile from the list in the Import Profiles window and click Edit.

In the Select Sample File group, you see the original sample file behind Profile based on.

3. Click Browse to select the new observational data file and click Open.

4. Follow the instructions 4-6 under “Creating a new Import Profile” above.

5. Click Save Profile As when you are finished filling in the Data definition sheet.

6. Type in the name for the Import Profile.

7. Click OK.

8. Close the Profile Definition window.

9. Close the Import Profiles window. Make sure you select the right import profile.

10.Select the observational data file and click Open to finish import.

header detection

When you create a Custom Import Profile when you want to import an observational data 
file, The Observer XT usually automatically detects header and data information in the file. In 
some cases, however, the format of the file prevents The Observer from automatically 
detecting header and data. For these cases, new Header detection methods have been added 
to the Import Profile Definition window.

The methods for Header detection are:

 Automatic - This method (which was already available in previous Observer XT versions) 
is selected by default and works most of the time.

 Specify tag - If automatic detection does not work, you can specify the line (with either 
nominal or numerical information) that indicates the end of the header part of the file. If 
necessary, you can also specify the number of rows between this ‘header end line’ and 
the data.

 Specify row number - If automatic detection does not work but the data file always has 
the same number of rows in the header, you can specify the number of rows in the 
Import Profile.
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Specify tag

Select this method if the external data file has a variable number of header lines rows and 
header and observational data are always separated by the same ‘header end line’.

Example - The header always ends with a line containing the following text: “[ObsData]”. 
After this header end line there are always two empty lines before the data starts. So, in the 
End tag box you enter: “[ObsData]” and in the Extra rows box you enter a value of ‘2’.

Specify row number

Select this method if the header contains less than 10 lines. In the Fixed rows box, enter the 
appropriate number of rows.

11.5 Importing European Data Format files

European Data Format (EDF) and BioSemi Data Format (BDF) are standard binary formats to 
store and exchange physiological data. BDF is the 24 bit version of EDF, which is 16 bit. Many 
systems to collect physiological data can export to EDF, or BDF. You can import EDF, or BDF 
data into The Observer XT.  

To import EDF, or BDF data:

1. Open the observation that you want to import the data into. 

If you do not have an observation open, a new observation will be created. Give the 
observation a name, select a video if you score offline, and continue with step 3 below. 

2. Choose File > Import > European Data Format Files.

3. Locate the file and click Open. 

If you do not have an observation open, a new observation will be created. Give the 
observation a name and select a video if you score offline. 

You can now:

 If necessary, synchronize the imported data with the event log (see manual 
synchronization in Chapter 5 External Data).  

 Select data based on the value of the imported data (see select intervals by external 
data in Chapter 6 Selecting Data).

You need the External Data Module (see Additional licenses on page 21) to import 
EDF or BDF data. 
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 Visualize the imported data (see Visualizing external data in Chapter 7 Visualizing Data).

 Analyze the imported data with Numerical Analysis (see Chapter 8 Calculating Statistics).

11.6 Importing Viso sessions

Sessions made in the Noldus video recording program Viso can be imported into The 
Observer XT. The Viso annotations markers and remarks are imported into the coding 
scheme and event log. Viso markers are imported as behaviors without duration (point 
events) and remarks as comments in the event log. 

To import Viso sessions directly into The Observer XT, the computer with The Observer XT 
must be in the same network as the Viso computers. If the computers are in different 
networks, export the sessions in Viso to The Observer XT and import the sessions (*.odx) as 
observational data into The Observer XT (see page 424).

If the computers are in the same network, choose File > Preferences > Viso settings to set 
communication between the computer with The Observer XT and the computer with Viso 
Services. See page 96 for details. Choose File > Import > Viso Sessions and select the sessions 
in the Import Viso Sessions window that appears.  

11.7 Media files

Check the The Observer XT Service Manual to see which media files The Observer XT 
supports. 

For more information on Viso sessions in The Observer XT, consult the Viso 
Reference Manual. 
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Why add media files?

If you have not added a media file to a new Observation, you can afterwards add one or more 
media files to an existing Observation. This is useful if you want to log events from different 
scenes or from two cameras recording the same scene from different angles.

You can add two video and/or audio files to an existing observation in the standard version 
of The Observer. With the Multiple Video add-on module you can add a total of four video 
and/or audio files to an observation.

Adding a video file

To add a video file to an existing observation, open the observation, then click the 
Import Video button in the Component tool bar.

Select a video file in the Select Video window and click OK.

The video file is always added with the Observation as the Scope. The Scope determines at 
what level you can score using this video file. 

Adding an audio file

To add an audio file to an existing observation, open the observation, then click the 
Import Audio button in the Component tool bar. 

Select an audio file in the Select Audio window and click OK.

Showing audio waveforms from a video file

When you add a video file you can choose to show the audio waveforms next to the video 
image. See the procedure on page 160.

Adding two or more media files

Depending on your license, you can add multiple media files to the same observation. See 
the procedures on page 158. 

Replacing a media file
1. Open the Independent Variable List window by doing one of the following:

- From the Setup menu, select Independent Variables.
- Click the Enter independent variables button on the tool bar. 
- In the Project Explorer, click Independent Variables.

2. Click on the name of the media file you want to replace and click the ellipsis button.

In the window that opens, select another media file and click Open.
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Removing a media file from an observation

To remove a single media file from an observation, click in the Independent Variables List the 
corresponding cell in the Video or Audio column and press Delete and then OK.

The media file is only removed from your project, not deleted from disk.

Removing a media file variable

The instructions below remove a Video or Audio column in your Independent Variable List. 
This means that all the links between the video/audio files in that column and the 
observations are removed. To remove a specific media file from your project, see above.

1. Open the Independent Variable List window by doing one of the following:
- From the Setup menu, select Independent Variables.
- Click the Enter independent variables button on the tool bar. 
- In the Project Explorer, click Independent Variables.

2. Right-click in a Video or Audio column and select Delete independent variable, 
and click OK.

11.8 Analysis results

Analysis results are created when you run behavioral analysis, numerical analysis, reliability 
analysis or lag sequential analysis. However, they are not saved automatically.

Saved (archived) Analysis Results can contain one or more Charts.

Saving Analysis Results and associated charts
1. Make sure that the analysis result is open on the screen. In the Component tool bar,

click the Archive button.

2. Change the result file name or accept the suggested name, then click Save.
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3. The Analysis Result now appears in the Project Explorer in the appropriate folder under 
Analyses. 

- The destination folder is named as the type of analysis you have run, and is located 
under Analysis Results in the current Project folder. You cannot save your analysis 
results outside that folder. 

- The default name for the Analysis Results file is: <prefix><number>.arx. The prefix 
varies according to the type of result (Behavior Analysis, Reliability Analysis etc.). The 
number is augmented by 1 every time you save the result with the default name. 

Opening analysis results

You can open one or more analysis results for re-inspection or export. You can only open 
analysis results from the current project.

1. From the Analyze menu, select the analysis type and then Open Archive.

2. Select the result file you want to open and click Open.

The result window opens. You cannot re-run calculations in a saved and re-opened 
analysis result.

To open an analysis result you can also:
- Click the Analysis result in the Project Explorer.
- Right-click the Analysis result in the Project Explorer and select Open.
- If an analysis result of the same type is open, click the Open Archive button on 

the Component tool bar. 

Removing analysis results

To remove an archived analysis result, right-click it in the Project Explorer and select Remove. 
Removing an analysis result does not delete the file (*.arx) from the Analysis Results folder of 
your project. To open it again, click the Open Archive button on the Component tool bar.
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Exporting analysis results

You can export analysis results to Excel or ASCII (text). Either format can be imported into 
Excel or a statistical program for further analysis.

1. Make sure that the analysis result you want to export is open on the screen (see
the previous page). From the Analyze menu, select Export Analysis Results, or click
the Export button on the Component tool bar.

2. In the Export Analysis Results window, browse to the folder where you want to store the 
exported file. By default, this is the Export folder within your project folder. 

3. From the Save as type list, select the format you require:
- Excel Workbook (*.xlsx).
- Text File (*.txt).

If you choose Text Files, next to Encoding, select whether you want to export as Unicode 
(UTF-16) (choose this if your export file contains Chinese, Japanese, or Cyrillic characters, 
or characters like "ä", "õ" etc.) or ANSI (choose this option if you want to open the analysis 
results in SPSS). Furthermore, select a column separator from the List separator list.
- Additionally, you can select the option Merge header rows.

4. In the File name field, type in a name or accept the suggested name and click Export.

Notes

 Exporting to Text files – If the results are in separate sheets in the Analysis Results 
window, then these sheets are exported to separate text files. The name of such a file is: 
[File name]_[name of sheet].txt. 

 Exporting to Excel –
- You get a message when the maximum number of rows/columns is exceeded (Excel 

2007/2010: maximum number of rows = 1.048.876, maximum number of columns = 
16384, Excel 2003 and earlier: maximum number of rows = 65.536, maximum number 
of columns = 256.

- If the results are in separate sheets in the Analysis Results window, then these sheets 
are exported as separate worksheets within the Excel file.

You can only export the current analysis result or those saved previously. If you 
plan to export many results, first save each of them, or export each of them 
before creating the next one.
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 Copy and paste – You can also export analysis results directly by copying and pasting the 
cells into, for example, an Excel-sheet:

a Drag the mouse to select the rows and columns you want to export. Select Copy in the
Edit menu. If you want to copy the whole result including the headings, select Select All
in the Edit menu and subsequently select Copy.

b Open the document you want to paste the result to, and press <Ctrl+V>.

Saving a Chart

See page 336 how to create a Chart. Make sure the corresponding Analysis Results are saved.

1. In the Chart window, click the Save Chart in Archive button.

2. In the Analysis Chart window, enter the Chart name.

3. Click OK to save the chart in the Analysis Results archive.

Opening a Chart

In the Project Explorer, under an archived Analysis Result, click a Chart to open it.

Deleting a Chart

To delete a chart, right-click it in the Project Explorer and select Delete. Deleting a chart also 
deletes the chart file from the computer. 

Exporting a Chart
1. Open the Chart (see above).

2. In the Chart window, click the Export button.

3. Enter the File name and select one of the image formats from the Save as type list.

4. Click Save to export the Chart.

11.9 Episode selections

With an episode selection (page 273) you can create a selection of events from the Event Log. 
From this episode selection you can generate a video file containing the selected episodes 
(available with an additional module of The Observer XT). You can export an episode 
selection to a text file.

By exporting an episode selection, you also export the physiological data associated with the 
observations listed in the episode selection to text.
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Opening an episode selection

Do one of the following:

 From the Analyze menu, select Episode Selection, then Open. Select an episode selection 
and click OK.

 In the Project Explorer, right-click Episode Selections and select Open Episode Selection. 
Select an episode selection and click OK.

 In the Project Explorer, open the Episode Selections folder and click the episode selection 
you want to open.

Deleting an episode selection

Do one of the following:

 From the Analyze menu, select Episode Selection, then Delete. In the Remove Episode 
Selection window, select the Episode Selection you want to delete and click OK.

 In the Project Explorer, right-click the Episode Selections folder and select Delete. Select 
the episode selection you want to delete and click OK.

 In the Project Explorer, right-click an episode selection and select Delete.

Exporting an episode selection

You can choose to export all created episode selections at once or each episode selection 
separately.

If you export an episode selection, The Observer automatically also exports the associated 
physiological data to ASCII.

1. To export all episode selections at once, from the Analyze menu, select Episode Selection,
then Export.

To export a single episode selection, In the Project Explorer right-click the episode 
selection and select Export Episode Selection.

2. In the Episode Selection Export window, browse to the folder where you want to store the 
episode selections.

3. In the File base name field, enter a name.
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4. Select whether you want the files to be exported as Unicode (UTF-16) (choose this if your 
export file contains Chinese, Japanese, or Cyrillic characters, or characters like "ä", "õ" etc.) 
or ANSI text files from the Encoding list.

5. Select the column separator you require from the List separator list. By default, Windows 
default list separator is selected. 

You can check what your current Windows list separator is in the Control Panel, under 
Region and Language. In the Formats tab, click the Additional Settings button to display 
the List separator. 

6. Click Export. 

Notes

 Default folder – By default, The Observer opens the Export folder of your project. 

 Exporting physiological data – The associated physiological data are exported to a 
separated file: [Base filename]-[Episode Selection name]- physiological data set number 
(#).txt. If you have an episode selection with more than one associated physiological 
data file, each data file is exported to a separate text file. For example, if you have 2 
Episode Selections with 3 physiological data files each, the result of the export is 2 files 
with events and 6 files with physiological data.

If you have set roll-on and roll-off times, the samples within these intervals are 
also exported.

 Exporting multiple episode selections – The name of each text export file is: [Base 
filename]-[Episode Selection name] (#).txt. 

Figure 11.13 The result export of an episode selection. The associated physiological data are also exported.
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11.10 Independent Variable list

Exporting independent variables

You can export the independent variables (i.e., system variables, user-defined variables, 
external variables). The independent variables are exported in two files. One file contains the 
Header with variable names and their properties:

The other file contains the actual values of the variables for each combination of 
observation, event log and subject (see Structure of the values file below).

1. From the File menu, select Export, then Independent Variables.

2. In the Independent Variable List Export window (Figure 11.14), browse to the folder where 
you want to store the variable list.

3. In the File base name field, enter a name. An example of the file names is shown in the File 
name example box:
- [file name entered in step 3] - Independent Variables Header (1).txt is the file 

containing the variable definitions.
- [file name entered in step 3] - Independent Variables Values (1).txt is the file containing 

the variable values.

4. Select whether you want the files to be exported as Unicode or ANSI text files from the 
Encoding list. 

5. From the List separator list, select the column separator you require. By default, Windows 
default list separator is selected. 

6. Click Save. 
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To check what your current Windows list separator is, open the Control Panel, and choose 
Region and Language > Formats > Additional Settings.  

Structure of the values file 

 The values file contains the values of all independent variables, including the system 
variables, and those you chose not to display in the Independent Variables List (see 
page 91). 

 Each combination of observation, event log and subject is written in a row. Values of 
variables with Subject scope are written in those rows. 

 If a variable has Event log or Observation scope, it gets an additional row. Values of such 
variables are written in those rows. 

Figure 11.14 The Independent Variables List Export window.
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 All other cells are filled in with missing values (""). 

Example - The project contains two observations, each with one event log and two 
subjects (Child 1 and Child 2). The independent variables include the user-defined variable 
Age with Subject scope and the system variable Start date with Observation scope.

The export file opened with the Notepad contains the following:

For Observation 1, we can distinguish:

 A – First line containing the variable names. Note the Age variable at the end of the line.

 B – Two lines, each specifying one subject (Child 1 or Child 2), with the values of Age. Note 
the age values at the end of the lines. Values of variables with other scope than Subject 
are exported as "" for those lines.

 C – A line specifying the event log. In this file there are no variables with Event Log scope, 
thus all values for this line are "". Note that this line does not contain the subject names.

 D – A line specifying the observation. This line contains the values of the system 
variables, since those have Observation scope. Note that this line does not contain the 
event log and subject names.
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11.11 File locations

General folders

The default application folder of The Observer is C:\Program Files\Noldus\The Observer XT 
11. You can specify the application folder during installation. The application folder is only 
written to during installation.

All files that The Observer writes to or reads after installation are, by default:

 C:\Users\Public\Public Documents\Noldus\The Observer XT \Projects - contains all 
project folders.

 C:\Users\Public\Public Documents\Noldus\The Observer XT \Video files - contains all 
video files.

 C:\Users\Public\Public Documents\Noldus\The Observer XT \Audio files - Here you can 
store the audio files which you use for coding.

 C:\Users\Public\Public Documents\Noldus\The Observer XT \Templates - contains all 
templates.

The application folder and all other Observer folders can be network folders. However, in that 
case the program or Projects might not be accessible by all users.

Project-level folders

Each project you make has its own folder. It is named as the project and has a fixed structure. 
It contains the following subfolders:

 Analysis Results - with the analysis results files (*.arx) and sub-folders with the analysis 
charts (*.nac).

 Episode Selections - with the episode selection files (*.esr). 

 Event Data - with the binary observational data files.

 Export - with the exported files (*.odx, *.txt, *.xls).

 External - with the imported binary external data, or imported European Data Format 
Files (*.pbi).

 Intermediate – with files created by the external data analysis.

 Plug-ins – with settings of installed external event generator plugins.

 Log - with The Observer log file (*.log).

The Profiles for import of observational (*.oip) and physiological data (*.eip) are stored in:

C:\ProgramData\Noldus\Common\Profiles.
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These files are common for Noldus applications.

Log and dump files (for Technical Support)

The Observer continually records computer events to a log file. In the case you encounter 
problems using the software, the Technical Support Department may ask you to send us two 
files, the log file Observer.log and the dump file The Observer XT 11.dmp. These are stored on:

 Log file – C:\ProgramData\Noldus\The Observer\XT 12\Log.

 Dump file – C:\Users\<user name>\AppData\Local\Temp\.
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Appendix A
Keyboard shortcuts

All the common functions in The Observer XT have keyboard shortcuts. You can use the 
keyboard to activate all the functions in The Observer XT that are on the menus. Press Alt 
plus the letter underlined in the menu and then select the desired function by scrolling down 
to the function or by pressing the underlined letter. For example, to go to Preferences on the 
File menu, press ALT+F, f.

Why Keyboard Shortcuts? - Keyboard shortcuts allow you to use The Observer XT without 
taking your hands off the keyboard. Using keyboard shortcuts can also help in the prevention 
of repetitive strain injury.

Keyboard shortcuts are only available when the corresponding menu or window is active.

A.1 General

Ctrl+N New project
Ctrl+O Open project
Ctrl+S Save project
Ctrl+Shift+S Save As project
Ctrl+B Make Backup
Ctrl+R Restore Backup
Ctrl+P Print
Alt+F4 Exit
Ctrl+M Open Playback control options window
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A.2 Coding Scheme

A.3 Carrying out observations

Ctrl+E Add new element
Ctrl+Del Delete element
Ctrl+C Copy
Ctrl+V Paste
Ctrl+Shift+E Add new group
F2 Rename element

Alt+F6 New observation
Ctrl+Shift+N New observation
Ctrl+Alt+F6 Open observation
Ctrl+Alt+O Open an event log within the observation currently

open
Ctrl+E Add new element
Enter Accept entry and go to first column of next row
Ctrl+Alt+B Start observation
Ctrl+Alt+Q Stop observation/ stop reviewing
Ctrl+Alt+X Suspend observation
Ctrl+Alt+V Resume observation
Ctrl+End Go to end of Event Log Data File
Ctrl+Home Go to begin of Event Log Data File
Ctrl+Shift+Down-arrow Go to Next sample
Ctrl+Shift+Up-arrow Go to Previous sample
Ctrl+Enter Finish sample
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A.4 Playback control

Spacebar Play forward at speed 1x; Pressing Spacebar toggles
between Play forward and Pause

Shift+Spacebar Play backward at speed 1x; Pressing Shift+Spacebar
toggles between Play backward and Pause

Ctrl+= Play one speed faster
Ctrl+- (key next to 0) Play one speed slower
Ctrl+Up-arrow key Jump to begin
Ctrl+Down-arrow key Jump to end
Ctrl+0 Pause/Stop
Ctrl+Left-arrow key Step frame backward
Ctrl+Right-arrow key Step frame forward
Ctrl+Shift+Left-arrow key Step 10 frames backward
Ctrl+Shift+Right-arrow key Step 10 frames forward
Ctrl+Backspace Quick review
Ctrl+Shift+= Offset
Ctrl+1 Play forward at speed 1/25xa

Ctrl+2 Play forward at speed 1/5x
Ctrl+3 Play forward at speed 1/2x
Ctrl+4 Play forward at speed 1x
Ctrl+5 Play forward at speed 2x
Ctrl+6 Play forward at speed 4x
Ctrl+7 Play forward at speed 8x
Ctrl+8 Play forward at speed 16x
Ctrl+9 Play forward at last used speed
Ctrl+Shift+1 Play backward at speed 1/25x
Ctrl+Shift+2 Play backward at speed 1/5x
Ctrl+Shift+3 Play backward at speed 1/2x
Ctrl+Shift+4 Play backward at speed 1x
Ctrl+Shift+5 Play backward at speed 2x
Ctrl+Shift+6 Play backward at speed 4x
Ctrl+Shift+7 Play backward at speed 8x
Ctrl+Shift+8 Play backward at speed 16x
Appendix A - Keyboard shortcuts 451



a If a fixed play speed is not available, nothing happens. If the video is already playing, it 
keeps playing at the current speed.
b The Ctrl+Alt(+Shift) shortcut-keys can be used for jog/shuttle devices. The speeds are not 
fixed but are set when they are available. For example, if only speed 1 (forward/backward) is 
available, pressing Ctrl+Alt+1 selects speed 1. If all speeds are available, pressing Ctrl+Alt+1 
selects speed 1/25, pressing Ctrl+Alt+2 selects speed 1/5 etc. 

Ctrl+Shift+9 Play backward at last used speed
Ctrl+Alt+1 Play forward at 1st available speedb

Ctrl+Alt+2 Play forward at 2nd available speed
Ctrl+Alt+3 Play forward at 3rd available speed
Ctrl+Alt+4 Play forward at 4th available speed
Ctrl+Alt+5 Play forward at 5th available speed
Ctrl+Alt+6 Play forward at 6th available speed
Ctrl+Alt+7 Play forward at 7th available speed
Ctrl+Alt+8 Play forward at 8th available speed
Ctrl+Alt+Shift+1 Play backward at 1st available speed
Ctrl+Alt+Shift+2 Play backward at 2nd available speed
Ctrl+Alt+Shift+3 Play backward at 3rd available speed
Ctrl+Alt+Shift+4 Play backward at 4th available speed
Ctrl+Alt+Shift+5 Play backward at 5th available speed
Ctrl+Alt+Shift+6 Play backward at 6th available speed
Ctrl+Alt+Shift+7 Play backward at 7th available speed
Ctrl+Alt+Shift+8 Play backward at 8th available speed
Ctrl+. Zoom+ (x-axis)
Ctrl+Mousewheel Zoom+ (x-axis) or Zoom- (x-axis)
Ctrl+, Zoom- (x-axis)
Ctrl+Shift+. Zoom+ (y-axis)
Ctrl+Shift+, Zoom- (y-axis)
Ctrl+L Switch loop on/off
Ctrl+H Reset loop to default (start and end of slider range)
Ctrl+J (User defined loop) Set start of loop
Ctrl+K (User defined loop) Set end of loop
Ctrl+J (Fixed loop) Move loop to previous interval
Ctrl+K (Fixed loop) Move loop to next interval
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A.5 Data Profile

A.6 Grids (e.g. Event log, Episode selection window)

General
   Ctrl+Alt+F7 New Data Profile
   Alt+F7 Show current Data Profile
Components window
   Enter Add box of selected component
Data Selection window
   Arrow key Move the mouse pointer 10 pixels within the Data

Selection window
   Shift+arrow key Move the mouse pointer 1 pixel within the Data

Selection window
   Alt+arrow key Connect, move, size depending on the current position

of the pointer

Ctrl+left-arrow key Event log: move 1 second backward or 1 frame
backward when video is available. Episode Selection:
move one row backward

Ctrl+right-arrow key Event log: move 1 second forward or 1 frame forward
when video is available. Episode Selection: move one
row forward

Ctrl+up-arrow key Jump to start
Ctrl+down-arrow key Jump to end
Arrow keys Move highlight in direction of key
F2 Edit Event Time in Event Log
Ctrl+I Insert row or Episode 
Tab Go to next cell in row. If last cell, do nothing
Shift+Tab Go to previous cell in row. If first cell, do nothing
Enter Accept entry and go to same column, next row.
Page Up Go to row - no. of rows visible in window and highlight

same location (and deselect)
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A.7 Selecting and editing

A.8 Windows

Page Down Go to row + no. of rows visible in window and highlight
same location (and deselect)

Ctrl+Home Go to first cell of first column
Ctrl+End Go to last cell of last column
Up-arrow key Step one row up
Down-arrow key Step one row down
Shift+Down-arrow key,
Shift+Up-arrow key

Select row

Ctrl+Z Undo
Ctrl+Y Redo
Ctrl+X Cut
Ctrl+C Copy
Ctrl+V Paste
Ctrl+Delete or Delete Delete
Shift+arrow keys Expand/ contract block selection in direction of arrow

key
Ctrl+A Select all

General
   Esc Cancel action
   F1 Help
   F2 Rename/edit
   Alt+F4 Close application
   Shift+F10 
   or context-menu key

Open context menu of selected item

   Alt+Spacebar Open shortcut menu of selected window
   Ctrl+Esc Display Start menu
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   Alt+underlined letter Application: open corresponding main menu
Dialog: carry out corresponding command

   F10 Activate main menu bar
   Main menu: Down-arrow
 key

Open menu-item/cycle through sub-items

   Main menu: Up-arrow key Open menu-item/cycle through sub-items
   Main menu: Right-arrow key Open sub-items/Cycle through items
   Main menu: Left-arrow key Close sub-items/Cycle through items
   Spacebar Select/clear box (if active option is a checkbox)
   Arrow keys Move/nudge cursor or selected item
   Mousewheel Scroll up or down
   Ctrl+Mousewheel Zoom in or out
   Shift+Mousewheel Scroll left or right
Project Explorer
   End Display the bottom of the active window
   Home Display the top of the active window
   * on numeric keypad Display all subfolders under the selected folder
   + on numeric keypad Display the contents of the selected folder
   - on numeric keypad Collapse the selected folder
   Left arrow key Collapse current selection if it is expanded, or select

parent folder
   Right arrow key Display current selection if it is collapsed, or select first

subfolder
   Up arrow key Previous item
   Down arrow key Next item
Dialogs
   Ctrl+Tab Cycle thru tabs (direction: left -> right and top ->

bottom)
   Ctrl+Shift+Tab Cycle thru tabs in reverse order
   Tab Cycle thru options (direction: left -> right and top ->

bottom)
   Shift+Tab Cycle thru options in reverse order
   Arrow keys Cycle thru options if option group (radio button group)

is active
Switch applications
   Alt+Tab Switch between open applications
   Alt + Esc Cycle through applications in order they were opened
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Appendix B
Technical support

B.1 Support database

If you encounter a problem using The Observer XT or any other Noldus system, you can 
search through hundreds of entries in a database of questions submitted by our customers 
to the Noldus support department with answers by our support staff.

You find the support database at (www.noldus.com/support-center).

B.2 Help Desk

If you have any problems, questions, remarks or comments, please let us know. You can 
contact us via our website (www.noldus.com/helpdesk) and fill out a Support Request Form 
(preferred), or phone. We offer 24-hour support via several help desks in different time zones. 
You can also contact us via the The Observer XT program. From the Help menu choose Noldus 
Online and then Contact Help Desk. If you encounter a problem with the program, you can 
also select Report an Issue. This opens a form on our website which is sent to the help desk 
when submitted. 

Having the following information available when you contact the help desk will enable our 
support staff to help you as quickly as possible. To find this information, go to the Help menu 
and select About The Observer XT:

 The version number of your copy of The Observer XT.

 The name of the registered user of The Observer XT (click User Info).

 The license number of your copy of The Observer XT (click User Info).
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Please refer to the About Noldus - Contact section on our website (www.noldus.com) for 
other contact information.

error messages

When an error message occurs, in most cases a log file is created called Observer.log. The 
Technical Support Department may request this file when answering your support question. 
You can locate the file in: 

C:\ProgramData\Noldus\The Observer\XT 12\Log.

It is possible that this folder is hidden – to view hidden files: from the Organize menu of the 
Windows Explorer, choose Folder and Search Options. Go to the tab View. Under Hidden Files 
and Folders select Show Hidden Files and Folders. 

B.3 Service contracts

Your licence of The Observer XT comes with a standard service package of one year. This 
includes a one-year period of free support.

We can offer you even greater value and reassurance by providing comprehensive service 
contracts. Our Plus and Platinum service contracts both extend the standard service you are 
entitled to as well as provide peace of mind at defined cost.

Please look for more information on our website (www.noldus.com) under Human Behavior 
or Animal Behavior in the Services - Service Contracts section.
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Appendix C
License agreement

1. LICENSE. Noldus Information Technology b.v. ('Noldus') grants you a non-exclusive license
to use the software and accompanying documentation (collectively called the 'Software'
in this agreement) in accordance with the following terms. Noldus retains title and all
ownership rights to the Software. Noldus will allow you to make back-up copies of the
Software, always including copyright notices, provided that these copies are only for your
own use. Noldus grants you the right to transfer this license and the Software to another
party, provided that (a) the other party accepts all terms of this agreement, (b) all copies
of the software are transferred and you discontinue use of the Software after
transferring, (c) Noldus is promptly notified of the license number of the Software and
the name and address of the other party, and (d) Noldus is not required to supply new
media. You may not sublicense, assign or transfer the license or the Software except as
expressly provided in this agreement. Any attempt otherwise to sublicense, assign or
transfer any of the rights, duties or obligations hereunder is void. You may not receive
money or any other form of compensation for transferring the license.

2. TERM AND TERMINATION. Failure to comply with any of these terms will terminate this 
agreement and your right to use the Software. You may also choose to terminate the 
agreement at any time. Upon termination of this agreement, you must immediately 
destroy the Software and all copies of it.

3. LIMITED WARRANTY. Noldus warrants that the media on which the Software is furnished 
are free of defects in workmanship and material under normal use, and that the Software 
will perform substantially in accordance with the specifications set forth in the 
documentation provided with the Software, for a period of ninety (90) days from the date 
of purchase by you. During the 90-day warranty period, if the Software does not perform 
as warranted, Noldus at its sole option will (a) provide, without charge, a replacement of 
the media, (b) provide, without charge, corrected Software, (c) replace, without charge, 
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Software with a functionally similar program, or (d) refund the fees paid for licensing the 
Software. These are your sole and exclusive remedies for any breach of warranty. Do not 
return any product until you have called Noldus or its supplier and obtained a return 
authorization number.

4. DISCLAIMER. Software is licensed 'as is' without warranty as to its performance. Except for 
the limited warranty provided above, there are no warranties expressed or implied, 
including but not limited to implied warranties of merchantability or fitness for a 
particular purpose, and all such warranties are expressly disclaimed. In no event shall 
Noldus or its suppliers be responsible for any indirect or consequential damage or lost 
profits, even if Noldus and its suppliers had been advised of the possibility of such 
damage.

5. MISCELLANEOUS. The Software and accompanying documentation are protected by both 
Dutch copyright law and international copyright treaty provisions. This agreement will be 
governed by the laws of The Netherlands.

6. OTHER SOFTWARE. The Observer XT contains:
- The ZipArchive Library - Creation, modification and decompression of "zip" format 

archives. Copyright © 2000 - 2015 Artpol Software - Tadeusz Dracz.
- MainConcept codecs. Copyright  2015 MainConcept AG, Aachen.
- LAV audio Filters. 

LAV audio Filters are based on the FFmpeg multimedia libraries (licensed under GPLv2) 
which is free software: you can redistribute it and/or modify it under the terms of the 
GNU Lesser General Public License as published by the Free Software Foundation, 
either version 3 of the License, or (at your option) any later version. The full text of the 
GNU Lesser General Public License can be found at http:// www.gnu.org/licenses/
lgpl-3.0.txt . Source code is available at http://code.google.com/p/lavfilters/ .

These files or modules may not be reverse assembled, reverse compiled or otherwise 
translated.
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Index
— Numerics
1st quartile – 323, 327
25th percentile – 323, 327
3rd quartile – 323, 327
75th percentile – 323, 327

— A
About The Observer XT – 28, 457
Abscissa – 341
Absolute time format

AM and PM – 61
Action by external program – 157
Action-reaction – 130
Activating a data profile – 249
Active

coding scheme element – 86
Adding

a new line in the Event Log – 122
an element to a scored event line – 121
an element to the coding scheme 
while observing – 114
comment – 104
media files – 437
series to chart – 339

Agreements in reliability analysis – 390
Aligning observations – 373

in reliability analysis result – 388
with absolute start times – 373
with first scored events – 374
with observation start times – 374
with video start time – 374

Allow other values – 90
AM notation – 61

Analysis – 438
behavior analysis – 300
lag sequential analysis – 346
numerical analysis – 300
reliability analysis – 364

Analysis chart
see Charts

Analysis result
behavior analysis – 306
customizing for charts – 337
exporting – 440
folder – 447
lag sequential analysis – 357
numerical analysis – 306
opening – 439
reliability analysis – 381
removing – 439
saving – 438
statistics – 306

Analysis settings
for behavior analysis – 302
for lag sequential analysis – 356
for numerical analysis – 302
for reliability analysis – 376
for statistics – 304

Analyzed duration – 166
Analyzing data – 18
AND logic

data selection – 240
Audio – 62, 261

from video – 134, 261, 437
import – 131

Auto record subject – 62
Auto recovery – 406
Index 461
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Automatic
correcting errors in event log – 147
generating keycodes – 57
header detection – 176, 185, 434
linking of digital video files – 157
stopping an observation – 111
synchronization – 187

Average Kappa – 396
Axes

scaling chart axes – 341

— B
Backing up a project – 408
Bar chart – 339
BDF data – 435
Behavior – 70

adding to coding scheme while 
observing – 114
behaviors can overlap – 78
behaviors cannot occur at the same time – 78
color – 77, 82
deleting from coding scheme – 86
filtering – 215
find – 151
frequently-asked questions – 78
instantaneous sampling – 75
merging in data selection – 208
modifiers – 78
mutually exclusive – 78
mutually exclusive and exhaustive – 78
properties – 77
selecting intervals – 228
start-stop – 78
triggering – 130
with or without duration – 78

Behavior analysis – 300
Behavior data plot

see event plot

Behavior group for 
instantaneous sampling – 73
Behavior group properties – 76
Behaviors

selecting intervals – 228
Behaviors can overlap – 72
Behaviors cannot occur at the 
same time – 71, 77, 78

Behaviors with duration – 74
Behaviors without duration – 73
BIOPAC

data acquisition system – 172
import profile – 173

BioSemi data format files – 435
Blood pressure data – 172

— C
Calculating Statistics – 299

for multiple event logs – 330
procedure overview – 301

Cameras – 32
Carrying out an observation – 97

procedure in short – 99
with external data – 156
with external programs – 157

Cell values in reliability analysis – 383
Channels – 69
Characters 
(Chinese/Japanese/Cyrillic) – 32, 424
Charts – 336, 441
Check coding scheme while 
editing – 58, 83
Check for Updates – 28
Checking

coding scheme – 83
event log – 138, 147
for Pocket Observer compatibility – 58

Chinese characters – 32
importing data – 427

Chinese/Japanese/Cyrillic 
Characters – 20, 424
Codec – 33, 292
Codes window – 136

customizing – 137
Coding error – 67, 83
Index



Coding scheme
adding an element while observing – 114
check – 83
combinations – 70
creating – 66
deleting element – 86
editing – 85
exchanging – 409
importing with odx files – 426
online validation of – 58
removing an element while observing – 117
settings – 57
using coding scheme sounds – 64

Cohen’s Kappa – 391
Collapsing elements in a result

behavioral and numerical analysis – 313
lag sequential analysis – 361

Colors
changing in an event plot – 272
changing in external data plots – 272

Combine continuous and 
instantaneous sampling – 51
Combined results in 
reliability analysis – 375, 384, 387
Combined sampling

why use – 53
Combining

filters – 211
intervals – 356
intervals and timebins – 261

Comment – 118
visualization – 26

Compare all events in 
reliability analysis – 372
Compare time based intersection in 
reliability analysis – 373
Comparing observations

see Reliability analysis

Comparison list – 387, 396
Complex data selections – 240
Components pane – 199
Compulsory

variable value update – 92
Computer specifications – 33, 34
Concordance – 390

Confidence interval – 395
Confusion matrix – 382
Connecting

selection boxes – 204
Connecting arrow

deleting – 204
Contact Help Desk – 457
Continuous and instantaneous sampling

scoring – 109
Continuous sampling – 51

statistics – 316
subjects – 68
why use – 51

Copying
a project – 406
a project to multiple computers – 409
backup copy of a project – 408
data profile – 250
events in the episode selection – 286
selection box – 204
transitions in the episode selection – 286

Correcting errors in event log 
automatically – 147
Crash – 406
Creating

a new event log – 167
a new project from a template – 46
a project – 405
behavior group while scoring – 116
behavior groups – 74
behaviors – 74
blank episode selection – 274
charts – 336
data profile – 248
data selection – 200
episode selection – 273
episode selection from single event log – 275
episode selection from time event plot – 278
episode selection visualization – 25
epsiode selection from current 
data profile – 276
new DAQ hardware settings profile – 187
new import profile – 176
new observation – 99
new project – 46
results box – 205
sample groups – 75

Criterion event – 346
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Current time
of observation – 135

Customizing
codes window – 137
event log window – 140
event plots – 267
lag sequential analysis result – 360
playback control window – 145
reliability analysis result – 386, 387
statistics result – 311
timers window – 136
video window – 146
windows – 133, 134

Cyrillic characters – 32, 407, 424, 427

— D
Data Acquisition System – 48
Data labels

charts – 340
Data points – 134, 262, 263
Data profile – 199, 248
Data selection

AND logic – 240
complex selections – 201, 240
creating – 200
multiple results boxes – 241
OR logic – 240
screen – 198
screenshot – 202
window – 199

Decimals
in independent variable values – 88, 89
in lag sequential analysis – 350
in reliability analysis – 375
in statistics – 302
separator – 88

Default
file locations – 447
keycode length – 58

Deleting
a coding scheme element – 86
a coding scheme element while 
observing – 117
a media file – 159, 438
a media variable – 438
a scored element in the event Log – 121
an episode selection – 442
charts – 342
coding scheme element while observing – 117
connecting arrow – 204
current element from event log – 138
data profile – 250
event rows from event log – 122
group of selection boxes – 204
media variable – 438
pairs of observation in 
reliability analysis – 369
selection box – 204
transitions from an episode selection – 286
variables from independent variable list – 92

Description
of behaviors – 77
of coding errors – 84
of modifiers – 82
of project – 55
of subjects – 69

Disagreements in 
reliability analysis – 390

caused by modifiers – 389
Disk space – 35
Docking and undocking windows – 146
Double scoring of active behaviors – 62
Download page – 14
Downloading technical notes – 28
DSI

import profile – 173
Dump file for Technical Support – 448
Duration

as percentage – 322
changing – 125
filtering – 217
observation – 165
of analyzed observation – 166
selecting intervals – 234
total duration – 319, 329

DV-AVI
record live video to dv-avi files – 113
Index



DV-device – 113

— E
ECG data – 172
EDF data – 435
Editing

a chart – 339
an import profile – 184, 434
chart category name – 340
coding scheme – 115, 117
coding scheme element – 85
data – 120
data profile – 249
episode selection – 282
episode video – 293
event data in event plot – 266
independent variables – 59, 92
statistics results – 311

EEG data – 172
Elapsed time

of observation – 135
Ending an observation

automatically – 111
manually – 111
prompt for confirmation to end – 59

Environmental data
see external data

Episode selection – 256, 441
changing duration of 
roll-on/roll-off times – 289, 296
changing duration of subtitles – 289, 294
copying events – 286
copying transitions – 286
creating – 273
creating a blank one – 273, 274
creating from current data profile – 273, 276
creating from single event log – 275
creating from visualization – 25, 278
deleting – 442
deleting transitions – 286
episode video – 293
exporting – 290, 442
exporting to text – 290
hiding a column – 288
moving episodes – 285
opening – 442
playing a point event – 289
playing an event – 289
playing back – 289

rename – 281
showing columns – 287
sorting columns – 289
transitions – 296
with instantaneous sampling – 274

Episode video – 293
roll on/off time – 294
subtitles – 293
transitions – 296

Error message – 458
Errors in event log – 147, 426

after deleting combinations – 70
automatic fix – 147

European data format files – 172, 435
Event Log – 98, 165

adding a new row – 122
analyzing multiple – 330
changing or deleting a scored element – 121
checker – 147, 426
checking import – 167
containing errors – 112, 147
customizing window – 140
event logs in view settings – 133
exporting – 132, 411
importing – 167, 424
in reliability analysis – 380
multiple in one observation – 164
not overlapping in time – 333
overlapping in time – 331
removing one or more event rows – 122
re-opening – 124
start time – 135, 165, 168
stop time – 135, 165
window – 138

Event plot – 254, 257, 258
changing colors – 272
comment – 119
copy and paste – 266
customizing – 267
double data labels – 268
exporting – 266
interpreting – 259
making screenshot – 266
playing back data – 265
showing/hiding audio – 271
showing/hiding events – 270
showing/hiding plots – 271
showing/hiding video – 271
sorting plots – 270
specifying time format – 269
specifying time mode – 269
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Events
finding – 151
initial state events – 74
sample events – 51

Example projects – 14
Excel – 413, 440

export – 411, 413, 416
maximum number of 
rows/columns – 413, 440

Exchanging
coding scheme – 409

Exhaustive – 77
Exporting

an analysis result – 440
an episode selection – 290, 442
charts – 342
current observation – 139
data with Chinese/Japanese/Cyrillic 
characters – 416
event plot – 266
external data – 412
independent variables – 444
media files – 412
observational data – 132, 411
selected data – 413, 414
to excel – 413, 416

External data – 26, 156, 171
carrying out observations with – 156
equidistant time stamps – 183
european data format files – 435
external data in view settings – 134
folder – 447
header detection – 185
importing – 173
interval selection – 224, 225
missing samples – 183, 236
module – 21
plots – 258, 263
prerequisites – 183
scope – 173
selecting intervals – 235
show/hide – 128
specifying external data acquisition – 156
synchronizing with logged events – 186
visualizing – 263

External Data Module – 172
External programs – 157
Eye-tracking data

see external data

— F
File locations – 447

setting preferences for – 94
File management – 403

removing results – 439
Filter keys – 102
Filtering – 197

behaviors – 215
duration – 217
independent variables – 213
methods – 210
modifiers – 216
observations – 212, 367
procedure in short – 211
rules – 241
selecting data – 210
subjects – 214

Find – 151, 422
First

latency to – 323
Folders – 447
Formatting charts – 340
Free interval selection

see intervals by manual selection

Frequency
of transitions – 349
see also total number – 321

— G
Gaps in reliability analysis – 384, 396
Generating a media file – 290
Group in the coding scheme

behaviors – 71
modifiers – 79, 83

Grouping
see Merging

— H
Hardware devices – 32, 48

save in template project – 47
Hardware key – 41

upgrading – 28, 42
Hasp Sentinel Runtime – 40
Index



Header
automatic detection – 176, 434
detection – 185, 434
specify row number – 434
specify tag – 434

Heart rate data – 418
Help – 139

help desk – 457
Noldus technical support – 457

Hiding
columns in event log window – 140
columns in the episode selection – 288
independent variables in 
independent variable list – 91
rows and columns in analysis result – 315

Higher than
external data selecting – 225, 235

— I
Ignore recurring criteria – 349, 355
Ignore recurring targets – 349, 355
Import profile

create new – 176, 428
editing – 184, 434
folders – 447

Importing
data from previous The Observer XT 
versions – 43
european data format files – 435
event log data from 
The Observer XT – 167, 424
external data – 173
independent variables – 426
media files and external data with 
odx files – 427
other observational data – 427
the coding scheme – 426
The Observer XT data files – 424
Viso sessions – 436

Importing data into SPSS – 414, 440
Inactive coding scheme element – 77, 78

in analysis results – 86
Include all results combined – 375, 387
Incomplete events – 120

Independent variable – 86, 330
editing before/after observation – 59
exporting – 444
filtering – 213
format – 88
importing with odx files – 426
predefined variable values – 90
printing – 92
scope – 91
type – 88

Independent variable list
hide/show variables – 91

Index of concordance – 390
Initial state events – 74, 100
Inserting selection box – 203
Installation – 36, 39

before you install – 36
device driver updates – 36
USB stick – 39

Installation DVD – 36
Instantaneous sampling – 51

lag sequential analysis – 356
next sample – 265
previous sample – 265
sample group – 75
sample groups – 73
scoring – 105
statistics – 317
subjects – 68
why use – 52

Interface
The Observer XT interface – 23

Intermittent sampling
see instantaneous sampling – 51

Inter-observer reliability – 364
Interval sampling

see instantaneous sampling – 51
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468
Intervals – 305
based on external data – 224, 225
based on observation time – 224
based on observational data – 224
by duration – 234
by manual selection – 223
effect of suspending 
the observation – 220, 225
elapsed time – 136
how they are calculated – 326
minimum interval length – 235
open and closed borders – 305
remaining time – 108, 136
rules – 244
start criteria – 224
statistics – 317, 325
stop criteria – 225
with external data – 235

Intra-observer reliability – 364

— J
Japanese characters – 32, 407, 424

importing data – 427

— K
Kappa (Cohen’s) – 391

max – 393
significance – 392
statistics – 374

Key code
case-sensitive codes – 57
default length – 58
generate automatically – 57
required – 57
stop codes – 58
subject code – 69

Keyboard shortcuts – 449
Keylogging – 27
Knowledge Base – 28

— L
Lag sequential analysis – 21

across event logs – 352
collapsing observations or subjects – 362
customizing the result – 360
exporting the result – 440
layout of result – 350
overview – 346
procedure – 347
result – 357
with instantaneous sampling – 356

Latency – 323
Legend

charts – 340
License

upgrading – 42
License agreement – 459
License key – 41
License number – 28
Licenses – 22
Line chart – 339
Live and save video – 99
Live scoring – 48, 99

on a netbook – 33
with external data acquisition – 187

Location
media files – 447
projects – 447
templates – 447

Locking project setup – 55
Log file for Technical Support – 448
Logging

computer events – 27
Loop – 27, 143

fixed interval – 143
interval – 65
options – 65
user defined – 143

Lower quartile – 323, 327
Lower than

external data selecting – 225, 235
Index



— M
Managing data profiles – 248
Manual offset – 192
Manual synchronization – 190, 192
Manual variable – 92

hiding – 59
Manually selecting intervals – 221
Maximum

in behavior analysis – 319
in numerical analysis – 327
kappa – 396

Mean
in behavior analysis – 319
in numerical analysis – 327
kappa – 396
per minute – 329

Media file – 436
importing – 131
levels of association with data – 158
position – 101
recording to disk – 50
removing – 159, 438
removing column in independent 
variable list – 438
replacing – 159, 437
scoring from – 48
selecting multiple media files at 
the observation level – 159
setting preferences for file paths – 95
using multiple media files 
simultaneously – 158, 437

Media Recorder – 157, 292
Median – 323, 327
Memory – 35
Menus – 18

right-click – 25
Merged numerical modifiers – 315
Merging – 366

relation with coding scheme – 209
selecting data – 206

MindWare
data acquisition system – 172
import profile – 173

Mini USB-IO box – 188

Minimal interval length
external data selecting – 235

Minimal sampling time for 
external data – 188
Minimum

in behavior analysis – 319
in numerical analysis – 327
kappa – 396

Missing combinations – 148
Missing data – 120, 147
Missing values

in external data – 183, 422
in lag sequential analysis – 350
in reliability analysis – 375
in the statistics result – 302

Mobile scoring devices – 32
Modifier – 78, 79

adding to coding scheme 
while observing – 114
comparing in reliability analysis – 375, 380
defining – 80
defining subjects as modifiers – 83
deleting from coding scheme – 86
filtering – 216
finding – 151
merging in data selection – 208
numerical – 120
numerical analysis – 300
numerical modifier statistics – 326
properties – 82
selecting intervals – 233

Modifying coding scheme – 115, 117
after observing – 117
while observing – 115

Module
external data – 48
multiple media – 21
uASQ – 22

Modules – 22
Moving

coding scheme elements – 85
episodes – 285
events in an episode selection – 285
group of selection boxes – 203
selection box – 203

Multiple coding stations – 409
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Multiple event logs – 164, 167
analyzing – 330

Multiple Media module – 21
Multiple occurrences of events in 
Reliability analysis – 389
Multiple results boxes

data selection – 241
Mutually exclusive – 71, 78

modifiers – 80
Mutually exclusive and 
exhaustive – 72, 77, 78, 100

— N
Name

for observation – 59
Nesting

see intervals

Netbook – 33
New

chart – 336
DAQ hardware settings profile – 187
line in event log – 122
what’s new – 25

No records in reliability analysis – 385
Noldus IT

online – 457
website – 28

Noldus mini USB-IO box – 188
Not normally distributed 
data – 26, 323, 327
Nothing scored in combination – 385, 388
Numerical

analysis – 300
modifier groups – 315
offset – 191
statistics – 326
variable – 88

Numerical modifiers
finding – 154
scoring – 120

— O
Observation – 98, 164

changing name and description – 131
changing start and stop times – 125
current time – 135
customizing observation screen – 133
data outside – 168
elapsed time – 135
exporting – 411
filtering – 212
importing – 424
importing data to an observation – 131
manually stopping – 111
new – 99
observed time – 135
playing back observation data – 114
remaining time – 135
re-opening – 124
resuming – 150
saving – 112
setting an observation for live 
scoring (without video) – 48
settings – 99
start time – 135, 164, 168, 169
starting – 101, 388
stop time – 135, 164, 168, 169
stopping automatically – 110
suspending – 149
time in interval selection – 224
vs. event log – 98, 164
with external data – 156
with external programs – 157
with multiple event logs – 164, 330

Observation duration – 53, 165
analyzed duration – 166
extending – 168
reducing – 169

Observational data
header detection – 434

Observations
sort by name – 25

Observed time – 135
Observer XT data file – 411
ODX files – 410, 411

exporting data – 411
importing data – 424
what data they include – 412

Offline scoring – 48
Index



Offset – 101, 129, 139, 191, 192
number of offset values – 189

Opening
a chart – 342
a data profile – 248
a media file – 437
a project – 407
an analysis result – 439
an audio file – 100
an episode selection – 442
an observation or event log – 124
multiple media files – 158, 159, 437
other observational data – 427

Operating system – 25
Optional variable value update – 92
OR logic in data selection – 240
Order

of data entry – 119
of selection boxes – 246

Ordinate – 341
OTB file

open a project from – 46
save as – 406

OTX file
see OTB file

Overlap of event logs – 330, 331
Overview of the program – 15

— P
Pairs tab – 367
Pausing playback when scoring 
an event – 62
Pearson’s Rho – 393
Percentage (analyzed duration) – 322
Percentage of agreements – 391
Percentage of time spent – 322
Physiological data – 171
Pie chart – 339
Playback control window – 134, 141, 258

customizing – 145
selecting buttons – 26, 144, 145

Playing
playing back the data after scoring – 114
playing back the data in time event plot – 265
the episode selection – 289

Plot
analysis results – 336
external data – 263
observation – 257

PM notation – 61
Pocket Observer

for Google Android – 58
for Windows mobile – 58
supported devices – 32

Point events – 73, 78
paired with unspecified – 389
playing back in the episode selection – 289

Point sampling
see instantaneous sampling – 51

Polar
import profile – 173

Positioning media file – 101
Predefined variable values – 90

replacing or deleting – 90
Preferences – 93
Prevalence index – 395
Previous Observer versions – 36, 167, 379
Printing

a chart – 343
a lag sequential analysis result – 359
a reliability analysis result – 390
a statistics result – 311
the independent variable List – 92

Probability of transitions – 349
Profile

import profile – 176
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Project – 404
backup – 408
create – 46
create from template – 46
creating new – 405
date created – 55
description – 55
explorer – 23, 24
for multiple coding stations – 409
location – 55
locked settings – 409
name – 55
open – 46
opening an existing – 407
renaming/copying – 406
restoring – 408
saving – 406
setting preferences for project location – 95
setting preferences for templates – 95
settings – 59
setup project – 45
with Chinese/Japanese/Cyrillic 
characters – 407

Project setup
locked – 409
locking – 55
unlocking – 56

Project template – 47
Proportion (all samples) – 325
Proportion (scored samples) – 325
Proportion of agreements

see Index of concordance – 390
Proportion of time spent – 322

— Q
Questionnaire

module – 22
Quick help – 29, 139
Quick review – 108

— R
Rate per minute (analyzed duration) – 321
Rate per minute (interval duration) – 321
Rate per minute 
(observation duration) – 320

Reciprocal behavior scoring – 130
Recommended computer – 33, 34
Record video – 49
Recording

digital media file to disk – 50
live video (general) – 113
live video to dv-avi files – 113

Redo – 105, 124
Regional settings Windows – 424
Registered user – 28
Relative event time – 288
Reliability analysis – 21, 363

average kappa – 396
choosing specific event logs – 380
combined results – 375
comparison based on duration – 365
comparison based on 
duration/sequence – 365
comparison based on frequency – 365
comparison based on 
frequency/sequence – 364
comparison list – 387
comparison method – 364
comparison scope – 372
confidence interval – 395
customizing the result – 386, 387
exporting the result – 440
filtering observations – 367
for previous Observer users – 379
how the algorithm works – 376
how to align observations – 373
layout of the result – 376
maximum kappa – 396
minimum kappa – 396
overview – 364
prevalence index – 395
procedure – 366
result – 381
selecting pairs – 367
settings – 370
statistics – 390

Remaining interval time – 108
Remaining observation time – 135
Index



Renaming
a project – 406
a results box – 206
an episode – 285
an episode selection – 281
charts – 342
data profile – 250

Repeated scoring of active behaviors – 62
Replacing a media file – 159, 437
Replacing observations in 
reliability analysis – 369
Report an Issue – 28, 457
Resetting

data profile – 249
filter observations – 367

Restoring a backed up project – 408
Restrict lag to subject-behavior 
group – 349
Result container – 356
Results box – 236

changing the name – 206
creating – 205
effect of filtering – 237
renaming – 206

Resuming an observation – 150
Review

loop – 143
quick review – 65, 142

Rho (Pearson’s) – 393
significance – 394

Roll-off time – 288
changing duration – 289

Roll-on time – 288
changing duration – 289

— S
Sample

interval – 177
number of samples prescan TCAP – 189

Sample groups – 73, 79
Sample projects – 14
Sample rate – 177, 188

Saving
a chart – 341
a data profile – 249
a digital media file – 112
a project – 406
a project as a template – 47
a project as backup – 408
a statistics result – 311
an analysis result – 438
an import profile – 182
an observation – 112

Scaling axes of charts – 341
Scan sampling

see instantaneous sampling – 51
Scatter plot – 339
Scope – 91

in reliability analysis – 372
of an independent variable – 90

Score live and save video – 49
Scored samples – 325
Scoring

data (general) – 102
from video – 50
live – 48, 99
offline – 101
reciprocal behavior – 130
redo – 105, 124
undo – 105, 124

Screen capture – 32
Screenshot of data selection – 202
SDK – 22, 161

automatic synchronization – 163
event data plug-in – 163
external applications – 162
observational data – 163
plug-in viewer COM object – 162

Selecting
media files – 158
pairs for reliability analysis – 367
selection box – 203
window – 133
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Selecting data
behaviors – 215, 228
by manual selection – 221
data profile – 199
data selection screen – 198
duration – 217, 234
external data – 225, 235
filtering – 197, 210
for analysis – 195
for creating a chart – 339
for export – 413, 414
independent variables – 213
intervals – 218
intervals by manual selection – 221
merging – 197, 206
modifiers – 216, 233
observations – 212
subjects – 214, 231
time bins – 197, 236
why select data? – 196
working with selection boxes – 203

Selecting intervals
procedure – 220

Selection box
changing criteria – 205
connecting – 204
copying – 204
deleting – 204
inserting – 203
managing – 203
moving – 203
order of boxes – 246
selecting – 203
selecting a group – 203
working with – 203

Series
adding to chart – 339
formatting – 341
name – 340

Service contract – 458
Sessions

from Viso in The Observer XT – 96
Settings

analysis settings – 316
coding scheme settings – 57
project settings – 56
re-using via a template project – 47
synchronization – 189
video editing settings – 291

Setup – 18
locked – 409
locking – 55
unlocking – 56

Shortcut keys – 449
Show intervals as – 352
Show not scored elements

in lag sequential analysis – 352
in reliability analysis – 376

Show/hide
codes – 133
columns in the episode selection – 287
comment – 134
comments – 271
date with absolute times – 60
events in event plot – 270, 271
external data – 134
frame numbers – 268
grid – 200
hidden rows and columns in an 
analysis result – 315
options in the view settings – 133
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